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Magnifi 5 Overview



INTRODUCING MAGNIFI 5

The Ectane™ instrument is operated by Magnifi, a powerful and easy-to-use acquisition and analysis
software. It is designed for a wide range of nondestructive testing techniques dedicated to tubing and

surface inspections and relies on intuitive wizards to configure setups.

Magnifi has a graphical user interface (GUI) designed to simplify the inspection process and enhance your
experience. Through the GUI, all the functions associated to inspection project management, the global
settings, and the preferences are in what is referred to as the backstage view. All inspection work,
calibration, acquisition, and analysis is in what is referred to as the front stage view. This is how Magnifi

offers a streamlined and coherent interface that makes the learning process easy.

BACKSTAGE OVERVIEW

At the opening of Magnifi, the backstage view is displayed. It is composed of nine sections that supply

different information.

The default section and first section of the backstage view is the General section, which contains

information about:

e Probe currently connected to Ectane
e Selected project and inspection folders
e Currently loaded setup and data

L

Acg. Summary

B

Report Summary

Decumentation

Preferences

o)
<

License

(7

10

General

Project / Inspection

Project Folder:

Inspection Folder: Doc

Setup / Data

SetupLoaded:  From original data file

Setup Location:

Data Loaded: ECT-Bobbin

Data List
Naming Format: | Row, Cal

Preview: 001001.magdata

Report

Name: Report.mdb
Table Profile: Tubing ECT

[[] Take screenshot with report entry

Start / Resume

Magnifi® 5.381T376 - [Setup from original data file] - ECT-Bobbin.magdata

Documents\Magnifi\Projects\Defa

jects\Default\DemoDatas

Jocuments\Magnifi\Projects\Defa

[ ]

Project Folder

]

Inspection Sub-
folder

Create Setup.

Open Setup

i)

]
Open Data

Create New List

=

Import List

Report

T
Export Defect”
Table

Information
Probe: Unable to detect
Application: Generic
Tube Dimensions:

oD 2540mm

WL 165mm

Length: 500 mm
Stainless Steel 316

Material:

Frequencies: 160.0, 80.0, 40.0, 20.0 kHz




This is also where you:

e Create or open a project folder

e Create, open or transfer an inspection sub-folder

e Create or open a setup

e Opendata

e Select the file naming format

o Create or import a list of file names

e Choose the report table profile and automatic screen capture option
e Generate a report or export the defect table

Under many circumstances, this is the only section that is needed to manage inspection projects.

Other sections of the backstage are described below.

FRONT STAGE OVERVIEW

The front stage displays all the information about your current inspection. This is where you will find all
the tools to acquire, save and analyze inspection data.

Continue reading the following sections of the document for additional information on the available tools
and functions.

4
] A & 4 -6 x
1) ome | sow momncs _smmisens i @—10
; | | oses L F
99.2 kHz
n-:
—5
VPP " | FIF P "
9__| Report i _ _ | _
g—of [ [" | II I G N |
T
7 6
1. Backstageicon 7. Information
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Views vary according to the type of probe or technology you are using. You can select layouts or set one

Click to access to backstage view.

Quick access toolbar
Customizable toolbar to provide access to
the commands you use the most often.

Ribbon-style menus
These nine menus allow you to perform
several inspection operations.

Status icons
These icons convey unit status
information graphically.

Data display area
This area is where you will see the
inspection data.

File navigator

Use the file navigator to open and display
files in the data area. An alternative
method would be to use the data tab
(see 10).

10.

11.

This area displays information about
cursor position, measurements and
acquisition parameters.

Keyboard arrow mode selector
Click to change the operational mode of
the keyboard arrows.

Information tabs
Click on the tabs to display information,
documentation, or report content.

Notifications
Click on the tabs to display the
notifications.

Data tabs

Click on the tabs to display the list of
data, DQV tool, Screening tool and
notes.Views

up yourself. This section introduces the various elements of available views.

Note that some elements of a view are automatically removed when the view is resized smaller. To display

all the elements of a view, increase its size until they reappear.

12
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Q —

A

Link button

Views with the same number are linked.
Changing the channel/C-scan or
frequency of a linked view also modifies
all the other linked views.

Global channel/C-scan selector
Regroups the channel/C-scan and
frequency selectors in a single button.

Channel/C-scan group name selector
Frequency selector

Scale

Signal component selector

Vertical arrow for the vertical component
of the Lissajous or horizontal arrow for
the horizontal component of the
Lissajous.

Data area

Cursor

Only the data within the dashed cursors
are displayed in a Lissajous.

Information
Operating frequency.



LissAJous VIEW
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Link button
Views with the same number are linked. Changing the channel/C-scan or frequency of a linked
view also modifies all the other linked views.

Global channel/C-scan selector
Regroups the channel/C-scan and frequency selectors in a single button.

Channel/C-scan group name selector

Frequency selector

Rotate

Warning: Displayed number corresponds to the Lissajous’ rotation, not the signal’s phase angle
measurement.

Scale
Data area
Displays data located inside the cursor of the corresponding strip chart or C-scan.

Sizing measurement
Measurements available only when a sizing curve corresponding to the displayed channel has
been created and calibrated.

Report/Indication codes
Click to add an indication corresponding to the selected code in the report. Long click to edit.

10. Mini Strip Chart area
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11.

12.

13.

14.

15.

16.

17.

18.

19.

Displays two strip charts: Vertical (left) and horizontal (right) components of the Lissajous. When

mini strip charts are used, data displayed in the Lissajous corresponds to the data within the
mini cursors identified with blue dashed lines.

Manual measurement
Use the mouse to manually trace a measurement vector in the Lissajous.

Two-points measurement
Activates two additional cursors in the strip chart. The measurement vector in the Lissajous is
based on the data located at the position of the two cursors.

Invert phase angle measurement
Invert the direction (+ 180°) of the measurement vector in the Lissajous.

Phase angle measurement mode
Phase measurement illustrated by the red dashed line. Automatic adjustment based on the
measurement mode used.

Amplitude measurement mode
Amplitude measurement illustrated by the blue vector. Automatic adjustment based on the
measurement mode used.

Signal measurement result
Based on the measurement modes used.

Cursor position circle
Red circle over data point corresponding to location of cursor in strip chart or C-scan.

Null mark
Center of the Lissajous where the two blue lines intersect. Corresponds to 0 V for both the
horizontal and vertical axes.

Information
Operating frequency or array probe’s channel corresponding to cursor’s position on C-scan.
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1. Link button
Views with the same number are linked. Changing the channel/C-scan or frequency of a linked
view also modifies all the other linked views.
2. Global channel/C-scan selector
Regroups the channel/C-scan and frequency selectors in a single button.
3. Channel/C-scan group name selector
4. Frequency selector
5. Scale
6. Dataarea
Displays data located inside the cursor of the corresponding strip chart.
7. Cursor position circle
Red circle over data point corresponding to location of cursor in strip chart or C-scan.
8. Sizing measurement
Measurements available only when a sizing curve corresponding to the displayed channel has
been created and calibrated.
9. Report/Indication codes

Click to add an indication corresponding to the selected code in the report. Long click to edit.

10. Mini Strip Chart area

16
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

Displays two strip charts: Vertical (left) and horizontal (right) components of the Lissajous. When

mini strip charts are used, data displayed in the Lissajous corresponds to the data within the
mini cursors identified with blue dashed lines.

Save nominal
Saves the current adjustment to the nominal value.

Back to nominal
Returns the signal back to the nominal point previously stored using the button “Save nomina

Normalize signal

Normalizes the displayed signal. Brings the cursor position circle data point to the (1,0) position.

Manual measurement
Use the mouse to manually trace a measurement vector in the Lissajous.

Invert phase angle measurement
Invert the direction (+ 180°) of the measurement vector in the Lissajous.

Phase angle measurement mode
Phase measurement illustrated by the red dashed line. Automatic adjustment based on the
measurement mode used.

Amplitude measurement mode
Amplitude measurement illustrated by the blue vector. Automatic adjustment based on the
measurement mode used.

Signal measurement result + Circumferential extent of the indication
Signal measurement result based on the measurement modes used. Circumferential extent
based on flaw coverage curves (see 22).

Angle correction
Displayed with red font if angle correction is outside of accepted tolerance.

Null mark
Center of the Lissajous where the two blue lines intersect. Corresponds to 0 V for both the
horizontal and vertical axes.

Theoretical nominal point
Corresponds to the intersecting point of the flaw coverage curves.

Flaw coverage curves
From bottom to top: 90°, 180°, 270° and 360°.

Information
Operating frequency.
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”—

ARO

Header

No channel/C-scan/frequency selector in the header of a code view. It regroups together
information coming from all the channels. Position of indications in the code view are directly
related to positions in strip charts.

Saturation
Red background in the code view indicating that signal is saturated. Often happens when the
probe gets in the air.

Reported indications

Position and width of the marks corresponding to position and width of the cursor when
indications were added. Clicking on an indication in the code view automatically moves and
resizes the cursor to match this indication.

Detected indications

Position and width of the marks corresponding to position and width of the detected
indications. Clicking on an indication in the code view automatically moves and resizes the
cursor to match this indication.

Landmarks
Blue triangles pointing at the position of the landmarks. Landmarks don’t have a width.



The Info view displays information using large and easy to read numbers. It can be customized to display
information such as:

e Cursor position on the X or Y axis, in samples or units;

e Cursor width (A) along the X or Y axis, in samples or units;
e Acquisition rate;

e Maximum probe speed;

e Measured crack’s depth and length (Sharck™ probes only);
e Etc.

The outputs provided by an Info view can be different during acquisition and analysis.

The view is automatically divided into the appropriate number of individual boxes to display all the
selected information.

19

Compensated
Depth (mm)

3.2

Length (mm)

12.3

Liftoff (mm)

0.2

Center X (mm)

292.0

Delta X (mm)

49.7

Center Y (mm)

24.0

Delta Y (mm)

15.8




C-ScAN AND 3D C-ScAN VIEWS
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111 J
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Link button
Views with the same number are linked. Changing the channel/C-scan or frequency of a linked
view also modifies all the other linked views.

Global channel/C-scan selector
Regroups the channel/C-scan and frequency selectors in a single button.

Channel/C-scan group name selector

Frequency selector

Signal component selector

Vertical arrow for the vertical component of the Lissajous or horizontal arrow for the horizontal
component of the Lissajous.

Color palette
Double-click or go to current view ribbon to edit.

Data area
Cursor
Only the data within the 2D C-scan cursor are displayed in a Lissajous and in the 3D C-scan.



9. 3D C-scan orientation

Click on the vertical or horizontal arrows to change the orientation of the 3D C-Scan.

A-scaN UT

45
Il

{9—O

[T

General | Gates |

Scan Duration [30.00mm |

Gain [26.0d8 |

InoutFilter [4520MH2 =]

Rectification [Yes <]

l ' il Smoothing Filter [7T5MHz _+]
-1
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A-scan data area

General tab

Regroups general information that can be modified by the user, such as the scan duration, the
tension, the filters, etc.

Gates tab
Regroups information about the positions and dimensions of the gates. Also, contains fields to
adjust the TCG. Fields can be modified by the user.

Envelop
Click to activate the persistence of the data on the screen. To clear the cumulated data from the
screen, disable the envelop option.

A-scan back wall
Zooms on the front wall and back wall portions of the data to make it possible to adjust the back
wall.

Show/Hide A-scan UT view

Back wall gate
Blue outlined box. Use the mouse to adjust the position and dimensions. Alternatively, the gates
tab can be used.

Front wall gate
Red outlined box. Use the mouse to adjust the position and dimensions. Alternatively, the gates
tab can be used.

Pin gate
Back outlined box. Use the mouse to adjust the position and dimensions. Alternatively, the gates
tab can be used.

10. Gain



Identified by the yellow line. Flat portion is the static gain. Angled portion is the Time
Compensated Gain (TCG). Use the mouse to adjust the position and dimensions. Alternatively,
the tabs on the right can be used.

PROJECTION
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————— H —
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View A-scan

O—4) |

1. C-scanview
For additional information, see the previous section dedicated to the C-scan view.

2. Infofields

Customizable infofields providing information such as the wall thickness, the wall loss, etc. Fields
can be added/removed.

3. Scale

Circumferential projection view

5. Cursor’s brackets
Automatically adjust to the wall thickness at the location of the cursor. Can be manually
adjusted using the mouse if necessary.

o

6. Nominal
Yellow portion showing the nominal dimensions of the tube.

7. Cylindrical projection view
8. Report/Indication codes

Click to add an indication corresponding to the selected code in the report. Long click to edit.

9. Show/Hide A-scan UT view
10. ID/OD
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Identification of the OD and the ID of the tube in the Circumferential and Longitudinal projection
views.

11. Longitudinal projection view



Operating Magnifi 5
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BACKSTAGE DETAILS

The intent of the following pages is to highlight several key features and important details about each
section of the backstage in order to provide guidance and helpful information to the users of Magnifi 5.

GENERAL SECTION

Magnifi® 5.3B1T376 - [Setup from original data file] - ECT-Bobbin.magdata -8x
General
Project / Inspection Information
Project Folder: Documents\Magnifi\Projects\Defa Probe: Unable to detect
) 9 )
General r
Inspection Folder: Decuments'Magnifi\Projects\ Default\DemoDatas .6 "0 Application:  Generic
Project Folder | |InsPection Sub- Transfer
rese folder nspection Tube Dimensions:
oD: 2540

Acq. Summary Setup / Data mm

Setup Loaded:  From original data file WE - 1.65mm
. L +

Setup Location: Jocuments\Magnifi\Projects\Defa '6 - Length: 500 mm

Report Summary Create Set Open Set Open Dat: )
Data Loaded: ECT-Bobbin reate Setup pen Setup pen Data Material  Stainless Steel 316

Frequencies: 160.0, 80.0, 40.0, 20.0 kHz
Data List
Naming Format: | Row, Col ~
Preview: 001001.magdata = =
Create New List Impaort List

Documentation
Report
Name: Report.mdb ~

EEEER Table Profile: Tubing ECT - @ © .
. Export Defect
eport
[] Take screenshot with report entry Table
License

Start / Resume

Project / Inspection

Project Folder: ChUsers\orousseau-gyr\DocumentsiMagnifiyProjecs\Default

Inspection Folder: ChUJsers\orousseau-cyr\Documents\Magnifi\Projects\Default\Default ro -0 .D

. Inspection Transfer
Praject Folder :
) Sub-folder Inspection

Magnifi offers a two-level folders structure to stay organized. The higher-level folder is called the Project.
The second-level folder, or sub-folder, is called the Inspection. The Project folder simply regroups
together Inspection sub-folders that are related in some ways.
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For instance, a Project folder could be created for all the inspections to be performed during a refinery
shutdown. Each Inspection sub-folder could focus on a specific asset or component of the refinery. All the
files used and produced for a given Inspection are stored within the Inspection sub-folder.

PROJECT
(ex: Refinery 04-17)

|
| l l

INSPECTION 1 INSPECTION 2 INSPECTION ...
(ex: Bundle No A1D3FX)

* Setups;

¢ Data lists;

* Data files;

= Screen captures;
* Notes;

* Reports;

The Project folder and Inspection sub-folder buttons open windows allowing you to add new folders or
browse and select existing ones.

A Default Inspection sub-folder gets automatically created when the Project folder is selected. This
Default Inspection sub-folder can’t be deleted or renamed.

H Manage *
Inspections
(1] Manage Inspections Select Other...
Name State
Default Ready for | t
Bl select 2 project x efaul eady for Inspection
DemoDatad.3 Inspection Done |:|
« v <« Magnifi » Projects » v O Search Projects »p
DemoDatad.2 R Inspection Done |:|
Organize ~ New folder == - 0 DemoDatad.4 Inspection Done |:|
[ This PC - Name Type DemoDatad.4 R Inspection Done |:|
3D Objects Default File folder MNew inspection |:|
[ Desktop Project 1 File folder
= Documents Project 2 File folder
3 Downlosd Project 3 File folder
ownloads
B Music
| Pictures
B Videos
. 05(C) ¥ = =
Folder: | Default
Select Folder Cancel

Figure 1 Project / Inspection management windows

The Transfer Inspection button is available only when an external drive is connected to the computer.
This button allows you to transfer Inspection folders with all their content between the local drive and
the external drive. The Inspections are transferred to the Project folder selected with the drop-down
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menu. In the figure below, clicking on Export would copy the local Inspection called New inspection in the

Project called Project ABC located on the external drive.

% Inspection Transfer

.- Inspection Transfer
=] Select the Inspections you want to copy between the local and external drive.

Local Inspections

Project: | Default <

Name
Default
DemoDatad.3

DemoDatad.3 R
Import

DemoDatad.4 -
4" Export
DemoDatad.d R

[X]%]X][X]

BHooooo

Inspections on External Drive

Project: | Project ABC

Select All | | Clear All
Mame

[] Component1

[] Component2

(X

Note that the Project folders that are detected and displayed in the Project drop-down menus must be

located at the following directories:

» USE Drive (D) + Magnifi * Projects

#» ThisPC » Docurnents » Magnifi » Projects »
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SETUP AND DATA

Setup / Data

Setup Loaded: From original data file
Setup Location: Ci\Usershorousseau-cyr\Documents\Magnifi\Projects\Default

Data Loaded: PSBCO708-001

1

=
Create Setup Open Setup Open Data

A new setup can be created by clicking on the Create Setup button, which will guide the user through a

step-by-step process that differs for each inspection technique.

The Open Setup button is used to retrieve an existing setup from different locations such as the Master

List (user-configured), the Default Master List (installed with the software, can’t be modified) or from the

Inspection sub-folders contained in the current Project folder. Another option is to click on the Select

Other... button to browse on your computer.

. Open
Setup
O Selecta Setup

X

Select Other...

MName

@ Current Inspection (1)
(%) Recent Files (5)

@ Master List (1)

@ Default Master List (91)
® Default (2)

@ Inspection bundle 1 (3)

@ Inspection bundle 2 (2)

Location

oK Cancel

The Open Data button allows you to load a data file from the current Inspection sub-folder. It is also

possible to browse on your computer to load a data file in a different location. The location of the loaded

file will become the current Inspection sub-folder.
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DATA LisT

Data List

Maming Format: Zone, Row, Col v

Preview: ZoneD01001.magdata o ump ey
(= [

Create New List Import List

Four options are available to configure the file naming format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for heat exchanger tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for heat exchanger tubing
inspections.

5. Custom:
Allow you to create a custom file format with other properties than the ones presented above. A
new property can be customized by choosing its name, by adding a default prefix or a suffix or
by selecting is type (Number or Text). All the parameters that can be changed are shown in the
following figure.

Configuration name:
Custom file format
Properties:
Prefix D Seldsted Property
Index Name: custom property
custom property D Prefix:
l:‘ Suffix:
Value type: @ Number O Text
Value length 1 digit(s) -
Default sorting: @ Ascending () Descending
Default sort order.
L) Prefix [ Index » | 4 custom property »
File name previews:
Data file: A-0001.magdata

Re-scan data file: A-0023.001.magdata
Screenshot file:  A-0045.001.png
Comment file: A-0067.001.txt

For improved productivity, the names of the files to be acquired can be generated prior to the inspection
by using the Create New List button. Several different lists can be added in the same Inspection.
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‘ W File List Creato X | Data ‘IF' x
File List Configuration
| Zone A 25 c{ 25 daa jY]‘
Number of Rows in Compenent: |4 >
Start Numbering at Row: 2 > | Zme HW Cd ﬁ
Row Interval: 1 -
MNumber of Columns per Row: ’ ﬁl. 002 m1
Row Nb. of Columns
2 3 P A 002 002
: j » A 002 003
P A 003 001
P A 003 002
> A 003 003
‘ Column Interval: 1
Include first and last column of each row ’ A 004 001
‘ Files to Create: 9
Filename Preview: A0D1001 P A 004 002
‘+ Create & New | |\/ Create | | x Cancel ’ .I‘"- 004 DDS

A complete List can be imported from a different Inspection folder by clicking on the Import List button.
Note that the complete List of files of an Inspection is automatically stored in a file called
FolderDescription.xml, located in the Inspection folder.

I open X

—1 Import inspection

=0 Select a File
Name Location

@ Current Inspection (1)
FolderDescription.xml |Z|

(%) Default (1)

® DemoDatad.3 (1)

® DemoDatad.3 R (1)

® DemoData4.4 (1)

® DemoData4.4 R (1)

|\/ K ||x Cancel|

It is also possible to import a List created in the TubePro™ software, which is directly available from
Eddyfi™.
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REPORT

Report
MName: Report.mdb v
[
Table Profile: Tubing ECT v o .
Report Export Defect
[] Take screenshot with report entry Table

A selection of several defect table profiles to be displayed in the report can be selected from the Table
Profile drop-down menu. The information displayed in each profile is adapted to a specific inspection
technique.

Once the analysis of a data set is completed, the Generate Report button can be used to produce a report.
A few report parameters can be configured, such as the # of tube in component, which is used to show
the percentage of tubes in each category. Additional customization of the report’s header, such as the
company logo, can be done through other sections of the backstage. Continue reading for more
information.

[s] Report Summary
| configure the summary section

B Generate Report *

Report Parameters
Tube project parameters Client

Component Type

# of tubes in component: |30 - Component S/N

Site

Service Provider
Wark Order
Procedure

Calibration Standard ~

Comment

Add| [Clear| [Reset to Default] [Import| |Export

Manage ..|

Cancel ' Mext Display in File Explorer Cancel Finish |

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed
using any regular web browser.

There is a “copy” button next to each element of the report such as tables and images. When clicking on
it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or
Word.
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Eddyfi . i
W Analysis Report @ Setiogies

Instrument Settings

Channels Instrument Settings

Channel Calibrations
Setup name: ECT-Bobbin
Mix Channels

‘Component

Information Channels
Inspection Summary
Indication Table Name Frequency (KHz) Drive (V) Gain (dB) Low Pass (KHz) High Pass (Cnt)
Mee=iem R_ABS-F1 1600 250 460 400
Data
R_ABS-F2 80,0 2,50 46,0 400
R_ABS-F3 40,0 2,50 46,0 400
R_ABS-F4 20,0 2,50 46,0 400
R_DIF-F1 160,0 2,50 46,0 400
R_DIF-F2 80,0 250 48,0 400

R_DIF-F3 40,0 250 46,0 400

The Print button, bottom right corner on image above, can be used to either print a paper copy of the

whole report or to save it as a .pdf document. The PDF generator available with the current web browser

wwzes 153 Magn gt
. - Imprimer 4 pages
Analysis Report (Gl P
Instrument Settings Destination B cnregistrer au format | v
Sotup mame: ECT-Babiin
Channels Pages Tous
o [r— o cmm f— Jr——
e s e . - Mise en page Portrait ~
ansr ™ 23 o @
e ™ 2 “ @
[ 2 P s o Plus de paramétres ~
e s 2 “n -
owrz ™ 23 “n @
oer ™ 2 “ @
e ™ 2 “n @

m Annuler
“

From the Backstage, the Export Report button allows you to export only the defect table in several
formats such as Tubepro or CSV.

Take screenshot with report entry option captures an image of the front stage every time an indication
is added to the report. The screenshots are visible in the Data tab of the front stage and can be appended
to the report.
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INFORMATION

When the computer has been connected to the Ectane through the Magnifi interface, probes with a
configured chip-ID can be recognized when connected to the instrument. In that condition, the probe
model will be displayed. The software will send a warning if the loaded setup is not compatible with the
connected probe. Note that the appropriate setup is not automatically loaded when the probe is
connected, it must be manually loaded by the user.

Information
Information Probe: SHARCK-BWO053-G2
Probe: SHARCEK-BW053-G2 A\l Incompatible with current setup, |

Also, the message Unable to detect could simply mean that the probe being used does not have a
functional chip-ID, but it can still be used for inspection.

Information

Probe: Unable to detect

START / RESUME

Click on the Start / Resume button or the blue arrow icon at the top-left of the backstage to switch to

the front stage view.
Start / Resume .
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ACQUISITION SUMMARY SECTION

This section of the backstage allows you to specify information related to the inspection and the inspected
items such as the component type, the service company, the operator, the serial number of the probe
used for inspection, etc. This information remains attached to the data files, even if they are separated
from the original Inspection folder. Therefore, the Acquisition Summary should be filled in before data
acquisition.

Note that the information can be updated at any time during an inspection to reflect the real conditions
in which the data were acquired. For instance, a change of operator would ask for a modification in the
Acquisition Summary. Therefore, all the files acquired by the new operator would be tagged correctly.

The Acquisition Summary is also saved with the setup file.

Fields can be added, removed and customized. Additional information can also be typed in the Comment
section. The bottom portion of this section (Filename, Setup, Date, Version) is filled automatically.

Note that it is possible to import/export the Acquisition Summary with all the information it contains for
improved productivity.

Magnifi® 5.0R1 - ECT-Bobbin. magdata B

Acquisition Summary

Add| (Ciear| Reset to Defautt [Import| |Export

Manage ..
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REPORT SUMMARY SECTION

This other section of the backstage allows you to specify information that will appear in the header of the
reports, such as the client, the work order, the procedure, etc.

Fields can be added, removed and customized. The fields that are grayed are linked to the Acquisition
Summary and will be filled if the corresponding fields are filled in the Acquisition Summary section.
Additional information can also be typed in the Comment section.

The Report Summary is saved with the setup file.

Note that it is possible to import/export the Report Summary with all the information it contains for
improved productivity.

Magnifi® 5.0R1 - ECT-Bobbin.magdata

Acquisition Summary

Cent
Component Type  ~
Companent S/N

Site

,,,,,,,

Add| (Ciear| Reset to Defautt [Import| |Export
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SAVE SECTION

The Save section of the backstage proposes a few different saving options for the data files and the setup
files:

1. Save Setup:
Saves the currently used setup in the current Inspection folder.

2. Save Setup as...:
Saves a new copy of the currently used setup and allows you to specify its name and location.

3. Save Setup as Read-Only...:
Saves a new copy of the currently used setup and allows you to specify its name and location.
The file can’t be overwritten. Attention, it remains possible to apply modifications to the setup
while using it, however, the modifications can’t be saved.

4. Copy Setup in Master List...:
Add the currently used setup to the Master List for a quick access from any Inspection folder.

Magnifi® 5.0R1 - ECT-Bobbin.magdata

10
up As Copy Setup In
Master Ust.

Data

==
Copy Data..
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MATERIAL DATABASE SECTION

The Material Database section shows a list of materials and their properties.

Three properties are associated to each material. The resistivity and the permeability are used by Magnifi
to calculate the theoretical inspection frequency of the electromagnetic techniques. The ultrasonic
velocity is used to preset the gates’ locations when using IRIS.

Magnifi® 5.0R1 - ECT-Bobbin.magdata

Material Database

Custom Materials

Resistivity (s Reiative Permesbilty Ry
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DOCUMENTATION SECTION

This section of the backstage allows you to open PDF documents. A list of documents is automatically
added during the installation of Magnifi. Other documents such as codes, procedures or drawings can be
added to the list by saving a copy at the following location on your computer:

» ThisPC » Docurmnents * Magnifi » UserData

Magnifi® 5.0R1 - ECT-Bobbin,magdata

Documentation

Name

Ectane SXSC2001G - Users Guide - EN - 201310

User's Guide - Probat
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SYSTEM PREFERENCES SECTION

Magnifi® 5.0R1 - ECT-Bobbin.magdata

System (Computer Related)
Measurement Convention Measurement Units
® ASME N ® Metric
ASME Inverted - Imperial
EDF e
Readback
¥/ Do not display data during loading
Speed

Keep Current Setup” Button Behavior:
Retain check state

® Reset to checked after loading a data file

Setup Wizard Path: |C:\Users\daube\Documents\Magnifi Setup Browse..

Automatic Features
Allow to save setup in original location

] Reminder to save setup after acquisition if not saved yet

Logo
T Preview

. .
=5 Eddyfi
Technologies

Shartcuts

Keyboard.

Remote...

Integration
TubePro 5.3 of greater

[l Keyboard Shorteuts X
Actions Shorteuts
Add General Marker Return
Add next landmark Fo
Add Number Marker Alt+Return
Balance 6
Best Fit F12
Center Space
Change Active View AlteFT
Change Layout Fil
Clear Fs
Manual Measurement M
Maxirmize / Minimize View AltrFE
Next Data Segment R
Next File 21
Next Indication F8
Next Indication (Without resize) Ctrl+F8
No Indication N
Previous Data Segment 3
Previous File F3
Previous Indication F7
Previous Indication (Without resize) Curl+FT
Quick Copy AltrFS
Raster Next Pass o
Raster Previous Pass A
E T
Start / Stop Acquisition F2
Start / Stop Recording F10
Tag/Untag T
Toggle Arrow Keys K

The System Preferences section contains several options that are related to the user’s computer, meaning
that the configurations will remain the same, independently of the loaded setup file.
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The Select Company Logo button allows you to define the logo to be displayed in the header of the report.
The button lets you browse your computer to select an image with any of the following
formats: .bmp, .png, .jpg, .jpeg.

The list of default keyboard shortcuts available during acquisition and analysis can be visualized and
managed by clicking on the Keyboard... button. To modify a shortcut, simply select the action in the list
and press the desired key.

To integrate the TubePro software with Magnifi, check the TubePro box at the bottom of the System
Preferences section.

GENERAL PREFERENCES SECTION

The General Preferences section contains several options that are related to the setup, meaning that the
configurations are stored with the setup when it is saved and are retrieved when the setup is loaded.

Additional information regarding some of the available options:

1. Hide Raw Channel:
Only the processed channels appear in the list of available channels to be displayed in the front
stage, facilitating the analysis if the raw channels are not relevant.

2. Automatic File Recording:
Data recording is initiated as soon as the acquisition starts. When unchecked, a Record button
will become available in the front stage during acquisition. After starting the acquisition, data is
displayed on the screen, but it is not recorded until the Record button is pressed.

3. Auto Create new file on Next:
Automatically adds a new file name in the data tab of the front stage when clicking on the Next
button.

4. Automatic Next on Stop acquisition:
Automatically skips to the next file in the list when stopping the acquisition, making the
acquisition process faster.
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Magnifi® 5.0R1 - ECT-Bobbin.magdata

General (Setup Related)

Measurement Units

Report Units: | Millimeter

] Automatic Next on Stop acquisition

DISPLAY PREFERENCES SECTION

The Display Preferences section also contains several options that are related to the setup, meaning that
the configurations are stored with the setup when it is saved and are retrieved when the setup is loaded.

The Name Splitting options refer to the channel/C-Scan group name selectors displayed in the headers
of the different views for easier navigation. By default, it is set to Automatic. The software automatically
recognizes patterns in the names of the channels/C-scans and produces the appropriate selectors.
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Display (Setup Related)
Colors

Color Scheme: | Light v

General Preferences
] Display Null Mark

Zoom Behavior on Stop Acquisition
Lissajous
] Display Cursar position circle

Display Mini Strip Charts

Channel
=

Display Direction

C-saan

Hame Spitting
/] Split Channel Names

® Automatic

Manage.

Magnifi® 5.0R1 - ECT-Bobbin,magdata

Keep Current Scale  ~

Down

Manual: Prefix Frequency

/] Spiit C.scan Names

@ Automatic

Channel Group coil Manual: Prefix

Display Duration
® Time

Scan avis scale displayed during acquisition:

Channel Group Frequenty

Sample

10,0005



ANALYSIS PREFERENCES SECTION

The Analysis Preferences section also contains several options that are related to the setup, meaning that
the configurations are stored with the setup when it is saved and are retrieved when the setup is loaded.

Magnifi® 5.0R1 - ECT-Bobbin,magdata

/| Absolute Select All

Clear All

7| Peak to Peak

/| Peak to Peak First Transition

] Peak to Pesk First Transition

The Measurement Methods portion shows all the possible measurement methods that can be used by
Magnifi. Only the selected methods are available for analysis, defects reporting, sizing curves, calibration,
etc. Itis recommended to select only the methods that are relevant to facilitate the analysis. The methods
are:

1. Absolute (A):
Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude.

2. Absolute Horizontal (AH):
Uses only the horizontal component, from the Lissajous origin to the main cursor position to
measure amplitude.

3. Absolute Vertical (AV):
Uses only the vertical component, from the Lissajous origin to the main cursor position to
measure amplitude.

4. Absolute Peak (AP):
Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure
amplitude.

5. Absolute Peak Horizontal (APH):
Uses only the horizontal component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.
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10.

11.

12.

13.

Absolute Peak Vertical (APV):
Uses only the vertical component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

Average Peak (MP):

Takes the distances from points at the extremity of the cursor to the peak of the data selection

to build an average vector. Used only, and recommended, for absolute signals.

Average Peak Horizontal (MPH):

Uses the horizontal component of the distances form points at the extremity of the cursor to the

peak of the data selection to make an average vector. Used for absolute signals.

Average Peak Vertical (MPV):

Uses the vertical component of the distances form points at the extremity of the cursor to the

peak of the data selection to make an average vector. Used for absolute signals.

Peak to peak (PP):
Uses the combination of the vertical and horizontal component to measure the maximum
amplitude.

Horizontal (PPH):
Uses only the horizontal component to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to measure the amplitude.

Peak to peak First Transition (PPF):

Uses the combination of the vertical and horizontal component of the first transition of the
signal to measure maximum amplitude. The firsts signal transition is from the base of an
indication to its peak.



LICENCE SECTION

Magnifi 5 integrates a cloud-based licensing system to activate, release and share a license key in seconds,
worldwide, without requiring assistance from Eddyfi.

To activate, manage or simply view the status and information associated with a license, launch Magnifi
5 and open the License menu by clicking on the License tab button from the backstage interface. Note
that an internet connection is required to perform operations on this menu.

Magnifi® 5.0R1 - [Mew setup.magsetup]

License

Current License Information

Status: Valid
General License Code:
h Package: PRO
ro Computer 1D
Acg. Summary Company: Eddyfi
Type: Subscripticn
% Last Refreshed: July 18, 2022 1:57 PM
Terar FarTeT Licensing System: Connected
Renewal Date: Movember 01, 2022
Contact Information
First Mame: First Name
Last Mame: Last Name

Material Database Company Name: Eddyfi

Contact Email:  support@eddyficom

Fhone Number:  1-418-760-1365

Documentation Edit...

>

Preferences

Once a license has been identified as valid, Magnifi can be used without any internet connection for a
given period of time. Whenever an internet connection is established while using Magnifi, the software
automatically contacts the cloud-based licensing system to confirm the validity of the license and reset
the offline time period, without the need to access the Licence menu.
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If the software remains offline for longer than the allowed time, the license will be temporarily
deactivated, and it will no longer be possible to use Magnifi. To correct the situation, simply connect to
the Internet and let the license system refresh.
License

Current License Information
Status: Valid v

License Code:
Package: PRO

Computer IC:

Company: Eddyfi
Type: Subscription
Last Refreshed: July 18, 2022 3:31 PM
I Licensing System: Mot Connected 0 I
Renewal Date: November 01, 2022

l Connection to internet required by: September 16, 2022 I
Manage. S Refresh

It is important to keep the Contact Information section of the License menu up to date, as it can be used
by Eddyfi staff for assistance.

Contact Information

First Mame: First Mame

Last Marme: Last Mame

Company Name: Eddyfi

Contact Email:  support@eddyficom

Phone Mumber:  1-418-780-1565

Edit...

To Activate a license, click on the Manage... button to open the Manage License menu, type the license
code in the designated field and click on the Activate button.
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License

Current License Information
Status: Released iy

License Code:

Package: None
Computer ID: .
I rz2nage License *
Company:
Last Refreshed: -
Licensing System: . .
Current License Information
Renewal Date:
Enewal Uate Status: Released iy
Connection to ja#net required by: License Code:
[ = Package: MNone
9

Computer 1D: |
Contact Information Company: Eddyfi
First Mame: First Mame Type: Subscription
Last Name: Last Name Last Refreshed: July 18, 2022 3:58 PM
Company Name; Eddyfi Licensing System: Connected v
Contact Email:  support@eddyfig

= F i Renewal Date: November 01, 2022 @

Phone Mumber:  1-418-T&0-1363

Ceonnection to internet required by: Septermnber 16, 2022 @

Edit...
~u

A given license code can only be activated on one (1) PC at a time. To assign a license to another PC, it
must first be released from the original PC by clicking the Release button. Then the code becomes
available and can be entered in the License Code field for activation in another PC. These steps make it
easy to share a license between users, even if they are in different locations. They can also allow a switch
to another type of license, for example from a data acquisition license to a standard analysis license.
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License

Current License Information
Status: Valid v

License Cade:

Package: PRO
Computer ITx
. Manage License *
Company:
Type: License Code: e inate
e
Licensing System: .
Curreptlicamsesefe TItion

Renewal Date:

Status: Valid v
= Licenze Code:
Contact Information Package: PRO
First Mame: First Mame Computer |D:
Last Mame: Last Mame Cornpany: Eddyfi
Company Name; Eddyfi Type: Subscription
Contact Email:  support@eddyfi.d Last Refreshed: July 18, 2022 4:01 PM
Phone Mumber:  1-418-780-1365 Licensing Systern: Connected v

Renewal Date: MNovember 01, 2022

Edit...

Close

The cloud-based licensing system offered with Magnifi 5 is not compatible with Magnifi 4. Therefore,
moving to the most recent version of Magnifi requires an upgrade from an existing Magnifi 4 license keys.
Once upgraded, the key can no longer be used with Magnifi 4 versions.

If needed, Eddyfi can offer users the possibility to trying the newest 5.x version, while maintaining access
to Magnifi 4.x using a transition license. A transition license is a Magnifi 5 key that is linked to a specific
Magnifi 4 key. In this condition, Magnifi 5 will run only if both keys are connected to the computer
simultaneously.

Once the transition license user feels ready to fully upgrade, the previous license key needs to be
deactivated. This operation can’t be reverted. A simple procedure must be followed.

Please contact your sales representative to find out the best path forward to make the most out of this
licensing system.

HELP SECTION

The last section of the backstage shows information about:

e The version of the software;
e The instrument currently connected to the computer;
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e Eddyfi’s contact information.
This is also where you can:

e Edit the privacy options;
e Get Assistance

The Get Assistance button allows you to send information about a problem you encounter with the
software. You can first fill in the form accessible through the Ask for help button. If relevant, you can also
use the Export files button to send the file associated with the problem you want to report. This
information will be used to analyze the problem. Following a request an expert will contact you.

Magnifi® 5,081 - [Setup from criginal data file] - ECT-Bobbinmagdata - &%
Help
System Contact Information
Software Version: Magnifi® 5.0R1 Build 5 ] Edayfi Technologies

Pigrre-Ardouin

] Québec G1P 083
Check for Updates

-

-«
Get Assistance

Show License Agreement

Instrument R
Nt connected
Privacy Options
| Edelyf Technologies
Product Improvement Program
; Allow Notifications from

Eddyfi Technologies
Show Program Details
Third-Party Licenses
Show Inctrumnent Licenses

Material Database Show Software Licenses

Documentation
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ECT Bobbin Probes ECT Detachable Bobbin Probes

YL

ECT Flexible Bobbin Probes ECT Magnetic Saturation
Bobbin Probes
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INTRODUCTION

This document presents how to use an ECT probe with Magnifi 5 on an Ectane test instrument.

Eddyfi offers four types of ECT bobbin probes. The following was made using a standard bobbin probe
(ECT-BBST), but can also be applied to all other types of ECT bobbin probes.

EQUIPMENT

ECT probes use a 4-pin connector that can be connected to an Ectane with the “E” option. The absolute

and differential signal from the probe will provide Strip charts and Lissajous.

As these probes need to fill an optimal portion of the tube inner diameter, a wide range of probe

diameters are offered (see the tubing probe catalog for more details). A wide range of frequencies is also

available to allow inspections of tubes of different thickness and material.

From the following tables, the best standard probe for your application can be selected. Note that Eddyfi

also offers custom products that are not shown in these tables.

9.53mm
12.70mm
15.87 mm
19.06mm
22.22mm
25.40mm
31.75mm
38.10mm
50.80mm

TUBE 0D
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BWG 10 1"
mm 340 305
in 0135 0120
0.375in = =
0.500in - -
0.625in 084 090
0.750in 114 122
0.875in 144 152
1.000in 174 182
1.250in 234 238
1.500in 295 300
2.000in 415 420

Table 1 — ECT-BBST probes diameter selection table

12
2,77
n.109

096
126
156
186
2486
310
430

13
2.41

14

21

TUBE WALL THICKNESS (BWG, mm, in)

15

1.83

16

1.65

17

1.47

18

1.24

nnas 0083 0072 0065 0058 0.049

072
104
134
164
194
255
315
435

440

084
114
144
174
204
265
325
445

088
118
148
178
208
270
330
450

080
122
152
180
210
275
335
455

096
126
156
186
216
280
340
460

19
1.07
n.n4z2
098
128
158
188
218
280
340
460

20 21 22 23 24
083 081 071 065 056
no3s 0032 0028 0025 0022
070 072 074 076 078
102 104 106 106 108
132 134 136 136 138
162 164 166 166 168
192 194 196 196 198
222 224 224 226 228
285 285 290 290 290
345 345 350 350 350
465 465 470 470 470



Table 2 — ECT-BBST probe frequency range selection table

TUBE WALL THICKNESS (BWG, mm, in)
BWG 10 1 12 13 14 15 16 17 18 19 20 21 22 23 24
mm 340 305 27 241 211 183 165 147 124 107 089 08 071 065 056
in 0135 0120 0.109 0095 0083 0.072 0065 0058 0049 0042 0035 0032 0028 0.025 0022

Aluminum UF UF UF UF UF UF UF UF UF UF LF LF LF LF LF
Aluminum bronze UF UF UF UF UF LF LF LF LF LF LF LF LF MF MF
Brass (admiralty) UF UF UF UF UF UF UF UF LF LF LF LF LF LF LF
Brass (70/30) UF UF UF UF UF UF UF UF LF LF LF LF LF LF LF
Brass (85/15) UF UF UF UF UF UF UF UF UF LF LF LF LF LF LF
= Brass (95/5) UF UF UF UF UF UF UF UF UF UF LF LF LF LF LF
cc  Copper UF UF UF UF UF UF UF UF UF UF UF UF LF LF LF
E Copper-nickel (70/30) UF LF LF LF LF LF LF LF LF MF MF MF MF MF HF
= Copper-nickel (90/10) UF UF UF UF LF LF LF LF LF LF LF MF MF MF MF
Copper-nickel (95/5) UF UF UF UF UF LF LF LF LF LF LF LF LF MF MF
INCONEL® 600 LF LF LF LF LF MF MF MF MF MF HF HF HF HF HF
Stainless steel 304/316 LF LF LF LF LF LF MF MF MF MF MF HF HF HF HF
Titanium 99 % LF LF LF LF LF LF LF LF MF MF MF MF MF HF HF
Zirconium LF LF LF LF LF LF LF LF MF MF MF MF MF MF HF

Table 3 — ECT-BBST Frequency range

CODE FREQUENCY IN kHz
Min. Max, Central
UF 1 10 5
LF 10 100 50
MF 50 500 250
HF 100 1000 500

The ECT calibration tube used in this document includes the following flaws:
e Internal groove, 10% of wall loss
e External groove, 20% of wall loss
e Hole, 100% of wall loss
e OD Flat Bottom Hole (FBH) at 40%, 60% and 80% depth
e OD4xFBH20% depth
Other combinations of flaws can be used to calibrate the probe and to build sizing curves.

Note: Fill factor and selection tables may differ for other types of bobbin probes. Please refer to the tubing
probe catalog on our website to find out more.
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In this section, we will create a folder structure that will manage the saving location of your setup, data
and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of files. The first level is the Project. It is meant to include different inspections
that are related in some way. For instance, it can include all the inspections done at a refinery shutdown
and be named Refinery_Shutdown_May 2018. The second level of file is the Inspection folder. Inspection
folders are saved in the project file. An inspection folder can include the data specific to the inspection of
a tube bundle with a specific technology and could be named SS316_075x0.065_ECT, for instance. This
inspection folder groups the setup, the tube list, the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

—F— ] |

INSPECTION 2 INSPECTION X

| |
I |
| |
| |
| SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE |
| <« D

| LIST A I
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
I |
e--- - - - - - - 1
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When you open Magnifi, the first page displayed is called the Backstage.

Magnifi& 5.3B1T376 - [Setup from original data file] - ECT-Babbin.magdata

General
Project / Inspection Information
Project Folder: Documents\Magnifi\Projects\Def Probe: Unable to detect
General r
Inspection Folder: Documents\Magnifi\Projects\Default\DemoData3 .5 o Application: Generic
Project Folder | | ITSPEction Sub- Transfer
s e older nspection Tube Dimensions:
A S OD:  2540mm
\cq. Summary Setup / Data
Setup Losded:  From original data file WE 165 mm
. L
Setup Location: Jocuments\Magnifi\Projects\Defa () é Length: 500 mm
SR Create Sety Open S
P pen Setup Open Data )
Deta Losded:  ECT-Bobbin Materiali  Stainless Steel 316

Frequencies: 160.0, 80.0, 40.0, 20.0 kHz
Data List

Naming Format: | Row, Col -

Preview: 001001.magdata — c—

Create New List| | Impert List

Documentation
Report
> S Report.mdb .
i P
Preferences Table Profile: Tubing ECT “ © .
Export Defect
) Report
[[] Take screenshot with report entry Table

License

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an existing
project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your project file. Select
New, Folder and enter the chosen name. You can then select the newly created folder and click
on Select Folder.

—
I Sciect 3 project [
@ J* -4 e

Organize v New folder s @
\
|
- = ’
g
i
L Projects Folder
A Shorteut
@' Microsoft Access Database
& Biamap image
3 Contact
81 Microsoft Word Document
= View » 3] Microsoft Access Database
B Sort by » B Microsoft Project Document
Group by * @) Microsoft PowerPoint Presentation
. Refresh @3 Microsoft Publisher Document
[ SonicWALL Global VPN Client Document
s ~ #  Rich Text Format
B Undo Delete CrleZ e Doxapent
e G/ Dessin Microsoft Visio
Share with ’
E = B Microsoft Excel Worksheet
New » B Briefase
Properties
Folder: Magnifi
| select Folder Cancel
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2. Click on Inspection Sub-folder in the backstage, then click on Add and enter the name of your
inspection.

- N
. Manage ﬁ

l Inspections
o Manage Inspections Select Other...

Mame State

Default Ready for Inspection

Bundle_A_55316_0.75X0.065_ECT |_E

|V’ Select |[x Close ]

. 4
3. Click Select. This will define the position where the setup(s) and data will be saved.




SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System
tab, you can change the measurement units from metric to imperial and vice versa. For the metric units,
you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement
for imperial units is inches. When finished, click on Preferences again to go back to the General window.

System (Computer Related)

Measurement Convention Measurement Units
® ASME Y ® Metric
ASME Inverted e j Imperial
EDF A/
Readback
] Do not display data during loading
Speed
&\
"Keep Current Setup” Button Behavior:
Retain check state
® Reset to checked after loading a data file
Setup Wizard Path
Automatic Features
Allow ta save setup in original location
W] Reminder to save setup after acquisition if not saved yet
Logo
o Preview
2 Eddyfi
i yfi
fnee Technologies
Shortcuts
Keyboard_

Remote.

To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to
start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected.
If the material is not in the list, you can click on Manage... to open the List of Available Material window.

5 Mew Setup Wizard *
Component Definition -

0 Configure the geometry and material of the component to inspect

Geometry: 1 Surface @ Tube from ID
Application: (®) Generic () Air Conditioner
Material: Carbon steel v

Resistivity: 21 pllem

Permeability: 450 p

Velocity: 5890.000 m/s
Wall thickness: 1.65 mm -

16
BWG

] 24
Outside diameter: 19.05 mm -
Length: &000 mm =

Mote about selected material:

ASTM: A178, A179, A192, AZ10, A214

o | [ e

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant

name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is
used to set IRIS parameters only, and doesn’t need to be set if an IRIS inspection is not performed on this
material.

It's possible to add a note about the material to specify information such as its application or composition.
When you are done, click OK.
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[y List of Available Materials

Custom Matenals

g

Browse...

Materials Co
MName 5:{;;;: ?r: /) [R;?i::;ty Permeability <+  Add
Stainless Steel 321 - ET ONLY 0.000 715 1 (| “ & Remaove Al
Stainless Steel 430 - ET ONLY 0.000 B3 100 (%

Stainless Steel Duplex - ET OMLY 0.000 74 75 |
Stainless Steel 9041 - ET ONLY 0.000 94 75 | ¥
Titanium 6070.000 486 1 (%€
Ti-6AI-4V - ET ONLY 0.000 123 1 (%
Zirconium 4650.000 a1 1| %

Motes About Selected Material

v ok J[X conce

You will be back to the Component Definition window. If you added a new material, it will now be available
in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider.
Enter the tube's outer diameter and length.

These tube properties will help Magnifi to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION

In the Probe Selection window, select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu.
More precise filtering can be done by using the Model drop-down menu. You can then select your probe
by its catalog number (PRBT-ECT-BBST) and then click Next.

. e w

#+ New Setup Wizard

| l’r\/ Probe Selection -

| .y Select the probe that you want [}\9 use for your inspection

| Technigue: | ECT v | Model: Bobbin
Probes

|
Tecl | Model | Cataloa Numbe ¥ | Description 1

|Q§ New... | |Uj Manage.. |

|x Cancel ||‘ Back ||" Next |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the acquisition
rate and the typical probe speed.

% Mew Setup Wizard *

Scan Definition _

Configure the type of scan you will be performing with your probe

Scan: Single Pass
Paosition from: Clock hi
Acquisition rate: 2000 Hz =

4

Typical probe speed: | 1000.0 mm/'s

Acquisition Size: 600.000 s Maximum

|x Cancel ||‘ Back ||’ Next |

The position along the tube can be defined by using either the internal clock of the system, or by using an
axial encoder. If you use the internal clock, the default position will be given assuming that the probe is
always pulled at the typical probe speed. If the typical probe speed is set to 300mm/s, and the time since
the acquisition began was 2 seconds, then the system will indicate a position of 600mm. Using an encoder
will give you the exact position of the probe. Note that the position can also be obtained by using the
landmark tool, but this feature will be shown later.

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate
is set to 2000 Hz for ECT, but depending on the drive frequency used to inspect, the actual acquisition rate
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may differ. The system will automatically readjust this value if needed. For standard eddy current probes,
the acquisition rate can always be set at 2000 Hz.

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For an
acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least 2 points per
millimeter. If you do not use a pusher-puller device such as the Probot, the pulling speed won’t be
constant. Therefore, it is recommended to target a lower pulling speed to be able to reach your axial
resolution target. The typical probe speed should be set as close as possible to the real value - this will
help the algorithm that automatically detects landmarks (this will be explained in the Landmarks section).
The recommended pulling speed for ECT is approximately 300mm/s.

If you select to measure the position from Encoder, different fields will appear, and a second Scan
Definition page will become available.

5+ New Setup Wizard

5+ New Setup Wizard

Scan Definition

Configure the type of scan you will be performing with your probe

Scan Definition

Encoder and axis settings

Scan: Single Pass

Asial Encoder

Type: Clock Dir

¥ Ais
Encoder -

] Detect Overspeed

Resolution: 2546 - count/mm

Invert direction
Typicel probespeec: 2500 mm/s Presett 0000 mm

Maximum probe speed:  350.0 mm/s. 9] Apply preset on Start

Density: 2,000 smpl/mm

am 2| [ Maximum

(3 cancel | (4 Back |[p next [

Cancel | [ Back | [P Nex |

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered.
The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the
number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition
rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a
speed exceeding the Maximum probe speed, there will be gaps in the data.

The second page includes the type of encoder and its resolution. A preset can also be specified if your
acquisition doesn’t start at 0 mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute
and Differential channels. It is important to set these parameters correctly before acquiring the data since
they are driven by the instrument and cannot be modified during the analysis.

= New Setup Wizard X

) BRI ]

Select the channels you will be using and the necessary frequencies

Gain: 32 dB =
Channels Required frequencies
MName Prefix Prefin  Val (kHz) Ampl (V) Phase ()
Absolute ABS Fl 576 250 00 ]
Differential DIF 2 288 250 0.0 ]
B 144 250 00 ]
4 50 250 0.0 ]
A At least one suggested frequency is out of bounds and has
been clamped.
Suggest Add

|x Cancel | |‘ Back | [P Next |

By default, Magnifi suggests four frequencies theoretically calculated with the parameters previously
entered:

Prefix Frequency
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F1 2 x F90
F2 F90
F3 F90/2
F4 F90/8

The frequency and drive voltage can be changed by replacing their values in the Required frequencies
table. Up to 4 frequencies can be set at the same time, and the sum of their amplitudes cannot exceed

10v.

Make sure that the frequencies are within the probe limits that you can find in Table 3. If one of the
suggested frequencies is not within the recommended probe frequency range, you can either remove it

by clicking on the X or change it within the recommended range.

Click on Next when the desired parameters are entered.

The next window is used to build mixed channels. Mixes are processed channels that are mainly used to
detect indications close to support plates. They are built with 2 frequencies of the same channel type to
attenuate the effect of the support plate and to be able to size an indication at this location more

accurately.
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5% Mew Setup Wizard d

P Oxt= Deinition ]

Configure the channel mixes for your inspection

Input Channel 1 Input Channel 2 Output Mixed Channel Mixed Reference Signal
DIF-F1 DIF-F3 MK REF @

|x Cancel | |‘ Back | | b Net |

If you do not wish to use mixed channels, click on Next.

To add a mixed channel, click on the Add button. A new line will appear. Choose from which input you
want to use the mixed channel. Note that Input Channel 2 must have a lower frequency than Input Channel
1. Mixed channels can be built for both absolute and differential channels.

You can rename the mixed channel output by modifying the Output Mixed Channel field.

The Mixed Reference Signal (usually a support plate signal) will be used to calibrate the mix channel. The
system will apply processes to the chosen input channels and will subtract them to eliminate the reference
signal.

Click on Next.
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DATA PROCESSING

The Data Processing window is used to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually or you can apply the same filters to every
channel with the Individually configure all the channels check box.

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can
be changed without any problem during data analysis, while wrong parameter choice for the data
acquisition can mislead the analysis. It is possible to change the filter parameters after data acquisition,
so it is always possible to fine tune the filter parameters during analysis.

5 New Setup Wizard d

P& Data Processing ]

' Select the processings that you want to apply to the channels you have selected

[ Individually configure all the channels

Low Pass Median High Pass
MName - Cutoff (Hz) Window Size (smpl)
ABS- 400 [ 3m
DIF- 400 1 3m
MIX1 400 [ 3m

|x Cancel | |‘ Back | | b Net |

The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful
when your defect signal has a lower frequency content than the background noise. In this case, using a
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filter will remove part of the noise without removing the defect’s signal. This may help with data analysis.
However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too
low will filter out the defect’s signal.

The median high pass filter is used to filter out low frequency noise or drift such as lift-off variations of
the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of
the high-pass median filter should be set to at least three times the axial length of the longest flaw that
may be encountered. Data should be examined in both its filtered and unfiltered states. It is important to
keep in mind that the median high-pass filters can distort phase. More information about median filters
for NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.
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CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These indications will
later be used to calibrate your probe and to build sizing curves.

The units of measurement can be set in percentage or in depth (millimeters or inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and
size. The side and size of the flaw will be used to position the calibration point on the sizing curve(s).

Calibration points can also be imported with the Import button.

+* New Setup Wizard X

@ Calibration Points ]

Configure calibration points used for channels and sizing curves

Units of measurement: | Percentages (35) hd

Calibration points

Mame Side Size

HOLE Through 100.0 ]
FBH-80 oD 0.0 x|
FBH-60 oD §0.0 ]
FBH-40 oD 00 ]
4xFBH-20 oD 200 ]
IDGR-10 D 100 x|
ODGR-20 oD 200 ]
ODGR-40 oD 200 ]
ODGR-60 oD §0.0 x|
SUPPORT Unknown 00 ]
LIFT-OFF Unknown 0.0 x|
REF Mone 0.0

A Import | | == Add

|x Cancel ||-‘ Back ||’- Mext |

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).

CALIBRATION

The Calibration page is used to define reference signal(s) that will be used to set the amplitude(s) and
phase(s) of each channel using the selected measurement method.
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By default, the calibration is performed on the Hole signal by adjusting it to 1V and 40° on both the
absolute and the differential channels. However, the calibration can be done differently on each channel
type. It can also be done individually for each frequency by selecting the Individually configure all the
channels option. Different reference signals can be set to calibrate the phase and the amplitude
independently.

5 New Setup Wizard et

O calibration ]

A Configure parameters to calibrate channel amplitude and phase

[] Individually configure all the channels

Amplitude Phase
Mame Voltage (V) Reference Measurement Angle (%) Reference Measurement
ABS- 1.00 HOLE MP 40.0 HOLE MP
DIF- 1.00 HOLE PP 40.0 HOLE PP
MIK1 1.00 HOLE PP 40.0 HOLE PP

|x Cancel | |< Back | [P Next

When you select the reference signal, the system will use the selected measurement method to apply a
rotation and a gain. Here is a short description of the available options:

14. Absolute (A):
Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude.

15. Absolute Horizontal (AH):
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16.

17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

Uses only the horizontal component, from the Lissajous origin to the main cursor position to
measure amplitude.

Absolute Vertical (AV):
Uses only the vertical component, from the Lissajous origin to the main cursor position to
measure amplitude.

Absolute Peak (AP):
Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure
amplitude.

Absolute Peak Horizontal (APH):
Uses only the horizontal component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

Absolute Peak Vertical (APV):
Uses only the vertical component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

Average Peak (MP):
Takes the distances from points at the extremity of the cursor to the peak of the data selection
to build an average vector. Only used and recommended for absolute signals.

Average Peak Horizontal (MPH):
Uses the horizontal component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

Average Peak Vertical (MPV):
Uses the vertical component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

Peak to peak (PP):
Uses the combination of the vertical and horizontal component to measure the maximum
amplitude.

Horizontal (PPH):
Uses only the horizontal component to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to measure the amplitude.

Peak to peak First Transition (PPF):

Uses the combination of the vertical and horizontal components of the first transition of the signal
to measure maximum amplitude. The first signal transition is from the base of an indication to its
peak.

Click on Next went the parameters in the table are set according to your requirements.
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SI1ZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this
table.

%% Mew Setup Wizard it

Sizing Curves ]

Add and configure the sizing curves necessary for your inspection

In3 Mame Source Measurement
ABS-F1 ABS-F1 Phase %
ABS-F2 ABS-F2 Phase X]
DIF-F1 DIF-F1 Phase X
DIF-F2 DIF-F2 Phase X]
MIXT MIXT Phase X

|x Cancel | |‘ Back | |> Ned |

The sizing curve will allow you to estimate the size of a defect based on the calibration point signals
(amplitude or phase) obtained with your calibration standard. Magnifi will give you the interpolated flaw
size based on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be changed.
You can add sizing curves by clicking on the Add button.

Click Next when you are done.
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For every sizing curve created in the last window, a window will appear to configure the curve properties.
The name of the curve will be shown in the upper left corner of the page (ABS-F1 in the example below).

%" Mew Setup Wizard X

Sizing Curves -]

Configure the properties of the ABS-F1 sizing curve

Measurement method: MP L GelecitheiamyEspomt
Shape: BFDS . MName Side Size
e IDGR-10 D 10.0 £l
HOLE Through 100.0
FEH-80 oD 20.0
FEH-60 oD 60.0
FEH-40 oD 40.0
4x FBH-20 oD 20.0 A
] REF MNone 0.0
[] ODGR-60 oD 60.0
[] ODGR-40 oD 400
[] ODGR-20 oD 20.0
[] SUPPORT Unknown 0.0
[] LIFT-OFF Unknown 0.0

|x Cancel ||‘ Back ||b‘ Net |

The measurement method options are the same as what is described in the calibration section of this
document. By default, the average peak option is set for absolute channels, and the peak-to-peak option
is used for the differential channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of
the available options:

1. Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side calibration
points with respect to phase.

2. Best Fit (Dual Slope) (for phase measurement only):
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A curve with two segments representing ID and OD (or Near and Far) sides. The ID section is
linear, and the OD section is polynomial. The OD side of the curve will need at least three points
(including the hole) in order to trace a polynomial curve.

Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured calibration points (requiring at
least three points).

Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.

Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD sides of the curve.
Need at least three points.

The linear options are mostly used when few data points are available, while the Best fit (Dual Polynomial)
option is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select the curve
points for each sizing curve previously created. The order in which the points appear in the list may
influence your sizing cure. Make sure that the measured values of the calibration points are in ascending
order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking
the box Report as remaining wall thickness.

Click Next when you are done.
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INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when analyzing
the data.

%% Mew Setup Wizard it

== _ Indication Codes ]

0 Configure the indications codes used for the report

Code Description Type Automatic Celor

COR Corrosion Defect @
CRK Crack Defect X]
DNT Dent Defect @
D3l Distorted support indicatic  Defect |Z|
ERO Erasion Defect @
MDD Mo defect detected Mo indication |Z|
0BS Obstructed Feature I" Red @
PIT Pitting Defect X]
PLG Plugged Feature I" Brown @
RST Restricted Feature I Yellow |Z|
WLL Wall loss long Defect @
WLS Wall loss short Defect X]
WLT Wall loss taper Defect @

2 Import | | =)= Add
(% Concel | |4 Back | [P Nea |

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.

You can modify the default indications codes list by changing the parameter in the table. New indications
can be defined by clicking on the Add button.

Click Next when you are done
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DiISPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.

5% Mew Setup Wizard d
F Display ]

Configure display and layout properties

General options Lissajou / Strip chart options

Zoom behavior on stop acquisition: Miniature strip chart

Zoom to full scale
Proportion: 33.00

4Fk
B

) Zoom to content . o
Display Direction: Down <

(®) Keep current scale . )
Strip chart duration: |10 s

4F

|x Cancel | |‘ Back | |.' Next |

The scroll direction is the direction in which data appears on the screen. If you choose downward, the
signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal
will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box.
The strip chart duration is the length of a Strip chart window when the data is acquired.

Click Next.
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The second Display window is used to set the layouts. Checking the tick boxes in this window will make
the proposed layouts available in your setup. You will be able to switch from one to the another via the
layout tab. The " S " stands for Strip chart, " L " for Lissajous and “C” is for the defect Code indication zone.

The layout with the blue background will be the one opened by default, which can be changed to your
desired option.

Layouts can be readjusted at any time.

5 New Setup Wizard d
F Display ]

Select the layout that you want to use to display your inspection results

2 Strip charts, 1 Lissajous 2 Strip charts, 4 Lissajous

Wlds|s L

4 Strip charts, 2 Lissajous

L L

Wllds|s]|s]|s

. : Default layout

|x Cancel | |-‘ Back | |\/ Finish

Click Next to complete the setup wizard process.
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SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the
parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button
associated with the parameter you want to change.

o Home | Setup ‘ Advanced SMART Setup Instrument Calibration Analysis Layout Current View

w3 @y R A NS E

New ~
Comp Probe Scan Data Process 8l calibration Sizing Indication Display
Points

This will open one of the windows previously described, where you can change the values you originally
entered If applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed
using the advanced settings, the information shown using the Setup tab may not match your actual setup.

SMART SETUP TOOLS

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.

LOGBOOK
The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook.

SMART Setup

= ' ' 0o
E q\ ((‘ an e 98 g
o W L AN
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications DQV Grouping Report Help
Logbook Shortcuts

The logbook stores information about the analysis in addition to allowing the following functions: batch
screening, seeing results at a glance from the data list pane and saving manual modifications made to the
landmarks during the analysis.

The logbook stores the following information: landmarks (type, position, dimension, including manual
modifications), indications (Al and conventional, label, position, dimension, etc.), indication grouping, and
data quality validation results. When enabled, an additional column is added to the data file list to allow
seeing results and to filter, sort, or analyze according to these results.
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The following table shows the possible icons and their meaning:

Icon Description Meaning
No logbook entry associated with this file because
(empty) Empty .
it has not been screened yet.
Logbook entry associated with the file contains
. . information such as landmark detection or regions.
Dashed outline circle, . . . i
~ . The absence of additional information on the icon
() without a number e . .
= reveals that no indication detection engine or DQV
tests were enabled when the logbook was written.
Logbook entries associated with the file contains
information such as landmark detection as well as
. . . detected indications. The number displayed inside
= Dashed outline circle, with a . . .
{1} the circle shows the quantity of potential

number

indications detected.
No DQYV tests were enabled when the logbook was
written.

Dashed outline circle, with a

green check mark

The green check mark indicates that the DQV
test(s) passed on this file.
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o, Dashed outline circle, with a
red cross

The red cross indicates that at least one DQV
test(s) failed on this file.

Dashed outline circle, with a
(37 number, with a green check
mark

The logbook entries associated with this file
indicates that potential indications have been
detected by the detection engine and that the DQV
test(s) passed.

Dashed outline circle, with a

The logbook entries associated with this file
suggest that potential indications have been

13‘ number, with a red cross detected by the detection engine and that at least
one DQV test(s) failed.
The Al detection tools identified an unusual
situation. In this case, the level of confidence in the
A Orange warning triangle detection findings could be very low. Therefore,

users should pay special attention when reviewing
the detection results.

The logbook is saved within the inspection folder. Its data is written when a file is screened using the

dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the

logbook is enabled, and no logbook entry existed for this file yet.

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been

detected with detection tools that do not use Al (conventional landmark detection and indication boxes).

Also note that the automatic indication detection tools are not available if you use the acquisition license

(ACQ).
WIZARD

AI-ECT detection of landmarks and indications can be enabled through the SMART Setup tab.

To configure this tool, click the Wizard button.

SMART Setup

Enable Wizard JPackage Landmarks Indications
Logbook

Q | O

Landmarks Regions Indications paQv

00
i85 5 O«
| vg 6
Grouping Report Help
Shortcuts

Before the Wizard is displayed, a warning message appears:
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Bl riew a1 wizard e

Completing the Al Wizard will permanently modify the current setup with the
following:

Q - Addition of channels used for Al
- Replacement of the Landmark Detection configuration;
- Replacemnent of the Region Detection configuration,

Continue?

Yes | | Mo

When Al is added to your setup, Magnifi applies minor changes for the detection algorithms to work:

1. Channels will be copied and renamed with the prefix “AA_.” These are additional channels that
the Al engine will use for processing. The original channels in your setup will not be modified.

2. If conventional landmark detection was previously set up, it will be disabled and replaced by the
Al landmark detection.

3. If conventional region detection was previously configured, it will be replaced by a set of read-
only regions that are required for Al detection.

Once Al is added to a setup, it cannot be reverted. Make a copy of your installation before continuing if
you want to keep a backup.

Al PACKAGE

The first window of the wizard gives the option of choosing the appropriate algorithm for the type of
equipment being inspected. In version 5.0, only one algorithm is available.

@ New Al Wizard x

AlPackage I
@ Select the detection package for the current setup
Probe

Technique:  ECT
Model:  Bobbin

Probe: PRET-ECT-BBST
Package

Select Recommended|

If the setup for the acquisition was done with the Setup Wizard, the probe configuration will automatically
be selected. For legacy setups, the Technique, Model and Probe must be selected from the drop-down
menus.
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Al LANDMARKS

The second window allows you to set the landmark detection parameters. Landmarks are important to
detect defects. They allow the system to automatically create regions (e.g., tube sheet, support plates, in
tube) in the tube. This allows the detection of defects in these pre-defined regions.

@ New Al Wizard k4

@.—‘ Al Landmarks |

@ Configure the landmark detection

Bundle Type: Straight > Type Name
Inspection Type: Straight v AIRI AIRI
Tube Length: 6000.0 mm - G st
) sp sp
Reporting From: Stop Record ks
TS0 Ts0
Megative Positioning: [] From 0.0 mm
AIRO AIRO
TSO SP SP TSI

SP SP SP
Stop | ~J Start
Record | e d Record
0 Length
|x Cancel ‘ |4 Back | | ’ Mext |

The fields in the upper right corner of the window allows one to enter the morphology of the exchanger
and the way it is inspected. This information will be expected by the Al during its analysis.

The type of bundle inspected must be selected. The Al supports three configurations:

Straight: The tubes are straight and tube sheet signals can be acquired.
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TSO SP SP TSI

SP SP SP
Stop | | Start
Record | Record

Reporting from

Straight restricted: A restriction is present which prevents the sensors of the probe from coming out of
the tube completely. Select this inspection type if the exit is restricted on some of the tubes or all of them.

TSO SP SP TSI

SP SP LSP
Stop | | Start
Record | e — d| Record

0 Length

U-bend: Inspection of the straight parts only, so the scan includes only one tube sheet signal.

TSO SP SP

SP SP SP
Stop | | Start
Record |

Reporting from

Tube length value is optional and does not affect the Al detection performance. This information is
relevant if an estimate of the axial location of indications is expected. Entering the appropriate length will
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result in more accurate values and a better-quality report, especially if you are using TubePro™ 5.X with
3D models to visualize the defect location.

Names for the types of detected landmarks can be customized if required. Here are the abbreviation
descriptions for each type:

Al INDICATIONS

The last window allows one to enable Al indication detection and customize the label of these detected
indications. The label will be displayed in the Code view as well as in the Indications pane of the Front
Stage interface.

Type Description
AR AIR In: Only used for detection in calibration tube data. Signal acquired by the probe
when it leaves the air and enters the tube.
T5) Tube Sheet In: Signal acquired by the probe when it leaves the air and enters the
bundle.
Last Support Plate: Only used with Straight Restricted and U-Bend One Leg inspection
Lsp types.
LSP replaces TSI when a restriction prevents the probe from acquiring the full TSI
signal.
SP Support Plate signal.
150 Tube Sheet Out: Signal acquired by the probe when it leaves the bundle and is then in
the air.
AIRG AIR Out: Only used for detection in calibration tube data. Signal acquired by the probe
when it leaves the tube and is then in the air.
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@5 New Al Wizard X

Al Indications |

‘l Configure the indication detection

Enable Al indication detection
Options

Label: IND

Position correction channel : | DIF-F2 w

Position correction

When filters are applied on data, @ misalignment can be observed
between the detected indications represented by the red marks in the
code window and the signal displayed in the strip chart. The detected
indications will be realigned with the signal of the selected "Position
correction channel’.

|x Cancel ‘ |‘ Back | |~/ Finish |

Data processing such as filtering can induce a spatial or temporal delay in the data, meaning that the
whole signal in the strip charts can be slightly shifted up or down. Since the Al channels and user’s channels
don’t necessarily have the same data processing, there can be some misalignment between them. This
could translate into detected indications, represented as red marks in the Code view, appearing slightly
offset compared to the indication signals observed in the strip charts of the user’s channels. This is where
the Position correction channel option is applicable. This parameter realigns the indications shown by the
Al with the user’s channel signals by applying a position correction to the Al channels.

The applied correction is calculated automatically when calibrating on the through-wall hole. This
compensation is applied on every tube. If the filters are modified during the analysis, it is recommended
to calibrate again to readjust the compensation.

Typically, the most used channel for reporting indications should be selected as the reference for the
position correction.

LANDMARKS

The Landmarks button is used to setup the parameters for landmark detection with conventional tools
(not Al). This function is not accessible if you are using the Al landmark detection tool that is set with the
Al wizard.
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SMART Setup

@

Wizard

Enable
Logboak

Package Landmarks Indications

-

Landmarks | Regions

‘lﬂ\yui

L AN 5

Indications pav

oo
8 %@
Report Help
Shortcuts

Grouping

The Landmark Detection window is used to configure the automatic detection of features such as tube

sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional

setup. They can however give a reference for the axial position in a tube. They can also be used by the

software to trigger automatic acquisition sequences.

Detection Channel: R_DIF-F1 hd
Reporting From: (@ startRecord () Stop Record
[] Negative Positioning: From | 0.0 mm

Detection Engine: Extended v

Manual Sequence: [] (Check for Acquisition Detection)

Enable Detection

Landmark Table (in the order seen by the probe during data acquisition)

Name Type

Exit Exit -25

TSI TSI 0

Ts0 Ts0 6000
import. | [ Beort. | [ suggest

TSO

(Exit is used for
sequence only)

7

Stop
Record ::

Length

Pos.(mm) MinQty MaxQty Shape

Reporting from

Component Threshold (V)

- 10000.00
- 10000.00
- 10000.00

Floating Group Landmark

- [m] X
Exit
TSI
]
% Start
: Record
0
P2P (mm) Enable
Disabled \E
Enabled m
Enabled w

Positioned Landmark

Three landmarks are created if you press on the Suggest button. The channel selected to detect these

landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw.
This is the signal of the channel without software filter, rotation, or software gain applied.

You can base the position of your landmarks either on the location where you start to record (usually the

tube entrance, opposite from the operator position) or on the place you stop to record (usually the
operator side).
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Detection Channel: R_DIF-F1 ¥
Reporting From: (® StartRecord () Stop Record
[] Negative Positioning: From 0.0 mm

Detection Engine: Extended v

Manual Sequence: [] (Check for Acquisition Detection)

Detection Channel: R_DIF-F1 -
Reporting From: ) StartRecord (@ Stop Record
[ Negative Positioning: From 0.0 mm

Detection Engine: Extended v

Manual Sequence: [] (Check for Acquisition Detection)

TSO

(Exit is used for
sequence only)

-

Stop
Record :_4_

Length

TSO

Reporting from

(Exit is used for
sequence only)

Exit

TSI
]

-

Stop

% Start

Record }

0

Reporting from

;: Record

Length



In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has
a negative position because this event happens before entering the tube. It is enabled only when doing
the acquisition.

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered
at the end of the acquisition.

Landmark detection can be set up manually by describing the shape, component, and voltage threshold
that will trigger the detection. The Shape describes the appearance of the signal when the landmark is
reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed.
The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to
trigger the landmark. And the Threshold is the voltage amplitude threshold.

Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as
they will be automatically measured by the software. It's important to set the landmark positions as
accurately as possible. If the position is not accurately set, the software might prevent their automatic
detection since it won’t be at an expected position.

The Type field is a name that associates the calibration point with the landmark. If landmarks share the
same Type, they will be calibrated at the same time using the same point and process. To associate two
landmarks with the same Type, their signal must be the same. If support plates of the same geometry are
present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the
same Type because one is triggered when the probe goes inside the tube and the other is triggered when
the probe exits the tube.

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the
landmarks need to be entered with the right position. The system will look for the exact number of
landmarks entered at positions close to those entered in the table. With the Extended mode, the system
will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact
number of support plates don’t need to be constant or known.

REGIONS

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used
to categorize the data to process correctly. For example, they can be useful for restricting the detection
of channel saturation to an area within the tube or specify an automatic analysis type for a given region
(e.g., under the tubesheets).

SMART Setup
— ' 00
i Q‘ = AN b 8 go
4 Bl W ¥ | g >
Enable Wizard Package Landmarks Indications | Landmarks] Regions | Indications DOV Grouping Report Help
Logbook Shortcuts

When using the Al Wizard, the parameters of the Region Detection window are set automatically and
most of them cannot be modified. You will only be able to change the thickness of the landmark and the
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number of support plates. Changing these values will modify the schematic in the regions page to help
visualize the exchanger.

. Region Detection X
Regions Details Preview
Name Name: SP ——
In Tube Abbreviation: ASLOSD
Air to Air Location: Around SEACEY
R et
Freespan Selection: Specific Landmark Types SO
FreespanCal = SP (SP)
Start Range: 0.0 mm =
TSI _ SP (SP)
End Range: 0.0 mm 3
TSO SP (SP)
<p Landmark Types '
AIRI SP (SP)
TSI
SP (SP)
== Add V| sp
SP (SP)
TSO
General Simulation Parameters AIRO SP (SP)
Landmark Thickness: |25.0 mm  +
SP (SP)
Floating Quantity Simulation E TSO (TSO)
Sp: 10 3
0 [ Read-only regions are required for Al detection tools. I | OK | ' Cancel | H

If you are using the conventional detection tools (not Al-based), you can set up the regions according to
the automatic analysis tools you will use with the Indications and DVQ buttons (described later).

INDICATIONS

The Indications module allows the user to define various zones or even waveform types to trigger a certain
detection threshold.

SMART Setup ‘
— 00
[j Q\ an |6 | o8 oG
o W | % | ep
Enable Wizard Package Landmarks Indications | Landmarks Regions [Indications] DQV Grouping  Report Help
Logbook Shortcuts

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name
that will appear in the Code view (described later).
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. Indication Detection
Detection Zones Details

Label Based on Seurce Zone Type Zone

pIT Channel DIF-F2 W []|  nsideRadivs  [011V :
Outside Radius | 20.00V >
Orientation 46 ° -
Aperture 84.9° =
Inter Lobe Dist. |4 cnt =
Center (0,0)
Bounda%
Increase by 4cnt =
Regions

Restrict to selected (Select...
b Duplicate | | == Add |
| oK | | Cancel | Apply
s 5] i {34 18
O W ! !
.
N
kx“-i:!,_.J
\":i_
i
LN | ¥

L] w [o]a]w

There are five zone types:

b Absolute pie

w Differential pie

[ | Centered rectangle

Sl Rectangle

s Over or under a horizontal or vertical threshold

And seven waveform types:
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B Up
# - Down
$T Down-up
o Any direction
$ f Up-down
E:T Down-up-up
i1 Up-down-up-down

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also
include the boundary setting to prevent signal oscillation from triggering unnecessary detections.

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating
the Edit Alarm option on the Current View tab.

The detected indication can be found in the Indication window, which can be activated in the Layout tab.

| Layout

B BmEm B | ®E e s ERBR|E A

Select Manage Reload BackUp New Layout Replace  Remove  Split Infofield Cal. Infofield Data Report DOV | Indications] Note Large
Acquisition

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip
chart view. If you click on an indication in the code view (described later), the associated indication is
highlighted in the Indications pane.

Indications o | | R | | DIF- | F2‘ || 238V | + |
Label 80.0 kHz -
IND
IND
IND
IND
IND

IND

IND

IND

IND
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Note that conventional indication detection boxes can be used along Al detection tools. It is
recommended to configure them after Al activation to have access to regions automatically defined when
going through the Al Wizard.

DATA QUALITY VALIDATION (DQV)
Data Quality Validation (DQV) allows defining tests to validate the quality of the data.

SMART Setup

= ' 0o
E Q\ am | b wB &
o W v |lwm G
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications] DQV Grouping Report Help
Logboaok Shortcuts

Five test types are available. To add a test, click on the Add button on the DQV page and select the test
type with the drop-down menu. Parameters associated with this test can be changed in the Details section
of the DQV window.

DOV Tests: Details
Enabled Test Type MName (Optional) Merge
Hardware Saturation |:| Range 10.0 mm -
Dead Channel |:| Regions
e N |:| Restrict to selected [Select...
== Add
| oK | | Cancel |

e Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined
threshold. An amplitude that remains below the threshold throughout the scan indicates a dead
channel.

e Landmark Detected: Verify the presence of all the selected landmark names in the Details section.
To validate full tube-length of straight bundles for ECT bobbin data using Al detection, select this
option and check the TSI and TSO landmarks. When Al setup for landmarks is completed and the
TWH calibrated, the DQV test will automatically use the Al results to perform the test.

e Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows
grouping a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region,
for example, the areas inside the tube.
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e Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field
allows group a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region.

e (C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping
a zone together for which the test has failed. This function avoids having many notifications if the
test fails several times in one area. This test can be limited to a specific region.

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab.

Layout
mEmE ® (D mE o =R REE B M
Select Manage Reload BackUp Newlayout | Replace Remove  Split Infofield Cal. Infofield Data Report| DQV [indications Note Ac:ififion
¢ oav 3 X
Test Result
Channel Saturation x 8 errors

Failures
Criteria
Hardware Saturation |Q|
Hardware Saturation [0|

¥ DAV Indications Note

GROUPING

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the
automatically detected indications. This tool is compatible with the Al-based detection engine as well as
with conventional rule-based and user-defined indication detection boxes or waveforms.

SMART Setup ‘
— Qo
E Q\ @ C I N
(4] W & R
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications DQV Grouping Report Help
Logbook Shortcuts
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The Grouping menu offers a default configuration with three predefined categories:
e Support Plates
e  Critical

e Less Critical

Bl Detected Indications Grouping - O *
Groups Details
Mame MName: | Critical
Support Plates I:l Armplitude Phase
_ I:l Channel: | DIF-F2 i Channel: | DIF-F2 =
Less Critical I:l Measure: | PP v Measure: | PP i
Min: 1.00V = Min: - =
Max: [ [10.00v Mas: 120 ° -

Restrict to Regions

In Tube

Air to Air
[] Freespan
[] FreespanCal
]8I

] 150

[sp

[] Hide unclassified indications

(1] | The default configuration will be applied. ] |Resetto Default| |\/ OK | | Cancel |

The Details section of each group shows the parameters defining the conditions that must be met for a
detected indication to be classified in this group. The user can modify all parameters.

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP)
measurement method, and Max/Min threshold values are set for amplitude and phase. For this group,
the criteria are limited to indications detected under the SP regions. As a result, the indications detected
under support plates for which all conditions are true will fall into this category.

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on
DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping
criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube
length data.

It should be noted that each automatically detected indication can only be categorized in a single group.
Also, the grouping operation is executed according to the order of the groups defined in the Groups list.
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Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group.
If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be
categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does
not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single
indication will be categorized, and none can appear simultaneously in more than one group.

New groups can be created with custom parameters.

Groups Details
MName Mame: |Support Plates
_ IZI Amplitude Phase
Critical Channel: | ABS-F1 o Channel: | ABS-F1 "
Less Critical I‘E‘ Measure: | PP N Measure: | PP V
Min: 200V B Min: 2- =
Mas: L1 1000V Max: 150° =

It is also possible to remove a group or use the up/down arrow keys to change the group priority within
the list.

Groups

Name

Critical

Less Critical

&) [X] ¥

In the Front stage interface, the Grouping results will be displayed in the Indications pane.

93



Indicaticns a X
10 of 10 results

Label Ampl. Phase
@ Critical (4)

IND 1415V g2-
IND 340V CER
IND 278V 106 °
IND 706V 16°

(%) Less Critical (4)

IND 102V 111°
IND 1.00V 40°
IND 127V 56°
IND 113V 73"

(~) Undlassified (2)
IND

IND

DOV Indications Mote

To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the
Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom
of the Grouping menu and click on OK.
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Bl Detected Indications Grouping - O >

Groups Details

Name MName: |Critical

Support Plates Izl Amplitude Phase

_ Channel: | DIF-F2 o Channel: | DIF-F2 v

Less Critical Measure: | PP i Measure: | PP v
Min: 1.00v = Min: - =
Pac: [ |[10.00v Ma: 120 -

Restrict to Regions

In Tube

Air to Air
[] Freespan
[] FreespanCal
[Tl

[]Ts0

[]sp

Hide unclassified indications

0 l The default configuration will be applied. I |Resetto Default| |\/ oK | |x Cancel

Enabling this option influences the following elements of the software:

e Indications pane;
e Codeview;
e Logbook column.

The images below compare them when the Unclassified indications are shown (left) and when they are
hidden (right).

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the
header serves as a reminder to the user that not all indications are currently shown.
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Indications

26 of 26 results

Label Ampl. Phase
(&) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 084V 18°
IND 076V 17°
IND 1.20V 19°

(%) Undlassified (20)
IND

IND
IND
IND
IND

Indications

6 of 26 results

Label Armnpl. Phase
(~) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 0.84V 18°
IND 076V 17°
IND 120V 19°

OOV Indications Mote

OOV Indications Mote

In the Code view, the red markers from the Unclassified indications have been removed.
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In the data file list, the number shown in the Logbook column represents the number of visible indications,

matching the number shown in the header of the Indications pane.
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REPORT SHORTCUT

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is
possible to select a channel with a measurement method and to associate an indication with it.

SMART Setup ‘

Enable O
Logboaok

Wizard Package Landmarks Indications

oo
((‘ AT\ 1 . +O o1 '.D
Wy L | -
Landmarks Regions Indications DQV Grouping| Report Help
Shortcuts

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter

pits in the report.

| | Indication Based On
PIT Channel

- O o
!
Source Ampl. Measurer Phase Measurer Sizing Curve Shortcut
DIF-F2 Vpp op DIF-F2 “| D b4
5

|\/ OK | |XCanceI |

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a
single key or a combination of keys such as ALT+D, for example.

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication
displays momentarily on the corresponding Lissajous.
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DATA SCREENING

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under
the Analysis tab.

|.6.nal1,-sis
? n |» oOBs R
% |% o 1|9
‘s ‘m [ (0 30 ¥ | g
Screening  Screening All Previous  Mext No " RST poiiew Msg  Capture | Subtraction
All Files Selected Files Defect

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files
when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed
in the Data window.

DATA LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating a list of tubes.

This list can be created in the Data List of the General tab of the Backstage.

Data List

Maming Format: Row, Col b

Preview: 001001.magdata c— ===
| ) |-@

Create New List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending on the chosen

filename format.
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For the Row, Col option, enter the number of rows, the starting row number and row interval. You can
then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to
generate the list of tubes. You can also use the Create & New button to add another set of tubes to your
list.

Il File List Creator - X
File List Cenfiguraticn
Mumber of Rows in Component: 1 .
Start Mumbering at Row: 1 .
Row Interval: 1 -
MNumber of Columns per Row:
Row MNb. of Columns
1 1
Column Interval: 1 .
Include first and last column of each row
Files to Create: 1
Filename Preview: 001001
[-l- Create 8 Mew | [ v Create ] [ b 4 Cancel |

The same principles apply to the other file formats, except for the Free format option for which the file
name(s) needs to be entered manually in the Data window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube list file can
be found in the Inspection folder. It is also possible to import a list created in the Tubepro software
(available from Eddyfi).
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button.
Click on the Connect button under the Instrument tab. This will open the Instrument
configuration page. Click on the line showing the instrument to which you want to connect, and
then click Connect.

Home Setup Advanced Instrument Calibration

XRREREe

Setup  Disable Ch. Setup Info /o Alarm  Fine Tune

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case,
ared and white Xicon will be shown in the Status field of the Instrument connection window. To download
a matching version to your Ectane, click on the Config. button and then click the Send firmware to the
instrument button of the Instrument configuration window.

¥ |
Instrument Connection (Ectane) ﬁ
—

Type Model MAC Address Host Status §Config Details
Ectane2 | E128RNMI . EC:92:33.00.0014 Q |o| @

Cancel
b
7 ¥ - - -
Instrument Configuration &J
Metworl Information Embedded Software Update
Made: Automatic - 2 Use the embedded software that comes with Magnifi
|P address:  |192.168.19 .10 Use custom embedded software
Subnet Mask:  |255.255.255.0
Gateway: (0.0 .0 .0
Cancel

Two (2) acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is used
to scan your calibration tube and make the necessary adjustments on your setup without saving the data
automatically. Acquisition mode is used for the inspection - in this mode, the software automatically saves
the acquired data using file names based on the tube list.
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3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the
Home tab. This mode is active when the Setup Mode button is grayed.

Il
L3 ©

Setup Mull
Mode

4. Plug the bobbin probe on the Ectane 4-pin connector.

5. Bring the probe head in a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

Push the probe head all the way through the tube so that it exits the tube.

Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2
on your keyboard.

8. Pull the probe at approximately 12”’/s (300 mm/s)

9. When it's done, press the Stop button or F2 again on your keyboard.
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Note that a red zone in the code pane means that at least one of the raw signals is saturated. This is usually
the case when your probe is out of the tube.

VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes useful
functions to do so:
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DISPLAYED CHANNEL

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These buttons
are used for the channel selection.

1. 2. 3. 4.
- DIF | F1

- - 4 A

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart
are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this
channel.

PR EREEER R PR ED R AT
158.4 kHz 158.4 kHz ;

s
.

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the
desired channel to select it. Right-click or Left-click on this button to switch to the following or

previous channel in the list.
| -] Joor [r)]
158.4 F1AES |

FIDIF
F2ABS
F2DIF
FIABS
F3DIF
Land
MIX1

3. Same principle as 2., but for the type of channel only (absolute or differential).
4. Same principle as 2., but for the frequencies only.

STRIP CHART AXIS ORIENTATION

The Strip charts are projections of the Lissajous on the vertical or horizontal axis. To switch from one axis
to another, click on the box showing an arrow at the upper right corner of the Strip chart.

103



| a

158.4 kHz

a

o [ F1 ] IRETE B

ZOOMING

On the strip chart, hold the right button of your mouse and drag on the zone of interest to zoom in this
section.

1 2000v [ oF

u JoF JFl 1 2000V _[=] I_‘l ‘l DIF ‘| FW“ J P
158.4 kiiz o84 kitz I

158.4 kHz

—
/\

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.

BREZRER
158.4 kiz

7 Previous Zoom
Full Extent
Adjust Cursor Size
3 BestFit

~++ Horizontal

View indications
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ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and
the full line is the center of what you have selected.

Only the portion of data between the dotted lines will be shown in the Lissajous.

To adjust your cursor length, hover your mouse over the dotted line, and click and drag the left mouse
button. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same
operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the
left button (decrease scale) or the right button (increase scale) of your mouse.

BPRERE N EBEIR IR [t 2m30° Ju 7sev
158.4 kHz FIDIF 158,84 kiiz

Fl Fl

;/
;

;
#

-

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the
scale button.

MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method.
A short description of the measurement methods can be found in the above calibration section of the
setup wizard.

1. 2 3 4 5
Lveed] e ]2 [ w]

1. Clicking on the corner with the black triangle gives the list of measurement method for the
amplitude of the signal. Click on the desired method to select it. Right- or left-click on this
button to select the next or the previous method in the list.

2. Same as 1., but for the phase measurement.

3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure
the phase with the right orientation.

4. Take the same two points in time to take the measurement in the other Lissajous.

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw
a vector on your Lissajous.
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LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of
your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on
the raw channels since these channels have no gain or rotation applied, by definition. Also, rotating the
signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous background
and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor at a point where you want the data to be
centered and use the spacebar on the keyboard.

CALIBRATION AND SIZING CURVES

CALIBRATION

The following section describes how to calibrate your probe.

1. Goto the Calibration tab and click on the System icon.

2. Select Channel in the calibration window.

3. Inthe Strip chart, select the signal to calibrate and adjust the cursors to see only the desired
signal.

Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you selected your calibration point. This will allow you to see what the system is using to make its
calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.

106



= . Pl 1 oaov | 1]

##| Calibration

® Channel A

Channel and Sizing Curves

HOLE
SUPPORT
TH-750D

E| Calibrate |
Reset |

Select the signal name in the list.

Click on the green arrow button to associate the measured signal to the calibration point.
If more than one calibration point is present in the list, repeat step 3, 4 and 5 for each one.
When all your calibration points are check-marked, click on the Calibrate button.

No v s

S1ZING CURVES

The following section describes how to build your sizing curves.

1. Go the calibration tab and click on the Sizing curve button.
2. Select Channel and Sizing Curves in the Calibration window.
3. Select the signal in your Strip chart and adjust the cursors to see only the desired signal.

Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you selected your calibration point. This will allow you to see what the system is using to make its
calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to
show the defect size. To have the correct interpolated point, the measurement method also needs to be
the same as the one used for the sizing curve. To change the measurement method, click on the icons at
the bottom left of the Lissajous.

4. Select the signal name in the list.

5. Click on the green arrow.

6. Redo the previous steps for all the other indications in the list.
7. Click on the Calibrate button.
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Error messages after creating the phase sizing curves may appear. The main cause of these errors is the

measurement direction.

The image below shows two different measurements. On the left, you can see that the measurement
arrow is pointing towards the liftoff signal. In this case, the measured phase is rotated of 180° from the
right value. When one or more points were measured in the wrong direction, Magnifi cannot build the
sizing curve and will generate an error message. Note that you won’t have this issue with an absolute

channel if you're using the average peak measurement method.

In the image on the right, the arrow is pointing from the liftoff signal to the defect signal, which is correct.
However, in this picture, the arrow starts quite far from the middle of the liftoff variation signal, which
will cause an error in the measurement. In this case, we suggest you move the cursors until your

measurement is taken from a point near the base of the signal.
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To adjust your sizing curves and remove the error messages, go the Calibration tab, and click on View

Curves.

[H select Calibration Point

~
[H select Calibration Point

FEH-40 oD

400 300 b 4
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The sizing curve window will appear. Each sizing curve you asked Magnifi to create will be listed in the
drop-down menu. If an invalid notification is present on the curve, it means that you either haven’t
entered the sizing points yet, or that Magnifi failed to create the curve. To adjust the sizing curve manually,
enter the value in the table.

In the above example, the entered phase angle for the 40% defect is 300°, but the correct phase angle for
the 40% defect is 120°. The 40% defect has an 180° bias due to an incorrect measurement direction. In
this case, we can simply change the angle value from 300° to 120° in the table to fix the sizing curve.

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws in the
Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw size does not
appear, it means that you are not in a channel where a sizing curve was set.

LANDMARKS

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks
window the same way you calibrated the sizing curve(s) points. You can use the Land channel to do so.
The positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the farside
tubesheet, that is, the first one encountered by the probe during data acquisition; TS1 is the nearside
tubesheet).
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Once the landmarks are calibrated properly, the system should be able to recognize them automatically.

Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far
end of the tube is needed.
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SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button
under the Home tab. The displayed window will allow you to give an appropriate name to your setup and
to save it at the desired locations. The save location is, by default, your inspection file. Note that when
data is saved, the setup is also saved with it.

You can also save the data of your calibration standard by clicking on the Save As button under the Home
tab.

STANDARD ACQUISITION

The following section describes how to perform an inspection.

1. Connect Magnifi to your instrument.

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab.
Acquisition Mode is activated when the Setup Mode button is not grayed.

3. Plug the bobbin probe into the Ectane 4-pin connector.

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

5. Push the probe all the way through the tube until it exits the far end.

6. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2
on your keyboard.

7. Pullthe probe towards you at a constant speed until it exits the tube.

8. When finished, press the Stop button or again F2 on your keyboard.

9. Repeat steps 4,5,6 and 7 for all the tubes to inspect in your bundle.

MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and
can trigger the acquisition start/stop and the data recording automatically. At least two (2) landmarks are
needed to use this feature. These landmarks can be created by using the Landmarks button under the
SMART Setup tab.

To set the manual sequence:

1. Click on the Manual Sequence button under the Calibration tab.
If a warning message is shown in this window, change the parameters until no warnings are
shown. The system will progress through the different windows to guide you.

3. Click on Settings ...

111



8.

i N i~ ™
[= Sequence lﬁl ﬂ Manual Sequence Configuration liz-]

Sequence
/\ Type: Mone @ Landmark
Launch Start Recording Landmark: | Exit - |
Start Recording Delay: 10= .

Stop Acquisition Landmark:  T51
Target Settings...

Stop Acquisition Delay: 20s .
Restart
NDD Review Type: None UserInput @ Timer
. Pushing Delay: 100s -
@ Pulling/Recording
OK ] [ Cancel

@ Waiting for Next

You must be
connected to an
instrument to start

the sequence.

Connect... |

Select Landmark in the Type section.

In the drop-down menu, choose the Landmark that will initiate the data recording. If you keep
the default landmarks, you can select the Exit landmark that will be triggered when the probe
goes out of the tube when the probe is pushed.

You can enter a delay to start the acquisition after the first landmark is detected (Start
Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop
Acquisition Delay).

Two options are available to restart the acquisition: The user can either push a button or use a
timer. Select the desired option in the Restart section.

Click on OK.

To use the manual sequence:
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1.

Connect Maghnifi to the instrument.

Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab.
Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the ECT probe into the Ectane 4-pin connector.

Bring the probe head to a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

Open the Sequence window by clicking on the Manual Sequence button under the Calibration
tab.

Put your probe in the tube to inspect and click on the Launch button. This will start the data
acquisition.

Push the probe until it exits the far end of the tube. If set correctly, Magnifi will recognize the
landmark and this will initiate the data recording.



8. Pull the probe towards you until it exits the tube. This will trigger the last landmark detection
that will stop the data recording.
9. Acquisition restart:
a. Ifyou selected User Input in the settings of the Manual Sequence Configuration, the system
will wait for the user to enter information on the tube to restart the acquisition. Click on
NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition.
Repeat steps 6, 7 and 8 for all the tubes to inspect.
b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown
will trigger after the last tube acquisition was taken. The acquisition will start after this time
has elapsed. Redo step 6 and 7 for all the other tubes to inspect in the bundle.

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is
the case, you won’t be able to catch the landmark that triggers the data acquisition at the end of the tube.
In this situation, you can click on the Target button in the Sequence window to start the data recording.

DATA LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the
Data list section of this document. To do so, checkmark the Automatic File Recording option that can be
found under the General tab of the Preference menu of the Backstage.

General (Setup Related)

Measurement Units
Report Units: | Millimeter

Channels
Full Channel Scale: 20.00Vpp =

Hide Raw Channel

Precision
[] Enable
Amplitude: | 2 decim...

General =
Phase: 0 decim..

| H Acquisition
[ Automatic File Recording

Depiy Auto Create new file on Next

Automatic Next on Stop acquisition

Analysis

The list of tubes is also shown in the Data window.
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A common practice is to rescan your calibration tube and balance the probe periodically. You can save
this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can
go out of acquisition mode, scan your tube, and click on the Save Cal As... button under the Calibration
tab to save your data. You can then go back to acquisition mode to continue your inspection and to
automatically save the acquired tubes in your bundle.

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark
icon.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home
tab.

A tube name can be changed by right-clicking on its name and by selecting the Rename option.

LOADING A FILE

1. First disconnect your computer from the Ectane by clicking on the Disconnect button under the
Home tab.

2. You can load a file by double-clicking on the file name in the Data window. It can also be done
by selecting the file in the list and by clicking on the Load button under the Home tab. Note that
double-clicking on a tube when you are still connected to an instrument will initiate data
acquisition.

3. You can open the next or the previous file in the list by clicking on the Previous or Next button of
the Home tab.

The data files can be filtered by using the Filter button of the Data window.
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to
the report. These two buttons indicate the code that is associated with the defect being entered. Both
buttons are identical, but can be set to identify different flaws.

To add an indications to the data:

1.
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Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous
includes only the defect signal.

Then, click on the red triangle in the corner of the Indication button to select the type of defect
to enter.

Click on the defect button to add an entry to the report.
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Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is

explained in the SMART Setup section of this manual.

Indications can also be added to a tube to indicate, for instance, that it has no flaws or that it is plugged.

To add an indication to a tube:

1. Load the file

2. Click on the appropriate indication button available under the Analysis tab

(M| OE 4 ¥ =
O Home Setup Advanced SMART Setup Instrument Calibration Analysis Layout Current View
[+ ] - 4 s s [» oBs i
fi E?‘ L7 i 1O
| | 13 . < > pLs ] |
Screening Screening All Previous  Mext Mo Review Msg  Capture | Subtraction
All Files Selected Files Defect | RST
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REPORT TABLE

To access the list of indications entered:

1. Make sure that the Report option is selected under the Layout tab.

Layout

Current View

=1

I Info

0=

=

ield

Data Report

Indications Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible.

Report

Zone FRow Col.” Code Size
1 0 0 0.00

2 0 0 0.00

Side Ampl. (V) Angle (7)
0.00 0

0.00 0

ChanneliC-scan  Ypos. (mm) LMK pos Offset Y pos. (mr Yleng (mm)  Comment
00 0.0 00

0.0 0.0 0.0

A\ 2 new notifications Informatior] Report

Entries in the report can be modified by changing the value in the table. You can also delete an entry by

clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.

To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.

Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tubes in component is

used to show the percentage of tubes in each category.
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[l Generate Report x i = Report X
Report Summary :
REPDrt Parameters { Configure the Summary Section |
Tube project parameters
Client v |X| &
‘ # of tubes in component: |30 - ‘ ComponentType  ~ IXI
Companent S/N v lzl
Site v (%]
i
Service Provider ¥ |X| N
Comment
|Resetto Defau|t| |Import| |E:<port|
|
| x EEHCE| | | h ﬂﬂt | ™ Display in File Explorer |x Cancel | |\/ Finish |

4. Click Finish to generate the report.

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed
using any regular web browser.

There is a “copy” button next to each element of the report such as tables and images. When clicking on
it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or
Word.

Eddyfi . "
Tecl\{:ologies AnalySIS Report @ s'g:x:olog'les

Instrument Settings

Channels Instrument Settings

‘Channel Calibrations
Setup name: ECT-Bobbin
Mix Channels

Component

Information Channels

Inspection Summary

T m Name Frequency (KHz) Drive (V) Gain (dB) Low Pass (KHz) High Pass (Cnt)

Lepects R_ABS-F1 1600 250 460 400

Data
R_ABS-F2 80,0 2,50 46,0 400
R_ABS-F3 40,0 250 48,0 400
R_ABS-F4 20,0 250 46,0 400
R_DIF-F1 160,0 2,50 46,0 400
R_DIF-F2 80,0 2,50 46,0 400

R_DIF-F3 40,0 2,50 46,0 400
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The Print button, bottom right corner on image above, can be used to either print a paper copy of the
whole report or to save it as a .pdf document. The PDF generator available with the current web browser
will be used.

w023 153 Mo Roper:
" . Imprimer 4 pages
Analysis Report eoges P
Instrument Settings Destination B cnregistrer au formati ¥
Sonup nama: ECT-Babin
Channels Pages Tous
e o ey camiem e o
: o s Mise en page Portrait b
s “
s =
ransr 20 P - Plus de paramétres v

m Annuler
: - S “

The report logo can be modified by clicking on the Select Company Logo that can be found under the
System tab of the Backstage.

System (Computer Related)

Measurement Convention Measurement Units
Freere= @ asme @ Metric
) ASME Inverted e o Imperial
) EDF
Readback
D Do not display data during loading
Speed:

! Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
! Retain check state

General

@ Reset to checked after loading a data file
Display Setup Wizard Path: C\Users\daube  QTEC\Documents'MagnifitSetup

Automatic Features
D Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo
Preview:

o
‘a.. °
Select

Company Logo

The report table file in the Inspection folder can also be imported into other reporting software such as

Tubepro.
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INTRODUCTION

This document presents how to set up and calibrate the DefHi® probe with Magnifi 5 on an Ectane test
instrument using the Setup Wizard. Equipment

The DefHi® probes use a 160-pin connector that can be connected to an Ectane with the “E64" or
“E128” option (depending on the probe model).

As this probe needs to be near the tube surface, a wide range of probe diameters are offered (see the
tubing probe catalog for more details). A wide range of frequencies is also available to allow inspections
of tubes of different thickness and material.

From the following tables, the best probe for your application can be selected.

Table 4 — Probe diameter selection table

TUBE WALL THICKNESS (BWG, mm, in)
BWG 10 1 12 13 14 15 16 17 18 19 20 21 22 23 24
mm 340 305 277 241 211 183 165 147 124 107 089 081 071 065 056
in 0135 0120 0109 0095 0083 0072 0065 0058 0049 0042 0035 0.032 0028 0025 0022
12.70mm 0.500in - - - - - - - - 096 096 102 102 106 106 106

wl
% & 16587mm | 0625in - - 096 102 106 114 118 118 126 126 132 132 136 136 136
3% 1905mm | 0750in 114 118 126 136 140 148 148 148 156 156 162 162 166 166 170
% = 2222mm | 0875 148 148 156 166 170 178 178 186 186 192 192 196 196 196 200
= 2540mm | 1.000in 178 186 186 196 200 208 208 216 220 220 226 226 226 230 230
Table 5 — Probe frequency range selection table
TUBE WALL THICKNESS (BWG, mm, in)

BWG 10 11 12 13 14 15 16 17 18 19 20 2 22 23 24

mm 340 305 277 241 211 183 1685 147 124 1.07 083 08 071 065 056

in 0135 0120 0109 0095 0083 0072 0065 0.058 0049 0042 0035 0032 0028 0025 0022

Brass (admiralty) = = = = = HW  HW  HW  HW  HW LF LF LF LF LF

Brass (70/30) - - - - - HW  HW  HW  HW  HW LF LF LF LF LF

Brass (85/15) = = = = = = HW  HW  HW  HW  HW LF LF LF LF
Brass (95/5) - - - - - - - - HW  HW  HW  HW  HW LF LF

i Copper - - - - - - - - - - HW HW HW HW HW
% Copper-nickel (70/30) HW HW HW HW LF LF LF LF LF MF MF MF MF MF HF
E Copper-nickel (90/10) = HW  HW  HW  HW  HW LF LF LF LF LF MF  MF  MF  MF
= Copper-nickel (95/5) - - - HW  HW  HW  HW  HW LF LF LF LF LF MF MF
Inconel 600 LF LF LF LF LF MF MF MF  MF  MF HF HF HF HF HF
Stainless steel 304/316 HW LF LF LF LF LF MF  MF  MF  MF HF HF HF HF HF
Titanium 99 % HW  HW  HW LF LF LF LF LF MF  MF  MF MF HF HF HF
Zirconium HW  HW  HW LF LF LF LF LF MF MF  MF MF MF HF HF
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Table 6 - Frequency range

FREQ. (KH2)

HW: 4-60kHz * Maxi MF is reduced to 400 kHz with 15 bl
aximum MF is reduced to z wi m cable.
LF: 20-200kHz ** Maximum HF is reduced to 1 MHz with 15 m cable.

MF: 50-500 kHz*
HF: 100-1200 kHz**

Table 7 — Total number of array channels

FREQ. HW L7 MF FREQ. HF

CONFIG. BC BCA BC BCA BC BCA CONFIG. BC BCA
= 096-106 - - 12 36 18 54 = 096-106 - -
‘5‘: 114140 12 36 18 54 18 54 ‘5‘: 132136 18 54
L 148178 12 36 24 72 24 72 L 162170 24 72
§ 186-196 18 54 24 72 24 72 § 196-200 30 90
o 200230 18 54 30 90 30 90 o 226-230 36 108

Defhi® probes are available with one row or two rows pancake coils. The model with one row (ERBC) will
allow the detection of circumferential cracks. The model with two rows (ERBCA) will allow the detection
of both axial and circumferential cracks with the array part of the probe.

Table 4 indicates the number of array channels for each standard probe. The total number of channels for
a DefHi® probe equals the number of array channels plus two (one for the absolute and one the
differential bobbin channels). Therefore, if the number of array channels is 63 or over, it means that an
Ectane with the “E64” option won’t have enough channel for this probe and that an Ectane with the
“E128" option will be required to use this probe.

The DefHi® calibration tube used in this document includes the following flaws:
e Internal groove, 10% of wall loss
e External groove, 20% of wall loss
e Hole, 100% of wall loss
e OD Flat Bottom Hole (FBH) at 40%, 60% and 80% depth
e 0D 4 x FBH 20% depth

Other combinations of flaws can be used to calibrate the probe and to build sizing curves.
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In this section, we will create a folder structure that will manage the saving location of your setup, data
and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of files. The first level is the Project. It is meant to include different inspections
that are related in some way. For instance, it can include all the inspections done at a refinery shutdown
and be named Refinery_Shutdown_May_2018. The second level of the file is the Inspection folder.
Inspection folders are saved in the project file. An inspection folder can include the data specific to the
inspection of a tube bundle with a specific technology and could be named S5316_075x0.065_ECT, for
instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

—F—— ] |

INSPECTION 2 INSPECTION X

| |
| |
| |
|
| SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE I
| <> D
i LIST ATA
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
- 1
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When you open Magnifi, the first page displayed is called the Backstage.

Magnifi® 53B1T376 - [Setup from original data file] - ECT-Bobbin.magdata

General
Project / Inspection Information
Project Folder: Documents\Magnifi\Projects\Defa Probe: Unable to detect
General [
Inspection Folder: DocumentstMagnifi\Projects\Default\DemoData3 .6 "o Application: Generic
P | R
L folder Tube Dimensions:
Acg. S o 2540 mm
T Setup / Data
Setup Loaded:  From original data file WL 165mm
A
Setup Location: Jocuments\Magnifi\Projects\Defa (3] é Length: 500 mm
Report Summary Create Setu
p Open Setup. Open Data X i
Data Loaded: ECT-Bobbin Material:  Stainless Steel 316
Frequencies: 160.0, 80.0, 40.0, 20.0 kHz
Data List
Maming Format: | Row, Col P
Preview: 001001.magdata = =
Create New List| | Import List
Documentation
Report
Name: Report.mdb v
Preferences "@
oS Table Profile: Tubing ECT v =
Export Defect
Report
[] Take screenshot with report entry Table

License

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an existing
project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your project file. Select
New, Folder and enter the chosen name. You can then select the newly created folder and click
on Select Folder.

B select s project ]
S~ v |4 »
Organize v New folder = (7]
}
- |
g
|
& Projects Folder
A Shortcut
87 Microsoft Access Database
& Bitmap image
3 Contact
8 Microsoft Word Document
e View » | Bi] Microsoft Access Database
= Sort by » @) Microsoft Project Document
Group by » G% Microsoft PowerPoint Presentation
N Refresh @ Microsoft Publisher Document
[ SonicWALL Global VPN Client Document
[
Paste & Rich Text Format
= Undo Detete CireZ o D
= - 5 07 Dessin Microsoft Visio
= = S~ " 18 Microsoft Excel Worksheet
New » B Briefcase
Properties
Folder: Magnifi
| selectFolder | Cancel
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your

inspection.
[l Manage ﬁ
. Inspections
o Manage Inspections Select Other...
g P
Mame State
Default

Bundle_A_55316_0.75x0.65_DefH

]

I\.i"' Select Hx Close ]

L

A

3. Click Select. This will define the position where the setup(s) and data will be saved.

SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System
tab, you can change the measurement units from metric to imperial and vice versa. For the metric units,

you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement
for imperial units is inches. When finished, click on Preferences again to go back to the General window.
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System (Computer Related)

Measurement Convention Measurement Units
@ AsME ©@ Metric

) ASME Inverted == Imperial
_| EDF

Readback
[] Do not display data during loading
Speed:
J) Actual Inspection Speed
© Maximum
“Keep Current Setup” Button Behavior:
) Retain check state

© Reset to checked after loading a data file

General

Display Setup Wizard Path:  C:\Users\daube.QTEC\Documents\MagnifilSetup

Automatic Features
[] Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded
Logo
Preview:
‘- ®
Select
Company Logo

Shorteuts

Keyboard.. |
Remote.. |

To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to
start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected.

If the material is not in the list, you can click on Manage... to open the List of Available Material window.

" New Setup Wizard @

Component Definition |

0 Configure the geometry and material of the component to inspect

Geometry: ) Surface @ Tube from ID
Application: @ Generic ) Air Conditioner
Material: Stainless Steel 316 vl [ Manage... ]

Resistivity: 74 pll-cm

Permeability: lp

Velocity: 5660.000 m/s
Wall thickness: 211 mm -

14
BWG

6 24
COutside diameter: 2540 mm
Length: 6000 mm -

Mote about selected material:

Application: Austenitic alloy-steel boiler, superheater, and heat-
exchanger tubes,

Composition: ~17% Cr, ~12% Ni, 2% Mo, Fe remaining

UNS: 531600

ASTM: A213 TP216, A249 TP216, AGBS TP316

3 Cancel Back ’v Mext

L

4

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant

name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is

used to set IRIS parameters only, and doesn’t need to be set if an IRIS inspection is not performed on this

material.

It's possible to add a note about the material to specify information such as its application or composition.

When you are done, click OK.
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p
B List of Available Materials

Custom Materials

Cilsers\daube QTEC\AppData\Roaming\Eddyfi\Magnifi\UserMaterialsDatab:

N

Materials Ei Co
Mame Ultram?;?;emc'w Resistivity (u0cm)  Relative Permeability == Add
Stainles... 0.000 74 75 . 2L Import.
Stainles... 0.000 a4 75 & Remave All
Titanium a070.000 486 i
Ti-bAl-4... 0.000 123 il
Zirconium 4650.000 1 i

mem

Motes About Selected Material

[\/ OK ] [x Cancel

b

"

You will be back to the Component Definition window. If you added a new material, it will now be available

in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider.
Enter the tube’s outer diameter and length.

These tube properties will help Magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION

In the Probe Selection window, select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu.
More precise filtering can be done by using the Model drop-down menu. You can then select your probe
by its catalog number and then click Next.

r ™
=" New Setup Wizard u

/ ’ Probe Selection = - |

Select the probe that you want to use for your inspection

Technique: [ECT v | Model:  |DefHi-BCA -
Probes

Tech. | Madel Catalog Number Y | Description ‘;
ECT DefHi-BCA DEFHI-ERBCA-(096 to 106)LF DEFHI Probe with bobbin, circ. and axial array. Rigid design, 9.6 to 10.6 mm

diameter, LF 20-200 kHz frequency range.

. DEFHI Probe with bobbin, circ, and axial array. Rigid design, 9.6 to 14.0 mm
ECT DefHi-BCA  DEFHI-ERBCA-(096 to 140)MF diameter, MF 50-500 kHz frequency range.

. DEFHI Probe with bobbin, circ. and axial array. Rigid design, 11.4 to 14.0 mm
ECT DefHi-BCA  DEFHI-ERBCA-(114 to 140)HW diameter. HW 460 kHz frequency range.

DEFHI Probe with bobbin, circ. and axial array. Rigid design, 11.4 to 14.0 mm

m

ECT DefHi-BCA  DEFHI-ERBCA-(114 to 140)LF diameter, LF 20200 kHz frequency range.

. 3 B DEFHI Probe with bobbin, circ. and axial array. Rigid design, 12.6 to 14.5 mm
EcT DefHi-BCA  DEFHI-ERBCA-(126 to 148)HF diameter, HF 100-1200 kHz frequency range.
ECT DefHi-BCA DEFHI-ERBCA-(148 to 178)HW DEFHI Probe with bobbin, circ. and axial array. Rigid design, 14.5 to 17.5 mm

diameter, LF 4-60 kHz frequency range.

DEFHI Probe with bobbin, circ, and axial array. Rigid design, 14.5 to 19.6 mm
DefHi-BCA DEFHI-ERBCA-(148 to 196)LF diameter, LF 20-200 kHz frequency range.

DEFHI Probe with bobbin, circ, and axial array. Rigid design, 15.6 to 18.6 mm
DefHi-BCA  DEFHI-ERBCA-(156 to 186)HF diameter, HF 100-1200 kHz frequency range.

W DEFHI Probe with bobbin, circ, and axial array. Rigid design, 18.6 to 19.6 mm
diameter, HW 460 kHz frequency range.

ECT DefHi-BCA  DEFHI-ERBCA-(186 to 196)H

-

(& New.. ||g4Manage. |

[ Cancel |[4 Back |[Pp Nex |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the acquisition
rate and the typical probe speed.

% New Setup Wizard ldhj

Scan Definition

Configure the type of scan you will be performing with your probe

Scan: Single Pass

Main Scan Axis: Y Axis

Paosition from: @|

Acquisition rate: 1500 Hz -

[

Typical probe speed: 300.0 mm/s

L

[ Cancel | [ ‘ Back | [ ’ MNext |

L A

The position along the tube can be defined by using either the internal clock of the system, or by using an
axial encoder. If you use the internal clock, the default position will be given assuming that the probe is
always pulled at the typical probe speed. If the typical probe speed is set to 300mm/s, and the time since
the acquisition began was 2 seconds, then the system will indicate a position of 600mm. Using an encoder
will give you the exact position of the probe. Note that the position can also be obtained by using the
landmark tool, but this feature will be shown later.

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate
is set to 1500 Hz for DefHi, but depending on the drive frequency used to inspect, the actual acquisition
rate may differ. The system will automatically readjust this value if needed.

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For an
acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least 2 points per
millimeter. If you do not use a pusher-puller device such as Probot, the pulling speed won’t be constant.
Therefore, it is recommended to target a lower pulling speed to be able to reach your axial resolution
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target. The typical probe speed should be set as close as possible to the real value. This will help the
algorithm that automatically detects landmarks (this will be explained in the Landmarks section). The
recommended pulling speed for DefHi® is approximately 300mm/s (12in/s).

If you select to measure the position from Encoder, different fields will appear, and a second Scan
Definition page will become available.

Concat | [d_ ok | [P mem

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered.
The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the
number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition
rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a
speed exceeding the Maximum probe speed, there will be gaps in the data.

The second page includes the type of encoder and its resolution. A preset can also be specified if your
acquisition doesn’t start at 0 mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute
and Differential channels. It is important to set these parameters correctly before acquiring the data since
they are driven by the instrument and cannot be modified during the analysis.

" New Setup Wizard @

b Data Definition |

-

Select the C-scans you will be using and the necessary frequencies

Connector: 160 pins

Gain: 58 dB .
C-scans Required frequencies
Mame Prefix Prefix  Val (kHz) Ampl (V) Phase (%)
Aoial A 092 250 0.0 @
e c P2 496 2.50 0.0 @

Suggest + Add

[x Cancel ] I‘ Back I [ ’v Mext l

L 4

Pages of this section are used to set the parameters of the array part of the probe (C-Scan) and others are
used for the bobbin part of the probe (channels).

By default, Magnifi suggests two frequencies for the array part of the probe and four frequencies the
bobbin part. These frequencies are calculated with the parameters previously entered:

Prefix Frequency Channels
F1 2 x F90 Array & bobbin
F2 F90 Array & bobbin
F3 F90/2 bobbin
F4 F90/8 bobbin
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The frequency and drive voltage can be changed by replacing their values in the Required frequencies
table. Up to 4 frequencies can be set at the same time, and the sum of their amplitude cannot exceed 10V.

Make sure that the frequencies are within the probe limits that you can find in Table 3. If one of the
suggested frequencies is not within the recommended probe frequency range, you can either remove it
by clicking on the X or change it within the recommended range.

Click on Next when the desired parameters are entered.

DATA PROCESSING

The next windows are used to build mixed channels. Mixes are processed channels that are mainly used
to detect indication close to support plates. They are built with two frequencies of the same channel type
to attenuate the effect of the support plate and to be able to size an indication at this location more

accurately.
" New Setup Wizard lﬁj
PV Dpata Processing
mho
' Select the processings that you want to apply to the channels you have selected
[T Individually configure all the channels
Low Pass Median High Pass
MName - Cutoff (Hz) Window Size (smpl)
ABS ] 400 ] 225
DIF [] 400 O] 225
Cancel | [ 4‘ Back | [ b Mext

L ’

If you do not wish to use mixed channels, click on Next.

To add a mixed channel, click on the Add button. A new line will appear. Choose from which input you
want to use the mixed channel. Note that Input Channel 2 must have a lower frequency than Input Channel
1. Mixed channels can be built for C-Scans, absolute and differential channels.
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You can rename the mixed channel output by modifying the Output Mixed Channel field.

The mixed reference signal (usually a support plate signal) will be used to calibrate the mix channel. The
system will apply processes to the chosen input channels and will subtract them to attenuate the
reference signal.

Click on Next to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually with the Individually configure all the
channels/C-scans check box or you can apply the same filters to every channel/C-scans.

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can
be changed without any problem during data analysis, while a wrong parameter choice for the data
acquisition can mislead the analysis. It is possible to change the filter parameters after the acquisition, so
it is always possible to fine tune the filter parameters during the analysis.

3 New Setup Wizard X 5 New Setup Wizard X

F_i Data Processing

, Select the processings that you want to apply to the C-scans you have selected

Individually configure all the C-scans

P pata Processing

, Select the processings that you want to apply to the channels you have selected

Individually configure all the channels

Low Pass Median High Pass Low Pass
Cutoff (Hz)

¥ 400 25 ABS 400 25
c & 400 25 DIF 400 25

Median High Pass

Name. Cutoff (Hz) Window Size (smpl) Name. Window Size (smpl)

(3¢ cancel | [d_Back | [p ez Concel | [ Back | [B mex ]

The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful
when your defect signal has a lower frequency content than the background noise. In this case, using a
filter will remove part of the noise without removing the defect’s signal. This may help with data analysis.
However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too
low will filter out the defect’s signal.

The median high pass filter is used to filter out low frequency noise such as lift-off variations of the probe
within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of the high-
pass median filter should be set to at least three times the axial length of the longest flaw that may be
encountered. Data should be examined in both its filtered and unfiltered states. It is important to keep in
mind that the median high-pass filters can distort phase. More information about median filter for NDT
analysis can be found on Eddyfi’s blog.

CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These indications will
later be used to calibrate your probe and to build sizing curves.

The calibration point units of measurement can be set in percentage or in depth (millimeters or inches).
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You can add calibration points by clicking on the Add button. Specify the calibration point name, side and
size. The side and size of the flaw will be used to position the calibration point in the sizing curve(s).

Calibration points can also be imported with the Import button.

( '/'- MNew Setup Wizard lig-r
Calibration Points
@ Configure calibration points used for channels and sizing curves
Units of measurement: | Percentages (%a) =
Calibration points
MName Side Size
HOLE Through 1000 E|
FBH-80 oD 800 %
FBH-60 oD 60.0 (%
FBH-40 oD 400 (%
4x FBH-20 oD 200 E|
IDGR-10 D 100 E|
ODGR-20 oD 200 %
ODGR-40 oD 400 (%
ODGR-60 oD 600 (%
SUPPORT Unknown 0.0 E|
LIFT-OFF Unknown 0.0 E|
2 Import | | == Add |
[ Cancel | [ ‘ Back ] [ } Mext |

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).

CALIBRATION

The Calibration pages are used to define reference signal(s) that will be used to set the amplitude(s) and
phase(s) of each channel using the selected measurement method. There are two calibration pages: one
for the array (C-Scans) and one for the bobbin (channels).

By default, the calibration is performed on the Hole signal by adjusting it to 1V and 40° on the C-scans,
the absolute and the differential channel. However, the calibration can be done differently on each
channel type. It can also be done individually for each frequency by selecting the Individually configure all
the channels option. Different reference signals can be set to calibrate the phase and the amplitude
independently.
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[-)

Name

$G: Single Gain and Phase

5 New Setup Wizard X % New Setup Wizard X
Calibration & calibration
and phase /ﬂ\ Confie i fitude and phase
Individually configure all the C-scans Individually configure all the channels
Amplitude Phase Amplitude Phase
Voltage (V) Reference Measurement  Angle °) Reference Measurement 56 Name Valtage (V) Reference Measurement  Angle () Reference Measurement
1.00 HOLE MP 40.0 HOLE MP v/ ABS 1.00 HOLE MP 40.0 HOLE MP
100 HOLE wp 400 HOLE e & OF 100 HOLE P 400 HOLE PP
Cancel | [4 Back | [ Next Cancel | (4 Back | [ Wext

When you select the reference signal, the system will use the selected measurement method to apply a
rotation and a gain. Here is a short description of the available options:
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Absolute (A):
Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude.

Absolute Horizontal (AH):
Uses only the horizontal component, from the Lissajous origin to the main cursor position to
measure amplitude.

Absolute Vertical (AV):
Uses only the vertical component, from the Lissajous origin to the main cursor position to
measure amplitude.

Absolute Peak (AP):
Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure
amplitude.

Absolute Peak Horizontal (APH):
Uses only the horizontal component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

Absolute Peak Vertical (APV):
Uses only the vertical component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

Average Peak (MP):
Takes the distances from points at the extremity of the cursor to the peak of the data selection
to build an average vector. Only used and recommended for absolute signals.

Average Peak Horizontal (MPH):
Uses the horizontal component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.



10.

11.

12.

13.

Average Peak Vertical (MPV):
Uses the vertical component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

Peak to peak (PP):
Uses the combination of the vertical and horizontal component to measure the maximum
amplitude.

Horizontal (PPH):
Uses only the horizontal component to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to measure the amplitude.

Peak to peak First Transition (PPF):

Uses the combination of the vertical and horizontal component of the first transition of the signal
to measure maximum amplitude. The first signal transition is from the base of an indication to its
peak.

Click on Next went the parameters in the table are set according to your requirements.
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Si1zZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this
table.

% New Setup Wizard @

/\ Sizing Curves | |
Add and configure the sizing curves necessary for your inspection

D Mame Measure From Source Measurement
FA C-scan ¥ F1A Phase (%]
FIC C-scan’¥ FIC Phase X
F2A C-scan ¥ F2A Phase (X
Fac Cescan'¥ FaC Phase (%
FLABS Channel F1ABS Phase E|
F1DIF Channel F1DIF Phase El
F2ABS Channel F2ABS Phase gl
F2DIF Channel F2DIF Phase El

= Add |

[x Cancel | [‘ Back | | ’v Mext |

L 4

The sizing curve will allow you to estimate the size of a defect based on the calibration points signals
(amplitude or phase) obtained with your calibration standard. Magnifi will give you the interpolated flaw
size based on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be changed.
You can add sizing curves by clicking on the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window will appear to configure the curve properties.
The name of the curve will be shown in the upper left corner of the page (F1A in the example below).
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%" New Setup Wizard ldhj

Sizing Curves
Configure the properties of the F1A sizing curve
Measurement method: [ ME v| Select the curve’s points:
Shape: [ BFDS v| MName Side Size
e IDGR-10 D 100 T
HOLE Through 100.0
FBH-80 oD 80.0
FBH-60 oD 60.0
FEH-40 oD 40.0
4 x FBH-20 oD 20.0 o
[C] ODGR-60 ap 60.0
[C] ODGR-40 oD 40.0
[[] ODGR-20 oD 20.0
[T] UFT-OFF Unknown 0.0
[] SUPPORT Unknown 0.0
[ Cancel | [‘ Back | [ ’ Mext ]

"

o

The measurement methods options are the same as what is described in the calibration section of this

document. By default, the average peak option is set for absolute channels, and the peak-to-peak option

is used for the differential channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of
the available options:

1.

140

Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side calibration
points in respect to phase.

Best Fit (Dual Slope) (for phase measurement only):

A curve with two segments representing ID and OD (or Near and Far) side. The ID section is
linear, and the OD section is polynomial. The OD side of the curve will need at least three points
(including the hole) in order to trace a polynomial curve.

Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured calibration points (requiring at
least three points).

Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.



5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD sides of the curve.
Need at least three points.

The linear options are mostly used when few data points are available, while the Best fit (Dual Polynomial)
option is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select the curve
points for each sizing curve previously created. The order in which the points appear in the list may
influence your sizing cure. Make sure that the measured values of the calibration points are in ascending
order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking
the box Report as remaining wall thickness.

Click Next when you are done.
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INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when analyzing
the data.

%% Mew Setup Wizard it

== _ Indication Codes ]

0 Configure the indications codes used for the report

Code Description Type Automatic Celor

COR Corrosion Defect @
CRK Crack Defect X]
DNT Dent Defect @
D3l Distorted support indicatic  Defect |Z|
ERO Erasion Defect @
MDD Mo defect detected Mo indication |Z|
0BS Obstructed Feature I" Red @
PIT Pitting Defect X]
PLG Plugged Feature I" Brown @
RST Restricted Feature I Yellow |Z|
WLL Wall loss long Defect @
WLS Wall loss short Defect X]
WLT Wall loss taper Defect @

2 Import | | =)= Add
(% Concel | |4 Back | [P Nea |

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.

You can modify the default indications codes list by changing the parameter in the table. New indications
can be defined by clicking on the Add button.

Click Next when you are done
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DISPLAY
The first Display window is used to set how the data is displayed during and after the acquisition.
( " New Setup Wizard @1

| Display
-

Configure display and layout properties

General options Lissajou f Strip chart options

Zoom behavior on stop acquisition: [E] Miniature strip chart

) Zoom to full scale

3

Proportion: 33.00 %

4

) Zoom to content

Display Direction: Top to Bottom -

@ Keep current scale
Strip chart duration: Currently linked with the C-5can size

C-scan options

Scan axis scale displayed during acquisition: Orientation:

@ Entire C-scan

Sca
) Specific scale: | 0.0 mm | ’1 [ |

Index

4k

[x Cancel ] [‘ Back ] | ’v MNext |

b, 4

The scroll direction is the direction in which data appears on the screen. If you choose downward, the
signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal
will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box.
The strip chart duration is the length of a Strip chart window when the data is acquired.
Click Next.

The second Display window is used to set the layouts. Checking the tick boxes in this window will make
the proposed layouts available in your setup. You will be able to switch from one the another via the
layout tab. The " C " stands for code, " S " stands for Strip chart," L " for Lissajous, " CS " for C-scan and " CS-
3D " for 3D C-scan.

The layout with the blue background will be the one opened by default, which can be changed to your
desired option.

Layouts can be readjusted at any time.
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"+ New Setup Wizard @
Display =
Select the layout that you want to use to display your inspection results
2 Strip charts, 1 C-scan, 3 Lissajous 2 Strip charts, 1 C-scan, 3 Lissajous, 13
L L
L 45|55 —
L 1S-21]
4 Lissajous 2 C-scans, 230 C-scans
L L €S-3D
Id 5| S —Cs|Cs— c|cs|cs
L L €5-3D
. : Default layout
) Help [x Cancel ] [‘ Back l [\/ Finish
L

Click Next to complete the setup wizard process.

SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the
parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button
associated with the parameter you want to change.

-O Home ‘ Setup | Advanced SMART Setup Instrument Calibration Analysis Layout Current View

r >y 3 @Y E AN S @S

Comp Probe Scan Data Process & Calibration Sizing Indication Display
Points

This will open one of the windows previously described, where you can change the values you originally
entered. If applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed
using the advanced settings, the information shown using the Setup tab may not match your actual setup.
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SMART SETUP TOOLS

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.

LOGBOOK

The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook.

SMART Setup l
= ' 0o
T |@ Q fa © |8 %
o W L N
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications DQV Grouping Report Help
Logbook Shortcuts

The logbook stores information about the analysis in addition to allowing the following functions: batch
screening, seeing results at a glance from the data list pane and saving manual modifications made to the
landmarks during the analysis.

The logbook stores the following information: landmarks (type, position, dimension, including manual
modifications), indications (Al and conventional, label, position, dimension, etc.), indication grouping, and
data quality validation results. When enabled, an additional column is added to the data file list to allow
seeing results and to filter, sort, or analyze according to these results.

Data R
22of 22 data
Zone Row Col g el
|v 000 001 001 Gx
W 002 005 005 37
V002 003 007 o ¢
V003 004 009 )l [
+ 003 005 012 @
v 003 006 007 B
003 007 006 ay
V003 007 010 ay
+ 003 003 007
+ 004 003 010 I €]
v 004 003 015 0] 1
+ 004 004 009 ik @)
V004 004 014 "l ©)
V004 005 008 9 g
+ 004 007 005 ¥
v 004 007 015 a¥
V004 009 010 2
004 010 010 A
El

The following table shows the possible icons and their meaning:

Icon Description | Meaning
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No logbook entry associated with this file because

number, with a red cross

empt Empt
(empty) Pty it has not been screened yet.
Logbook entry associated with the file contains
. . information such as landmark detection or regions.
Dashed outline circle, . . . i
. ] The absence of additional information on the icon
{ } without a number o . .
- reveals that no indication detection engine or DQV
tests were enabled when the logbook was written.
Logbook entries associated with the file contains
information such as landmark detection as well as
. . . detected indications. The number displayed inside
. Dashed outline circle, with a ] . .
{1} the circle shows the quantity of potential
- number e
indications detected.
No DQYV tests were enabled when the logbook was
written.
. Dashed outline circle, witha | The green check mark indicates that the DQV
e green check mark test(s) passed on this file.
P Dashed outline circle, with a The red cross indicates that at least one DQV
h red cross test(s) failed on this file.
. . . The logbook entries associated with this file
Dashed outline circle, with a oo L
) indicates that potential indications have been
{37 number, with a green check . .
) ‘ detected by the detection engine and that the DQV
mar
test(s) passed.
The logbook entries associated with this file
(7% Dashed outline circle, with a | suggest that potential indications have been

detected by the detection engine and that at least
one DQV test(s) failed.

Orange warning triangle

The Al detection tools identified an unusual
situation. In this case, the level of confidence in the
detection findings could be very low. Therefore,
users should pay special attention when reviewing
the detection results.

The logbook is saved within the inspection folder. Its data is written when a file is screened using the
dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the

logbook is enabled, and no logbook entry existed for this file yet.

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been

detected with detection tools that do not use Al (conventional landmark detection and indication boxes).

Also note that the automatic indication detection tools are not available if you use the acquisition license

(ACQ).
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LANDMARKS

The Landmarks button is used to setup the parameters for landmark detection with conventional tools.

SMART Setup
= ' 0o
E (o & o e | 28 ag
o W L N
Enable Wizard Package Landmarks Indications | Landmarks JRegions Indications DQV Grouping Report Help
Logboak Shortcuts

The Landmark Detection window is used to configure the automatic detection of features such as tube
sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional
setup. They can however give a reference for the axial position in a tube. They can also be used by the
software to trigger automatic acquisition sequences.

Bl Landmark Detection - [} X
Detection Channel: FIC04 B (Exit is used for Exit

R TSO sequence only) TSI
Reporting From: @) StartRecord () Stop Record rn.l ]
[ Negative Positioning: From 0.0 mm

Stop ¥ Start
Detection Engine: Extended = Record I: I Record
Reporting from

Manual Sequence: [] (Check for Acquisition Detection) Length 0

Enable Detection

Landmark Table (in the order seen by the probe during data acquisition)

Narme Trpe Pos. (mm) MinQty MaxQty Shape  Component Threshold (V) P2P (mm) Enable

Bxit Exit 25 5 =5 1000000 Dicabled E

TSI TSI 0 -5 1000000 Enabled @

5 p P = 1000000 Enabled E

TS0 TS0 6000 5 =5 1000000 Enabled @
Floating Group Landmark Positioned Landmark

mport.. | [ Evport.. | [ suggest Ue = Add

Three landmarks are created if you press on the Suggest button. The channel selected to detect these
landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw.
This is the signal of the channel without software filter, rotation, or software gain applied.

You can base the position of your landmarks either on the location where you start to record (usually the
tube entrance, opposite from the operator position) or on the place you stop to record (usually the
operator side).

Detection Channel: R_DIF-F1 v (Exit is used for Exit

. ) - R TSO sequence only) TsI
Reporting From: @® StartRecord () Stop Record »
[] Negative Positioning: From 0.0 mm w

Stop % Start
Detection Engine: Extended v Record :_‘. : Record
Reporting from

Manual Sequence: [] (Check for Acquisition Detection) Length 0
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Detection Channel: R_DIF-F1

e 150 TSI
Reporting From: () StartRecord  (®) Stop Record rm m
[] MNegative Positioning: From I
Stop 8  Start
Detection Engine: Extended © Record : ;: Record

Manual Sequence: [ (Check for Acquisition Detection) 0 fs L Length
In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has
a negative position because this event happens before entering the tube. It is enabled only when doing
the acquisition.

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered
at the end of the acquisition.

Landmark detection can be set up manually by describing the shape, component, and voltage threshold
that will trigger the detection. The Shape describes the appearance of the signal when the landmark is
reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed.
The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to
trigger the landmark. And the Threshold is the voltage amplitude threshold.

Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as
they will be automatically measured by the software. It's important to set the landmark positions as
accurately as possible. If the position is not accurately set, the software might prevent their automatic
detection since it won’t be at an expected position.

The Type field is a name that associates the calibration point with the landmark. If landmarks share the
same Type, they will be calibrated at the same time using the same point and process. To associate two
landmarks with the same Type, their signal must be the same. If support plates of the same geometry are
present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the
same Type because one is triggered when the probe goes inside the tube and the other is triggered when
the probe exits the tube.

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the
landmarks need to be entered with the right position. The system will look for the exact number of
landmarks entered at positions close to those entered in the table. With the Extended mode, the system
will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact
number of support plates don’t need to be constant or known.

REGIONS

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used
to categorize the data to process correctly. For example, they can be useful for restricting the detection
of channel saturation to an area within the tube or specify an automatic analysis type for a given region
(e.g., under the tubesheets).
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SMART Setup ‘

| @ Q || © “v| B
(+] . y vm G
Enable | wizard Package Landmarks Indications | Landmarks || Regions |indications Dav Grouping Report Help
Logboak Shortcuts
Bl Region Detection X
Regions Details Preview
Name MName: Between —
—Izl Abbreviation: TSI (TSI)
Around [3]|  tocation: [Between v SP (SP)
In Specimen lzl Selection: | All < ‘ 5P (SP)
Start Offset: | 10.0 mm : SEGEY
End Offset: | -10.0mm = SP(SP)
SP(SP)
SP (5P)
' SP (SP)
spisp
General Simulation Parameters SP(SP)
Landmark Thickness: |25.0mm  + SP (SP)
Floating Quantity Simulaticn TS0 (TS0)
SP: 10 <

If you are using the conventional detection tools, you can set up the regions according to the automatic

analysis tools you will use with the Indications and DVQ buttons (described later).

INDICATIONS

The Indications module allows the user to define various zones or even waveform types to trigger a certain

detection threshold.

SMART Setup
Enable | wizard Package Landmarks Indications
Logbook

@

Landmarks

=

Regions

& -

DQv

W

Indications

“E

Grouping Report

@

Help
Shortcuts

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name

that will appear in the Code view.
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I8l 1ndication Detection b4 J Jem]re L il

Detection Zones Details
Label Based on Source Zone Type Zone
PIT Channel F2DIF 5y l:‘ Inside Radius | D11V
Qutside Radius | 2000V

ar| 4| |0

Orientation 46"
Aperture 85.0°
Center (0,0)

“

Boundary

Increaseby | 4cent :

Regions

Restrict to selected

[ ok ][ concel |[ apply

There are five zone types:

b Absolute pie

o Differential pie

[ | Centered rectangle

e Rectangle

s Over or under a horizontal or vertical threshold
And seven waveform types:

B Up

< - Down

$T Down-up

‘:’t Any direction

o1 Up-down

‘?T Down-up-up

%T Up-down-up-down

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also
include the boundary setting to prevent signal oscillation from triggering unnecessary detections.

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating
the Edit Alarm option on the Current View tab.

The detected indication can be found in the Indication window, which can be activated in the Layout tab.
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| Layout

mEmE B S ®mE ==l BRBE|E M

Select Manage Reload BackUp New Layout Replace  Remove  Split Infofield Cal. Infofield Data

Report

Indications| Note Large
Acquisition

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip

chart view. If you click on an indication in the code view (described later), the associated indication is

highlighted in the Indications pane.

Indications a4 X | || . | | DIF- |F2|

|[ 236V |1~|

Label 80.0 kHz
IND

IND
IND
IND

L

-~
IND

IND

~

IND
IND
IND

w

DATA QUALITY VALIDATION (DQV)

Data Quality Validation allows defining tests to validate the quality of the data.

SMART Setup |

U@ Q i ©

Enable Wizard Package Landmarks Indications | Landmarks Regions Indications
Logbook

oy

Dav

b4
Grouping Report Help
Shortcuts

Five test types are available. To add a test, click on the Add button on the DQV page and select the test
type with the drop-down menu. Parameters associated with this test can be changed in the Details section

of the DQV window.
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DOV Tests: Details
Enabled Test Type MName (Optional) Merge
Hardware Saturation l:‘ Range 10.0 mm -
Dead Channel |:| Regions
Clizn T N |:| Restrict to selected [Select
Add
| oK | | Cancel |

Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined
threshold. An amplitude that remains below the threshold throughout the scan indicates a dead
channel.

Landmark Detected: Verify the presence of all the selected landmark names in the Details section.
To validate full tube-length of straight bundles for ECT bobbin data using Al detection, select this
option and check the TSI and TSO landmarks. When Al setup for landmarks is completed and the
TWH calibrated, the DQV test will automatically use the Al results to perform the test.

Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows
grouping a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region,
for example, the areas inside the tube.

Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field
allows group a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region.

C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping
a zone together for which the test has failed. This function avoids having many notifications if the
test fails several times in one area. This test can be limited to a specific region.

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab.

Layout

@ o @B Em ® (B = = ([BREIE S M

Select
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Manage Reload BackUp New layout | Replace Remove  Split Infofield Cal. Infofield Data Report| DQV [indications Note Large

Acquisition




K oav 1 %

Test Result

Channel Saturation x Berors ©

Failures
Criteria

Hardware Saturation

o
Hardware Saturation @

¥ DQV Indications Note

GROUPING

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the
automatically detected indications.

SMART Setup ‘
— a0
]| O | B
(+] “B
Enable | wizard Package Landmarks Indications Landmarlﬁ Regions Indications Groupingl| Report Help
Logbook Shortcuts

The Grouping menu offers a default configuration with three predefined categories:

e Support Plates
e  Critical

e Less Critical
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B Detected indications Grouping — O X

Groups Details

Mame |:| Mame: |Critical

Support Plates I:l Amplitude Phase

_ I:l Channel: | DIF-F2 - Channel: | DIF-F2 -

Less Critical I:l Measure: | PP - Measure: | PP &
Min: 1.00V = Min: 10° =
Max: 1 [10.00V Max: 120° -

Restrict to Regions

In Tube

Air to Air
[] Freespan
[] FreespanCal
1Tl

[1Ts0

[sp

["] Hide unclassified indications

(1] | The default configuration will be applied. ] |Resetto Default| | oK | | Cancel |

The Details section of each group shows the parameters defining the conditions that must be met for a
detected indication to be classified in this group. The user can modify all parameters.

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP)
measurement method, and Max/Min threshold values are set for amplitude and phase. For this group,
the criteria are limited to indications detected under the SP regions. As a result, the indications detected
under support plates for which all conditions are true will fall into this category.

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on
DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping
criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube
length data.

It should be noted that each automatically detected indication can only be categorized in a single group.
Also, the grouping operation is executed according to the order of the groups defined in the Groups list.
Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group.
If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be
categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does
not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single
indication will be categorized, and none can appear simultaneously in more than one group.

New groups can be created with custom parameters.
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Groups Details

Name Mame: |Support Plates
IZI Amplitude Phase
Critical Channel: | ABS-F1 o Channel: | ABS-F1 "
Less Critical I‘E‘ Measure: | PP N Measure: | PP s
Min: 2,00V B Min: 2° =
Max: L1 1000V = Max: 150° -

It is also possible to remove a group or use the up/down arrow keys to change the group priority within
the list.

Groups

Name

Critical

Less Critical @

x|+

In the Front stage interface, the Grouping results will be displayed in the Indications pane.

Indications o =
10 of 10 results

Label Ampl. Phase

(~) Critical (4)

IND 1415V gz-

IND 340V g1-

IND 278V 106 °

IND To6V 16°

(A) Less Critical (4)

IND 1.02v 11°
IND 1.00W 40"
IND 127V 56°
IND 113V 73°

(~) Undlassified (2)
IND

IND

DOV Indications Mote
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the
Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom
of the Grouping menu and click on OK.

Bl Detected Indications Grouping - O #
Groups Details
Name MName: |Critical
Support Plates Izl Amplitude Phase
_ Channel: | DIF-F2 o Channel: | DIF-F2 v
Less Critical II| Measure: | PP = Measure: | PP v
Min: 1.00V = Min: 0° =
P [ |[10.00v M 120°° -

Restrict to Regions

In Tube

Air to Air
[] Freespan
[] FreespanCal
[Tl

[]Ts0

[]sp

Hide unclassified indications

0 l The default configuration will be applied. I |Resetto Default| |\/ oK | |x Cancel

Enabling this option influences the following elements of the software:

e Indications pane;
e Codeview;
e Logbook column.

The images below compare them when the Unclassified indications are shown (left) and when they are
hidden (right).

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the
header serves as a reminder to the user that not all indications are currently shown.
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Indications

26 of 26 results

Label Ampl. Phase
(&) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 084V 18°
IND 076V 17°
IND 1.20V 19°

(%) Undlassified (20)
IND

IND
IND
IND
IND

Indications

6 of 26 results

Label Armnpl. Phase
(~) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 0.84V 18°
IND 076V 17°
IND 120V 19°

OOV Indications Mote

OOV Indications Mote

In the Code view, the red markers from the Unclassified indications have been removed.
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In the data file list, the number shown in the Logbook column represents the number of visible indications,
matching the number shown in the header of the Indications pane.

Data 4 X Data 4 X
7 of 7 data hA 7 of 7 data
Row Cal 8 [el Row Cal 5 [el
201000001 v 201000001
201004005 201004005
| ~ 201006009 68 | ~ 201006009 ®
~ 201006016 ~ 201006016
v 201024022 v 201024022
v 201025017 v 201025017
v 201025019 v 201025019
El ED
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REPORT SHORTCUT

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is
possible to select a channel with a measurement method and to associate an indication with it.

SMART Setup ‘

Enable O
Logboaok

Wizard Package Landmarks Indications

oo
((‘ AT\ 1 . +O o1 '.D
Wy L | -
Landmarks Regions Indications DQV Grouping| Report Help
Shortcuts

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter

pits in the report.

| | Indication Based On
PIT Channel

- O o
!
Source Ampl. Measurer Phase Measurer Sizing Curve Shortcut
DIF-F2 Vpp PP DIF-F2 “| D b4
by

|V’ OK | |XCanceI |

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a
single key or a combination of keys such as ALT+D, for example.

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication
displays momentarily on the corresponding Lissajous.
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DATA SCREENING

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under
the Analysis tab.

| Analysis
E. n |» oOBs R
% |% o 1|9
b - ‘m L7 3 ] _;.,[D *?0 P PG m ]
Screening  Screening Al Previous  Mext No | RST poiew Msg  Capture | Subtraction
All Files Selected Files Defect

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files
when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed
in the Data window.

DATA LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating the list of tubes.

This list can be created in the Data List section of the General tab of the Backstage.

Data List

MNaming Format: Row, Col b

Preview: 001001.magdata |:i |:i
.-0 .-@

Create New List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending on the chosen
filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can
then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to
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generate the list of tubes. You can also use the Create & New button to add another set of tubes to your
list.

2]

. File List Creator

File List Cenfiguration

Mumber of Rows in Component: 1
Start Mumbering at Row: 1 .

Row Interval: 1

Mumber of Columns per Row:

Row Mb. of Columns
1 1
Column Interval: 1 -

v

Include first and last column of each row

Files to Create: 1
Filename Preview: 001001
[+ Create & Mew l I\f Create I [ 4 Cancel ]

L.

The same principles apply to the other file formats, except for the Free format option for which the file
name(s) needs to be entered manually in the Data window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube list file can

be found in the Inspection folder. It is also possible to import a list created in the Tubepro software
(available from Eddyfi).
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PERFORMING AN ACQUISITION

5. Ifyou are in the Backstage, move to the Frontstage by clicking on Start/Resume button.
6. Click on the Connect button under the Instrument tab. This will open the Instrument

configuration page. Click on the line show
then click Connect.

ing the instrument to which you want to connect and

M| Ok &t ¥ =

o Home Setup Advanced Instrument

L AR

LK 4

Connect Setup  Disable Ch. Setup Info o

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case,
ared and white X icon will be shown in the Status field of the Instrument connection window. To download
a matching version to your Ectane, click on the Config. button and then click the Send firmware to the

instrument button of the Instrument configuration window.

-
Instrument Connection (Ectane)

===

Type Madel MAC Address
Ectane2 E128RNMI  EC:52:33:00.0148

Host

inect Cancel

L

g
Instrument Configuration

===

Networl Information
Mode: | Automatic -
IP address:  [152.168.19 .10
Subnet Mask: | 25525525850

Gateway: DDD.D

Embedded Software Update
@ Use the embedded software that comes with Magmifi

Use custom embedded software
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Two acquisition modes are available in Magnifi: Setup Mode and the Acquisition Mode. Setup Mode is
used to scan your calibration tube and make the necessary adjustments on your setup without saving the
data automatically. Acquisition mode is used for the inspection. In this mode, the software automatically
saves the acquired data using file names based on the tube list.

7. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the
Home tab. This mode is active when the Setup Mode button is grayed.

el
B o

Setup Mull
Mode

8. Plug the DefHi® probe on the Ectane 160-pin connector.

9. Bring the probe head in a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

10. Push the probe head all the way through the tube so that it exits the tube.

11. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2
on your keyboard.

12. Pull the calibration tube at the appropriate speed

13. When it’s done, press the Stop button or F2 again on your keyboard

MCOOBS &« T ——
Wome  Sowp  somncid  Dvtoment [ Coibemion | Mras  AbkoMbnh  Lwet  Comeatviow EnGE
4 N =
QA Yo o o8 3 A [E| &
N ondie | Symem G SongCunes ViewCis Lnimuks S Ao Cabrion | Ml | 5o,

B 1) L] T w1 oy,

F2a27

80.0 khiz

(B T esv ] [e]] e ) B e e [ [oesv ][R AR

ooy Buweens  aba  med

0.20v 1880

7 %q
[ ] w JSTor]m]] con J con ]

___________________ L

Il =l = [ v ]
160.0 kHz

0.07V 3550 ? %4
IEBERFED [[cor Jcor,

0.18v 3510 7 %q

[ ] o Jozr]m][ con J con ]

Information Decumentation Repart

Note that a red zone in the code pane means that at least one of the raw signals is saturated. This is usually
the case when your probe is out of the tube.
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VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes useful
functions to do so:

DISPLAYED CHANNEL

There are four buttons at the upper right corner of the C-Scans, Strip charts and Lissajous windows. These
buttons are used for the channel selection.

1. 2. 3. 4.
- DIF | F1

4 A

A

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart
are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this
channel.

PR ERE RN DR ED E N BT
158.4 kHz 158.4 kHz S

/
s
’

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the
desired channel to select it. Right-click or Left-click on this button to switch to the following or
previous channel in the list.

) o ] R

158.4 F1ABS

FIDIF
F2ABS
F2DIF
F3ABS
F3DIF
Land
MIX1

3. Same principle as 2., but for the type of channel only (absolute or differential).
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4. Same principle as 2., but for the frequencies only.

STRIP CHART AXIS ORIENTATION

The Strip charts are a projection of the Lissajous on the vertical or horizontal axis. To switch from one axis
to another, click on the box showing an arrow at the upper right corner of the Strip chart.

1 oE | e 1 400V |

158.4 kHz (

On the strip chart/or on a C-scan, hold the right button of your mouse and drag on the zone of interest to
zoom in this section. This operation can be done in both axis for the C-scan.

ZOOMING

DR ER R [t noov J=] PREFER [t 2000v [ o '

158.4 kHz 158.4 kHz 584 kiz

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.

u |! oF [ F ) [t oy [=)
158.4 kiiz

! Previous Zoom

K, Full Bxtent

% Adjust Cursor Size
3 BestFit

~++  Horizontal

View indications

ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and
the full line is the center of what you have selected.
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Only the portion of data between the dotted line will be shown in the Lissajous.

To adjust your cursor length, hover your mouse over the dotted line, and click and drag the left mouse
button. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same
operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the
left button (decrease scale) or the right button (increase scale) of your mouse.

BRERE ||I 333V ‘ BRERE R T

80.0 kHz

2.98v 12 10.0% IDJ

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the
scale button.
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MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method.
A short description of the measurement methods can be found in the above calibration section of the

setup wizard.

[y

1. 2 3.4
Vep | e, 2P

=

1. Clicking on the corner with the black triangle gives the list of measurement method for the
amplitude of the signal. Click on the desired method to select it. Right- or Left-click on this
button to select the next or the previous method in the list.

2. Same as 1., but for the phase measurement

3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure
the phase with the right orientation.

4. Take the same two points in time to take the measurement in the other Lissajous

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw
a vector on your Lissajous.

LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of
your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on
the raw channels since these channels have no gain or rotated applied, by definition. Also, rotating the
signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous background

and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor at a point where you want the data to be
centered and use the spacebar on the keyboard.
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CALIBRATION AND SIZING CURVES

SLEW

The DefHi® probes include two bobbins that generate absolute and differential channels. It also includes
a set of pancake coils that generates C-scan(s). Since the bobbins and the pancake coils are not physically

located at the same position on the probe, there is a time delay between the channels (coils) and the C-
scan (pancakes coils). To bring all the signals at the same position, the bobbin channels can be shifted in
time to match the C-scan. This process is called Slew in Magnifi.

To Slew:

1.

4.
5.
6.

Click on the Slew button that can be found under the Calibration tab.

( . Slew Calibration I&w

Select current slew:
[5|Ew / Slew Wizard Group A |

Capture Positions

Slew value: | -112 smpl

Close

L™ A

Place your cursor over a flaw in your C-scan.

Click on the button at the left in the Slew Calibration window. This will set the reference point at
which the channels will move.

Place your cursor over the same flaw but on the differential or absolute channel.

Click on the button at the right in the Slew Calibration window

Click on Apply.

Note that this process will move the channels by a constant number of samples. Therefore, a probe pulling

speed that was not constant won’t have a data alignment that is valid throughout the hole scan.
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CALIBRATION

The following section describes how to calibrate your probe.

1. Goto the Calibration tab and click on the System icon
Select Channel in the calibration window

3. Inthe Strip chart, select the signal to calibrate and adjust the cursors to see only the desired
signal.

Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you select your calibration point. This will allow you to see what the system is using to make its
calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.

:gg: IER [t coov | 1]

| Calibration

@) Channel "y

Channel and Sizing Curves

HOLE
SUPPORT
TH-750D

E| [ Calibrate |

[ Reset |

Select the signal name in the list.

Click on the green arrow button to associate the measured signal to the calibration point.
If more than one calibration point is present in the list, repeat step 3, 4 and 5 for each one.
When all your calibration points are check-marked, click on the Calibrate button

Bl S
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SI1ZING CURVES

The following section describes how to build your sizing curves.

1. Go the calibration tab and click on the Sizing curve button.

2. Select Channel and Sizing Curves/or C-Scan and Sizing Curves in the calibration window.

3. Select the signal in your Strip chart/ or C-scan and adjust the cursors to see only the desired
signal.

Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you select your calibration point. This will allow you to see what the system is using to make its
calibration. If for some reason the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to
show the defect size. To have the correct interpolated point, the measurement method also needs to be
the same as the one used for the sizing curve. To change the measurement method, click on the icons at
the bottom left of the Lissajous.

Select the signal name in the list.

Click on the green arrow.

Redo the previous steps for all the other indications in the list.
Click on the Calibrate button.

Bl S

The previous operations must be done for the channels and the C-scans.
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Error messages after creating the phase sizing curves may appear. The main cause of these errors is the
measurement direction.
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The image below shows two different measurements. On the left, you can see that the measurement
arrow is pointing towards the liftoff signal. In this case, the measured phase is rotated of 180° from the
right value. When one or more points were measured in the wrong direction, Magnifi cannot build the
sizing curve and will generate an error message.

In the image on the right, the arrow is pointing from the liftoff signal to the defect signal, which is correct.
However, in this picture, the arrow starts quite far from the middle of the liftoff variation signal, which
will cause an error in the measurement. In this case, we suggest you move the cursors until your
measurement is taken from a point near the base of the signal.

the liftoff signal

1188

1194 "
(PP e [ [ani (&0 I+ coR[~ |
1500 Vep 249 P 2 % 23 Y I =) + COR ‘

=
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To adjust your sizing curves and remove the error messages, go the Calibration tab, and click on View

Curves.
[H setect Calibration Point I& [l select Calibration Point ﬁ

[ DiF-r1. - (ECT) - [ DrF-pL- ECT) ~|

00.0 W] 000

820 I;., 80.0
% 64.0 > % 600
] y
5 480 > 5 @00

280 200

>
10.0 < 00
300 340 20 &0 100 140 7 37 67 98 128 158
Phase (degree) Phase (degree)
MName Side Size (36) Value %) MName Side Size (%) Value ()
IDGR-10  ID 10.0 10 T IDGR-10  ID 100 10 T
HOLE Through 1000 40 HOLE Through 100.0 40
FBH-80  OD 200 71 FEH-80  OD 200 71
FEH-60  OD 600 99 FEH-60  OD 600 99
FEH-40  OD 200 300 ) 4 FBH-40  OD 400 120
A\ Invalid

The sizing curve window will appear. Each sizing curve you asked Magnify to create will be listed in the
drop-down menu. If an invalid notification is present on the curve, it means that you either haven’t
entered the sizing points yet, or that Magnifi failed to create the curve. To adjust the sizing curve manually,
enter the value in the table.

In the above example, the entered phase angle for the 40% defect is 300°, but the correct phase angle for
the 40% defect is 120°. The 40% defect has 180° bias due to an incorrect measurement direction. In this
case, we can simply change the angle value from 300° to 120° in the table to fix the sizing curve.

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws in the
Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw size does not
appear, it means that you are not in a channel where a sizing curve was set.

LANDMARKS

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks
window the same way you calibrate the sizing curve(s) points. You can use the Land channel to do so. The
positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the far side
tubesheet, that is, the first one encountered by the probe during data acquisition; TS1 is the nearside
tubesheet).

Once the landmarks are calibrated properly, the system should be able to recognize them automatically.
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Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far
end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button
under the Home tab. The displayed window will allow you to give an appropriate name to your setup and
to save it at the desired locations. The save location is, by default, your inspection file. Note that when

data is saved, the setup is also saved with it.

You can also save the data of your calibration standard by clicking on the Save As button under the Home
tab.

r. Save Setup As @-‘

F Setup
© save setup in current inspection Browse...

File name: | New setup

Mame

Setup_DEFHI-ERBCA-148MF_SN_1327503

|\f OK | [x{:anr_el l
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STANDARD ACQUISITION

The following section describes how to perform an inspection.

1. Connect Magnifi to the instrument

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab.
Acquisition Mode is activated when the Setup Mode button is not grayed.

3. Plug the DefHi® probe into the Ectane 160-pin connector. The orange dot on the connector must
be aligned with the orange dot on the Ectane.

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

5. Push the probe all the way through the tube until it exits the far end.

6. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2
on your keyboard.

7. Pull the tube towards you at a constant speed (approximately 12”/s or 300 mm/s) until it exits
the tube.

8. When finished, press the Stop button or again F2 on your keyboard.

9. Repeat steps 4,5 and 6 for all the tubes to inspect in your bundle.

MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and
can trigger the acquisition start/stop and the data recording automatically. At least two landmarks are
needed to use this feature. These landmarks can be created by using the Landmarks button under the
SMART Setup tab.

To set the manual sequence:

1.
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Click on the Manual Sequence button under the Calibration tab.

If a warning message is shown in this window, change the parameters until no warning are
shown. The system will progress through the different windows to guide you.

Click on Settings ...



8.

i '\ i '
= Sequence & Q Manual Sequence Configuration e

Sequence

/.\ Type: ) Mone @ Landmark
Start Recording Landmark: | Exit -
Launch . |

Start Recording Delay: 10s -

Stop Acquisition Landmarke  T51

Target Settings... Stop Acquisition Delay: 20s -
Restart
Type: () None ) UserInput @ Timer
MDD Review Delay: 100s -

. Pushing
. Pulling/Recording
. Waiting for Mext

0K l [ Cancel

You must be
connected to an
instrument to start
the sequence,

Connect... |

Select Landmark in the Type section

In the drop-down menu choose the Landmark that will initiate the data recording. If you keep
the default landmarks, you can select the Exit landmark that will be triggered when the probe
goes out of the tube when the probe is pushed.

You can enter a delay to start the acquisition after the first landmark is detected (Start
Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop
Acquisition Delay).

Two options are available to restart the acquisition: The user can either push a button or use a
timer. Select the desired option in the Restart section.

Click on OK.

To use the manual sequence:

1.
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Connect Magnifi to the instrument

2.

Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab.
Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the DefHi® probe into the Ectane 160-pin connector.

Bring the probe head in a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

Open the Sequence window by clicking on the Manual Sequence button under the Calibration
tab

Put your probe in the tube to inspect and click on the Launch button. This will start the data
acquisition.



Push the probe until it exits the far end of the tube. If set correctly, Magnifi will recognize the

landmark and this will initiate the data recording.

Pull the probe towards you until it exits the tube. This will trigger the last landmark detection

that will stop the data recording.

Acquisition restart:

a. Ifyou selected User Input in the settings of the Manual Sequence Configuration, the system
will wait for the user to enter information on the tube to restart the acquisition. Click on
NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition.
Repeat steps 6, 7 and 8. for all the tubes to inspect

b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown
will trigger after the last tube acquisition was taken. The acquisition will start after this time
has elapsed. Redo step 6 and 7 for all the other tubes to inspect in the bundle.

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is
the case, you won’t be able to catch the landmark that triggers the data acquisition at the end of the tube.
In this situation, you can click on the Target button in the Sequence window to start the data recording.
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DATA LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the
Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be
found under the General tab of the Preference menu of the Backstage.

General (Setup Related)

Measurement Units
Report Units: | Millimeter

Channels
Full Channel Scale: 2000Vpp ¥

Hide Raw Channel

Precision
[] Enable
Amplitude: | 2 decim...

General -
Phase 0 decim...

[ H Acquisition
Automatic File Recording

Display Auto Create new file an Next

Automatic Next on Stop acquisition

Analysis

The list of tubes is also shown in the Data window.

Data L 4
22 of 22 data h A
Row Col ﬁ :

v 101000001 ¥lig
v 101000002 (X
v 101000003 g
v 101001001 (g
v 101001002 @
v 10100200 i
v 101002010 (14
o 101004005 (5

el] (@]

A common practice is to rescan your calibration tube and balance the probe periodically. You can save
this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can
go out of acquisition mode, scan your tube, and click on the Save Cal As... button under the Calibration
tab to save your data. You can then go back to acquisition mode to continue your inspection and to
automatically save the acquired tubes in your bundle.

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark
icon.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home
tab.

A tube name can be changed by right-clicking on its name and by selecting the Rename option.
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LOADING A FILE

1. First disconnect your computer from the Ectane by clicking on the Disconnect button under the
Home tab.

2. You can load a file by double-clicking on the file name in the Data window. It can also be done
by selecting the file in the list and by clicking on the Load button under the Home tab. Note that
double-clicking on a tube when you are still connected to an instrument will initiate data
acquisition.

3. You can open the next or the previous file in the list by clicking on the Previous or Next button of
the Home tab.

The data files can be filtered by using the Filter button of the Data window.
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to
the report. These two buttons indicate the code that is associated with the defect being entered. Both
buttons are identical, but can be set to identify different flaws.

To add an indication to the data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous
includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect
to enter.

3. Click on the defect button to add an entry to the report.

[ 1] ] oF .|,
158.4 kHz

IR PR ER R R Y
158.4 kHz 7

‘ ERO
/! NDD

/ OBS

S PIT
PLG
RST
WLL

0.4)V 119 46.
IEEYEE D

Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is
explained in the SMART Setup section of this manual.
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Indications can also be added to a tube to indicate, for instance, that it has no flaw or that it is plugged.
To add an indication to a tube:

1. Loadthe file
2. Click on the appropriate indication button available under the Analysis tab.

(M| OE 4 ¥ -

O Home Setup Advanced SMART Setup Instrument Calibration Analysis Layout Current View
5] ) . 3 $ [» oBs mmn
fi l?“ L7 10 0
| | < .3 < > PG &l
Screening Screening All Previous  Mext Neo Review Msg  Capture | Subtraction
All Files Selected Files Defect | RST
REPORT TABLE

To access the list of indications entered:

1. Make sure that the Report option is selected under the Layout tab.

Layout Current View

I. Infofield Data Report Indications  Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report R X

Zoné  |Row  |Col” | Code Size Side Ampl. (V) Angle()  ChanneliCscan  Ypos. (mm)  LMKY pos. Offset Y pos. {mr Y leng. (mm)  Comment
1 0 0 0.00 0.00 0 0.0 0.0 00 x
2 0 0 0.00 0.00 0 0o 0.0 00 x

Entries in the report can be modified by changing the value in the table. You can also delete an entry by

clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.
Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tubes in component is
used to show the percentage of tube in each category.
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. Generate Report e B Generate Report ¥

Section Selection
REP‘n‘rt Parameters Sections to Include in Report

Tube project parameters

Defect Table Format: | Tubing ECT *

‘ # of tubes in component: |50 - ‘ Report Summary

[[] Show Empty Cells
Instrument Settings
Component Information

Picture: II‘

Inspection Summary
Date and Signature
Screen Captures

# of tubes in component: |81 -

|x Cancel | | P Next | [%€ cancel | [P Next |
4. Click Finish to generate the report.

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed
using any regular web browser.

There is a “copy” button next to each element of the report such as tables and images. When clicking on
it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or
Word.

Eddvfi . .
oW Analysis Report (G

Instrument Settings

Channels Instrument Settings

Channel Calibrations
Setup name: ECT-Bobbin
Mix Channels

‘Component

Information Channels

Inspection Summary

Indication Table Name Frequency (KHz) Drive (V) Gain (dB) Low Pass (KHz) High Pass (Cnt)

Inspection R_ABS-Fi 1600 250 460 400

Data
R_ABS-F2 800 250 460 400
R_ABS-F3 400 2,50 460 400
R_ABS-F4 200 250 460 400
R_DIF-F1 1600 250 460 400
R_DIF-F2 800 250 460 400
R_DIF-F3 400 250 460 400

&

The Print button, bottom right corner on image above, can be used to either print a paper copy of the
whole report or to save it as a .pdf document. The PDF generator available with the current web browser
will be used.
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h . Imprimer 4 pages
Analysis Report -, P P

Instrument Settings Destination B cnregistrer au formati ¥

Setup mama: ECT-Bobisin

Channels Pages Tous -

‘:w :‘ ’ :m ‘:‘"‘ h o o Mise en page Portrait -
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The report logo can be modified by clicking on the Select Company Logo that can be found under the
System tab of the Backstage.

System (Computer Related)

Measurement Convention Measurement Units
EIEIS e @ AsME @ Metric

7) ASME Inverted e o O Imperial

_ EDF o

Readback
D Do not display data during loading
Speed:
_! Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
_! Retain check state

General

@ Reset to checked after loading a data file

Display Setup Wizard Path: C\Users\daube  QTEC\Documents'MagnifitSetup

Automatic Features
D Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo
Preview:

o
‘a.. °
Select

Company Logo

The report table file in the Inspection folder can also be imported into other reporting software such as
Tubepro.
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RFT Application Guide

183



RFT Single-Driver Probes RFT Single-Driver Boiler Probes

Vo

RFT Double-Driver Probes RFT Single-Driver Flexible Probes
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INTRODUCTION

This document presents how to use an RFT probe with Magnifi 5 on an Ectane test instrument.

Eddyfi offers four types of RFT probes. The following was made using a dual-driver probe (RFT-DDST) but
can also be applied to all other types of RFT probes.

EQUIPMENT

The RFT probes use a 19-pin connector that can be connected to an Ectane with the “ERNM” option. The
absolute and differential signal from the probe will provide Strip charts, Lissajous and Voltage planes.

A wide range of probe diameters are offered (see the tubing probe catalog for more details). A wide range
of frequencies are also available to allow inspections of tubes of different thickness and material.

From the following table, the best probe for your application can be selected.

Table 8 — RFT-DDST probes diameter selection table

TUBE WALL THICKNESS (BWG, mm, in)
BWG 4 5 6 7 8 9 10 1 12 13 14 15 16 17 18
mm 605 559 516 45/ 419 376 340 305 277 241 21 183 166 147 124
in 0238 0220 0206 0180 0165 0148 0135 0120 0109 0095 0083 0072 0065 0058 0.049

15.87mm 0.625in = = = — = = = = — 100 100 110 110 110 120
19.05mm 0.760in - - - - - 100 110 110 120 120 130 130 140 140 140
22.22mm 0.875in = 100 100 110 120 130 130 140 140 150 160 160 160 170 170

25.40mm 1.0001n 120 120 130 140 150 150 160 170 170 180 180 190 190 190 200
31.75mm 1.250in 180 180 180 200 200 200 220 220 220 240 240 240 240 240 260
38.10mm 1.5000n 220 240 240 260 260 260 280 280 280 280 300 300 300 300 300
50.80mm 2.000in 340 360 360 380 380 380 400 400 400 420 420 420 420 420 440

TUBE OUTSIDE
DIAMETER

Table 9 — RFT-DDST probe frequency range selection table

TUBE WALL THICKNESS (BWG, mm, in)
BWG 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
mm 605 559 516 457 419 376 340 3056 277 24 211 183 166 147 124
in 0.238 0220 0206 0.180 0165 0.148 0135 0.120 0109 0085 0.083 0072 0065 0.058 0.049

I

Carbon steel A178, A179, A192, A214 LF LF LF LF MF MF MF MF MF MF MF MF MF MF MF
= Cast iron (gray) MF MF MF MF MF MF MF MF MF MF MF HF HF HF HF
z= Ductile iron LF LF LF MF MF MF MF MF MF MF MF MF MF MF HF
E Nickel 200 MF MF MF MF MF MF MF MF MF MF MF MF MF HF HF
= Stainless steel 439, A268, TP439 MF MF MF HF HF HF HF HF HF HF HF HF HF HF HF

Stainless steel duplex (2205), 3REG0, A789  HF HF HF HF HF HF HF HF HF HF HF HF HF HF HF

185



Table 10 — RFT-DDST Frequency range

CODE FREQUENCY IN Hz
Min. Max. Central
LF 10 400 50
MF* 50 2000 300
HF 500 20000 2500

* Standard frequency range

The RFT calibration tube used in this document includes the following indications:

e External groove, 40% and 60% of wall loss
e Hole, 100% of wall loss
e OD Flat Bottom Hole (FBH), 60% depth
e 0D 4 xFBH, 20% depth
e Asupport plate
Other combinations can be used to calibrate the probe and to build sizing curves.

Note: Fill factor and selection tables may differ for other types of RFT probes. Please refer to the tubing
probe catalog on our website to find out more.
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In this section, we will create a folder structure that will manage the saving location of your setup, data
and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of files. The first level is the Project. It is meant to include different inspections
that are related in some way. For instance, it can include all the inspections done at a refinery shutdown
and be named Refinery_Shutdown_May 2018. The second level of file is the Inspection folder. Inspection
folders are saved in the project file. An inspection folder can include the data specific to the inspection of
a tube bundle with a specific technology and could be named CS_075x0.083_RFT, for instance. This
inspection folder groups the setup, the tube list, the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

—f——— |

INSPECTION 2 INSPECTION X

| |
| |
| |
|
I SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE l
<« DATA |

| LIST
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
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When you open Magnifi, the first page displayed is called the Backstage.

Magnifi® 53817376 - [Setup from original data file] - ECT-Babbin.magdata

General
Project / Inspection Information
Project Folder: Documents\Magnifi\Projects\Defa Probe: Unable to detect
General
Inspection Folder: Document: \Projects\Default\DemoData3 .5 .5 L Application: Generic
Project Folder | |IMsPection Sub- g
rejectreider folder Tube Dimensions:
Aca.s oD 2540mm
<a. Summany Setup / Data
Setup Loaded:  From original data file WE 1.85mm
™
Setup Location: Jocuments\Magnifi\Projects\Defa é Length: 500 mm
R Create Setu Open Setu Open Data ;
Data Loaded: ECT-Bobbin P P P P Materiak  Stainless Steel 316
Frequencies: 160.0, 80.0, 40.0, 200 kHz
Data List
Naring Format: | Row, Cal ~

Preview: 001001.magdata =t —
T4 ] O

Creste New List| | Import List

Documentation

Report
Name: Report.mdb v
s *
s Table Profile: Tubing ECT - bae”
T Export Defect
P Table

[ Take screenshot with report entry

License

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an existing
project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your project file. Select
New, Folder and enter the chosen name. You can then select the newly created folder and click
on Select Folder.

—
I select s project it
Q' =)y v |4 p
Organize v New folder = v “
\
|
- }
g
P
L Projects Folder
A Shorteut
8 Microsoft Access Database
& Biamapimage
3 Contact
81 Microsoft Word Document
- View » (] Microsoft Access Database
= Sort by » @) Microsoft Project Document
Group by * G Microsoft PowerPoint Presentation
N Refresh @) Microsoft Publisher Document
[ SonicWALL Global VPN Client Document
B AN SR ¥ Rich Text Format
= Undo Delete Culez 6 Doxspent
= G7) Dessin Microsoft Visio
h
= = S " |8 Microsoft Excel Worksheet
New » @ Briefcase
Folder: Magnifi
|_selectFolder | | Cancel

188



2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your
inspection.

- Al
. Manage ﬁ

l Inspections
o Manage Inspections Select Other...

Mame State

Default Ready for Inspection

Bundle_A_55316_0.75X0.065_ECT |_E

|V’ Select |[x Close ]

. a4
3. Click Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System
tab, you can change the measurement units from metric to imperial and vice versa. For the metric units,
you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement
for imperial units is inches. When finished, click on Preferences again to go back to the General window.

System (Computer Related)

Measurement Convention Measurement Units
Preferences @ ASME @ Metric

ASME Inverted vl o O Imperial
) EDF o

Readback
[] Do not display data during loading
Speed:
) Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
Retain check state

General

@ Reset to checked after loading a data file

Display Setup Wizard Path:  C\Users\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
[] Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo
Preview:

£ (@ eddyfi

Shortcuts

Keyboard.. |
Remote... |

To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to
start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected.
If the material is not in the list, you can click on Manage... to open the List of Available Material window.

5 Mew Setup Wizard *
Component Definition -

0 Configure the geometry and material of the component to inspect

Geometry: 1 Surface @ Tube from ID
Application: (®) Generic () Air Conditioner
Material: Carbon steel v

Resistivity: 21 pllem

Permeability: 450 p

Velocity: 5890.000 m/s
Wall thickness: 1.65 mm -

16
BWG

] 24
Outside diameter: 19.05 mm -
Length: &000 mm =

Mote about selected material:

ASTM: A178, A179, A192, AZ10, A214

o | [ e

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant
name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is
used to set IRIS parameters only, and it doesn’t need to be set if an IRIS inspection is not performed on
this material.

It's possible to add a note about the material to specify information such as its application or composition.
When you are done, click OK.
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[y List of Available Materials

Custom Matenals

g

Browse...

Materials Co
MName 5:{;;;: ?r: /) [R;?i::;ty Permeability <+  Add
Stainless Steel 321 - ET ONLY 0.000 715 1 (| “ & Remaove Al
Stainless Steel 430 - ET ONLY 0.000 B3 100 (%

Stainless Steel Duplex - ET OMLY 0.000 74 75 |
Stainless Steel 9041 - ET ONLY 0.000 94 75 | ¥
Titanium 6070.000 486 1 (%€
Ti-6AI-4V - ET ONLY 0.000 123 1 (%
Zirconium 4650.000 a1 1| %

Motes About Selected Material

v ok J[X conce

You will be back to the Component Definition window. If you added a new material, it will now be available
in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider.
Enter the tube’s outer diameter and length.

These tube properties will help Magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION

In the Probe Selection window, select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu.
More precise filtering can be done by using the Model drop-down menu. You can then select your probe

by its catalog number (PRBT-RFT-DDST) and then click Next.

r?'-'- Mew Setup Wizard g1
f\_’ Probe Selection b - |
/s
- Select the probe that you want to use for your inspection
=
Technique: [RFF v] Model: [Dnal Driver v]
Probes
Tech. Model Catalog Number Y | Description
[H MNew... ] [-‘QManage.. ]
[ Cancel || Back |[Pp Nex |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the acquisition
rate and the typical probe speed.

}'- New Setup Wizard [&J
Scan Definition
Configure the type of scan you will be performing with your probe
Scan: Single Pass
Main Scan Axis: Y Axic
Position from: Clock - |
Acquisition rate: 800 Hz -

Typical probe speed:  300.0 mm/'s -

Acquisition Size: 600.000 s . Maximum

-

[ Cancel | [ ‘ Back | [ b Mext ]

[

The position along the tube can be defined by using either the internal clock of the system, or by using an
axial encoder. If you use the internal clock, the default position will be given assuming that the probe is
always pulled at the typical probe speed. If the typical probe speed is set to 200mm/s, and the time since
the acquisition began started is 2 seconds, then the system will indicate a position of 400mm. Using an
encoder will give you the exact position of the probe. Note that the position can also be obtained by using
the landmark tool, but this feature will be shown later.

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate
is set to 800 Hz for RFT, but depending on the drive frequency used to inspect, the actual acquisition rate
may differ. The system will automatically readjust this value if needed.

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For an
acquisition rate of 800 Hz, the pulling speed needs to be less than 400mm/s to have at least 2 points per
millimeter. If you do not use a pusher-puller device such as Probot, the pulling speed won’t be constant.
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Therefore, it is recommended to target a lower pulling speed to be able to reach your axial resolution

target. The typical probe speed should be set as close as possible to the real value. This will help the

algorithm that automatically detects landmarks (this will be explained in the Landmark section). The

recommended pulling speed for RFT depends on the excitation frequency (set in the next step) and is

shown in the table below:

Excitation Frequency (Hz) Maximum
Maximum Minimurm pulling speed (in/s)

20 100 4

100 200 6

200 350 8

350 500 10

500 1000 12

1000 - 20

If you selected to measure the position from Encoder, different fields will appear and a second Scan

Definition page will become available.

5+ New Setup Wizard

5+ New Setup Wizard

Scan Definition

Configure the type of scan you will be performing with your probe

(3 cancel | (4 Back |[p next

Scan Definition

Encoder and axis settings

Asial Encoder

Type: Clock Dir

Resolution: 2546 - count/mm
Tnvert direction
Preset 0000 mm

] Apply preset on Start

(

Cancel | [ Back | [P Nex |

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered.

The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the

number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition

rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a

speed exceeding the Maximum probe speed, there will be gaps in the data.

The second page includes the type of encoder and its resolution. A preset can also be specified if your

acquisition doesn’t start at 0 mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute
and Differential channels. It is important to set these parameters correctly before acquiring the data since
they are driven by the instrument and cannot be modified during the analysis.

" Mew Setup Wizard @

N Data Definition |
2

Select the channels you will be using and the necessary frequencies

Connector: 19 pins

Channels Required frequencies
Name Prefix Gain (dB) Prefix  Val (Hz) Ampl (V)
Absolute ABS- 56.0 F1 247 5.00 @
Differential DIF- 66.0

Suggest + Add

[x Cancel l[‘ Back “b Mext |

[

By default, Magnifi suggests a frequency theoretically calculated with the tube parameters previously
entered.

The frequency and drive voltage can be changed by replacing their values in the Required frequencies
table. Up to four frequencies can be set at the same time. And the sum of their amplitude cannot exceed
10v.

Make sure that the frequencies are within the probe limits that you can find in Table 3. If the suggested
frequency is not within the recommended probe frequency range, it means that either the probe that you
are using is not appropriate for your tube or that one of the tube parameters previously entered was not
set correctly.
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Another thing to consider when selecting the frequency is the frequency of the power outlet at the

location where you are performing your inspection. Under a certain frequency, it is recommended to

avoid the harmonics of the outlet frequency to prevent noise issues. The figures below indicate which

frequency to avoid.

BW =8 Hz BW = 10 Hz BW = 15 Hz BW =20 Hz BW =25 Hz
SPD =0.1m/s || SPD = 0.15 m/s SPD = 0.22 m/s SPD = 0.3 m/s SPD = 0.35 m/s
30 50 75 85 135 165 195 225 255 290 310 355 500
—_
0 60 120 180 240 300 360 420 480 540 600
Frequency (Hz)
- Frequency range to avoid - Frequency range allowed
Recommended frequencies for power outlet at 60Hz
BW =8 Hz BW = 10 Hz BW = 15 Hz BW =20 Hz BW =25 Hz
SPD =0.1m/s || SPD = 0.15 m/s SPD = 0.22 m/s SPD = 0.3 m/s SPD = 0.35 m/s
30 40 60 85 115135 165 205 215 240 260 295 305 500
B e T e T e B e B o B
0 50 100 150 200 250 300 350 400 450 500 550 600

Frequency (Hz)

- Frequency range to avoid - Frequency range allowed

Recommended frequencies for power outlet at 50Hz

Click on Next when the desired parameters are entered.

The next window is used to build mixed channels. Mixes are processed channels that are mainly used to

detect indication close to support plates. They are built with two frequencies of the same channel type to

attenuate the effect of the support plate and to be able to size an indication at this location more

accurately.
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5% Mew Setup Wizard d

P Oxt= Deinition ]

Configure the channel mixes for your inspection

Input Channel 1 Input Channel 2 Output Mixed Channel Mixed Reference Signal
DIF-F1 DIF-F3 MK REF @

|x Cancel | |‘ Back | | b Net |

If you do not wish to use mixed channels, click on Next.

To add a mixed channel, click on the Add button. A new line will appear. Choose from which input you
want to use the mixed channel. Note that Input Channel 2 must have a lower frequency than Input Channel
1. Mixed channels can be built for both absolute and differential channels.

You can rename the mixed channel output by modifying the Output Mixed Channel field.

The mixed reference signal (usually a support plate signal) will be used to calibrate the mix channel. The
system will apply processes to the chosen input channels and will subtract them to attenuate the
reference signal.

Click on Next.
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DATA PROCESSING

The Data Processing window is used to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually or you can apply the same filters to every
channel with the Individually configure all the channels check box.

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can
be changed without any problem during data analysis, while wrong parameters choice for the data
acquisition can mislead the analysis. It is possible to change the filters parameters after data acquisition,
so it is always possible to fine tune the filters parameters during analysis.

'/'- New Setup Wizard liE-J
%= Dpatap i
ata Frocessing
! Select the processings that you want to apply to the channels you have selected
[] Individually configure all the channels
Low Pass Median High Pass
Mame Cutoff (Hz) Window Size (smpl)
ABS- 12 ] 533
DIF- 12 [C] 533
MIX1 12 [[] 533
Suggest |
[ Cancel | [ ‘ Back | [ ’ Mext ]

The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful
when your defect signal has a lower frequency content than the background noise. In this case, using a
filter will remove part of the noise without removing the defects signals. This may help with data analysis.
However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too
low will filter out the defect’s signals.

The median high pass filter is used to filter out low frequency noise or drift such as lift-off variations of
the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of
high-pass median filter should be set to at least three times the axial length of the longest flaw that may
be encountered. Data should be examined in both its filtered and unfiltered states. It is important to keep
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in mind that the median high-pass filters can distort phase. More information about median filters for
NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.

CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These indications will
later be used to calibrate your probe and to build sizing curves.

The units of measurement can be set in percentage or in depth (millimeters or inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and
size. The side and size of the flaw will be used to position the calibration point on the sizing curve(s).
However, it should be note that RFT doesn’t allow an indication side differentiation.

Calibration points can also be imported with the Import button.

%% New Setup Wizard x
Calibration Points | |
Configure calibration points used for channels and sizing curves
Units of measurement: | Percentages (%) x

Calibration points

MName Side Size

HOLE Through 100.0 %
FBH-80 None 80.0 X
FBH-60 None 60.0 X
FBH-40 None 400 %
4 x FBH-20 None 200 X
GR-40 None 400 %
GR-60 None 60.0 X
SUPPORT Unknown 0.0 @
REF MNene 0.0

| L Import | | - Add |

| Concel || 4 Back |[p Nex |
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Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).

CALIBRATION

The Calibration page is used to define the calibration method that will be used to set the amplitude(s) and
phase(s) of a channel using the selected measurement method.

By default, the calibration is performed on the Hole signal by adjusting it to 1V and 90° on the differential
channel. The calibration can be done differently on each channel type. It can also be done individually for
each frequency by selecting the Individually configure all the channels option. Different reference signals
can be set to calibrate the phase and the amplitude independently.

»" New Setup Wizard l&J
6 Calibration
A Configure parameters to calibrate channel amplitude and phase
[T Individually configure all the channels
Use Voltage Plane representation for absolute (ABS) channels
Link differential (DIF) channels rotation and gain to the absolute (ABS) channels normalization
Amplitude Phase
MName Voltage (V) Reference Measurement Angle (%) Reference Measurement
ABS- 1.00 SUPPORT PP 0.0 SUPPORT PP
DIF- 1.00 HOLE PP 90.0 HOLE PP
M 1.00 HOLE PP 90.0 HOLE PP
[ Cancel | [ 4 Back | [ } Mext l

You can use a voltage plane for the absolute channel(s) by selecting the Use Voltage Plane representation
for absolute (ABS) channels option. This option is selected by default. Voltage planes are polar plot in
which theoretical curves show the effect of depth variation on the signal. They are used with RFT to
estimate the depth and coverage of a flaw. More information on these views can be found in Appendix 1.
The voltage plane option will allow you to use the functions offered by Magnifi to match the signal with
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theoretical curves. With this option, calibration settings will be grayed because the calibration can’t be
done with a single reference point when using a voltage plane.

A second option can be selected if voltage planes are used (Link differential (DIF) channels rotation and
gain to the absolute channel (ABS) normalization). This option links the absolute and the differential
channel. When an inspection is performed, certain tubes can have properties that are different from the
calibration tube. This will change the operation point position and the built sizing curves won’t be
applicable to the inspected tube. Bringing back the operation point to a reference point makes the sizing
curves compatible again. Automatic and manual functions can be used to do this operation. With the
second option checked, the gain and phase rotation applied on the absolute channel will also be applied
to the differential channel. If this second option is not selected, the adjustment of the differential channel
will be done separately. The ways to perform these adjustments is explained in the Inspection section of
this document.

If the voltage plane option is not checked, the absolute channel will be calibrated with the reference
signal(s) selected in the calibration page.

When you select the reference signal, the system will use the selected measurement method to apply a
rotation and a gain. Here is a short description of the available options:

1. Absolute (A):
Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude.

2. Absolute Horizontal (AH):
Uses only the horizontal component, from the Lissajous origin to the main cursor position to
measure amplitude.

3. Absolute Vertical (AV):
Uses only the vertical component, from the Lissajous origin to the main cursor position to
measure amplitude.

4. Absolute Peak (AP):
Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure
amplitude.

5. Absolute Peak Horizontal (APH):
Uses only the horizontal component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

6. Absolute Peak Vertical (APV):
Uses only the vertical component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

7. Average Peak (MP):
Takes the distances from points at the extremity of the cursor to the peak of the data selection
to build an average vector. Only used and recommended for absolute signals.

8. Average Peak Horizontal (MPH):
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10.

11.

12.

13.

Uses the horizontal component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

Average Peak Vertical (MPV):
Uses the vertical component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

Peak to peak (PP):
Uses the combination of the vertical and horizontal component to measure the maximum
amplitude.

Horizontal (PPH):
Uses only the horizontal component to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to measure the amplitude.

Peak to peak First Transition (PPF):

Uses the combination of the vertical and horizontal component of the first transition of the signal
to measure maximum amplitude. The firsts signal transition is from the base of an indication to
its peak.

Click on Next went the parameters in the table are set according to your requirements.

S1ZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this
table.

203



& Mew Setup Wizard X

/\ Sizing Curves |

Add and configure the sizing curves necessary for your inspection

D Mame Source Measurement
ABS-F1 ABS-F1 Phase ]
ABS-F2 ABS-F2 Phase ]
DIF-F1 DIF-F1 Phase ]
DIF-F2 DIF-F2 Phase ]
MIX1 MIX1 Phase X

|x Cancel ||‘ Back ||’- Net |

The sizing curve will allow you to estimate the size of a defect based on the calibration points signals
(amplitude or phase) obtained with your calibration standard. Magnifi will give you the interpolated flaw
size base on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be changed.
You can add sizing curves by clicking on the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window will appear to configure the curve properties.
The name of the curve will be shown in the upper left corner of the page (ABS in the example below).
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" New Setup Wizard l&J
Sizing Curves
Configure the properties of the ABS sizing curve
Measurement method: [ PPF - | e e
Shape: [ BEL v| Name Side Size -
GR-60 Mene 60.0
[T] Report as remaining wall cl
GR-40 Mene 40.0 A
[C] HOLE Through 100.0
[C] FEH-80 Mone 80.0
[C] FEH-60 Mene 60.0
[C] FEH-40 Mene 40.0
[] 4xFBH-20 MNone 2010
[] SUPPORT Unknown 0.0
Extrapolated curves:
Marme D Descripticn
Long L Long Defect
Taper T Taper Defect Reverse order of points
[ Cancel | [ 4 Back | PP Net |

The measurement methods options are the same as what is described in the calibration section of this
document. By default, the Peak to Peak First Transition (PPF) option is set for absolute channels, and the
Peak to Peak (PP) option is used for the differential channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of
the available options:

1. Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side calibration
points with respect to phase.

2. Best Fit (Dual Slope) (for phase measurement only):
A curve with two segments representing ID and OD (or Near and Far) side. The ID section is
linear and the OD section is polynomial. The OD side of the curve will need at least three points
(including the hole) in order to trace a polynomial curve.

3. Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured (requiring at least three points).
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4. Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.

5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD sides of the curve.
Need at least three points.

The linear options are mostly used when few data points are available, while the Best fit (Dual Polynomial)
option is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select the curve
points for each sizing curves previously created. The order in which the points appear in the list will
influence your curves. Make sure that the measured values of the calibration points are in the desired
order. You can use the Reverse order points option to associate the deepest flaw with the smallest
measured value.

For the absolute channel(s), two additional extrapolated curves will be created by default for each sizing
curve. These curves will give the depth of a flaw that is considered Long or Taper. A description of these
types of flaws can be found in Appendix 1.

Extrapolated curves:

Marme | Description
#| Long L Long Defect
o Taper T Taper Defect

You can set Magnifi to show the remaining wall instead of the defect size by checking the box Report as
remaining wall thickness.

Click Next when you are done.

206



INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when analyzing
the data.

%% Mew Setup Wizard it
“— _ Indication Codes ]

Configure the indications codes used for the report

Code Description Type Automatic Celor

COR Corrosion Defect @
CRK Crack Defect X]
DNT Dent Defect @
D3l Distorted support indicatic  Defect |Z|
ERO Erasion Defect @
MDD Mo defect detected Mo indication |Z|
0BS Obstructed Feature I" Red @
PIT Pitting Defect X]
PLG Plugged Feature I" Brown @
RST Restricted Feature I Yellow |Z|
WLL Wall loss long Defect @
WLS Wall loss short Defect X]
WLT Wall loss taper Defect @

2 Import | | =)= Add
(% Concel | |4 Back | [P Nea |

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.

You can modify the default indications codes list by changing the parameter in the table. New indications
can be defined by clicking on the Add button.

Click Next when you are done
DisPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.
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<" Edit Setup Wizard [

Displa
- Configure display and layout properties

General options Lissajou [ Strip chart options

Zoom behavior on stop acquisition: [E] Miniature strip chart

Zoom to full scale

Proportion: 33.00 -
) Zoom to content
Display Direction: Down A
@ Keep current scale
Strip chart duration: 10 s -

3 Cancel | Back P Next |

A ]

The scroll direction is the direction in which data appears on the screen. If you choose downward, the
signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal
will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box.
The strip chart duration is the length of a Strip chart window when the data is acquired.
Click Next.

The second Display window is used to set the layouts. Checking the tick boxes in this window will make
the proposed layouts in your setup. You will be able to switch from one to the another via the layout tab.
The " C" stands for Code, " S " stands for Strip chart, " L " for Lissajous and " V " for Voltage plane.

The layout with the blue background will be the one opened by default, which can be changed to your
desired option.

Layouts can be readjusted at any time.
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- 5
. Edit Setup Wizard [

Display
@ Select the layout that you want to use to display your inspection results

2 Strip charts, 1 Lissajous 2 Strip charts, 1 Voltage plane

qs|s L DCSS v

2 Strip charts, 1 Voltage plane, 1 Lissajc | | 4 Strip charts, 1 Voltage plane, 1 Lissajc

v v
ds|s 1 ds]s|s|s —
L L
. : Default layout
(3¢ cancel | [4 Back | [/ Finish

. 4

Click Next to complete the setup wizard process.

SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the
parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button
associated with the parameter you want to change.

] Ok 4 ¥ -

o Home Setup Advanced SMART Setup Instrument Calibration Analysis Layout Current View
S & | e dy y 9O A ¢ [
7 m e D Y A D So
Mew Locks Comp Probe Scan Data Process PC_EI Calibration  Sizing  Indication Display
oints
Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View
=B AN S
o i ) N Sp @
e* = Y A 2
Comp Probe Scan Data Process Landmark pC.al Calibration  Sizing Indication Display
oints

This will open one of the windows previously described, where you can change the the values you
originally entered. If applicable, go through the process by clicking on Next, and then click on the Finish
button. This will apply the modification to the setup.
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Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed
using these advanced settings, the information shown using the Setup tab may not match your actual
setup.

SMART SETUP TOOLS

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.

LOGBOOK
The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook.

SMART Setup

= ' | 0o
@ D |8 %

o W L N
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications DQV Grouping  Report Help
Logbook Shortcuts

The logbook stores information about the analysis in addition to allowing the following functions: batch
screening, seeing results at a glance from the data list pane and saving manual modifications made to the
landmarks during the analysis.

The logbook stores the following information: landmarks (type, position, dimension, including manual
modifications), indications (Al and conventional, label, position, dimension, etc.), indication grouping, and
data quality validation results. When enabled, an additional column is added to the data file list to allow
seeing results and to filter, sort, or analyze according to these results.
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The following table shows the possible icons and their meaning:

Icon Description Meaning
No logbook entry associated with this file because
(empty) Empty .
it has not been screened yet.
Logbook entry associated with the file contains
. . information such as landmark detection or regions.
Dashed outline circle, . . . .
. . The absence of additional information on the icon
() without a number e . )
- reveals that no indication detection engine or DQV
tests were enabled when the logbook was written.
Logbook entries associated with the file contains
information such as landmark detection as well as
. . . detected indications. The number displayed inside
. Dashed outline circle, with a . . .
{1} the circle shows the quantity of potential

s

number

indications detected.
No DQV tests were enabled when the logbook was
written.

Dashed outline circle, with a

green check mark

The green check mark indicates that the DQV
test(s) passed on this file.
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o, Dashed outline circle, with a The red cross indicates that at least one DQV
red cross test(s) failed on this file.

) ) ) The logbook entries associated with this file
Dashed outline circle, with a o o
. indicates that potential indications have been
{37 number, with a green check . )

- detected by the detection engine and that the DQV

test(s) passed.

mark

The logbook entries associated with this file
Dashed outline circle, with a | suggest that potential indications have been
number, with a red cross detected by the detection engine and that at least
one DQV test(s) failed.

The Al detection tools identified an unusual
situation. In this case, the level of confidence in the
A Orange warning triangle detection findings could be very low. Therefore,
users should pay special attention when reviewing

&

the detection results.

The logbook is saved within the inspection folder. Its data is written when a file is screened using the
dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the
logbook is enabled, and no logbook entry existed for this file yet.

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been
detected with detection tools that do not use Al (conventional landmark detection and indication boxes).

Also note that the automatic indication detection tools are not available if you use the acquisition license
(ACQ).

LANDMARKS

The Landmarks button is used to setup the parameters for landmark detection with conventional tools.

SMART Setup
— - o0
i ? f} { AT & +B8 U[‘T‘
o R W v sn 6
Enable Wizard Package Landmarks Indications [ Landmarks JRegions Indications DQV Grouping Report Help
Logboaok Shortcuts

The Landmark Detection window is used to configure the automatic detection of features such as tube
sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional
setup. They can however give a reference for the axial position in a tube. They can also be used by the
software to trigger automatic acquisition sequences.
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Bl Landmark Detection - [} X
Detection Channel: FICo4 - (Exitis used for
ence only)
. TsO e, TS|
Reporting From: ® StartRecord () Stop Record rm »
[ Negative Positioning: From |0.0 mm I
Stop ¥ Start
Detection Engine: Extended = Record I: I Record
Reporting from
Manual Sequence: [] (Check for Acquisition Detection) Length 0
Enable Detection
Landmark Table (in the order seen by the probe during data acquisition)
Name Tpe Pos. (mm) MinQty MaxQty Shape  Component Threshold (V) P2P (mm) Enable
Exit Exit 25 5 =5 1000000 Dicabled D
TSI TSI 0 5 -5 1000000 Enabled D
5 5 5 = 1000000 Enabled (%]
50 50 6000 P -+ 1000000 Enabled D
Floating Group Landmark Positioned Landmark
mport.. | [ Evport.. | [ suggest Ue = Add

Three landmarks are created if you press on the Suggest button. The channel selected to detect these
landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw.
This is the signal of the channel without software filter, rotation, or software gain applied.

You can base the position of your landmarks either on the location where you start to record (usually the
tube entrance, opposite from the operator position) or on the place you stop to record (usually the
operator side).

Detection Channel: R_DIF-F1 i3 ( is used for

e only) T

Reporting From: (@) Start Record () Stop Record

[] Negative Positioning: From 0.0 mm

==

Stop Start
Detection Engine: Extended S Record |4 Record
L Reporting from
Manual Sequence: [] (Check for Acquisition Detection) Length
Detection Channel: R_DIF-F1 - (Exit is used for
] . TSO sequence only) TSI
Reporting From: ) StatRecord (@) Stop Record -
[ Negative Positioning: From 0.0 mm rm I
Stop 8  Start
Detection Engine: Extended S Record : ;: Record
Reporting from
Manual Sequence: [ (Check for Acquisition Detection) 0 Length

In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has
a negative position because this event happens before entering the tube. It is enabled only when doing
the acquisition.

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered
at the end of the acquisition.

Landmark detection can be set up manually by describing the shape, component, and voltage threshold
that will trigger the detection. The Shape describes the appearance of the signal when the landmark is
reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed.
The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to
trigger the landmark. And the Threshold is the voltage amplitude threshold.
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Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as
they will be automatically measured by the software. It's important to set the landmark positions as
accurately as possible. If the position is not accurately set, the software might prevent their automatic
detection since it won’t be at an expected position.

The Type field is a name that associates the calibration point with the landmark. If landmarks share the
same Type, they will be calibrated at the same time using the same point and process. To associate two
landmarks with the same Type, their signal must be the same. If support plates of the same geometry are
present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the
same Type because one is triggered when the probe goes inside the tube and the other is triggered when
the probe exits the tube.

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the
landmarks need to be entered with the right position. The system will look for the exact number of
landmarks entered at positions close to those entered in the table. With the Extended mode, the system
will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact
number of support plates don’t need to be constant or known.

REGIONS

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used
to categorize the data to process correctly. For example, they can be useful for restricting the detection
of channel saturation to an area within the tube or specify an automatic analysis type for a given region
(e.g., under the tubesheets).

SMART Setup
i (] an b | VB 5
o Wy L Y >
Enable | wizard Package Landmarks Indications | Landmarks|| Regions [ Indications  DQV Grouping Report Help
Logbook Shortcuts
Bl Region Detection X
Regions Details Preview
Name Name: Between —
_IZI Abbreviation: ; TSI (1SD)
Around lzl Location: Eetween v 5P (SP)
In Specimen BI el Al v 5P (SP)
Start Offsct: | 10.0mm : wEH
End Offset:  |-10.0mm : SP(SF)
SP (SP)
5P (SP)
' SP (5P)
srise
General Simulation Parameters SP(SP)
Landmark Thickness: |250mm  + SP(SP)
Floating Quantity Simulation E TS0 (TS0)
SP: 10 =
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If you are using the conventional detection tools, you can set up the regions according to the automatic
analysis tools you will use with the Indications and DVQ buttons (described later).

INDICATIONS

The Indications module allows the user to define various zones or even waveform types to trigger a certain
detection threshold.

Enable Wizard
Logbook

Package

Landmarks

SMART Setup ‘
AN | e “&
W L Y
Indications | Landmarks Regions JIndications| DQV

Grouping Report

Help
Shortcuts

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name

that will appear in the Code view.

B indication Detection % INER D T o
Detection Zones —— e
Label Based on Source Zone Type Zone
PIT Channel F2DIF ‘ Iz‘ Inside Radius LARAY -
Qutside Radius | 20.00 V -
Orientation 46° =
Aperture 85.0° B
Center (0,0)
Boundary
Increase by dent =
Regions
Restrict to selected
'
[ ok ][ Cancel |[ Apply
LT P o
g = - 4 x ]
There are five zone types:
2 Absolute pie
o Differential pie
[ | Centered rectangle
- Rectangle
Sirs Over or under a horizontal or vertical threshold

And seven waveform types:

B Up
# - Down
$T Down-up
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¢+

Any direction

al

Up-down

31

Down-up-up

3

Up-down-up-down

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also

include the boundary setting to prevent signal oscillation from triggering unnecessary detections.

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating

the Edit Alarm option on the Current View tab.

The detected indication can be found in the Indication window, which can be activated in the Layout tab.

| Layout

L EBERER B D R == EREEE M

Select Manage Reload BackUp New Layout Replace Remove Split Infofield Cal. Infofield Data Report Dav Indications MNote Large

Acquisition

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip

chart view. If you click on an indication in the code view (described later), the associated indication is
highlighted in the Indications pane.

Indications oox

Label
IND

IND

IND

IND

| | - | | DIF- | F2‘ || 236V | 1 |

80.0 kHz £

IND

IND

IND

IND

IND

DATA QUALITY VALIDATION (DQV)

Data Quality Validation allows defining tests to validate the quality of the data.
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Enable
Logboaok

SMART Setup

% Q = D | ZE “:[f'DD

Wizard Package Landmarks Indications | Landmarks Regions Indications] DQV Grouping Report Help
Shorteuts

Five test types are available. To add a test, click on the Add button on the DQV page and select the test

type with the drop-down menu. Parameters associated with this test can be changed in the Details section
of the DQV window.

DOV Tests: Details
Enabled Test Type MName (Optional) Merge
Hardware Saturation |:| Range 10.0 mm =
Dead Channel |:| Regions
e N l:‘ Restrict to selected [Select
Add
| oK | | Cancel |

Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined
threshold. An amplitude that remains below the threshold throughout the scan indicates a dead
channel.

Landmark Detected: Verify the presence of all the selected landmark names in the Details section.
To validate full tube-length of straight bundles for ECT bobbin data using Al detection, select this
option and check the TSI and TSO landmarks. When Al setup for landmarks is completed and the
TWH calibrated, the DQV test will automatically use the Al results to perform the test.

Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows
grouping a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region,
for example, the areas inside the tube.

Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field
allows group a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region.

C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping
a zone together for which the test has failed. This function avoids having many notifications if the
test fails several times in one area. This test can be limited to a specific region.

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab.
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Layout

B BB S ®E = S ERBE S M

Select Manage Reload BackUp Newlayout | Replace Remove  Split Infofield Cal. Infofield Data Report| DQV |[Indications Note A Lafgl‘:
cquisition
¥ oav 3 X
Test Result
Channel Saturation x Berors ©

Failures

Criteria

Hardware Saturation

o
Hardware Saturation @

¥ DQV Indications Note

GROUPING

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the
automatically detected indications.

SMART Setup ‘
— ao
| O | B
(+) “B
Enable | wizard Package Landmarks Indications Landmarl-cs Regions Indications Grouping] Report Help
Logbook Shortcuts

The Grouping menu offers a default configuration with three predefined categories:

e Support Plates
e  Critical

e Less Critical
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B Detected Indications Grouping - O X

Groups Details

MName I:I Mame: |Critical

Support Plates I:l Amplitude Phase

_ I:l Channel: | DIF-F2 - Channel: | DIF-F2 N

Less Critical I:I Measure: | PP “ Measure: | PP M
Min: 1.00V - Min: 10° =
Max: [ [10.00v Max: 120 ° -

Restrict to Regions

In Tube

Air to Air
O Freespan
[] FreespanCal
] T8l

[] 150

[sp

["] Hide unclassified indications

(1] | The default configuration will be applied. ] |ResettoDefauIt| | oK | | Cancel |

The Details section of each group shows the parameters defining the conditions that must be met for a
detected indication to be classified in this group. The user can modify all parameters.

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP)
measurement method, and Max/Min threshold values are set for amplitude and phase. For this group,
the criteria are limited to indications detected under the SP regions. As a result, the indications detected
under support plates for which all conditions are true will fall into this category.

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on
DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping
criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube
length data.

It should be noted that each automatically detected indication can only be categorized in a single group.
Also, the grouping operation is executed according to the order of the groups defined in the Groups list.
Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group.
If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be
categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does
not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single
indication will be categorized, and none can appear simultaneously in more than one group.

New groups can be created with custom parameters.
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Groups Details

Name Mame: |Support Plates
IZI Amplitude Phase
Critical Channel: | ABS-F1 o Channel: | ABS-F1 "
Less Critical I‘E‘ Measure: | PP N Measure: | PP s
Min: 2,00V B Min: 2° =
Max: L1 1000V = Max: 150° -

It is also possible to remove a group or use the up/down arrow keys to change the group priority within
the list.

Groups
Name +
Siepspss I [
Critical
Less Critical @
In the Front stage interface, the Grouping results will be displayed in the Indications pane.
Indications &
10 of 10 results
Label Ampl. Phase
(~) Critical (4)
IND 1415V 32"
IND 340V 83"
IND 278V 106 *
IND TO6V 16°

(%) Less Critical (4)

IND 102V 11°®
IND 1.00V 40°
IND 127V 36"
IND 113V 73"

(*) Undlassified (2)
IND

IND

DOV Indications MNote
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the
Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom
of the Grouping menu and click on OK.

Bl Detected Indications Grouping - O #
Groups Details
Name MName: |Critical
Support Plates Izl Amplitude Phase
_ Channel: | DIF-F2 o Channel: | DIF-F2 v
Less Critical II| Measure: | PP = Measure: | PP v
Min: 1.00V = Min: 0° =
P [ |[10.00v M 120°° -

Restrict to Regions

In Tube

Air to Air
[] Freespan
[] FreespanCal
[Tl

[]Ts0

[]sp

Hide unclassified indications

0 l The default configuration will be applied. I |Resetto Default| |\/ oK | |x Cancel

Enabling this option influences the following elements of the software:

e Indications pane;
e Codeview;
e Logbook column.

The images below compare them when the Unclassified indications are shown (left) and when they are
hidden (right).

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the
header serves as a reminder to the user that not all indications are currently shown.
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Indications

26 of 26 results

Label Ampl. Phase
(&) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 084V 18°
IND 076V 17°
IND 1.20V 19°

(%) Undlassified (20)
IND

IND
IND
IND
IND

Indications

6 of 26 results

Label Armnpl. Phase
(~) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 0.84V 18°
IND 076V 17°
IND 120V 19°

OOV Indications Mote

OOV Indications Mote

In the Code view, the red markers from the Unclassified indications have been removed.
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In the data file list, the number shown in the Logbook column represents the number of visible indications,
matching the number shown in the header of the Indications pane.

Data 4 X Data 4 X
7 of 7 data hA 7 of 7 data
Row Cal 8 [el Row Cal 5 [el
201000001 v 201000001
201004005 201004005
| ~ 201006009 68 | ~ 201006009 ®
~ 201006016 ~ 201006016
v 201024022 v 201024022
v 201025017 v 201025017
v 201025019 v 201025019
El ED
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REPORT SHORTCUT

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is
possible to select a channel with a measurement method and to associate an indication with it.

SMART Setup ‘

Enable O
Logboaok

Wizard Package Landmarks Indications

oo
((‘ AT\ 1 . +O o1 '.D
Wy L | -
Landmarks Regions Indications DQV Grouping| Report Help
Shortcuts

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter

pits in the report.

| | Indication Based On
PIT Channel

- O o
!
Source Ampl. Measurer Phase Measurer Sizing Curve Shortcut
DIF-F2 Vpp PP DIF-F2 “| D b4
by

|V’ OK | |XCanceI |

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a
single key or a combination of keys such as ALT+D, for example.

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication
displays momentarily on the corresponding Lissajous.
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DATA SCREENING

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under

the Analysis tab.

o
‘m
Screening
Selected Files

e

screening
All Files

A
2.

All

| Analysis
\5 ? |* oBs - R
em \)0 e a m ]
Previous  Mext DNTO I” RST  peview Msg  Capture | Subtraction
efect

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files
when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed

in the Data window.
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DATA LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating a list of tubes.

This list can be created in the Data List section of the General tab of the Backstage.

Data List

Maming Format; Row, Col ¥

Preview: 001001.magdata _: _:
[O I:@

Create Mew List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending on the chosen
filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can
then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to
generate the list of tubes. You can also use the Create & New button to add another set of tubes to your
list.
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Il File List Creator e |
| 3
File List Configuration
Mumber of Rows in Component: 1 -
Start Mumbering at Row: 1 .
Row Interval: 1 -
Mumber of Celumns per Row:
Row Mb. of Columns
1 1
Column Interval: 1 .
Include first and last column of each row
Files to Create: 1
Filename Preview: 001001
[+ Create & Mew l |~J" Create | [ 4 Cancel l

The same principles apply to the other file formats, except for the Free format option for which the file
name(s) needs to be entered manually in the Data window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube list file can

be found in the Inspection folder. It is also possible to import a list created in the Tubepro software
(available from Eddyfi).
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button.
Click on the Connect button under the Instrument tab. This will open the Instrument
configuration page. Click on the line showing the instrument to which you want to connect and
then click on Connect.

Home Setup Advanced Instrument Calibration

XRREREe

Setup  Disable Ch. Setup Info /o Alarm  Fine Tune

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case,
ared and white Xicon will be shown in the Status field of the Instrument connection window. To download
a matching version to your Ectane, click on the Config. button and then click the Send firmware to the
instrument button of the Instrument configuration window.

¥ |
Instrument Connection (Ectane) ﬁ
—

Type Model MAC Address Host Status §Config Details
Ectane2 | E128RNMI . EC:92:33.00.0014 Q |o| @

Cancel
b
7 ¥ - - -
Instrument Configuration &J
Metworl Information Embedded Software Update
Made: Automatic - 2 Use the embedded software that comes with Magnifi
|P address:  |192.168.19 .10 Use custom embedded software
Subnet Mask:  |255.255.255.0
Gateway: (0.0 .0 .0
Cancel

Two acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is used to
scan your calibration tube and make the necessary adjustments on your setup without saving the data
automatically. Acquisition mode is used for the inspection. In this mode, the software automatically saves
the acquired data using file names based on the tube list.
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3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the
Home tab. This mode is active when the Setup Mode button is grayed.

o

Setup Mull
Mode

o

&3

4. Plug the RFT probe on the Ectane 19-pin connector.

5. If you wish to balance, bring the probe head in a clear area in your standard and balance the
probe by clicking on the Null button under the Home tab, or press F6 on your keyboard.

6. Push the probe head all the way through the tube so that it exits the tube.

7. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2
on your keyboard.

8. Pull the calibration tube at the appropriate speed

9. When it's done, press the Stop button or F2 again on your keyboard
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Note that a red zone in the code pane means that at least one of the raw signals is saturated. This is usually

the case when your probe is out of the tube.

VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes useful

functions to do so:
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DISPLAYED CHANNEL

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These buttons

are used for the channel selection.

3.
4.

1. 2. 3. 4.
- DIF | F1

4 4 4 o4

Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart
are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this
channel.

PR ER R EEN DR EDE N AT
158.4 kHz 158.4 kHz S

A
.

s

Clicking on the corner with the black triangle gives the list of available channels. Click on the
desired channel to select it. Right-click or Left-click on this button to switch to the following or

previous channel in the list.
|- Jor e
158.4 F1ABS

F1DIF
F2ABS
F2DIF
F3ABS
F3DIF
Land
MIX1

Same principle as 2., but for the type of channel only (absolute or differential)
Same principle as 2., but for the frequencies only

STRIP CHART AXIS ORIENTATION

The Strip charts are a projection of the Lissajous on the vertical or horizontal axis. To switch from one axis

to another, click on the box showing an arrow at the upper right corner of the Strip chart.
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ZOOMING

On the strip chart, hold the right button of your mouse and drag on the zone of interest to zoom in this
section.
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To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.
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ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and
the full line is the center of what you have selected.

Only the portion of data between the dotted lines will be shown in the Lissajous.

To adjust your cursor length, hover your mouse over the dotted line, and click and the left mouse button.
This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same operation, but
with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the
left button (decrease scale) or the right button (increase scale) of your mouse.

| oF | R, 1 756v Jepl | -] ] |1 =m0 i o7ssv
158.4 kHz F1DIF 158,84 khz
r

#

£
£
&

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the
scale button.

MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method.
A short description of the measurement methods can be found in the above calibration section of the
setup wizard.

n

1. 2 3. 4
Vep Ll pe L] 2P

=

1. Clicking on the corner with the black triangle gives the list of measurement method for the
amplitude of the signal. Click on the desired method to select it. Right- or left-click in this button
to select the next or the previous method in the list.

2. Same as 1., but for the phase measurement
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3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure
the phase with the right orientation.

4. Take the same two points in time to take the measurement in the other Lissajous

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw

a vector in your Lissajous.

LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of
your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on
the raw channels since these channels have no gain or rotated applied, by definition. Also, rotating the
signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous background
and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor at a point where you want the data to be
centered and use the spacebar on the keyboard.
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CALIBRATION AND SIZING CURVES

FREQUENCY VALIDATION
The injection frequency (set in the Data definition section) will influence the phase angle separation

between flaws of different depth. It can also affect the signal-to-noise ratio of certain flaws.

If this frequency is too low, the phase angles of your flaws will be close to each other. Therefore, it will be
difficult to build accurate sizing curves because a small variation of the phase will lead to a significant
change of depth estimate.

Multiple methods can be used to validate that the injection frequency was correctly set. Here’s two of
them:

e There is approximately 1° per percentage of wall loss between two grooves of different depth.
The two grooves must not be too close in terms of depth.

o There is approximately 65° between a through wall hole and a 4 x FBH 20% depth

With Magnifi, the automatic calibration process can also recommend you the right injection frequency.
You can go through these steps (described later) before adjusting your frequency.

To adjust the injection frequency:

1. Click on the Data button under the Setup tab.

WMEOOB s & -

Home Setup Advanced SMART Setup Instrument Calibration Analysis Layout Current View
" L} £\ S 5 )] o ™ = I—!T;—]
7. n o ¥ & A A o
MNew Locks Comp Probe Scan Data | Process PC.aI Calibration  5izing  Indication Display
oints

2. Toincrease the phase angle spread between your flaws, increase the injection frequency.
Decrease the injection frequency to lower the phase angle spread. Refer to the figures below for
the frequencies to avoid.

Click on Next and then click on Finish

Rescan your calibration tube

Verify that your injection frequency is right

Redo step 1 to 5 until you have an acceptable frequency

o v e w

CALIBRATION BASED ON SCALE PROCESS

The following section describes how to calibrate the channels that don’t use a voltage plane.

1. Go to the Calibration tab and click on the System icon.
Select Channel in the calibration window.

3. Inthe Strip chart, select the signal to calibrate and adjust the cursors to see only the desired
signal.
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Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you select your calibration point. This will allow you to see what the system is using to make its
calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.

= )l F [1 2oov [1]

2% Calibration 4 S

@ Channel A

Channel and Sizing Curves

HOLE
SUPPORT
TH-750D

E| [ Calibrate |

[ Reset |

Select the signal name in the list.

Click on the green arrow button to associate the measured signal to the calibration point.
If more than one calibration point is present in the list, redo step 3, 4 and 5 for all of them.
When all your calibration points are check marked, click on the Calibrate button.

No vk

CALIBRATION BASED ON VOLTAGE PLANE PROCESS

The following section describes how to calibrate the channels that use a voltage plane. Magnifi offers two
methods to do this operation.

MANUAL METHOD

1. Putyour cursorin a sound area of your calibration tube.
2. Click on the normalize button in the voltage plane window. This should bring the operation point
of the probe to the theoretical nominal point on the Voltage plane.
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Since this operation depends on how the probe was built, it is possible that the operation point of the
probe doesn’t reach the theoretical nominal point. If this is the case, right-click on the voltage, click on

the Reset Nominal button and continue to the next step.
To adjust the signal manually, Magnifi uses a vector drawn by the user that represents the effect
of a completely blocked signal. This vector must start at the operation point of the probe and
must go in the direction of the support plate. Its length must initially be set to twice the length
of the support plate for a dual driver probe. For a single driver probe, it must be set to the
length of the support plate. To draw this vector, click on the manual measurement button" M ",
click on the operation point of the signal, hold the left button of the mouse and drag it to the
desired location. Once the vector is correctly drawn, click on the normalise button again.
Magnifi will put the origin of the vector to the theoretical nominal point. It will apply a gain of
1/(vector amplitude) and a phase rotation of —(vector phase). If, for instance, the drawn vector
as an amplitude of 0.8 and a phase angle of 10 deg, the system will apply a gain of 1.25 (1/0.8)

3.

BRENE ey | [ s ] Al
850 Hz

and a rotation of -10 deg to the system.
I

850 Hz

T:2% !
L:2% 4.30V 940 Ext: 360.00 i 5 52.8%q
[e]e]eo]

1.54V 34 Ext: 42.9° S:20%q
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[elale]
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4. The signal may not be perfectly adjusted after the previous steps. You can adjust the signal again
by drawing a new vector and by clicking on the normalization button until the signal is set
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correctly. In the examples below, the calibration tubes included two 360° grooves and we can
see that both grooves reach the theoretical 360° coverage line. This can be a relevant indication
to determine if a voltage plane is calibrated correctly.

| 488V I anv |
2N
(A~ ]
‘t / "~ Grooves touching B ™~ Grooves touching

/ the 360° line / the 360° line

-
T:?%
L:?% - T:?2%
4.02V 96° Ext: 360.0° S:? %4 Angle correction: 0.0° = = L:?2%
v . ~ ~ e ~OR 3.71V 99° Ext: 360.0° S :? %4q
(el in] __ielele] [ [ele]o] [ J con ]

Dual driver probe Single driver probe

5. Save your calibration by clicking on the Save Nominal button
ele

You can go back to your calibration settings at any time by clicking on the Back to Nominal button.

D1 @10

AUTOMATIC METHOD

Another way to calibrate a voltage plane in Magnifi is to use the automatic calibration tool. This feature
requires the following indications:

e One point of type [360°, non-taper] or
e Two points of types [360°, taper] or [non-360°, non-taper]
e A support plate signal
e A nominal point
Also, one point must be 360° and one must be non-taper.

To define the calibration point that will be used by the algorithm, go to the RFT tab and click on Calibration
Settings.
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. RFT Calibraticn Configuration ﬁ

Calibration channels:

Channels Cut Off (Hz)
R_ABS-F1 16
[C] R_DIF-F1 16

Mominal tube reference;
Support plate: SUPPORT =

Calibration points:

Marne Size 360° Taper
GR-60 B0

[
L ol&

ok || cancel |

b o

Checkmark the raw channel(s) that will be used to calibrate the signal.
Select from the drop-down menus the signal name that corresponds to your nominal point and
to your support plate (If these signals were not created, you can go back to the Calibration
Points window via the Setup tab).

3. Click on Add and select the reference signals that will be use by the algorithm

4. Inorder to make the algorithm work, the user must associate the calibration points to the real
signal. This operation is done at the same time as the sizing curves calibration process. Go to the
Sizing Curves section of this document and follow the steps using the signals entered previously.
This will trigger the automatic calibration.

Tip: For the calibration, when selecting the support plate with a dual-driver probe, it is recommended to
take the straight part of the signal that goes from the nominal point to the first signal transition.
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5. Once the automatic calibration process is done, the system may recommend you a drive
frequency. If this is the case, you can change your frequency, rescan your calibration tube and

repeat the previous steps.

Magnifi® [

Calibration is done. However, the main frequency (F1) produces not enough
phase shift to allow appropriate depth sizing.

E It is recommended to increase F1 frequency to around 1123 Hz.

Select a frequency value that is 20 Hz away from a multiple of the power
outlet,

Adjust others frequencies accordingly.




The automatic calibration will give you access to the Frequency Check option that can recommend you
another inspection frequency in case the inspected tube has properties that are too far from your
calibration tube. This feature is shown in the inspection section of this document.

Note that the automatic calibration tool doesn’t only adjust the signal to match theoretical curves, but it
also dynamically compensates the change of tube properties by recalculating the theoretical curves. This
increases the precision of the sizing.

Itis possible to use the automatic calibration and the manual calibration on the same setup. The automatic
calibration process will create a new channel with which the calibration curves will be readjusted
according to a theoretical model. The newly created channel(s) will have the letter " m " (for model) added
at the end of the channel name (example: ABSm-F1 for absolute channel with frequency 1).

NOMINAL POINT VARIATION TOLERANCE

After scanning a tube, you can select a sound point in the data and click on the normalize button in a
voltage plane. This will bring this point to the nominal theoretical point. The angle correction will then be
shown at the lower left corner of the voltage plane window. It will become red If it's not within an
acceptable range. To set this range, click on the voltage plane window, go in the Current View tab and
enter the value in the Tolerance parameter.

Layout Current View RFT
0 3
wve Reset

ninal Mominal

SI1ZING CURVES

The following section describes how to build your sizing curves.

1. Go the calibration tab and click on the Sizing curve button
Select Channel and Sizing Curves in the calibration window

3. Select the signal in your Strip chart and adjust the cursors to see only the desired portion of the
signal.

Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you select your calibration points. This will allow you to see what the system is using to make its
calibration. If for some reason the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to
show the defect size. To have the correct interpolated value, the measurement method also needs to be
the same as the one used for the sizing curve. To change the measurement method, click on the icons at
the bottom left of the Lissajous.
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4. Select the associated signal name in the list.

5. Click on the green arrow.

6. Redo the previous steps for all the other indications in the list.

7. Click on the Calibrate button.
L Jees]m) peny ][] s [ e)] Toany
0.9 kHz 0.9 kHz

7| Calibration [
) Channel A
@ Channel and Sizing Curves
) Landmark
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Exit
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GR-60
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Reset ‘
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Angle correction: 0.0° L:?%
1.85V 108° Ext: 360.0° 5: 7?7 %d
vep | er |0 M Ql ) COR | COR ,

Error messages after creating the phase sizing curves may appear. The main cause of these errors is the
measurement direction.

The image below shows two different measurements. On the left, you can see that the measurement
arrow is pointing toward the liftoff signal. In this case, the measured phase is rotated of 180° from the
right value. When one or more points were measured in the wrong direction, Magnifi cannot build the
sizing curve and will generate an error message.

In the image on the right, the arrow is pointing from the liftoff signal to the defect signal, which is correct.
However, in this picture, the arrow starts quite far from the middle of the liftoff variation signal, which
will cause an error in the measurement. In this case, we suggest you move the cursors until your
measurement is taken from a point near the base of the signal.
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To adjust your sizing curves and remove the error messages, go the Calibration tab, and click on View
Curves.

-
[B select Calibration Point

i
[Bl select Calibration Point

[ ABS - S(RFT) v] [ ABS - S{RFT) v]
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GR-60 None 60.0
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The sizing curve window will appear. Each sizing curve you asked Magnify to create will be listed in the
drop-down menu. If an invalid notification is present on the curve, it means that you either haven’t
entered the sizing points yet, or that Magnifi failed to create the curve. To adjust the sizing curve manually,
enter the value in the table.

In the above example, the entered phase angle for the 40% groove is 270°, but the correct phase angle is
90°. The defect has an 180° bias due to an incorrect measurement direction. In this case, we can simply
change the angle value from 270° to 90° in the table to fix the sizing curve.

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws in the
Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw size does not
appear, it means that you are not in a channel where a sizing curve was set.
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Built sizing curves can give you access to the phase-depth indications on the Lissajous and the Strip Charts.
To activate this option, click on a window (Strip Chart, or Lissajous), go to the Current View tab and check
the Depth-P. option.
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LANDMARKS

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks
window the same way you calibrate the sizing curve(s) points. You can use the Land channel to do so. The
positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the farside
tubesheet, that is, the first one encountered by the probe during data acquisition; TS1 is the nearside
tubesheet).

Once the landmarks are calibrated properly the system should be able to recognize them automatically.

Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far
end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button
under the Home tab. The displayed window will allow you to give an appropriate name to your setup and
to save it at the desired locations. The save location is, by default, your inspection file. Note that when a
data is saved, the setup is also saved with it.
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r. Save Setup As @ﬁ

Setup

© save setup in current inspection Browse... |

File name: Mew setup

Mame

[V ok ][ cancel |

" ’,

You can also save the data of your calibration standard by clicking on the Save As button under the Home

tab.

INSPECTION

STANDARD ACQUISITION

The following section describes how to perform an inspection.

1.

N
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Connect Magnifi to your instrument.

Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab.
Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the RFT probe into the Ectane 19-pin connector.

If you wish to balance, bring the probe head to a clear area in your standard and balance the
probe by clicking on the Null button under the Home tab, or press F6 on your keyboard.
Push the probe all the way through the tube until it exits the far end and start the acquisition by
clicking on the Acquire button under the Home tab or by pressing the F2 on your keyboard.
Pull the probe towards you at a constant speed until it exits the tube.

When finished, press the Stop button or again F2 on your keyboard.

Repeat steps 4,5,6 and 7 for all the tubes to inspect in your bundle.



MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and
can trigger the acquisition start/stop and the data recording automatically. At least two landmarks are
needed to use this feature. These landmarks can be created by using the Landmarks button under the
SMART Setup tab.

To set the manual sequence:

1. Click on the Manual Sequence button under the Calibration tab.
If a warning message is shown in this window, change the parameters until no warnings are
shown. The system will progress through the different windows to guide you.

3. Click on Settings ...

s ! g B
[ Sequence Iﬁ Q Manual Sequence Configuration [ﬁ

Sequence

/\ Type: ) Mone @ Landmark
Start Recording Landmark: | Exit -
Launch J |

-

Start Recording Delay: 10s -

Stop Acquisition Landmark:  T51

Target Settings... Stop Acquisition Delay: 20s -
Restart
Type: () None ) UserInput @ Timer
MDD Review Delay: 100s -

. Pushing
. Pulling,/Recording
. Waiting for Mext

OK l [ Cancel

You must be
connected to an

0 instrument to start
the sequence.

Connect... |

4. Select Landmark in the Type section.

5. Inthe drop-down menu choose the Landmark that will initiate the data recording. If you keep
the default landmarks, you can select the Exit landmark that will be triggered when the probe
goes out of the tube when the probe is pushed.

6. You can enter a delay to start the acquisition after the first landmark is detected (Start
Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop
Acquisition Delay).
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7.

8.

Two options are available to restart the acquisition: The user can either push a button or use a
timer. Select the desired option in the Restart section.
Click on OK.

To use the manual sequence:

1.

Connect Magnifi to the instrument

Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. The

Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the ECT probe into the Ectane 4-pin connector.

Bring the probe head to a clear area in your standard and balance the probe by clicking on the

Null button under the Home tab, or press F6 on your keyboard.

Open the Sequence window by clicking on the Manual Sequence button under the Calibration

tab.

Put your probe in the tube to inspect and click on the Launch button. This will start the data

acquisition.

Push the probe until it exits the far end of the tube. If set correctly, Magnifi will recognize the

landmark and this will initiate the data recording.

Pull the probe towards you until it exits the tube. This will trigger the last landmark detection

that will stop the data recording.

Acquisition restart:

a. Ifyou selected User Input in the settings of the Manual Sequence Configuration, the system
will wait for the user to enter information on the tube to restart the acquisition. Click on
NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition.
Repeat steps 6, 7 and 8a. for all the tubes to inspect

b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown
will trigger after the last tube acquisition was taken. The acquisition will start after this time
has elapsed. Redo step 6 and 7 for all the other tubes to inspect in the bundle.

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is

the case, you won’t be able to catch the landmark that triggers the data acquisition at the end of the tube.
In this situation, you can click on the Target button in the Sequence window to start the data recording.

DATA LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the
Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be
found under the General tab of the Preference menu of the Backstage.
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General (Setup Related)

Measurement Units

Report Units: | Millimeter

Preferences

Channels

Full Channel Scale: 2000V p-p o

Hide Raw Channel

Precision
[] Enable

Amplitude

Phase

Acquisition
Automatic File Recording

Auto Create new file on Next

Automatic Next on Stop acquisition

Analysis

The list of tubes is also shown in the Data window.

Data L
22 of 22 data h

Row Col

101000001
101000002
101000003
101001007
101001002 )]
101002001 qiy
101002010 r
101004005 (5Y

E] D

A common practice is to rescan your calibration tube and balance the tube periodically. You can save this
new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can go out
of the acquisition mode, scan your tube, and click on the Save Cal As... button under the Calibration tab
to save your data. You can then go back to acquisition mode to continue your inspection and to

] <K

automatically save the acquired tubes in your bundle.

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark
icon.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home
tab.

A TUBE NAME CAN BE CHANGED BY RIGHT-CLICKING ON ITS NAME AND BY SELECTING THE RENAME OPTION.

FAST NORMALIZATION SETTINGS

The opened data may not have been already adjusted to match your sizing curves. Magnifi offers a tool
to do these adjustments in an efficient way.
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Go the RFT tab and click on the Settings button. The displayed window will show the channels using
voltage planes and standard scale process.

. RFT Normalization Settings &
Channels based on voltage plane process
Channels Shortcut
ABS-F1 A
ABS-F2 A
Channels based on scale process
Channels Amplitude (V) Angle (%)  Shortcut
DIF-F1 2.00 20 D
DIF-F2 200 20 D

[ Measure Reference I

| ok || Cancel |

(% 4

The channels using a standard scale process will only be shown if the option to link the differential
channels to the absolute was not selected in the Calibration part of the setup wizard.

-

%"+ Edit Setup Wizard

6 Calibration

/ \ Configure parameters to calibrate channel amplitude and phase

Individually configure all the channels

Uze Voltage Plane representation for absolute (4B5) channels

[ Link differential (DIF) channels rotation and gain to the absolute (ABS) channels normalization
Keyboard shortcuts next to the channels can be customized to normalize the associated channel. To
normalize the process using a voltage plane, select a sound area in the tube and push on the keyboard
shortcut. To normalize the channels using a standard scale process, select the reference (normally a

support plate) and click on the keyboard shortcut. The system will adjust the selected reference to the
value set in the RFT Normalization Settings window (Amplitude and Angle).
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LOADING A FILE

1.

First disconnect your computer from the Ectane by clicking on the Disconnect button under the
Home tab.

You can load a file by double-clicking on the file name in the Data window. It can also be done by
selecting the file in the list and by clicking on the Load button under the Home tab. Note that
double-clicking on a tube when you are still connected to an instrument will initiate data
acquisition.

You can open the next or the previous file in the list by clicking on the Previous or Next button of
the Home tab.

The data files can be filtered by using the Filter button of the Data window.
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to
the report. These two buttons indicate the code that is associated with the defect being entered. Both
buttons are identical, but can be set to identify different flaws.

To add an indication to the data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous
includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect
to enter.

3. Click on the defect button to add an entry to the report.

1,] .| oF .| F, T o14sv 4] DIF | F1,[ |1 2783° |1 148V
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CRK
, DNT
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; 0BS
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PLG
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&
0.4 119° 46.!
Vmp mp | CY 2P M COR
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Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is
explained in the SMART Setup section of this manual.

Indications can also be added to a tube to indicate, for instance, that it has no flaw or that it is plugged.
To add an indication to a tube:

1. Load thefile
2. Click on the appropriate indication button available under the Analysis tab

(M] OE i ¥ =
o Home Setup Advanced SMART Setup Instrument Calibration Analysis Layout Current View
E.ii' B o it o : o [» oBs mmn
I i
| | ¢ .3 s > e &)
Screening Screening All Previous  Mext Mo Review Msg  Capture | Subtraction
All Files Selected Files Defect | RST

REPORT TABLE

To access the list of detect entered:

1. Make sure that the Report option is selected under the Layout tab.

Layout Current View

. Infofield Data Report DOV Indications = Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report

Zone |Row  |Col” |Code Size Side Ampl. (V) Angle()  ChanneliCscan  Ypos (mm)  LMKY pos Offset Y pos. (mr Yleng (mm)  Commen t
1 0 0 0.00 0.00 0 0o 0.0 00 X

2 0 0 0.00 0.00 0 0.0 0.0 0.0 x

A\ 2new notifications Infurmanurl Report I

Entries in the report can be modified by changing the value in the table. You can also delete an entry by

clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.
Click on the Generate Report button under the Report section of the General tab.

3. Choose your preferences and enter the required parameters. The # of tubes in component is
used to show the percentage of tube in each category.
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. Generate Report e B Generate Report ¥

Section Selection
REPQrt Parameters Sections to Include in Report

Tube project parameters

Defect Table Format: | Tubing ECT *

‘ # of tubes in component: |30 - ‘ Report Summary
[[] Show Empty Cells

Instrument Settings
Component Information

Picture: II‘

Inspection Summary
Date and Signature
Screen Captures

# of tubes in component: |81 -

|x EEHCEI | | ' ﬂa{t | |XCanceI | | ’ Mext |
4. Click Finish to generate the report.

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed
using any regular web browser.

There is a “copy” button next to each element of the report such as tables and images. When clicking on
it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or
Word.

Eddyfi . {
W Analysis Report @ St ogies

Instrument Settings

Channels Instrument Settings

Channel Calibrations
Setup name: ECT-Bobbin
Mix Channels

‘Component

Information Channels

Inspection Summary

Indication Table Name Frequency (KHz) Drive (V) Gain (dB) Low Pass (KHz) High Pass (Cnt)

b RABS-FI 1600 250 460 400

Data
R_ABS-F2 80,0 2,50 46,0 400
R_ABS-F3 40,0 2,50 46,0 400
R_ABS-F4 20,0 2,50 46,0 400
R_DIF-F1 160,0 2,50 46,0 400
R_DIF-F2 80,0 2,50 46,0 400

R_DIF-F3 40,0 250 48,0 400

The Print button, bottom right corner on image above, can be used to either print a paper copy of the
whole report or to save it as a .pdf document. The PDF generator available with the current web browser

will be used.
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The report logo can be modified by clicking on the Select Company Logo that can be found under the
System tab of the Backstage.

System (Computer Related)

Measurement Convention Measurement Units
EIEIS e @ AsME @ Metric

7) ASME Inverted e o O Imperial

_ EDF o

Readback
D Do not display data during loading
Speed:
_! Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
_! Retain check state

General

@ Reset to checked after loading a data file

Display Setup Wizard Path: C\Users\daube  QTEC\Documents'MagnifitSetup

Automatic Features
D Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo
Preview:

o
‘a.. °
Select

Company Logo

The report table file in the Inspection folder can also be imported into other reporting software such as
Tubepro.
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The two following equations describe the through-wall transmission behavior of RFT:

B=B, e =B, V7o ¢ =d. o, u,

B = Magnetic field strength at a depth ¢ = Phaselag
corresponding to phase lag (@) Ho= U= Permeability
, = Initial magnetic field strength d = Thickness
¢ = Phaselag /= Frequency
c = Conductivity

The phase lag equation shows that the signal is influenced by the tube properties (d, EERy) but

also depends on the frequency (f) at which the tube is inspected. Given a tube of constant permeability
and conductivity, and using a fixed inspection frequency, the phase lag will be proportional to the
thickness of the tube.

The magnetic field strength (B) will depend on this phase lag. For an infinite theoretical thickness, the
resulting magnetic field will be null. The explanation being that the field is completely blocked and that
nothing is caught by the receiver(s).

The voltage plane is a graphical representation of these formulas. The curves built on a voltage plane show
the effect of the thickness variation on the signal. There are four curves that represent a flaw coverage of

90°, 180°, 270° and 360°. The point crossing the horizontal axis is the nominal point. This is the signal
obtained when the probe is in a sound area of the tube. It has an amplitude of 1V and a phase of 0°.
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When you first scan your calibration tube, this point doesn’t match the nominal point of your theoretical
curve. You must calibrate the signal to match your probe signal to the theoretical curve(s). This operation
is called normalization.

A bundle of tube may include tubes that have different properties. The permeability, for example, may be
different for some tubes. This will affect the nominal point position and the built sizing curves won’t be
applicable to this tube.

If the nominal point moved not too far from the theoretical nominal point, the common practice is to
renormalize and to size the flaw with the built sizing curves.

If the nominal point moved far from the theoretical value, it means that the tube properties are
significantly different from the calibration tube. Therefore, the phase lag for a given flaw will also be
significantly different and this will generate an error in the sizing that must be considered. In this case, it
is recommended to change the drive frequency to put the nominal point back to the renormalization zone.
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A common practice is to set the threshold angle at which the inspection frequency needs to be changed
to 30°.
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RFA Application Guide
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INTRODUCTION

This document presents how to use an RFA probe with Magnifi 5.1 on an Ectane 3 instrument.

EQUIPMENT

The RFA probes use a 41-pin connector that can be connected to an Ectane 3 with the “E64RNM”’ or the
“E128RNM “ option.

Magnifi acquisition and analysis software version 5.1 or greater must be used. A license allowing for tubing
array techniques is required.

Possible probe diameters are offered from 11.0 mm to 23.0 mm in 0.5 mm increments. It is recommended
to use the largest diameter possible. This will decrease the lift-off and improve performance. You can refer
to the table below for the recommended diameters depending on the size of the tube to be inspected.

The center frequency of the probe is 300 Hz and it should be used with frequencies ranging from 50 Hz to
2 kHz.

From the following table, the best probe for your application can be selected.

Probe Diameters

4 5 6 7 8 9 10 n 12 13 14 15 16 17 18
mm 6.05 5.59 5.16 4.57 4.19 3.76 3.40 3.05 277 2.4 21 1.83 1.65 1.47 1.24
in 0.238 0.220 0.206 0.180 0.165 0.148 0.135 0120 0109 0.095 0.083 0.072 0.065 0.058 0.049
15.87 0.625 = - = - = - = - = 1o 110 115 120
19.05 0.750 = - = - = - 110 15 120 125 130 135 140 140 145
22.22 0.875 = 115 120 130 135 140 145 155 160 165 165 170 if5
25.40 1.000 115 125 135 145 150 160 165 170 175 180 185 190 195 200 200
31.75 1.250 iz 180 190 200 205 215 220 225 230

The RFA calibration tube used in this document includes the following machined defects and features:
e External grooves, 20%, 40% and 60% of wall loss
e Flat bottom hole, 60% of wall loss
e Hole, 100% of wall loss

e Asupport plate
RFA PROBE DESCRIPTION & CHANNELS

The RFA probe includes 2 drivers at each end of the probe head. The driver on the cable side is named the
Lead since it is the first to pass under the defects and features when the probe is pulled through the tube.
The second driver is called the Trail.
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The probe includes 2 circumferential bobbin coils that create absolute and differential channels, referred
to as “conventional bobbin channels”, similar to what is obtained with an RFT probe. The absolute and
differential signals from the bobbin coils will produce Strip charts, Lissajous and Voltage planes.

Next to these 2 coils is the array portion of the probe. It consists of 2 rows of sensors. The number of
sensors per row depends on the diameter of the probe. The second row on the cable side is used to create
the absolute array channels. The differential array channels are obtained by subtracting the signals of row
1 from row 2. As with conventional channels, the absolute array is used to analyze large volumetric defects,
such as taper defects for example, and the differential array is used to analyze smaller defects such as pits.
The channels of the array component of the probe are combined to produce C-Scan imaging.

Trail Driver Bobbin Array Lead Driver
(absolute & (absolute &
differential) differential)

——

Note that neither the conventional coils nor the array part is perfectly centered between the 2 drivers.
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In this section, we will create a folder structure that will manage the saving location of your setup, data,
and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of files. The first file level is the Project. It is meant to include different
inspections that are related in some way. For instance, it can include all the inspections done at a refinery
shutdown and be named Refinery_Shutdown_May 2022. The second file level is the Inspection folder.
Inspection folders are saved in the project file. An inspection folder can include the data specific to the
inspection of a tube bundle with a specific technology and could be named CS_075x0.083_RFA, for
instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

—f——— |

INSPECTION 2 INSPECTION X

| |
| |
| |
|
I SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE l
<« DATA |

| LIST
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
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When you open Magnifi, the first page displayed is called the Backstage.

Acg. Summary

Report Summary

Documentation

Preferences

General
Project / Inspection

Project Folder:

Inspection Folder:

Setup / Data
Setup Loaded:  From original data file

Setup Location:

Data Loaded: ECT-Bobbin
Data List
Maming Format: | Row, Col

Preview: 001001.magdata

Report
Name: Report.mdb
Table Profile: Tubing ECT

[ Take screenshot with report entry

Decuments\Magnifi\Projects\Default\DemoDatas

Magnifi® 5.3B1T376 - [Setup from original data file] - ECT-Bobbin.magdata

Documents\Magnifi\Projects\Defa

i

Project Folder

[ ]

Inspection Sub-
folder

Information
Probe: Unable to detect

Application:  Generic

Tube Dimensions:

oD: 2540 mm

Jocuments\Magnifi\Projects\Defa
Create Setup

b

Open Setup

WE 165mm
1 Length: 500 mm
— ']
Open Data Material:  Stainless Steel 316

Frequencies: 160.0, 20.0, 40.0, 20.0 kHz

Create New List

=@
Import List

Report

(%
Export Defect
Table

License

Start / Resume

To create or open a project, click on Open/Add Project in the Backstage. You can select an existing
project/folder, or you can create a new folder.

5. Create a folder by right-clicking on the location where you want to add your project file. Select
New, Folder and enter the chosen name. You can then select the newly created folder and click
on Select Folder.

[ Select 3 project i)
g’ L » v 4 p
Organize New folder 2 @
\
|
- = §
g
]
L Projects Folder
4 Shorteut
87 Microsoft Access Database
& Bitmap image
[ Contact
8! Microsoft Word Document
= View b B]] Microsoft Access Database
= Sert by * @) Microsoft Project Document
Group by * @) Microsoft PowerPoint Presentation
_ Refresh @5 Microsoft Publisher Document
[ SonicWALL Global VPN Client Document
B
- ¥ Rich Text Format
= Undo Delete Ctrtez o Doxsment
e @) Dessin Microsoft Visio
hare with ’
= = Sharew @ Microsoft Excel Worksheet
New » B Briefcase
Properties ]’
Folder: Magnifi
| select Folder Cancel
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6. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of
your inspection.

[ . Manage ﬁ1

I Inspections

0o Manage Inspections Select Other...
Mame State
Default Ready for Inspection

Bundle_A_55316_0.75X0.065_ECT |_E

|‘, Select Hx Close ]

7. Click Select. This will define the location where the setup(s) and data will be saved.

RFA SETUP WIZARD

In this section, we will show how to create a setup using the RFA Setup Wizard in Magnifi.

Before going further, you can select the appropriate measurement unit. To do so, click on Preferences. In
the System tab, you can change the measurement units from metric to imperial and vice versa. For the
metric units, you can choose to use meters, centimeters, or milimeters in the General tab. For imperial
units, inches must be used. When finished, click on Preferences again to go back to the General window
of the Backstage menu.
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Preferences

General

Analysis

System (Computer Related)

Measurement Convention Measurement Units

(@) ASME (@ Metric
O AsMEnverted <= + ) Imperial
*) EDF

Readback
Do not display data during loading
Speed:
Actual Inspection Speed

& Maximum
“Keep Current Setup" Button Behavior:

() Retain check state

® Reset to checked after loading a data file

Setup Wizard Path: |C\Users\

Automatic Features
[ Allow to save setup in original location

Reminder to save setup after acquisition if not saved yet

Logo

Preview:

- Eddyfi

Company Logo

Technologies

To create a new setup, use the RFA Setup Wizard process. Go to the Frontstage by clicking on the blue

triangle at the top left corner of the Backstage. Then, click on the New button under the Setup tab and

select the RFA Setup option in the drop-down menu.
OEk 4 ¥ =

o Home Setup Advanc

PROBE SELECTION

o 5
Ve H ()]

Mew I}' Locks Comp
v Setup

*

*o%  MFL Surface Setup

*

“#*  Spyne Setup

"

Vs RFA Setup

=L T

E-] |

The first page shown by the RFA Setup Wizard is the Probe Selection page.

In this window, the probe used for the inspection can be selected, the interaction between the bobbin

and array channels can be set, and the display and settings for the absolute channel can be changed.
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" Mew RFA Setup Wizard *

’ll Probe Selection -

Select the probe to use.
L
Calibration of C-scans in cal. tube: Automatic * | Gains/rotations from cal. of bobbin channels
Representation for absclute channels (ABS): | Voltage Plane <
Probe Setups:

PRET-RFA-DDSA-(110 to 1200MF
PRET-RFA-DDSA-(125 to 135)MF
PRET-RFA-DDSA-(140 to 150)MF
PRET-RFA-DDSA-(155 to 160)MF
PRET-RFA-DDSA-(165 to 173)MF
PRET-RFA-DDSA-(180 to 190)MF
PRET-RFA-DDSA-(195 to 200)MF
PRET-RFA-DDSA-(205 to 215)MF
PRET-RFA-DDSA-(220 to 230)MF

CALIBRATION OF C-SCAN IN CAL. TUBE

In the software, the channels generated from the bobbin coils and the C-scans produced by the array are
coupled, making the use of the RFA probe very similar to the RFT probe. Adjustments made to the
conventional channels, such as the normalization of a support plate signal, are automatically propagated
to the C-scans, allowing for easier analysis with a limited number of operations in the software.

The Calibration of C-scans option offers 2 possibilities:

Calibration of C-scans in cal, tube: Automatic VI}
Representation for absclute channels (ABS): Automatic
Manual

Prahe Setiine

e Automatic: With this option, the probe is used the same way as an RFT probe would be used. The
initial calibration of the conventional channels made in the calibration tube is automatically
applied to the C-scans. Calibration of the C-scans independently from the channels is not possible.

e Manual: With this option, the C-scans must be calibrated independently from the conventional
bobbin channels for the initial calibration in the calibration tube. It must be understood that once
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the initial calibration has been performed, any subsequent change to the rotation or gain made
to the conventional bobbin channels to adjust the nominal point, for instance, will be
automatically applied to the C-scans as well. This is true for both options.

These options will be explained in more detail in the calibration section of this document.

REPRESENTATION FOR ABSOLUTE CHANNELS (ABS)

The Representation for absolute channels (ABS) drop-down menu allows for the selection of either a
standard Lissajous plot or a Voltage plane for the bobbin absolute channels. Note that this option does
not affect the representation for the Absolute C-scans, which always use a Lissajous representation. The
Voltage plane tool is explained in the appendix.

Representation for absclute channels (ABS): | Voltage Plane =

—

Lissajous

Probe Setups:
PRET-RFA-DDSA-(110 to 120)MF

Voltage Plane

PROBE SETUPS

In the Probe Setups section of the window, select the probe model used for inspection. The numbers
inside the parentheses correspond to the range of probe’s diameter covered with a specific setup. Refer
to this information to find the appropriate model. For example, if an 18.0 mm mid-frequency probe is
used, the PRBT-RFA-DDSA-(180 to 190)MF setup should be selected.

COMPONENT DEFINITION

The second page shown by the Setup Wizard is the Component Definition page.
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+" Mew RFA Setup Wizard X

n Component Definition _

0 Configure the geometry and material of the component to inspect

Material: Admiralty brass -

Wall Thickness (WT): 211 mm

'

Qutside Diameter (0D): | 2540 mm

'

Tube Length: 9000 mm -

|x Cancel | |" Back | | P Mext |

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected.

If the inspected material is not on the list, go to Backstage and open the Material Database tab. To add a
new material to the list, click on Add. A new line will appear in the list. Give the material a relevant name
and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is used to
set IRIS parameters only, and doesn’t need to be set if an IRIS inspection is not performed on this material.
It is possible to add optional notes about the material to specify information such as its application or
composition.
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Magnifi® 51817240 - [Setup from original data file] - Calibration_tube.magdata - = X ‘

Material Database

Custom Materials

C\Users'
Materials B Copy
b
k Name Llzsound Neodly Resistivity (u0-cm) Relative Permeability m
(m/s)

Acg. Summary Incoloy 825 - ET ONLY 0.000 113 1 m

General

Nickel 200 5630.000 95 200
LS PER SIT Stainless Steel 5660.000 72 1
3 Stainless Steel 304 5660.000 72 1
Stainless Steel 316 5660.000 74 1
Stainless Steel 321 - ET... 0.000 715 1

Stainless Steel 439 - ET... 0.000 63 100

Stainless Steel Duplex -.. 0.000 74 75

Material Database Stainless Steel 904L - E... 0.000 94 75
Titanium 6070.000 486 1
Ti-6AI-4V - ET ONLY 0.000 123 1
Documentation Zirconium 650,000 41 1

New material 0.000 0 0 —‘

Preferences Notes About Selected Material

()

License

o

Also in the Component Definition page, adjust the tube wall thickness, outside diameter and length by
entering the values in the designated fields. All the information filled in on this page will be used by the
software when generating the analysis report.

The tube length defined here is also used as a default suggestion when enabling the automatic detection
of landmarks.

Click Next when everything is set correctly.

SCAN DEFINITION

The Scan Definition window is used to configure the data acquisition rate of the instrument, the typical
probe pulling speed, and the acquisition size.
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| #*

e Scan Definition I

Configure your scan parameters

Acquisition Rate: 500 Hz =
Typical Probe Speed: 250.0 mm/s =
Density: 2,000 smpl/mm =
Acquisition Size (Time): 30s =

v

Acquisition Size (Distance): |7500.0 mm

| Cancel H‘ Back H’ Next ‘

The acquisition rate corresponds to the number of acquisition points, or samples, taken per second. By
default, the acquisition rate is set to 500 Hz for RFA, but depending on the drive frequency used to inspect,
the actual acquisition rate may need to be changed.

The recommended probe pulling speed for RFA depends on the excitation frequency, as defined in the
Data Definition page of the Wizard, and is shown in the table below:

Excitation Frequency (Hz) Maximum pulling speed
Minimum Maximum Imperial (in/s) Metric (mm/s)
20 100 4 100
100 200 6 150
200 350 8 200
350 500 10 250
500 1000 12 300
1000 - 20 500
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The density, or axial resolution, is the number of samples per unit of distance. This field is non-editable as
it is a direct result of the acquisition rate and pulling speed combined. Use this information to confirm
that both parameters are defined adequately.

A resolution of 2 points per millimeter is typically targeted. Given that the probe speed value is based on
the excitation frequency, the acquisition rate can be edited to obtain the desired axial resolution.

For instance, if the pulling speed was set to 300 mm/s, then the acquisition rate should be set to 600 Hz
to reach a resolution of 2 points per millimeter.

Note that if a probe pusher-puller mechanism is not used, the pulling speed will not be constant. Therefore,
it is recommended to target a lower pulling speed to be able to reach the axial resolution target.

These parameters also serve another purpose. When analyzing a data file where landmarks are not
enabled or defined yet, the axial position of the cursor in a strip chart is defined assuming a constant
pulling speed. Therefore, if the cursor is located at exactly 4.0 seconds, and a probe speed of 300 mm/s
was used, then Magnifi will indicate a position of 1200 mm. This information can be used to axially locate
features and defects in the tube.

Report

i Ti(s) AT (s)
4.256 1.806

@X (smpl) @Y (smpl) |©X (") AX (")
8 2128 205.68 12855

The last parameter that can be edited on this page is the Scan Size or scan duration, in units of time. The
non-editable field below shows the same parameter in units of distance instead. The scan duration should
be set to allow for acquisition of slightly longer than the tube length. This additional buffer time will ensure
that the full tube length is captured even if there are some pulling speed variations and to provide enough
time to insert the probe in the tube and completely pull it out in the air. For instance, if 30 seconds is
needed to exactly capture the full 9 m length of tube, then a 40 second acquisition time could be set.

It is important to note that the acquisition size should not be set more than what is needed, as this could
result in software memory issues.

Click Next when finished.

DATA DEFINITION

The Data Definition window is used to set the hardware gain, excitation frequencies and drive voltages
(or amplitude). It is important to set these parameters correctly before acquiring the data, since they are
driven by the instrument and cannot be modified during the analysis.
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% New RFA Setup Wizard *

% Data Definition ]

Configure the necessary frequencies

Gain: 54 dB -

Enabled drivers: | Both -
Prefix  Frequency (kHz) Armplitude (V) Phaze (%)
F1 0.425 5.00 0.0
F2 0.325 5.00 0.0

|x Cancel | |‘ Back | | P Next

The hardware gain is applied to both the bobbin and the array portions of the probe.

Two frequencies are always enabled with RFA setups. The table in this window can be used to edit the
frequencies and drive voltages values. The sum of their amplitudes cannot exceed 10 V.

Selecting an appropriate frequency can be aided with the following equation:

_405-p

B pr - t2 7
where f is given in kHz, p is the tube’s resistivity in ufl - cm, y, is the relative permeability, and t is the
thickness in millimeters. It is important to make sure the frequency selected is within the probe limits
found in the table above. Another point of consideration when selecting the operating frequency is the
frequency of the power transmission lines and outlets in your global region of inspection. It is
recommended to avoid the harmonics of the outlet frequency to prevent noise issues. The figures below
show the frequency ranges for 60 Hz and 50 Hz.

271



BW =8 Hz BW =10 Hz BW =15 Hz BW =20 Hz BW = 25 Hz

SPD=0.1m/s || SPD =0.15m/s SPD =0.22 m/s SPD =0.3m/s SPD =0.35m/s
3 50 75 85 135 165 195 225 255 200 310 355§ 500
e T e T e A e S
0 60 120 180 240 300 360 420 480 540 600
Frequency (Hz)
- Frequency range to avoid - Frequency range allowed
Recommended frequencies for power outlet at 60 Hz
BW =8 Hz BW =10 Hz BW =15 Hz BW =20 Hz BW =25 Hz
SPD=0.1m/s || SPD =0.15m/s SPD =0.22 m/s SPD =0.3m/s SPD =0.35m/s
30 40 60 85 115135 165 205 215 240 260 295 305 500
B e T e B e B e B e S
0 50 100 150 200 250 300 350 400 450 500 550 600
Frequency (Hz)
- Frequency range to avoid - Frequency range allowed

Recommended frequencies for power outlet at 50 Hz

By default, the RFA probe operates as a dual-driver probe. However, it is possible to turn one driver off to
use it as a single-driver probe. To do so, select the Lead or the Trail option in the Enabled Drivers drop-
down menu. The Lead corresponds to the driver that is close to the cable; this is the first driver to reach
a feature when the probe is pulled. The Trail is the driver closest to the tip of the probe.

If you choose to use the probe in single-driver mode, the Setup Wizard will automatically divide the drive
voltage values in half for both frequencies, and the amplitudes will no longer be editable. A warning will
also appear, indicating that these values were adjusted to generate approximately the same driver output.
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N NN | 1 (LI R I | L N Y B | 4] 4 L Al L4 4

| Data Definition |

Configure the necessary frequencies

=1

Gain: 54 dB -

Enabled drivers: | Lead -
Prefix Frequency (kHz) Amplitude (V) Phase ()
F1 0425 250 0.0
F2 0325 250 0.0

ﬂ [ The amplitude (V) has been automatically adjusted to generate approximately the same individual driver output. I

|x Cancel H" Back H" Next |

T - . - T B B e T A B

This is done such that the driver signal has approximately the same amplitude, regardless of whether dual-
driver or single-driver mode is used. An example is given below, where the amplitudes of the driver signals
have roughly the same amplitude (shown with the red dotted line) for both mode settings. Additionally,
it can be noted that the amplitude of the receiver signal, when the defect passes right under the receiving
coil, has decreased by half as expected.

[T Teln]  Feov Tel ] Tmoln] T cov I
— :
\ I :

) ' Both ' Lead
/ | drivers . driver
‘:\ ' enabled \ ' enabled

~ | S~

~
1 /\D
: 1 — |
N I ,// I
“_‘_’—l—ﬁl_‘_i\ 1
/f-f-fﬂl’ - Ix“j}l>
i |
/
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Should you need to change the drive voltage in single-driver mode, select the option Both, edit the voltage
value and then select the option Lead or Trail again.

Click on Next when the desired parameters are entered.

DATA PROCESSING

The Data Processing section is where post-processing software filters can be activated on the channels of
the RFA probe.

The hardware parameters that were defined in the Data Definition page of the Wizard cannot be modified
once the acquisition is completed. Therefore, it is crucial to validate those values before performing data
acquisition. In the case of the Data Processing page, the available parameters allow you to enable and edit
post-processing filters. Therefore, it is always possible to edit these parameters to fine tune the analysis
after the data acquisition if needed.

The first page of the Data Processing section presents the list of available C-scans and their filters.

5+ Edit RFA Setup Wizard b 4

ﬁ Data Processing

Y Configure the processes to apply to the C-scans.

C-5cans
Low Pass Median High Pass Periodic Moise
MName Cutoff (Hz) Window Size (smpl) Window Size (smpl) Moise Threshold (V)
F1ABSA 20 40 1 3 0.030
F1ABSA-LargeSignal 20 [] 4m [1 35 0.030
F1DIFA 20 40 1 3 0.030
F2ABSA 20 40m [1 35 0.030
F2ZABSA-LargeSignal 20 [ 401 1 3 0.030
F2DIFA 20 40m [1 35 0.030

1Y Before enabling the Periodic Moise filter, learn how to configure it adeguately with the RFA probe user guide available in the
Documentation section of Magnifi.

The following table describes each of the C-scans:
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Name Description

Frequency 1, Absolute Array, Large Signal. Dedicated C-scan that should be
F1ABSA-LargeSignal configured (filters values and color palette range) to optimize the analysis of
large indications such as taper defects

F1ABSA Frequency 1, Absolute Array, Trail row of sensors (farthest from the cable)

F1DIFA Frequency 1, Differential Array

Frequency 2, Absolute Array, Large Signal. Dedicated C-scan that should be
F2ABSA-LargeSignal configured (filters values and color palette range) to optimize the analysis of
large indications such as taper defects

F2ABSA Frequency 1, Absolute Array, Trail row of sensors (farthest from the cable)

F2DIFA Frequency 2, Differential Array

Three types of filters are available. The low-pass filter eliminates part of the signal that is above a certain
frequency. As an example, it is useful when a defect signal has a lower frequency content than the
background noise. In this case, using a filter will remove part of the noise without removing the defect’s
signal. This may help with data analysis. However, a cut-off frequency that is too high won’t remove much
noise, and a cut-off frequency that is too low will filter out the defect signals.

The median high-pass filter is used to filter out low frequency noise or drift such as lift-off variations of
the probe within the tube, or changes in material, geometry, or thickness. As a rule-of-thumb, the window
size of the high-pass median filter should be set to at least three times the axial length of the longest flaw
that may be encountered. This rule-of-thumb is specific to what you are looking for with the channel you
are using. If, for example, you plan to use the differential channel to detect holes, you can adjust this
setting to about three times the length of the largest hole you are looking for with this channel. The
window size should be adjusted with care. If it is set too small, it could filter out defects of interest. Note
that the size of the filter is set in samples and not in mm. For example, if you have set your parameters to
have 2 samples/mm and you want to enter a length of 300mm, then you should use a value of 600 samples.

Pilger noise! is yet another type of noise that can be observed on tubing data that can negatively alter the
amplitude and phase of the signal. The Periodic filter can be enabled to reduce the effects of this
phenomenon. Similar to the other filters, there is always a trade-off between the noise reduction level
and the side-effects of the filter on the indication signals themselves when adjusting the parameters of
the filter. It is not recommended to apply this filter by default, but it can be used on tube data that contains
a strong pilgering signal.

' Pilger noise is caused by the cold pilgering process in which the diameter and wall-thickness of a tube
are reduced to form seamless metal tubing. Pilger noise is typically seen as spiral-shaped variations on
a C-scan. Because of the helical shape of pilger noise in the tube, the noise is somewhat periodical, but
not constant.
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More details about the adequate configuration of this filter can be found in Appendix 2.

The second page of the Data Processing section presents the list of available bobbin channels and their
filters.

%~ New RFA Setup Wizard *

L
2% Data Processing ]

' Configure the processes to apply to the channels.

Channels
Low Pass Median High Pass
MName Cutoff (Hz) Window Size (smpl)
F1ABS 20 1 4
FIDIF 20 L] 4ot
F2ARS 20 1 4
F2DIF 20 L] 4ot

|x Cancel | |‘ Back | [ Next

The following table describes each of the channels:

Name Description

F1ABS Frequency 1, Absolute Bobbin
F1DIF Frequency 1, Differential Bobbin
F2ABS Frequency 2, Absolute Bobbin
F2DIF Frequency 2, Differential Bobbin

Low-Pass and Median High-Pass filters are available for these channels. The comments made for the C-
scan filters above can also be applied with the channel filter.
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Data should be examined in its filtered and unfiltered states. It is important to keep in mind that the filters
can distort the phase and change the amplitude of the signals.

Click Next when finished.

INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when analyzing
the data.

*

»+ New RFA Setup Wizard >
~— _ Indication Codes - ]
L

Configure the indication codes used for the report

Code Description Type Automatic Color

COR Corrosion Defect m
CRK Crack Defect m
DNT Dent Defect m
Dsl Distorted Support Indicati  Defect m
ERO Erosion Defect m
NDD No Defect Detected No indication m
0OBS Obstructed Feature |" Red m
PIT Pitting Defect m
PLG Plugged Feature |" Brown m
RST Restricted Feature | Yellow m
WLL Wall Loss Long Defect m
WS Wall Loss Short Defect %]
WLT Wall Loss Taper Defect m

| & import | |4 Add |

|x Cancel ||‘ Back ||\/ Finish |

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.

You can modify the default indication code list by changing the parameter in the table. New indications
can be defined by clicking on the Add button.

Click Finish to complete the RFA setup wizard process.
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SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after completing the Setup Wizard process. To
modify a parameter previously entered, go to the Setup tab in the Frontstage and click on the button
associated with the parameter you want to change.

b Home Setup ‘ Advanced SMART Setup Instrument Calibration Analysis
SEOR-3 B
New - Yy

Probe Component  Scan Data C-scans Channels Indication

This will open one of the windows previously described, where you can change the values you originally
entered. If applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.

It is important to note that the parameters defined in the Probe Selection window cannot be changed
after the initial generation of the setup. If you wish to change the probe model, the Calibration of C-
scans option, or the representation for the Absolute channels, you must create a completely new setup.

Advanced setup modifications are also possible in the Advanced Setup section on page 315.

DATA LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating the list of tubes.

This list can be created in the Data List section of the General tab of the Backstage.

Data List

Naming Format: Row, Col h

Preview: 001001.magdata — =
E =

Create Mew List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
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Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:

Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending on the chosen

filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can
then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to
generate the list of tubes. You can also use the Create & New button to add another set of tubes to your

list.

. File List Creator

2]

Mumber of Columns per Row:

Row

1

Column Interval;

I
File List Cenfiguration
Mumber of Rows in Component: 1 -
Start Mumbering at Row: 1 .
Row Interval: 1 -

Mb. of Columns
1

1 -

v

Include first and last column of each row

Files to Create: 1
Filename Preview: 001001
[+ Create & Mew | [ v Create ] [ 4 Cancel

L.

The same principles apply to the other file formats, except for the Free format option for which the file

name(s) needs to be entered manually in the Data window of the Frontstage.
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The tube list can also be imported from another project using the Import List button. The tube list file can
be found in the Inspection folder. It is also possible to import a list created in the Tubepro software
(available from Eddyfi).

PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on the Start/Resume button.
2. Click on the Connect button under the Instrument tab. This will open the Instrument Connection
window. Click on the line showing the instrument to which you want to connect and then click

Connect.

o Home Setup Advanced SMART Setup Instrument
R - K
& A (x) i -4 A

Connect Setup  Disable Ch.  Setup Info IO Alarm  Fine Tune

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case,
a red and white X icon will be shown in the Status field of the Instrument connection window. To send a
matching version to your Ectane, click on the Config. button and then click the Send firmware to the
instrument button of the Instrument configuration window.

L -
Instrument Connection (Ectane) ﬁ
—

Type Model MAC Address Host

Ectene2 | E128RNMI - EC:32:33:00:00:14
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r -
Instrument Configuration ﬁ

Metwork Information Embedded Software Update
Mode: ThETE - Use the embedded software that comes with Magnifi
|P address:  |192.168.19 .10 Use custom embedded software
Subnet Mask: | 255.255.255.0

Gateway: (0.0 0 0

&

Cancel

b

Two (2) acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is
used to scan your calibration tube and make the necessary adjustments on your setup without saving the
data automatically. Acquisition Mode is used for the inspection. In this mode, the software automatically
saves the acquired data using file names based on the tube list.

Follow the steps below to perform the acquisition of the calibration standard:

1. Enable Setup Mode by toggling on the Setup Mode button under the Home tab. This mode is
active when the button is grayed.

O]
8 ©

Setup Mull
Mode

2. Plug the RFA probe into the Ectane 41-pin connector.

3. Bring the probe head in a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

4. Push the probe head all the way through the tube so that it exits the tube.

5. Start the acquisition by clicking on the Acquire button under the Home tab, or by pressing F2 on
your keyboard.

6. Pull the probe at the recommended speed.

7. When the probe exits the tube, press the Stop button, or again F2 on your keyboard.

The image below shows a typical RFA scan of a calibration tube. No calibration has been performed yet.
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Note that a red zone in the code pane means that the raw signal from at least one of the channels is
saturated. This is usually the case when your probe is not inside the tube.

VISUALIZING THE DATA

LAYOUT
By default, the setup generated with the RFA Wizard offers a layout that includes the following elements:

e 2 strip charts and Lissajous/Voltage plane corresponding to the bobbin (ABS, DIF) coils, similar to
the conventional RFT setups generated with the Generic Wizard
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e 2 C-scans and 2 Lissajous corresponding to the array coils
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2 %4
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The tools found in the Layout ribbon can also be used to adjust the display settings to suit your preferences.
Use the Replace, Remove or Split button to adjust the current display setting.

o Home Setup Adwvanced SMART Setup Instrument Calibration Analysis Current View

Layout

) GR ERER BB | & I = =) BBED@E i

Select Manage Reload BackUp New Layout Replace Remove  Split Infofield Cal. Infofield Indications  Note

Acq ulsmun

DISPLAYED CHANNEL

There are four buttons at the upper left corner of the Strip charts and Lissajous windows. These buttons
are used to adjust the display settings for a channel in the specified window.

1. 2. 3. 4,
- DIF ,| F1

a4 4 4 4

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart
are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this
channel.
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2. Clicking on the corner with the black triangle gives the list of available channels. Click on the
desired channel to select it. Right-click or Left-click on this button to switch to the following or
previous channel in the list.

| -J| | DIF Jl F1 J|

158.4 F1ABS

FIDIF
F2ABS
F2DIF
F3ABS
F3DIF
Land
MIX1

3. Same principle as 2., but for the type of channel only (absolute or differential).

4. Same principle as 2., but for the frequencies only.
STRIP CHARTS AXIS ORIENTATION

The Strip charts are projections of the Lissajous on the vertical and horizontal axis. To switch from one
axis to another, click on the box showing an arrow at the upper right corner of the Strip chart.

NI 1 400V |

158.4 kHz (

ZOOMING

BOBBIN CHANNELS

On the strip chart, hold the right button of your mouse and drag on the zone of interest to zoom in this
section.
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ARRAY CHANNELS

On the C-scan, hold the right button of your mouse and drag on the zone of interest to zoom in on that
section. You can drag your mouse either horizontally or vertically on the C-scan.

To zoom out, right-click on the C-scan and select Zoom to Previous, Zoom to Content or Full Extent.

ol ] or |

450 Hz

Zoom to Content
Zoom to True Proportions
Zoom to Full Extent

Adjust Cursor Size

Edit Processes

Edit Color Palette...

Show Detected Indications

Show Scroll Bars

Swap Orientation

ADJUSTING THE CURSOR LENGTH

On the Strip chart, the cursor is composed of 3 lines. The dotted lines represent the limit of your cursor,
and the solid line is the center of the selection.

Only the section bound by the dotted lines will be shown in the Lissajous.

Adjusting the cursor length is easily done using the mouse. Clicking and dragging on a dotted line with the
left mouse button will adjust the 2 dotted lines symmetrically. To adjust only one dotted line, do the same
operation with the right mouse button.
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ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the
left button (decrease scale) or the right button (increase scale) of your mouse.

N R IREXN B IFPREEIE BREY
158.4 kHz F1DIF 158,4 kHz
i/

&

£
£
&

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the
scale button.

MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method.

1. 2 3.4
Vep | e, 2P

[y}

=

1. Clicking on the corner with the black triangle gives a list of measurement methods for the
amplitude of the signal. Click on the desired method to select it. Right- or Left-click on this button
to select the next or the previous method in the list.

2. Same as 1., but for the phase measurement.

3. Rotate the measured phase by 180°. This option can be used if the software doesn’t measure the
phase with the correct orientation.

4. Take the same two points in time to take the measurement in the other Lissajous.
5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw
a vector on your Lissajous.

LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of
your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on
the raw channels since these channels have no gain or rotation applied, by definition. Rotating the signal
will affect your calibration, so if you perform this operation, make sure to recalibrate afterwards.
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The origin point can also be moved by holding the left button of your mouse on the Lissajous background
and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor at a point where you want the data to be
centered and press on the space bar on the keyboard.

C-SCAN DISPLAY ADJUSTMENT

Manual adjustments can be made to the C-scans to improve their display for the detection of defects.

One way of changing the display of a C-scan is by changing the color palette type and/or adjusting the
scale of the color palette. To do so, double-click on the color palette ribbon at the top of the C-scan.

4 B Palette Selector > ‘
4 C-scan:  F1ABSA v
Palette Sym From To
Traffic Light Absolute ] |-wo0v S 100V -
Traffic Light Absolute

Traffic Light Differential
Blue&Red Threshold

Blue&Yellow Threshold

MoonLight

Sunrise

e

White Rainbow
Saw Tooth Rainbow ]
Shifted Dark Rainbow
Absolute Saw Tooth Rainbow
Dark Rainbow

(18

Stress Corrosion Cracking

ApplyToan || ok || cancel

o

Another way of adjusting the display of the C-scan is to manually rotate the signal in the associated
Lissajous. Below shows a C-scan with a pit signal circled in red. As shown by the arrow in the upper right
corner of the C-scan pane, the C-scan shows the vertical components of the Lissajous.

On the Lissajous (below, left), the noise signal sits at approximately 60°. Manually rotating the Lissajous
can be done by clicking and dragging the left-mouse button on the field highlighted in red. To minimize

the noise signal, the Lissajous can be rotated such that the noise is horizontal.
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After rotation (below, right), the pit signal becomes more prominent on the C-scan and the noise in the
nominal sections of the tube (green) has been reduced.

2 resa | F 1 oo Jiwoov
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Caution: If you use sizing curves with the array part of the probe, it is necessary to readjust the manual
rotation to zero so that the sizing curves give the expected values.

SETUP ADJUSTMENT

FREQUENCY VALIDATION

The injection frequency (set in the Data definition section) will influence the phase angle separation
between flaws of different depths. It can also affect the signal-to-noise ratio of certain flaws.

If this frequency is too low, the phase angles of your flaws will be close to each other. Therefore, it will be
difficult to build accurate sizing curves because a small variation of the phase will lead to a significant
change of depth estimate.

Multiple methods can be used to validate that the injection frequency was correctly set. Here’s two of
them:

e There is approximately 1° of phase change per 1% of wall loss between two grooves of different
depths. The two grooves must not be too close in terms of depth.
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e There is approximately 65° of phase separation between a through-wall hole and a 4 x FBH 20%
depth.

To adjust the injection frequency:

8. Click on the Data button under the Setup tab.

O Home Setup ‘ Advanced SMART Setup Instrument Calibration Analysis
Y 9 —
New - Y VY 6

Probe Component Scan Data C-scans Channels Indication

9. To increase the phase angle spread between your flaws, increase the injection frequency.
Decrease the injection frequency to lower the phase angle spread.

10. Click on Next and then click on Finish.

11. Rescan your calibration tube.

12. Verify that your injection frequency is correct.

13. Redo steps 1 to 5 until you have an acceptable frequency.

NOMINAL PONT VARIATION TOLERANCE

When renormalizing the support plane signal in the Voltage plane, the angle correction applied relative
to the nominal point is displayed in the bottom left corner of the view. Magnifi offers the possibility to
display this correction value in red if it exceeds an acceptable value.

[] Jaes Jr) . B 19V, (] Joes 7] BEEDD
850 Hz j1;-_[;,[; ! j T - -

.0 200 850 Hz 180.0

) T: 36.6% " T:70.3%

lAngIe correction: 14.4¢ I L:27.7% |Ang|e correction: 39.3° I L: 49.4%
. . . S5:47.6%4 i Xt . S :100.0%4q
Celwlzlv] [elelo] [l Celwlolv] [e]efo] [ ] o,

A common practice is to set the threshold angle correction value at +/- 30°. To change this default value,
click on the Voltage Plane window to highlight its borders and change the Tolerance field under the
Current View tab.
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Current View

RFT

{:} Tolerance:

Outside this value, the inspection frequency should be adjusted. This is described in more detail in
Appendix 1 of this document.

CALIBRATION

Calibration is used to set the amplitude(s) and phase(s) of a channel using the selected measurement

method. Given the options selected in the Probe Selection step of the Setup Wizard, the calibration of the

bobbin channels can be performed with either the Lissajous or Voltage Plane, and the array channels can

be independently calibrated if the Manual link type was chosen. All methods of calibration are shown

below.

LissAlous
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On either the conventional absolute (ABS_F1 or ABS_F2) or differential (DIF_F1 or DIF_F2)
bobbin channel, position your cursor on the defect or feature corresponding to the calibration
reference. In the picture below, the through-hole is selected. Make sure that the measurement
vector includes the ends of the signal.
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Absolute Lissajous before calibration

2. Click the System button under the Calibration tab.
3. Select the Channel radio button.
4. Select the item that corresponds to your calibration reference from the list.
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5. Then press the green arrow. This action tells the system that the previous measurement

matches the selected reference.
6. Click Calibrate. This will apply the gain and rotation necessary to bring the reference signal to

the desired value.

If you have calibrated the hole to 1V, 90°, the signal after calibration should look like the images below:

| 5 | | ‘I 200V | 1 | 1‘| ‘| |I 00° |I 200V ‘l 2| ] oF et sy JeR[L] ] s Rl 1 04V
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|
.......................................... :
/
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{
/
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| f
i 2% !
------------------------------------------- | ? % ! T:2%
1.00v 90° i ? %d ! L:i?%
! 0,14V 102° Ext: 21,3° | 512 0%hq
Vme e | M | | COR | [we o] = ]w][@]@]e]] cor.] cor )]
| 2‘| | |I oo |I 200V | F2DIF i 450 Hz
F14BS i 600 Hz
|
i
i
i
i
i
i 7%
i ? %
o
1.00v 90 i ? 0 ml -
| Vmp | ‘mp | M | | COR | BHEEYE D [ cor ] cor]
Absolute Lissajous after calibration. Differential Lissajous after calibration.

VOLTAGE PLANE

J Probe Selection -
.* Select the probe to use.

Calibration of C-zcans in cal. tube: Manual

¥ | Must be cal. independently from bobbin channels

Representation for absolute channels (ABS):)| Voltage Plane -

14. To adjust the signal, the user must manually draw a vector on the voltage plane from the nominal
point of the calibration tube signal to the point of full attenuation (the effect of a completely
blocked signal). Its length must initially be set to twice the length of the support plate, in the case
of a Dual-Driver probe. To draw this vector, click on the manual measurement button "M", click
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on the operation point of the signal, hold the left button of the mouse and drag it to the desired
location. Once the vector is correctly drawn, click on the normalize button (blue compass). Magnifi
will put the origin of the vector to the theoretical nominal point. It will apply a gain of 1/(vector
amplitude) and a phase rotation of —(vector phase). If, for instance, the drawn vector has an
amplitude of 0.8 and a phase angle of 10°, the system will apply a gain of 1.25 (1/0.8) and a
rotation of -10° to the system.
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Operation point —

8.19V 287° Ext: 360.0° /! S:? %4 3.87V 95° Ext: 360.0°
Vep | || M D @0 cor ,| cor, vep | e |2 M

15. The signal may not be perfectly adjusted after the previous steps. You can adjust the signal again
by drawing a new vector and by clicking on the normalization button until the signal is set correctly.
In the examples below, the calibration tubes included two 360° grooves and we can see that both
grooves reach the theoretical 360° coverage line. This can be a relevant indication to determine
if a voltage plane is calibrated correctly.
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16. Save your calibration by clicking on the green Save Nominal button.

ARRAY CHANNEL — AUTOMATIC LINK TYPE

w

_}- ew RFA Setup

Select the probe to use.

J I Probe Selection -
v

Calibration of C-scans in cal. tube: Automatic “ | Gains/rotations from cal. of bobbin channels

With the Automatic link type option selected during setup, the settings made on the bobbin channels will
be copied to the array channels; meaning the gain and rotation applied to the bobbin channels (absolute
and differential) will be also copied to the array channels. Therefore, no action needs to be taken to
calibrate the array channels. The example below shows how the array channels get calibrated side-by-
side with the conventional bobbin channels.
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Above, calibration has not been applied to either channel. Below, the calibration was applied to the
conventional bobbin channels which has been automatically pushed to the C-scan channels.
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ARRAY CHANNEL — MIANUAL LINK TYPE
= New RFA Setup Wizard *
”’\./ Probe Selection ]
s Select the probe to use.
Calibration of C-scans in cal. tube: Manual “ | Must be cal. independently from bobbin channels
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With the Manual link type option selected during setup, you must manually calibrate the array channels
according to the following steps.

1.
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On an array channel, position your cursor on the defect or feature corresponding to your
reference for your calibration. In the image below, the through-hole is selected on the array.

Make sure that the angle of the measurement vectors is oriented correctly on the array channels.
The vector should include the signal ends on the differential. On the absolute, it should start from
the nominal point and go to the signal end.
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Press the System button under the Calibration tab.

Select the C-Scan radio button.

Select the item that corresponds to your calibration reference from the list.

Then click the green arrow. This action tells the system that the previous measurement matches

the selected reference.



74 Calibration X

) Channel @
() Channel and Sizing Curves
(@) C-scan

() C-scan and Sizing Curves

+w Hole

| Caﬂbrate |
|

| Reset |

7. Click Calibrate. This will apply the gain and rotation necessary to bring the measured reference
signal to the desired value
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If you have calibrated the hole to 1V and 90°, the signal after calibration should look like the image below:
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CALIBRATION RESET

A calibration reset will reset changes made to the software gain and rotation, while preserving the sizing

curves that have been previously created. To perform a soft reset, follow the steps below:

1. Under the Calibration ribbon, select the System menu. For both the Channel and C-scan radio
buttons, click the “Reset” button to remove the stored information.

299



7% Calibration X ‘ 24 Calibration X
4 Channel @ () Channel ®
| Channel and Sizing Curves (Z) Channel and Sizing Curves
C-scan (@) C-scan
C-scan and Sizing Curves () C-scan and Sizing Curves
Hole Hole
i
s Calibrate | | Calibrate |
n Reset | | n_Reset |
- bz 5 g

2. If you have chosen the Voltage Plane representation for your setup, select the voltage plane in
Magnifi. Under the Current View ribbon, click on the “Reset Nominal” button. Note that you must
perform this step individually for both frequencies. To do so, change the displayed frequency from
the Voltage Plane view and then click on the Reset Nominal button again.

| | |
7 03[0
Back To Save Re

Maominal MNominal | Mominal

Maormalize

3. The final step to completely remove calibration information from the current setup is to reset
the manual rotation applied to the C-scan Lissajous. To do so, click on the rotation button, hold
the left button and drag the mouse up or down until the display value is 0. Do this for all array

channels.
4] DIFA J Ij 2520° I 687V 41 . DIFA J Ij 00° I 687V |
s N
3.22v 328° 2 %aq 3.22v 76° \ 2 %q
I Vpp I P I,'[zplml R R I Vpp I ‘op I;-Izplm | R R

After performing the steps above, the calibration reset has been completed.
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S1ZING CURVES CALIBRATION

The sizing curves allow the size of a defect to be estimated based on the calibration point signals
(amplitude or phase) obtained with your calibration standard. Magnifi will give you the interpolated flaw
size based on the sizing curves generated.

The default RFA setups come with predefined curves for bobbin and array channels.
To calibrate your sizing curves:

1. Go to Calibration tab and click on the System icon.

-
Home Setup Advanced SMART Setup Instrument | Calibration Anal

O[] .4 Lolo 68 ¢ B

Nu Load System| Encoder SiZING  VIEW  jandmarks  Slew Manual
File Curves Curves Sequence

2. Inthe Calibration window,

a. If the sizing curve to calibrate corresponds to bobbin channels (ABS, DIF): Select Channel
and Sizing Curves

b. If the sizing curve to calibrate corresponds to array channels (C-scan): Select C-scan and
Sizing Curves

() Channel @

(@ Channel and Sizing Curves
() C-scan

(") C-scan and Sizing Curves

FBH-40
FBH-60
Hole
ODGR-20
ODGR-40
ODGR-60

| Calibrate ‘

| Reset ‘

3. Place your cursor on the part of the signal that corresponds to an item in the list (on the strip
chart or the C-scan).
Note: The system calibrates the signal with a measurement method that is defined in the Sizing Curves
Configuration page (under the Advanced tab). Therefore, it is recommended to read the data with the
same method as the system when you select your calibration points. This will allow you to see what the
system is using to make its calibration.
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Defintion  Curve &

Mame DIF-F2 0
LInits Percentage (%)

Report as remaining wall

Measure from
Channel C-scan X C-scan¥ F20IF
Calibrated using measurement | Peak to Peak %

Select the associated signal name in the list.

Click on the green arrow.
Redo the previous steps for all the other indications in the list.
Click on the Calibrate button.

Now ok

When one or more points were not measured correctly, Magnifi generates an error message to indicate
the user that the sizing curve(s) could not be built. Here are some typical examples of problems that could
arise during sizing curve calibration.

In the left image below, the blue measurement arrow is pointing downward towards the nominal point,
instead of pointing up. In this case, the measured phase is rotated by 180° from the correct value. To
correct the situation, the swap orientation button (green circling arrows) can be clicked before making
the measurement during the calibration process.

In the image on the right, the arrow is pointing up towards the end of the defect signal, which is correct.
However, the arrow starts quite far from the nominal point, which will cause an error in the measurement.
In this case, we suggest adjusting the cursors until the measurement is taken from a point near the base
of the defect signal.
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To readjust your sizing curves (e.g., if error messages were obtained during calibration), go the Calibration

tab, and click on View Curves.

-o Home

Setup Advanced

SMART Setup

O A

Instrument | Calibration Anal

M\@ M\e 98 ﬂ' E?

Manual
Sequence

Null Load System Encoder 2iZing | View
File Curves || Curves

Landmarks Slew

The sizing curve window will appear. Each sizing curve will be listed in the drop-down menu. If an invalid
notification is present on the curve, it means that either the sizing points have not been entered yet or
that Magnifi failed to create the curve. To adjust the sizing curve manually, enter the values in the table.
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36 5T T 98 118 139
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Mame Side Size (%) Value (%)

| ODGR-60 0D 00 77 kg
ODGR-40 0D 00 98 i

[/ Hole Through 100.0 l
] FBH-60 OD 60.0 '
[] ODGR-20 QD 20.0

To validate that a curve works properly, bring the measurement cursor over a flaw’s signal from your
calibration tube and verify the value shown in the lower right corner of the Lissajous. It is recommended
to use the same measurement method as the one that was used to build the sizing curve. To change the
measurement method, click on the icons at the bottom left of the Lissajous.
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If the default size does not appear, it means that you are not displaying a channel where a sizing curve

has been defined.

Built sizing curves can give you access to the phase-depth sizing overlays on the Lissajous and the Voltage
planes. To activate this option, click on a window, go to the Current View tab and check the Depth-V.

checkbox.

LANDMARK CALIBRATION

This section describes how to calibrate your landmarks.
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Go to the calibration tab and click on the Landmarks button.

Instrument Calibration |
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Landmarks Slew Manual
Sequence



2. Calibrate the landmarks shown in the Landmarks window the same way the sizing curve(s)
points were calibrated. You can use the Land channel to do so.

| Landmarks W | \«"DD‘l ‘mp ‘l M |Q| o | || COR :l
Exit Land 600 Hz
Tsl
T50
: 7
=
=
,-/
Calibrate |

5.83V 3387

| Vpp

4

°pp‘| |2P| M| | COR

The positions of TSI and TSO are described in the Landmark window in the Setup tab (TSl is on the far-
side tube sheet, that is, the first one encountered by the probe while pulling it during data acquisition;
TSO is on the near-side tube sheet).

Once the landmarks are calibrated properly, the system should be able to recognize them automatically
and the name of the landmark will appear in the Code view with a blue triangle.

Note: In order to calibrate the default Exit landmark, data that includes the probe exit at the far end of the
tube is needed.

FAST NORMALIZATION SETTINGS

Material properties, such as relative permeability, can change from one tube to another in the same tube
bundle. This will cause a shift of the nominal point on the voltage planes and a rotation of the channels
using a Lissajous. Consequently, the sizing curves calibrated with the reference tube will no longer be valid
for these tubes. More information on this phenomenon can be found in Appendix 1 of this document.
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If the angular movement of the signals is not too great (typically less than 30°), a common practice is to
renormalize the absolute channels displayed on the Voltage plane (if this representation was chosen) and
recalibrate the support plate signal to the reference obtained with the calibration tube for the differential
channel.

As these operations are often performed several times during an inspection, Magnifi offers quick keys to
facilitate the analysis.

To configure them, go the RFT tab and click on the Settings Shortcuts button. The displayed window will
show the channels using voltage planes and standard scale process.

. RFT Normalization Settings %

Channels based on voltage plane process

Channels Shortcut
ABS-F1 A
ABS-F2 A

Channels based on scale process

Channels Amplitude (V)  Angle (%) Shortcut
DIF-F1 2.00 20 (i)
DIF-F2 2.00 20 ]

[ Measure Reference |

[ 0K |[ Cancel |

(% 4

The keyboard shortcut next to the channels can be customized to normalize the associated channel. To
set the reference values for channels using a Lissajous, select the reference indication signal with the
cursors in your calibration tube data, then click on the Measure Reference button. The reference used in
this case is normally the support plate.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button
under the Home tab. The displayed window will allow you to give an appropriate name to your setup and
to save it to the desired location. The save location is, by default, your inspection sub-folder. Note that
when data are saved, the setup is also saved with it.
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You can also save the data of your calibration standard by clicking on the Save As button under the Home
tab.

PERFORMING AN INSPECTION

Once you have used the Setup Wizard to create a setup, calibrated the data from your calibration standard,
and created your sizing curves, you are now ready to perform an inspection.

Perform a preliminary scan of the tube bundle using the frequency estimated from the equation on page
271. Be sure to renormalize the signal again to ensure the selected frequency is appropriate by checking
if the angle correction is within the set tolerance.

Renormalization and recalibration during the data-taking process is simplified with the shortcut keys you
defined earlier. To renormalize the channels using the voltage plane process, select a sound area in the
inspected tube and enter the keyboard shortcut you selected earlier for the fast normalization settings.

To recalibrate the channels using the standard scale process, select the reference (normally a support
plate) and enter the keyboard shortcut. The system will adjust the selected reference to the value set in
the RFT Normalization Settings window (Amplitude and Angle). Note that these operations should be
performed using the conventional channels, not the array channels. The gains and rotations made on the
conventional channels will also be applied to the array channels.

Whenever any hardware settings are changed, be sure to re-null the probe in the calibration tube before
performing another acquisition.

DATA LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the
Data List section of this document. To do so, checkmark the Automatic File Recording option that can be
found under the General tab of the Preference menu of the Backstage.

General (Setup Related)

Measurement Units
Report Units: | Millimeter

Channels
Full Channel Scale: 2000V p-p o
Hide Raw Channel

Precision
[] Enable

Amplitude: |2 decim...

General -
Phase 0 decim...

[ H Acquisition
Automatic File Recording

Display Auto Create new file on Next

Automatic Next on Stop acquisition

Analysis

The list of tubes is also shown in the Data window.
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Data
22 of 22 data

o
-

Row Cal

101000001
101000002
101000003
101001001
101001002
10100200

101002010
101004005

A common practice is to rescan your calibration tube and balance the probe periodically. You can save
this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can
exit out of acquisition mode, scan your tube, and click on the Save Cal As... button under the Calibration
tab to save your data. You can then go back to Acquisition Mode to continue your inspection and to
automatically save the acquired tubes in your bundle.

® @)=

e N N
o G 5 e

K < <<k

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark
icon.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home
tab.

A tube name can be changed by right-clicking on its name and by selecting the Rename option.

LOADING A FILE

17. First disconnect your computer from the Ectane by clicking on the Disconnect button under the
Home tab (optional step).

18. You can load a file by double-clicking on the file name in the Data window. It can also be done
by selecting the file in the list and by clicking on the Load button under the Home tab. Note that
double-clicking on a tube when you are still connected to an instrument will initiate data
acquisition.

19. You can open the next or the previous file in the list by clicking on the Previous or Next button of
the Home tab.

The data files can be filtered by using the Filter button of the Data window.
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REPORT

INDICATIONS

The two Indication buttons in the lower-right corner of the Lissajous view can be used to add an entry to
the report. These two buttons indicate the code that is associated with the defect being entered. Both
buttons are identical, but can be set to identify different flaws.

To add an indication to the data:

20. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous

includes only the defect signal.
21. Then, click on the red triangle in the corner of the Indication button to select the type of defect

to enter.
22. Click on the defect button to add an entry to the report.
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Report entries can also be added using keyboard shortcuts. The SMART Setup section of this manual

explains how to configure them.

Another type of report entry, called “feature”, can also be added to a tube to indicate, for instance, that
it has no flaw or that it is plugged. A feature is an indication that is general to the tube, it is not localized
like defects, and therefore has no measurement or size associated with it. To add a feature to a tube:

23. Load the file

24. Click on the appropriate indication button available under the Analysis tab

(M| OE i ¥ =
o Home Setup Advanced SMART Setup Instrument Calibration Analysis Layout Current View
[+ - P 3 s [» oBs mmn
g B L7 i0 10
| | ¢ .3 < > e S |
Screening Screening All Previous  Mext Mo Review Msg  Capture | Subtraction
All Files Selected Files Defect | RST
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REPORT TABLE

To access the list of indications entered:

25. Make sure that the Report option is selected under the Layout tab.

Layout Current View

. Infofield Data Report Indications  Mote

26. Click on the report tab at the bottom of the screen to make the list visible

Report X
Zone Row Col.” Code Size Side Ampl. (V) Angle (%) ChannelC-scan ¥ pos. (mm) LMK Y pos OffsetY pos. (mr Yleng (mm)  Comment

1 0 0 0.00 0.00 0 00 0.0 00 x

2 0 0 0.00 0.00 0 0.0 0.0 0.0 b 4

A\ 2 new notifications Informatior] Report

Entries in the report can be modified by changing the value in the table. You can also delete an entry be
clicking on the X next to it.

REPORT GENERATION

Magnifi can automatically generate a full report with the report table.
To generate this report:

27. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.

28. Click on the Generate Report button under the Report section of the General tab.

29. Choose your preferences and enter the required parameters. The # of tubes in component is
used to show the percentage of tube in each category.
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. Generate Report e B Generate Report ¥

Section Selection
REPQrt Parameters Sections to Include in Report

Tube project parameters

Defect Table Format: | Tubing ECT *

‘ # of tubes in component: |30 - ‘ Report Summary
[[] Show Empty Cells

Instrument Settings
Component Information

Picture: II‘

Inspection Summary
Date and Signature
Screen Captures

# of tubes in component: |81 -

| ¢ cancel | | P Next | [3€ Cancel | [P _Next |
30. Click Finish to generate the report.

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed
using any regular web browser.

There is a “copy” button next to each element of the report such as tables and images. When clicking on
it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or
Word.

Eddyfi . {
W Analysis Report @ St ogies

Instrument Settings

Channels Instrument Settings

Channel Calibrations
Setup name: ECT-Bobbin
Mix Channels

‘Component

Information Channels

Inspection Summary

Indication Table Name Frequency (KHz) Drive (V) Gain (dB) Low Pass (KHz) High Pass (Cnt)

b RABS-FI 1600 250 460 400

Data
R_ABS-F2 80,0 2,50 46,0 400
R_ABS-F3 40,0 2,50 46,0 400
R_ABS-F4 20,0 2,50 46,0 400
R_DIF-F1 160,0 2,50 46,0 400
R_DIF-F2 80,0 2,50 46,0 400

R_DIF-F3 40,0 250 48,0 400

The Print button, bottom right corner on image above, can be used to either print a paper copy of the

whole report or to save it as a .pdf document. The PDF generator available with the current web browser
will be used.
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The report logo can be modified by clicking on the Select Company Logo that can be found under the
System tab of the Backstage.

System (Computer Related)

Measurement Convention Measurement Units
EIEIS e @ AsME @ Metric

7) ASME Inverted e o O Imperial

_ EDF o

Readback
D Do not display data during loading
Speed:
_! Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
_! Retain check state

General

@ Reset to checked after loading a data file

Display Setup Wizard Path: C\Users\daube  QTEC\Documents'MagnifitSetup

Automatic Features
D Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo
Preview:

o
‘a.. °
Select

Company Logo

The report table file in the Inspection folder can also be imported into other reporting software such as
Tubepro.
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ADVANCED SETTINGS AND OPERATIONS

ADVANCED SETUP MODIFICATIONS

The RFA Setup Wizard offers possibilities to generate your setup, but some options are not directly
accessible with the Wizard. To access these modifications, it is necessary to use advanced menus.

MODIFICATION OF THE DEFAULT SCALE PARAMETERS FOR CALIBRATION

By default, if the absolute channels are represented with a Lissajous when generating setups with the RFA
Wizard, and the calibration of the absolute channels is performed on the Support Plate indication signal
by bringing it to 0.5V and 0°. For the differential channels, the calibration puts the signal of the Through-
Wall Hole indication at 1V and 90°.

These settings are the same for both the bobbin and array channels.

If needed, these calibration parameters (reference point, amplitude or phase value and measurement
method) can all be customized using the Advanced Channels and C-scans menus.

Reminder: If the conventional absolute channels are represented with the Voltage Plane, the calibration
uses the Voltage Plane process. Therefore, it can’t be customized.

Bobbin Channels:

1. To modify the calibration parameters for the bobbin channels: Click on Process Ch. under the
Advanced menu.

b Home Setup Advanced SMART Setup Instrument . Calibi
[N I — ~\_
S EBEBNE o6

Scan Process Ch.§ C-scans Sizing Cal. Points Indication | Probe DB

2. Inthe Data Processing page, select the page (ABS (Scale) or DIF) that you want to modify.
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b Data Processing X

(a2 (80 [ | [ (| 8 ot e

Median HP F1

ABS Bobbin F1

Low pass FL Copy to

channel F1

ABS Bobbin F2 Low pass F2 Medizn HP F2 Scale F2 Copy to
channel F2

4 ABS (Scale) B DIF

oK Cancel Apply

3. Double-click on the Scale icon for the channel that requires modification.

4. For both the Amplitude and Phase, you can change the targeted value, the reference point and
the measurement method. Note that different reference points can be used to calibrate the phase
and the amplitude independently.

B Scale F1 X
—_ PN I Enable
Jﬂ
Amplitude
Measurament |Average Peal. w |
Phase
Measuremnent |Avelage Peak ~ |
Orientation D deg Fief.

[] Single gain/phase
[] Assisted aray calibration

Cancel Details >
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Array Channels:

If the calibration mode for C-scans is set to Manual, the C-scans must be calibrated independently from
the bobbin channels in the calibration tube. In that case, you might also want to modify the calibration
parameters for the array channels:

1. Click on C-scans under the Advanced menu.
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2. Inthe C-scan Configuration page, select the C-scan that requires modifications.
W C-scan Cenfiguration
C-gcan F1DIFA Process
F1ABSA Mew... State Frocessing Type Detailz Add...
F1ABSA LargeSignal Subtraction F1DIF&LeadBuid
FIDIE e FIDIFA-Trail Build s
O FIDIFALesd-Buid Rename. . Edit..
O FIDIFATrakBuid Filter Aial
F2aB5A Duplicate Low-pass Up
F24B5A-LargeSignal 20.0Hz B
F2DIFL iRl Median filter Al e
O F20IFA-Lead-Buid High-pass
Expoirt...
O F2DIFATral-Buid 5 401 smel
Scale Aial
Periodic Moize Filter Dizabled
Cancel
3. Inthe Process section associated with the selected C-scan, select the Scale process, then click Edit

b Home Setup

........ Fromves

Advanced SMART Setup Instrument Cali

h h — .
= BN & o s
Scan Process Ch. | C-scans || Sizing Cal. Points Indication | Probe DB

to open the Scaling Setup page.




W, C-scan Configuration x
C-zcan F1DIFA Process

F1ABSA Mew... State Praceszing Type Details | Add...
F14B5A-LargeSignal Dot Sublraction F1DIFA-Lead-Buid D
FiDIFA mElete F1DIFA-Tral-Buid —eee
O FIDIFALeadBuid R i

Rename... Edit...
O FIDIFATralBuid Filter tial -.‘
F24B54, Duplicate Low-pass Up
F2aB54-LargeSignal 20.0Hz ;
F2DIFA Impart... Median filter Al avn
00 F2DIFA-Lead-Buid High-pass

Export... 401 |
[0 F2DIFA-TralBuid —
Cancel

5. For both the Amplitude and Phase, you can change the targeted value, the reference point and
the measurement method. Note that different reference points can be used to calibrate the phase
and the amplitude independently.

]
e X
[“]Enahle
[+ Amplitucie
IMeasurement Feak to peak ~
[#]Phase
teasurament Feakto peak w
Scaling axis Auxial Lo
Single gain/phase
[ Assistad array calibration
| I I
I OK. 1 Cancel | Details >»

S1ZING CURVE MODIFICATIONS

In the Sizing Curves Configuration window (under the Advanced tab), you can either create a new curve
by clicking on Add, or modify the general parameters of predefined curves such as measurement type,
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channel source, etc. By default, all curves are measured using phase angle. However, they can be changed

to amplitude.
i
-~ General
i Calibration Points .-
21- Defintions Create sizing curve and set general parameters
“ ABS-F1-S(RFT)
-ABS-F2-5(RFT)
: E:E:g: : Egi Inspection Type Tube from ID v
-ABSA-F1-S({RFT) __I_IE]__L Mame Technigue Based on Source Type
-ABSA-F2-S(RFT) : ABS-F1 RFT s |i Channel ~ | F1ABS + |i Phase .
E-D|FA'F1'|;HF|—} S ABS-FZ RFT s |i Channel « | F28BS + |i Phase .
- DIFA-F2-(RFT) DIF-F1 RFT + | Channel || F1DIF | Phase [ X
DIF-F2 RFT s |: Channel « |: F2DIF + |: Phase v X
S ABSA-F1 RFT w |iC-scan Y « | F1ABSA + |: Phase v &
S | ABSA-FZ RFT [ C-scan Y ~ | FZABSA ~ | Phase " r.e
DIFA-F1 RFT w |iC-scan Y « | F1DIFA + |: Phase .
DIFA-F2 RFT w |iC-scan Y | F2DIFA + |: Phase v i &
Add
Cancel << Back Next 5> Finish

For every sizing curve seen under the General section, there will be a specific page in the Definitions
section to configure the curve properties. By default, the Average Peak (MP) measurement method is set
for the absolute channels, and the Peak to Peak (PP) option is used for the differential channels.
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I[" Sizing Curves Configuration .

- (General
Calibration Points L
[=I- Definitions
- ABS-F1-S(RFT)
- ABS-F2-S(RFT)
- DIF-F1-{RFT})
- DIF-F2-{RFT})
- ABSAF1-5({RFT) Mame |ABS-F1 D |3
- ABSA-F2-5{RFT) )
- DIFAF1-{RFT) Units Percentage (%) ¥
- DIFAF2-(RFT) Report as remaining wall
Measure from
%' Channel C-zcan X C-scan Y F1ABS v
Calibrated using measurement | Average Peak v
Parameters
Input measurement | Phase L
Shape Best Fit (Linear) \

Extrapolated Curve

 Name o] Description
iLong L Long Defect
Taper T Taper Defect
Cancel << Back Mext = Finish

The plot of sizing curves for each individual channel can be seen by clicking on the Curve tab. From there,
you can click Select... to see or modify the calibration points for each curve.

1L sizing Curves Configuration X - R .
Gererd I[” Select Calibration Point o
Caltration Points ABS BILSUREI)
- Definitions
TRBS - S(RFT) ] D . . 5
e S : : MName Side  Sizel%) Value(
DIFF1-(RFT) Defnon | Curve | — e Y
oo ~ I
E‘BFSZH‘—HST;)W) ‘Show Tables é oD v [60.0 72
ABSA-F2-S(RFT -
orar e | 7] :ODGR-4 ‘0D |, 400 101 N
DIFAF2-(RFT) 100.0 Hole Throu [ :100.0
[] FEH-e0 0D . 800
[C]70DGRZ oD [ ]200
g > []:Support  ;Unkno |
% 40.0
200
00
1 P 7 101 130 159
Phase (dearee)
Cancel << Back Next > Finish Reverse Order

Note: When you modify an existing curve or add a new curve, you must recalibrate/calibrate all sizing

curves (channels and C-scans).
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RFA LINKS EDITOR

The RFA Links Editor menu can be found under the RFT ribbon. The drop-down menu available at the top
of this window shows the selected mode of calibration for the C-scans in the calibration tube, as initially
defined during the Setup Wizard.

In the Links table, the left column shows the conventional bobbin channels, and the right column shows
the C-scans associated to them. When a channel in this list is calibrated, or its software gain or rotation is
modified, the same changes are automatically applied to the C-scans linked to it.

Bl rra Links Editor X
Calibration of C-scans in cal. tube: | Automatic * | Gains/rotations from cal. of bobbin channels
Links C-scan Selection
Channels C-scans L1 F1assa
S <] s ermesiane!
FIDIFA
FIDIF FIDIFA (% -
] F1DIFA-Lead-Build
F2ABS F2ABSA, F2ABSA-LargeSignal (% -
[] FIDIFA-Trail-Build
F1ABS F1ABSA, F1ABSA-LargeSignal (% e
[] F2ABSA-LargeSignal
F2DIFA

[] F2DIFA-Lead-Build
[] F2DIFA-Trail-Build

= Add

| oK || Cancel |

It is highly recommended to leave this menu as it is. However, it is accessible to allow for advanced
customization of an RFA setups. For instance, should a new C-scan be added to a setup, this menu would
allow to link it to the correct bobbin channel.

Loss OF COMPATIBILITY WITH THE RFA WizARD

All the setup modifications covered until this point are considered as being a typical setup creation
workflow for RFA technology. If additional customization of the setup is required for specific purposes,
you should be aware that it might result in a loss of compatibility with the dedicated RFA Wizard.

Modifications made to the following menus would break compatibility:

e Advanced Scan Definition menu
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o Home Setup Advanced SMART Setup Instrument Calibr

Z 2 BN 8 S N

Scan || Process Ch. C-scans  Sizing  Cal. Points  Indication | Probe DB

e Channels and C-scans Advanced Process menus: Modifications to processes other than the Scale
(as shown previously)

M| OFE % ¥ -

o Home Setup Advanced SMART Setup Instrument

Bl & o |4o

Scan )| Process Ch. C-scans | Sizing  Cal. Points  Indication | Probe DB

e Instrument Configuration menu
M OEK 4 ¥ =

o Haome Setup Advanced SMART Setup Instrument I
bt b ¢ =

Disable Ch. Setup Info /O Alarm  Fine Tune

Important: If you need to make modifications to the above menus, you should stop using the RFA Wizard
and only use the Advanced menus for all the adjustments to the setup, including the frequency selection,

scan length, etc.

SMART SETUP TOOLS
Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.

LoGBOOK

The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook.

SMART Setup‘
— 00
O (@ \{ D |8 0
(+] ¥ | vA
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications DOV Grouping heport Help
Logbook Shortcuts
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The logbook stores information about the analysis in addition to allowing the following functions: batch

screening, seeing results at a glance from the data list pane, and saving manual modifications made to the

landmarks during the analysis.

The logbook stores the following information: landmarks (type, position, dimension, including manual

modifications), indications (Al and conventional, label, position, dimension, etc.), indication grouping, and

data quality validation results. When enabled, an additional column is added to the data file list to allow

seeing results and to filter, sort, or analyze according to these results.

Data
22 of 22 data

Zone Row Col
000 001 001
0oz 005 005
ooz 009 007
003 004 009
003 005 012
003 006 007
003 007 006
003 007 010
003 009 007
004 003 010
004 003 015
004 004 009
004 004 014
004 005 008
004 007 Q05
004 007 015
004 009 010

010 010

' 004
[+ e (@]

A N N N e e e e N . U U L S N

oy
SIS

The following table shows the possible icons and their meaning:

Icon Description Meaning
No logbook entry associated with this file because
(empty) Empty )
it has not been screened yet.
Logbook entry associated with the file contains
. . information such as landmark detection or regions.
Dashed outline circle, . . . i
e ] The absence of additional information on the icon
{_} without a number o . .
- reveals that no indication detection engine or DQV
tests were enabled when the loghook was written.
o Dashed outline circle, with a Logbook entries associated with the file contains
1 1]
= number information such as landmark detection as well as
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detected indications. The number displayed inside
the circle shows the quantity of potential
indications detected.

No DQV tests were enabled when the logbook was
written.

Dashed outline circle, with a
green check mark

The green check mark indicates that the DQV
test(s) passed on this file.

Dashed outline circle, with a

The red cross indicates that at least one DQV

“x
= red cross test(s) failed on this file.
) ) ) The logbook entries associated with this file
Dashed outline circle, with a o o
] indicates that potential indications have been
{37 number, with a green check . .
) mark detected by the detection engine and that the DQV
test(s) passed.
The logbook entries associated with this file
(% Dashed outline circle, with a | suggest that potential indications have been
h number, with a red cross detected by the detection engine and that at least
one DQV test(s) failed.
The Al detection tools identified an unusual
situation. In this case, the level of confidence in the
A Orange warning triangle detection findings could be very low. Therefore,

users should pay special attention when reviewing
the detection results.

The logbook is saved within the inspection folder. Its data is written when a file is screened using the

dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the

logbook is enabled, and no logbook entry existed for this file yet.

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been

detected with detection tools that do not use Al (conventional landmark detection and indication boxes).

Also note that the automatic indication detection tools are not available if you use the acquisition license

(ACQ).

LANDMARKS

The Landmarks button is used to setup the parameters for landmark detection with conventional tools.

Enable Wizard
Logboak
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The Landmark Detection window is used to configure the automatic detection of features such as tube

sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional

setup. They can, however, give a reference for the axial position in a tube. They can also be used by the

software to trigger automatic acquisition sequences.

(Exit is used for
sequence only)

Start
Record

Bl Landmark Detection
Detection Channel: F1C04 -
. TS0
Reporting From: @ StatRecord () Stop Record rm
[] Negative Positioning: From 0.0 mm
Stop
Detection Engine: Extended v Record i:
Manual Sequence: [ (Check for Acquisition Detection) Length
Enable Detection
Landmark Table (in the order seen by the probe during data acquisition)
Name Type Pos.(mm) MinQty MaxQty Shape
Exit Exit 25
TSI TSI 0
sp P
TS0 TS0 6000
import.. | | Export.. || Suggest

Reporting from

Compenent Threshold (V) P2P (mm) Enable

10000.00
10000.00
10000.00

144l

10000.00

Floating Group Landmark

O 1. s ()

Disabled
Enabled
Enabled

(]3¢ [ ]

Enabled

Pasitioned Landmark

Down Add

Three landmarks are created if you click on the Suggest button. The channel selected to detect these

landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw.

This is the signal of the channel without software filter, rotation, or software gain applied.

You can base the position of your landmarks either on the location where you start to record (usually the
tube entrance, opposite from the operator position), or the place where you stop recording (usually the

operator side).

(Exit is used for
sequence only)

Start
Record

Reporting from

{ is used for

sequence only)

O 1. .

TSI
5

¥ Start

Detection Channel: RDIF-F1 ~
. TSO
Reperting From: @ StartRecord () Stop Record rm
[ Negative Positioning: From | 0.0 mm
Stop
Detection Engine: Extended v Record i__
Manual Sequence: [ (Check for Acquisition Detection) Length
Detection Channel: R_DIF-F1 ~
. TS0
Reporting From: () StartRecord ~ (®) Stop Record rm
[[] Megative Positioning: From 0.0 mm
Stop
Detection Engine: Extended ¥ Record :
Manual Sequence: [] (Check for Acquisition Detection) 0

Reporting from

_: Record

Length

In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has
a negative position because this event happens before entering the tube. It is enabled only when doing

the acquisition.

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered
at the end of the acquisition.
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Landmark detection can be set up manually by describing the shape, component, and voltage threshold
that will trigger the detection. The Shape describes the appearance of the signal when the landmark is
reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed.
The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to
trigger the landmark. The Threshold is the voltage amplitude threshold.

Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as
they will be automatically measured by the software. It’s important to set the landmark positions as
accurately as possible. If the position is not accurately set, the software might prevent their automatic
detection since it won’t be at an expected position.

The Type field is a name that associates the calibration point with the landmark. If landmarks share the
same Type, they will be calibrated at the same time using the same point and process. To associate two
landmarks with the same Type, their signal must be the same. If support plates of the same geometry are
present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the
same Type because one is triggered when the probe goes inside the tube and the other is triggered when
the probe exits the tube.

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the
landmarks need to be entered with the correct position. The system will look for the exact number of
landmarks entered at positions close to those entered in the table. With the Extended mode, the system
will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact
number of support plates doesn't need to be constant or known.

REGIONS

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used
to categorize the data to process correctly. For example, they can be useful for restricting the detection
of channel saturation to an area within the tube or specify an automatic analysis type for a given region
(e.g., under the tube sheets).

SMART Setup
— - 00
i Q\ = an b | 98GR

© BRlw v sa G
Enable Wizard Package Landmarks Indications | Landmarks] Regions | Indications  DQV Grouping Report Help
Logbook Shortcuts
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Bl Region Detection X

Regions Details Preview
Name MName: Between —
—Izl Abbreviation: TSI (TsD)
Around EI Location: Between v SP(5P)
In $pecimen lzl Selection: All v SP(SP)
Start Offset: | 10.0 mm = 5P (5P)
End Offset: -10.0 mm = SP(SP)
5P (5P)
SP(SP)
' SP(SP)

SP(sP)

General Simulation Parameters SP(SP)
Landmark Thickness: | 250mm - SP (SP)
Floating Quantity Simulation TSO (TS50)
SP: 10 =

G

If you are using the conventional detection tools, you can set up the regions according to the automatic
analysis tools you will use with the Indications and DQV buttons (described later).

INDICATIONS

The Indications module allows the user to define various zones or even waveform types to trigger a certain
detection threshold.

SMART Setup
=S 00
E ? AN | & ; bl ) Dr‘D
o W | | wm
Enable Wizard Package Landmarks Indications | Landmarks Regions [Indications] DQV Grouping Report Help
Logbook Shortcuts

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name
that will appear in the Code view.

I8l indication Detection X IRER 2 I
T T T

Detection Zones — |

Label Based on Source Zone Type Zone

PIT Channel F2DIF N [¥]  neideRedius [omiv

Outside Radius | 20.00V -
Orientation 45 -

Center (0,0)

Boundary

Increaseby | 4cent :

Regions

Restrict to selected

[ ok ][ concer ][ apply

e | h P e

Vo m |o|w]w oW 0
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There are five zone types:

b Absolute pie

o Differential pie

[ | Centered rectangle

*i* Rectangle

e Over or under a horizontal or vertical threshold

And seven waveform types:

2+ Up
# - Down
$T Down-up

&t

Any direction

al

Up-down

1

Down-up-up

3

Up-down-up-down

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also
include the boundary setting to prevent signal oscillation from triggering unnecessary detections.

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating
the Edit Alarm option on the Current View tab.

The detected indication can be found in the Indication window, which can be activated in the Layout tab.

EN ER G Eo ER

Select Manage Reload BackUp New Layout

Layout

. mE|= = BERE

Replace  Remove  Split Infofield Cal. Infofield Data Report Dav

=7
/v

Indications

-
» N
Note Large

Acquisition

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip
chart view. If you click on an indication in the code view (described later), the associated indication is
highlighted in the Indications pane.
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Indications oo

- | | DIF- | F2 |

Label ' 80.0 kHz
IND

IND
IND
IND

[
IND

IND

IND
IND
IND

w

DATA QUALITY VALIDATION (DQV)

Data Quality Validation allows defining tests to validate the quality of the data.

| SMART Setup |

U@ Q o ©

Enable Wizard Package Landmarks Indications | Landmarks Regions Indications
Logbook

,I
Dav

00

8 %0

bl

Grouping Feport Help
Shortcuts

Five test types are available. To add a test, click on the Add button on the DQV page and select the test
type with the drop-down menu. Parameters associated with this test can be changed in the Details section

of the DQV window.

. Data Quality Validation (DQV)

DQV Tests: Details
Enabled Test Type MName (Optional) Merge
Hardware Saturation IZI Range
Dead Channel IZI Regions
| Channel Saturation v IZI

Restrict to selected |Select...

10.0 mm v

ok || canca
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Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined
threshold. An amplitude that remains below the threshold throughout the scan indicates a dead
channel.

Landmark Detected: Verify the presence of all the selected landmark names in the Details section.
To validate full tube-lengths of straight bundles for ECT bobbin data using Al detection, select this
option and check the TSI and TSO landmarks. When Al setup for landmarks is completed and the
TWH calibrated, the DQV test will automatically use the Al results to perform the test.

Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows
grouping a zone together in which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region,
for example, the areas inside the tube.

Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field
allows grouping a zone together in which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region.

C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping
a zone together in which the test has failed. This function avoids having many notifications if the
test fails several times in one area. This test can be limited to a specific region.

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab.

Layout

Select
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Test Result

Channel Saturation x Berors ©

Failures
Criteria

Hardware Saturation

o
Hardware Saturation @

¥ DQV Indications Note

GROUPING

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the
automatically detected indications.

SMART Setup ‘
— Qo
| D “»|B|%
(+] “B
Enable | wizard Package Landmarks Indications Landmarlﬁ Regions Indications Grouping] Report Help
Logbook Shortcuts

The Grouping menu offers a default configuration with three predefined categories:

e Support Plates
e Critical

e Less Critical
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[l Detected Indications Grouping - O X

Groups Details
Name I:I Name: | Critical
Support Plates I:' Amplitude Phase
_ I:I Channel: | DIF-F2 & Channel: | DIF-F2 w
Less Critical I:I Measure: | PP < Measure: | PP w
Min: 1.00V - Min: 10° =
Man: [ [10.00v Masx: 120 -

Restrict to Regions

In Tube
Airto Air
[] Freespan
[] FreespanCal
T8l

] 150

[dsp

[] Hide unclassified indications

(! ] | The default configuration will be applied. I |Resetto Defaultl | oK | | Cancel |

The Details section of each group shows the parameters defining the conditions that must be met for a
detected indication to be classified in this group. The user can modify all parameters.

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP)
measurement method, and Max/Min threshold values are set for amplitude and phase. For this group,
the criteria are limited to indications detected under the SP regions. As a result, the indications detected
under support plates for which all conditions are true will fall into this category.

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on
DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping
criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube
length data.

It should be noted that each automatically detected indication can only be categorized in a single group.
Also, the grouping operation is executed according to the order of the groups defined in the Groups list.
Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group.
If not, it will be passed to the next group. If it meets all the criteria of the second group, it will be
categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does
not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single
indication will be categorized, and none can appear simultaneously in more than one group.

New groups can be created with custom parameters.
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Groups Details

Name Mame: |Support Plates
IZI Amplitude Phase
Critical Channel: | ABS-F1 o Channel: | ABS-F1 "
Less Critical I‘E‘ Measure: | PP N Measure: | PP s
Min: 2,00V B Min: 2° =
Max: L1 1000V = Max: 150° -

It is also possible to remove a group or use the up/down arrow keys to change the group priority within
the list.

Groups
Name +
Critical
Less Critical @
In the Front stage interface, the Grouping results will be displayed in the Indications pane.
Indications &+ X
10 of 10 results
Label Ampl. Phase
(~) Critical (4)
IND 1415V gz-
IND 340V LER
IND 278V 106 =
IND 708V 16°

(~) Less Critical (4)

IND 102V 111°
IND 1.00 v 40°
IND 12T W 56°
IND 113 73"

(~) Undlassified (2)
IND

IMND

DOV Indications Mote
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the
Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom
of the Grouping menu and click on OK.

Bl Detected Indications Grouping - O #
Groups Details
Name MName: |Critical
Support Plates Izl Amplitude Phase
_ Channel: | DIF-F2 o Channel: | DIF-F2 v
Less Critical II| Measure: | PP = Measure: | PP v
Min: 1.00V = Min: 0° =
P [ |[10.00v M 120°° -

Restrict to Regions

In Tube

Air to Air
[] Freespan
[] FreespanCal
[Tl

[]Ts0

[]sp

Hide unclassified indications

0 l The default configuration will be applied. I |Resetto Default| |\/ oK | |x Cancel

Enabling this option influences the following elements of the software:

e Indications pane;
e Codeview;
e Logbook column.

The images below compare them when the Unclassified indications are shown (left) and when they are
hidden (right).

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the
header serves as a reminder to the user that not all indications are currently shown.
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Indications

26 of 26 results

Label Ampl. Phase
(&) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 084V 18°
IND 076V 17°
IND 1.20V 19°

(%) Undlassified (20)
IND

IND
IND
IND
IND

Indications

6 of 26 results

Label Armnpl. Phase
(~) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 0.84V 18°
IND 076V 17°
IND 120V 19°

OOV Indications Mote

OOV Indications Mote

In the Code view, the red markers from the Unclassified indications have been removed.
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In the data file list, the number shown in the Logbook column represents the number of visible indications,
matching the number shown in the header of the Indications pane.

Data 4 X Data 4 X
7 of 7 data hA 7 of 7 data
Row Cal 8 [el Row Cal 5 [el
201000001 v 201000001
201004005 201004005
| ~ 201006009 68 | ~ 201006009 ®
~ 201006016 ~ 201006016
v 201024022 v 201024022
v 201025017 v 201025017
v 201025019 v 201025019
El ED
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REPORT SHORTCUTS

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is
possible to select a channel with a measurement method and to associate an indication with it.

SMART Setup ‘
e oo
ﬁ q\ ((‘ e D I B IS o
o W L N
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications DQV Grouping| Report Help
Logboak Shortcuts

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter
pits in the report.

:.:e.‘:'.f':'.:_.'.:- - O *
|
| | Indication Based On Source Ampl. Measurer Phase Measurer Sizing Curve Shortcut |
PIT Channel DIF-F2 Vpp ‘pp DIF-F2 v D 4
b

|\/ OK | |x{:ancel |

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a
single key or a combination of keys such as ALT+D, for example.

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication
displays momentarily on the corresponding Lissajous.

2] . [t oos [ 20v ]
DIF:F2 80.0 kHz
\\‘
\\
A Y
‘\\
A
\\\
A
\\‘
1.21V 60° 74.4% 0D 4
|Vpp,| | 2P|M| | :DH‘|
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DATA SCREENING

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under
the Analysis tab.

|Analysis
> 0BS
- \ m 3 $ | -m
' % |%B jo 0|9FE® Q@G
- e Va 3 (14 %0 > PG ]
Screening Screening All Previous  Next No | RST Feview Msg  Capture | Subtraction
All Files Selected Files Defect

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files
when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed
in the Data window.

LIMITATIONS

Some operations, processes, and options are not available for the RFA probe and configuration in Magnifi.
This section lists the limitations of the workflow in Magnifi.

e RFA setups can only have two frequencies. More frequencies cannot be added.

e The Absolute C-scan does not have a Voltage plane representation, only a Lissajous
representation.

e Contrary to conventional RFT setups, it is not possible to link the Absolute and Differential
conventional channels together with RFA setups when the Voltage plane representation is used.

e The RFA Wizard cannot generate encoder-based setups.

o If the Periodic Noise filter has been activated, it may take a few seconds to complete processing.
This is normal - the process can take up to more than a minute for very long scans.

e The setup wizard does not suggest excitation frequencies based on the tube characteristics. This
parameter must be determined by the user.
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The following two equations describe the through-wall transmission behavior of RFT:

The phase lag equation shows that the signal is not only influenced by the tube properties, but also

B =B, e =B, V7o ¢=d. o, u,

depends on the frequency (f) at which the tube is inspected. Given a tube of constant permeability and

B = Magnetic field strength at a depth ¢ = Phaselag
corresponding to phase lag (¢) M = p,p =Permeability
, = Initial magnetic field strength d = Thickness
¢ = Phaselag /= Frequency
c = Conductivity

conductivity, and using a fixed inspection frequency, the phase lag will be proportional to the thickness of
the tube.

The magnetic field strength (B) will depend on this phase lag. For an infinite theoretical thickness, the
resulting magnetic field will be null. The explanation being that the field is completely blocked and that
nothing is caught by the receiver(s).

The voltage plane is a graphical representation of these formulas. The curves built on a voltage plane show
the effect of the thickness variation on the signal. There are four curves that represent a flaw coverage of
90°, 180°, 270° and 360°. The point crossing the horizontal axis is the nominal point. This is the signal
obtained when the probe is in a sound area of the tube. It has an amplitude of 1V and a phase of 0°.
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/" 360°
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When you first scan your calibration tube, this point doesn’t match the nominal point of your theoretical
curve. You must calibrate the signal to match your probe signal to the theoretical curve(s). This operation
is called normalization.

A bundle of tube may include tubes that have different properties. The permeability, for example, may be
different for some tubes. This will affect the nominal point position and the built sizing curves won’t be
applicable to this tube.

If the nominal point has not moved too far from the theoretical nominal point, the common practice is to
renormalize and to size the flaw with the built sizing curves.

If the nominal point has moved far from the theoretical value, it means that the tube properties are
significantly different from the calibration tube. Therefore, the phase lag for a given flaw will also be
significantly different and this will generate an error in the sizing that must be considered. In this case, it
is recommended to change the drive frequency to put the nominal point back to the renormalization zone.
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A common practice is to set the threshold angle at which the inspection frequency needs to be changed
to 30°.
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APPENDIX 2 — PERIODIC NOISE FILTER

The Periodic noise filter addresses the presence of cyclic or periodic noise in C-scans caused by the tube
manufacturing process.

The pilger process in tubing manufacturing may create a cyclic permeability change along the length of
tubes. This in turn may cause noise that appears like visible diagonal stripes in C-scans. In most cases, this
noise is low and will not prevent the analysis of the C-scan signal but in the instances where the noise is
stronger, the Periodic noise filter may help to reduce it.

Pilger noise

By default, the filter is not enabled. All filters affect the signal to which they are applied to a greater or
lesser extent, and improper use can lead to the creation of artifacts or can negatively affect the signal. It
is recommended to use this filter only on data that has pilger noise that interferes with the analysis.

It is possible to enable the filter and to set most parameters within the “C-scans” step of the RFA setup
wizard.

Setup | Advanced SMART Setup Instrument Calibration Anal
£\ 5 =] = —

> = B §F ¥ T

Frobe  Component  Scan Data C-scans  Channels Indication
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w
h Data Processing

1 ' Configure the processes to apply to the C-scans.

C-Scans

Name

F1ABSA
F1ABSA-LargeSignal
F1DIFA

F2ABSA
F2ABSA-LargeSignal
F2DIFA

7
i
vl

i

Low Pass
Cutoff (Hz)
20
20
20
20
20
20

WOR O™

Median High Pass
Window Size (smpl)
40

40

a0

4m

40

40

Periodic Noise

Window Size (smpl) Moise Threshold (V)

35 0,030
] 35 0.030
1 3s 0.030
35 0,030
[] 35 0.030
35 0,030

1) Before enabling the Periodic Noise filter, learn how to configure it adequately with the RFA probe user guide available in the
Documentation section of Magnifi.

K Cancel

[4 Back [[P et |

Checking the box on the desired C-scan line under the Periodic Noise column enables the filter. The other

parameters are described below.

It is also possible to enable the filter and access the filter parameters by right-clicking on the desired C-

scan and selecting the C-scan configuration menu. Double-clicking on Periodic Noise Filter brings up the

Periodic Noise Filter Configuration.

W -

Dmnnmmnnng

F1aBS&
F14B5A-LargeSignal
F1DIF&
F1DIF&-Lead-Build
F1DIF&-Trail-Build
F2ABSA-LargeSignal
F2DIF&
F2DIF&-Lead-Build
F2DIF&-Trail-Build
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Delete

Rename...

Duplicate
Impaort...

Expart...

*
F1AB5A Process
State Processing Type Dretailz Add...
Build from charinel Delete
Edi...
Auial Up
Low-pass
20.0Hz Diowin
Median filter Axial
High-pasz
401 zmpl
Axial
Interpolation Circ.
Jpls
Fiealtime processing
Perindic Maoise Filter Disabled

()3 Cancel




. Periodic Noise Filter Configuration *
["] Enable Filter

[1 High Intensity

Signal Type
(@ Absolute

() Differential

Window Size 35smpl

b |10

MNoise Threshold |0.030V

| QK || Cancel |

The "Enable filter" option allows you to activate or deactivate the filter.

The correct signal type, either "absolute" or "differential", must be selected according to the type of C-
scan to which it is applied.

The Window Size is the axial direction zone size, in data samples, that is considered by the filter. The size
of the window can be determined by measuring the axial length of a small defect, in samples, such as the
through-hole in the calibration tube. For RFA probes, this value is then divided by 5 for absolute C-scans,
and by 8 for differential C-scans.

Target defect size in samples
5

Window Sizeppsolute =

Target defect size in samples
8

Window Size Differential —

To measure the axial length of a defect, place the beginning and the end of the cursor at the defect’s axial
extremities and read the value displayed in the AY (smpl) field.

In the example below, on an absolute C-scan, the complete target defect signal is 185 samples long.
Therefore, a Window Size value of 185/5 = 37 samples could be used.

[e] Jees Jr) Tom37c |1 o200v
5

1.06V 64°

IEYEIEERD ’ [cor ] cor )

Y GmpD
) 185

The Noise Threshold parameter allows the filter to process only noise that comes from a periodic source
that needs to be reduced. Therefore, this threshold is set at an amplitude, in volts, between the observed
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periodic noise level and other baseline noise. The absolute peak measurement method can be used to
read the noise level.

Baseline noise can be measured when the probe is stationary in the calibration tube in an area free of
defects. The signal coming from the pilger noise can be measured in a fault-free zone.

If, for instance, the periodic noise has an approximate amplitude of 0.100 V and the baseline noise is about
0.020V, the Noise Threshold must be set between these two values.

The High Intensity checkbox does a more intense version of the filter. In the case of very high periodic
noise, it will reduce the noise further, but may create signal discontinuities.

‘3‘! I 285_€ ‘l Fz,l ! |4| ‘! F288SE1 ! [3] ] #ese Jr] [t o000 i 200v ]
1. X o 2 | 063 25 |

0.99V 241°

Y EE [ cor ] cor ]

o] ] Famse | |t oo |t 20v )
e ]
| Defects !
R NN
S
Y
TEssiesnteainy
1 Pilgering noise |
P i e s B o 1
0.73V 266°
Vep | e || 2P COR ,| COR ,

The example above (left) shows a relatively high noise level. On the right, the result after applying the
filter is shown. On the unfiltered C-scan impedance plane (top), the cyclic noise (seen as overlapping
ovals at the base of the defects) affects the signal to noise ratio and enlarges the defects such that the
phase is difficult to measure. On the filtered C-scan impedance plane (bottom), the signal is cleaner,
and the phases are easy to measure since the signals are narrow.

The Periodic Noise Filter does several operations in a row, and certain design constraints must be
highlighted to understand how it behaves:
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As previously mentioned, low noise levels usually do not necessitate filtering. It might prove
difficult to set a Noise threshold that would be consistently below the periodic noise and above
other noises. If this value is not set correctly or the periodic noise is too low, the filter will not
work correctly.

The filter must be used on signals that are around the zero mark (nulled / high-pass median-
filtered signals).

The filter uses parts of the signal that only include pilger noise to determine its parameters. If
there are very large defects in a zone, the software might not be able to find an adequate pilger
noise signal and it will not be correctly filtered.

Similarly, filtering might be inefficient at the beginning and end of the scan because there is not
enough data to measure the pilger noise parameters.

In the C-scan configuration window (seen above), each filter in the list sequentially processes
the data

The filter receives the signals obtained from the processes that precede it (see the C-Scan
configuration window above). This means that any signal amplitude used to select a Noise
Threshold must be measured on the signal that the filter receives. Since the periodic noise filter
is last in the C-scan processing chain, measure the signal with the filter disabled to determine
the correct value.

Prior processes like median filters or other filters might in some circumstances generate artifacts
(straight lines, data at zero) that will in turn affect the periodic noise filtering (seen below).

This filter is computationally intensive, so the processing time for long files can be a minute or
more for a single file.
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INTRODUCTION

This document presents how to use an NFT probe with Magnifi on an Ectane test instrument.

EQUIPMENT

NFT probes use a 19-pin connector that can be connected to an Ectane with the “ERNM’’ option. The
absolute and differential signal from the probe will provide Strip charts and Lissajous.

As these probes need to fill an optimal portion of the tube inner diameter, a wide range of probe
diameters are offered (see the tubing probe catalog for more details).

From the following table, the best standard probe for your application can be selected. Note that Eddyfi
also offers custom products that are not shown in these tables.

Table 11 — NFT-BBAD probes diameter selection table

TUBE 0D TUBEWT DIAMETER FREQUENCY POLY PROBE PART NUMBER
mm in BWG mm in CODE mm in CODE RANGE CODE LENGTH
10 340 0134 110 1 0.433 PRBT-NFT-BBAD-110MF-Nzz
1 305 0120
120 12 0.472 PRET-NFT-BBAD-120MF-Nzz
12 277 0109
i3 2 S 130 13 0512 PRET-NFT-BBAD-130MF-N
: 20 20m (85T -NFT-BBAD- Nz
1905 0750 14 211 0.083 MF 50-2000Hz 30 30m (9810
15 1.83 0.072
16 165 0.065 140 14 0.551 PRET-NFT-BBAD-140MF-Nzz
17 1.47 0.058
18 124 0.049 150 15 0.591 PRET-NFT-BEAD-150MF-Nzz
9 376 0.148 160 16 0.630 PRBT-NFT-BBAD-160MF-Nzz
10 340 0134
170 17 0.669 PRBT-NFT-BBAD-170MF-Nzz
1 305 0120
12 277 0109
180 18 0.709 PRBT-NFT-BBAD-180MF-Nzz
13 2.4 0.095
2540  1.000
14 211 0.083
190 19 0.748 PRET-NFT-BBAD-190MF-Nzz
15 1.83 0.072
16 1.65 0.065
200 20 0.787 PRBT-NFT-BBAD-200MF-Nzz
17 147 0.058
18 1.24 0.049 210 21 0.827 PRET-NFT-BBAD-21 OMF-Nzz
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419 0.165 210 21 o.e27
3.76 0.148
220 2 0.866
10 3.40 0134
1 3.06 0.120
230 23 0.906
12 2.77 0.109
3175  1.250 13 241 0.095 240 24 0.945
14 21 0.083
15 1.83 0.072 250 25 0.984
16 1.65 0.065
17 147 0.058
260 26 1.024
18 1.24 0.049
8 419 0.165 270 27 1.063
9 3.76 0.148
280 28 1.102
10 3.40 0134
" 3.05 0.120 290 29 1142
3810 1500
12 277 0.109
300 30 1.181
13 241 0.095
14 21 0.083
310 31 1.220
15 1.83 0072

The NFT calibration tube used in this document includes the following flaws:

Internal groove, 30% of wall loss

MF

50-2000Hz

20
30

20m (851
30m(e8fy

Internal round bottom holes (RBH), 6.35mm diameter, 75% of wall loss

Through wall hole, 6.35mm diameter

Internal round bottom holes (RBH), 6.35mm diameter, 50% of wall loss

Internal round bottom holes (RBH), 6.35mm diameter, 25% of wall loss

Internal groove, 60% of wall loss

PRET-NFT-EBAD-210MF-Nz

PRET-NFT-BBAD-220MF-NzZ

PRET-NFT-BEAD-230MF-Nzz

PRET-NFT-BEAD-240MF-Nz

PRET-NFT-BBAD-250MF-Nzz

PRET-NFT-BEAD-260MF-Nzz

FRET-NFT-BBAD-270MF-Nzz

FRET-NFT-BBAD-280MF-Nzz

FRET-NFT-BBAD-290MF-Nzz

FRET-NFT-BBAD-300MF-Nzz

PRET-NFT-BBAD-310MF-Nzz

Other combinations of flaws can be used to calibrate the probe and to build sizing curves.
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In this section, we will create a folder structure that will manage the saving location of your setup, data
and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different inspections
that are related in some way. For instance, it can include all the inspections done at a refinery shutdown
and be named Refinery_Shutdown_May_2018. The second level of the file is the Inspection folder.
Inspection folders are saved in the project file. An inspection folder can include data specific to the
inspection of a tube bundle with a specific technology and could be named CS_075x0.065_NFT for
instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

—F— ] |

INSPECTION 2 INSPECTION X

SETUP
TUBE
LIST

l_l

I

I

I

I

I

I

I

|

|

|

|

|

I <> DATA
|

|

|

I

I

|

: REPORT
I
I
I
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When you open Magnifi, the first page displayed is called the Backstage.

Magnifi@ 5.3B1T376 - [Setup from original data file] - ECT-Bobbin.magdata -

General
Project / Inspection Information
Project Folder: Documents\Magnifi\Projects'Defa Probe: Unable to detect
General r
Inspection Folder: Documents\Magnif\Projects\Default\DemoDatas r(', o Application:  Generic
Inspection Sub- Transfer
Project Folder e
folder nspection Tube Dimensions:
Acq. S oD 2540mm
< Summany Setup / Data
Setup Loaded:  From original data file WE - 165mm
n L s
Setup Location: Jocuments\Magnifi\Projects\Def = Length: 500 mm
Report Summary Create Setu Open Setu Open Dats
Dats Losded:  ECT-Bobbin P = P B Material.  Stainless Steel 316
Frequencies: 160.0, 80.0, 40.0, 20.0 kiz
Data List
Naming Format: | Row, Col
Preview: 001001.magdata = =
Create NewList| | Import List
Documentation
Report
Name: Report.mdb
- e,
== Table Profile: Tubing ECT - AT
Report
[] Take screenshot with report entry Table

License

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an existing
project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your project file. Select
New, Folder and enter the chosen name. You can then select the newly created folder and click
on Select Folder.

—
I Sciect 3 project [
GO~ 2
Organize v New folder s @
\
|
- = ’
g
i
L Projects Folder
A Shorteut
@' Microsoft Access Database
& Biamap image
3 Contact
81 Microsoft Word Document
= View » 3] Microsoft Access Database
B Sort by » B Microsoft Project Document
Group by * @) Microsoft PowerPoint Presentation
. Refresh @3 Microsoft Publisher Document
[ SonicWALL Global VPN Client Document
- S B ® ' Rich Text Format
B Undo Delete CrleZ e Doxapent
e G/ Dessin Microsoft Visio
Share with ’
E = B Microsoft Excel Worksheet
New » B Briefase
Properties
Folder: Magnifi
| select Folder Cancel
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your
inspection.

- Al
. Manage ﬁ

l Inspections
o Manage Inspections Select Other...

Mame State

Default Ready for Inspection

Bundle_A_55316_0.75X0.065_ECT |_E

|V’ Select |[x Close ]

. a4
3. Click Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System
tab, you can change the measurement units from metric to imperial and vice versa. For the metric units,
you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement
for imperial units is inches. When finished, click on Preferences again to go back to the General window.

System (Computer Related)

Measurement Convention Measurement Units
Preferences @ ASME @ Metric

ASME Inverted et O Imperial

EDF i

Readback
[] Do not display data during loading
Speed:
) Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
Retain check state

General

(@ Reset to checked after loading a data file
Display Setup Wizard Path: C\Users\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
[] Allow ta save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo
Preview:

E, @ eddyfi

Shortcuts

Keyboard.. |
Remote... ‘

To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to
start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected.
If the material is not in the list, you can click on Manage... to open the List of Available Material window.

5 Mew Setup Wizard *

h Component Definition -

0 Configure the geometry and material of the component to inspect

Geometry: ) Surface (® Tube from ID
Application: (® Generic () Air Conditioner
Material: Carbon steel L

Resistivity: 21 pfl-cm

Permeability: 450 p

Velocity: 5890.000 m/s
Wall thickness: 1.65 mm -

16
BWG

& 24
Outside diameter: 19.053 mm -
Length: 8000 mm =

Mote about selected material:
ASTM: A178, ATT9, A192, AZ210, A214

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant
name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is
used to set IRIS parameters only, and it doesn’t need to be set if an IRIS inspection is not performed on
this material.
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It's possible to add a note about the material to specify information such as its application or composition.
When you are done, click OK.

/] List of Available Materials S|

Browse...

Custom Maternals

Materials = ey
Uiz S pemeasit
Stainless Steel 321 - ET ONLY 0.000 715 1 (| &2 Remaove Al
Stainless Steel 430 - ET ONLY 0.000 B3 100 (%

Stainless Steel Duplex - ET OMLY 0.000 74 75 |
Stainless Steel 9041 - ET ONLY 0.000 94 75 (&%
Titanium 6070000 48.6 1 (%€
Ti-6AI-4V - ET ONLY 0.000 123 1 (%€
Zirconium 4650.000 a1 18

Motes About Selected Material

v ok J[¥ conce

You will be back to the Component Definition window. If you add new material, it will be available in the
material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider.
Enter the tube’s outer diameter and length.

These tube properties will help Magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION

In the Probe Selection window, select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu.
More precise filtering can be done by using the Model drop-down menu. You can then select your probe

by its catalog number (PRBT-NFT-BBAD) and then click Next.

-
+" New Setup Wizard

=)

/ l Probe Selection b - |
~ Select the probe that you want to use for your inspection
Technique: [NFF v] Model: [Eobbin v]
Probes

Tech. Model Catalog Number Y | Description ~

|& New.. ||gManage. |

|3 Cancel |[d Back |[p Nex |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the acquisition
rate and the typical probe speed.

%" New Setup Wizard l&J

Scan Definition

Configure the type of scan you will be performing with your probe

Scan: Single Pass

Main Scan Axis: Y Asis

Position from: @l

Acquisition rate: 800 Hz -

»

Typical probe speed:  300.0 mm/s

Acquisition Size: 600.000 s - Maxirnum

[ Cancel | [4 Back | [ ’ MNext l

L 4

The position along the tube can be defined by using either the internal clock of the system, or by using an
axial encoder. If you use the internal clock, the default position will be given assuming that the probe is
always pulled at the typical probe speed. If the typical probe speed is set to 300mm/s, and the time since
the acquisition began was 2 seconds, then the system will indicate a position of 600mm. Using an encoder
will give you the exact position of the probe. Note that the position can also be obtained by using the
landmark tool, but this feature will be shown later.

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate
is set to 800 Hz for NFT, but depending on the drive frequency used to inspect, the actual acquisition rate
may differ. The system will automatically readjust this value if needed. For standard NFT probes, the
acquisition rate can always be set to 800 Hz.

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For instance,
with an acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least two
points per millimeter. If you do not use a pusher-puller device such as the Probot, the pulling speed won’t
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be constant. Therefore, it is recommended to target a lower pulling speed to be able to reach your axial
resolution target. The typical probe speed should be set as close as possible to its real value. This will help
the algorithm that automatically detects landmarks (this will be explained in the Landmarks section). The
recommended pulling speed for NFT is approximately 300mm/s.

If you select to measure the position from Encoder, different fields will appear, and a second Scan

Definition page will become available.

 New Setup Wizard =5 % New Setup Wizard S

Scan Definition Scan Definition

Configure the type of scan you will be performing with your probe Encoder and axis settings
Scan: Single Pass o
Main Scan Axis: ¥ Ais Tz (Quedroture -
Position from: Encoder -] Resolution: ~ 25.460 tmm

Detect Overspeed [ Invert direction
Typical probe speect 3000 mmy/s Preset  0.000 mm -
Maximum probe speed: 4500 mm/s Apply preset on Start
Density: 2,000 smpl/mm
Acquisition Size: 100000 mm = | [ Maximum
(3 cancel | (4 Back | [ New [ Concel | [4 Back | [B Hes |

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered.
The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the
number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition
rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a
speed exceeding the Maximum probe speed, there will be gaps in the data.

The second page includes the type of encoder and its resolution. A preset can also be specified if your

acquisition doesn’t start at 0 mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute
and Differential channels. It is important to set these parameters correctly before acquiring the data since
they are driven by the instrument and cannot be modified during the analysis.

" New Setup Wizard @

» Data Definition | [

- Select the channels you will be using and the necessary frequencies

‘ Connector: 19 pins

Channels Required frequencies
MName Prefix Gain (dB) Prefix  Val (Hz) Ampl (V)
Absolute ABS- 60.0 F1 300 5.00 gl
Differential DIF- 60.0

Suggest | + Add |

[x Cancel |[‘ Back |[’ Mext l

L. r,

By default, Magnifi suggests a frequency of 300Hz. The frequency and the drive voltage can be changed
by replacing their values in the Required frequencies table. Up to 4 frequencies can be set at the same
time. And the sum of their amplitude cannot exceed 10V.

Make sure that the chosen frequencies are within the probe limits that you can find in Table 1. If one of
the suggested frequencies is not within the recommended probe frequency range, you can either remove
it by clicking on the X or change it within the recommended range.

Click on Next when the desired parameters are entered.

The next window is used to build mixed channels. Mixes are processed channels that are mainly used to
detect indication close to support plates. They are built with 2 frequencies of the same channel type to
attenuate the effect of the support plate and to be able to size an indication at this location more
accurately. Mixes are not typically used with NFT since this technology allows the detection of inside
diameter indications only. Therefore, the support plates are not typically detectable.
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" New Setup Wizard @

ﬂ Data Definition | [
03

Configure the channel mixes for your inspection

Input Channel 1 Input Channel 2 Output Mixed Channel Mixed Reference Signal

=)= Add

[x Cancel ] [‘ Back l | ’v Mext |

L ’,

Click on Next.

DATA PROCESSING

The Data Processing window is used to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually or you can apply the same filters to every
channel with the Individually configure all the channels check box.

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can
be changed without any problem during data analysis, while wrong parameters choice for the data
acquisition can mislead the analysis. It is possible to change the filters parameters after data acquisition,
so it is always possible to fine tune the filters parameters during analysis.
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( " New Setup Wizard l&r
ﬁ Data Processing
Y Select the processings that you want to apply to the channels you have selected
[T Individually configure all the channels
Low Pass Median High Pass
MName - Cutoff (mm) Window Size (mm)
ABS- [ 60 ] 1500
DIF- [ s0 ] 1500
[ Cancel | [ 4‘ Back | [ ’ Mext ]

L ’,

The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful
when your defect signal has a lower frequency content than the background noise. In this case, using a
filter will remove part of the noise without removing the defect’s signals. This may help with data analysis.
However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too
low will filter out the defect’s signals.

The median high pass filter is used to filter out low frequency noise or drift such as lift-off variations of
the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of
the high-pass median filter should be set to at least three times the axial length of the longest flaw that
may be encountered. Data should be examined in both its filtered and unfiltered states. It is important to
keep in mind that the median high-pass filters can distort phase. More information about median filters
for NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.
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CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These indications will
later be used to calibrate your probe and to build sizing curves.

The units of measurement can be set in percentage or in depth (millimeters or inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and
size. The side and size of the flaw will be used to position the calibration point on the sizing curve(s).

Calibration points can also be imported with the Import button.

'/‘- New Setup Wizard l&J
Calibration Points
Configure calibration points used for channels and sizing curves
Units of measurement: | Percentages (%) -

Calibration points

MName Side Size

HOLE Through 1000 X
RBH-75 D 750 X
RBH-50 D 500 (%)
RBH-25 D 250 (%)

GR-30 D 300 (%
GR-60 1D 600 (X

SUPPORT Unknown 00 (%

& Import | | == Add |

[ Cancel H{ Back Hb Mext |

“ 4

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).

CALIBRATION

The Calibration page is used to define reference signal(s) that will be used to set the amplitude(s) and
phase(s) of each channel using the selected measurement method.

By default, the calibration is performed on the Hole signal by adjusting it to 1V and 90° on the differential
channel. The absolute channel is calibrated on the 60% groove by adjusting it to 6V, 90°. However, the
calibration can be done differently on each channel type. It can also be done individually for each
frequency by selecting the Individually configure all the channels option. Different reference signals can
be set to calibrate the phase and the amplitude independently.
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-
+" New Setup Wizard

6 Calibration b - |
A Configure parameters to calibrate channel amplitude and phase
Individually configure all the channels
Amplitude Phase
MName Voltage (V) Reference Measurement Angle (%) Reference Measurement
ABS- 6.00 GR-60 pp 90.0 GR-60 Pp
DIF- 1.00 HOLE pp 90.0 HOLE PP

|3 Cancel || Back |[p Nea
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When you select the reference signal, the system will use the selected measurement method to apply a

rotation and a gain. Here is a short description of the available options:

365

10.

11.

12.

13.

Absolute (A):
Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude.

Absolute Horizontal (AH):
Uses only the horizontal component, from the Lissajous origin to the main cursor position to
measure amplitude.

Absolute Vertical (AV):
Uses only the vertical component, from the Lissajous origin to the main cursor position to
measure amplitude.

Absolute Peak (AP):
Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure
amplitude.

Absolute Peak Horizontal (APH):
Uses only the horizontal component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

Absolute Peak Vertical (APV):
Uses only the vertical component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

Average Peak (MP):
Takes the distances from points at the extremity of the cursor to the peak of the data selection
to build an average vector. Only used and and recommended for absolute signals.

Average Peak Horizontal (MPH):
Uses the horizontal component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

Average Peak Vertical (MPV):
Uses the vertical component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

Peak to peak (PP):
Uses the combination of the vertical and horizontal component to measure the maximum
amplitude.

Horizontal (PPH):
Uses only the horizontal component to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to measure the amplitude.

Peak to peak First Transition (PPF):



Uses the combination of the vertical and horizontal component of the first transition of the signal
to measure maximum amplitude. The first signal transition is from the base of an indication to its
peak.

Click on Next went the parameters in the table are set according to your requirements.

S1ZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this
table.

5" New Setup Wizard @

/\ Sizing Curves |
Add and configure the sizing curves necessary for your inspection

D Mame Source Measurement
ABS ABS-F1 Amplitude %
DIF DIF-FL Amplitude X

= Add |

[x Cancel |[‘ Back |[’ Mext ]

L. o

The sizing curve will allow you to estimate the size of a defect based on the calibration points signals
(amplitude only for NFT) obtained with your calibration standard. Magnifi will give you the interpolated
flaw size based on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be changed.
You can add sizing curves by clicking on the Add button.

Click Next when you are done.
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For every sizing curve created in the last window, a window will appear to configure the curve properties.

The name of the curve will be shown in the upper left corner of the page (ABS in the example below).

-

L

" New Setup Wizard I&I
Sizing Curves
Configure the properties of the ABS sizing curve
Measurement method: [ PP x | Select the curve’s points:
P [ BFL v| Narme Side Size
GR-30 D 30.0 T
[T] Report as remaining wall cl
Force to zero GR-60 1D 600 £
[[] RBH-25 1D 25.0
[C] RBH-50 D 50.0
[C] RBH-75 D 75.0
[7] HOLE Through 100.0
[] sSUPPORT Unknown 0.0
[ Cancel | [ ‘ Back | [ ’ MNext l

4

The measurement method options are the same as what is described in the calibration section of this

document. By default, the option peak to peak (PP) option is set for the absolute and the differential

channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of

the available options:

1. Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side calibration

points with respect to phase.

2. Best Fit (Dual Slope) (for phase measurement only):
A curve with two segments representing ID and OD (or Near and Far) sides. The ID section is

linear and the OD section is polynomial. The OD side of the curve will need at least three points

(including the hole) in order to trace a polynomial curve.

3. Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured calibration points (requiring at

least three points).
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4. Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.

5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD side of the curve.
Need at least three points.

The linear options are mostly used when few data points are available, while the Best fit (Dual Polynomial)
option is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select the curve
points for each sizing curve previously created. The order in which the points appear in the list may
influence your sizing cure. Make sure that the measured values of the calibration points are in ascending
order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking
the box Report as remaining wall thickness.

Click Next when you are done.
INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when analyzing
the data.

5 New Setup Wizard lﬂhj
— Indication Codes
- 0 Configure the indications codes used for the report
Code Description Type Automatic Color
COR Corrosion Defect E|
CRK Crack Defect (%
DNT Dert Defect (%
DSt Distorted support indicatic  Defect E|
ERO Erosion Defect E|
NDD Mo defect detected Mo indication E|
0BS Obstructed Feature |" Red E|
PIT Pitting Defect E|
PLG Plugged Feature |’ Brown E|
RST Restricted Feature | Yellow E|
wiL Wall loss long Defect (%
WS Well loss short Defect (%
WLT Wall loss taper Defect ¢
& Import | | o Add |
l Cancel ‘ [ 4 Back | [ } Next I

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.

You can modify the default indications codes list by changing the parameter in the table. New indications
can be defined by clicking on the Add button.
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Click Next when you are done

DISPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.

" New Setup Wizard @

Display | |
Configure display and layout properties

General options Lissajou f Strip chart options

Zoom behavior on stop acquisition: [E] Miniature strip chart

Zoom to full scale
Proportion: 33.00 % -

4

) Zoom to content

Display Direction: Bottomn to Top -

@) Keep current scale

b

Strip chart duration: 6000 mm

4

[x Cancel H‘ Back Hb Mext

L. A

The Display Direction is the direction in which data appears on the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box.
The strip chart duration is the length of a Strip chart window when the data is acquired.

Click Next.

The second Display window is used to set the layouts. Checking the tick boxes in this window will make
the proposed layouts available in your setup. You will be able to switch from one to the another via the
layout tab. The " S " stands for Strip chart, " L " for Lissajous and “C” is for the defect Code indication zone.
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i ™
+" New Setup Wizard u

Display = s

Select the layout that you want to use to display your inspection results

2 Strip charts, 1 Lissajous 2 Strip charts, 2 Lissajous

L
Yl s|s|

DCSS

4 Strip charts, 2 Lissajous

L

[:]CSSSS

. : Default layout

|3 cancel | |4 Back ||/ Finisn |

L. ",

The layout with the blue background will be the one opened by default, which can be changed to your
desired option.

Layouts can be readjusted at any time.

Click Next to complete the setup wizard process.
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SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the

parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button

associated with the parameter you want to change.
Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

O K< & A N Sp EE

Comp Probe Scan Data Process Landmark F'C'al Calibration  Sizing  Indication Display
oints

This will open one of the windows previously described, where you change the values you originally
entered. Change the desired parameter. If applicable, go through the process by clicking on Next, and
then click on the Finish button. This will apply the modification to the setup.

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed
using advanced settings, the information shown using the Setup tab may not match your actual setup.

SMART SETUP TOOLS

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.

LOGBOOK
The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook.

SMART Setup

= ' | 0o
@ D |8 %

o Wy L N
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications DOV Grouping  Report Help
Logbook Shortcuts

The logbook stores information about the analysis in addition to allowing the following functions: batch
screening, seeing results at a glance from the data list pane and saving manual modifications made to the
landmarks during the analysis.

The logbook stores the following information: landmarks (type, position, dimension, including manual
modifications), indications (Al and conventional, label, position, dimension, etc.), indication grouping, and
data quality validation results. When enabled, an additional column is added to the data file list to allow
seeing results and to filter, sort, or analyze according to these results.
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22 of 22 data
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L0000 00000000 CK
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o
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The following table shows the possible icons and their meaning:

Icon Description Meaning
No logbook entry associated with this file because
(empty) Empty .
it has not been screened yet.
Logbook entry associated with the file contains
. . information such as landmark detection or regions.
Dashed outline circle, . . . .
. . The absence of additional information on the icon
() without a number e . .
- reveals that no indication detection engine or DQV
tests were enabled when the logbook was written.
Logbook entries associated with the file contains
information such as landmark detection as well as
. . . detected indications. The number displayed inside
. Dashed outline circle, with a . . .
{1} the circle shows the quantity of potential

s

number

indications detected.
No DQV tests were enabled when the logbook was
written.

Dashed outline circle, with a

green check mark

The green check mark indicates that the DQV
test(s) passed on this file.
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e Dashed outline circle, with a The red cross indicates that at least one DQV
e red cross test(s) failed on this file.
) ) ) The logbook entries associated with this file
Dashed outline circle, with a o L
. indicates that potential indications have been
{37 number, with a green check . .
- mark detected by the detection engine and that the DQV
test(s) passed.
The logbook entries associated with this file
(7% Dashed outline circle, with a | suggest that potential indications have been
- number, with a red cross detected by the detection engine and that at least
one DQV test(s) failed.
The Al detection tools identified an unusual
situation. In this case, the level of confidence in the
A Orange warning triangle detection findings could be very low. Therefore,
users should pay special attention when reviewing
the detection results.

The logbook is saved within the inspection folder. Its data is written when a file is screened using the
dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the
logbook is enabled, and no logbook entry existed for this file yet.

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been
detected with detection tools that do not use Al (conventional landmark detection and indication boxes).
Also note that the automatic indication detection tools are not available if you use the acquisition license

(ACQ).

LANDMARKS

The Landmarks button is used to setup the parameters for landmark detection with conventional tools.

Enable Wizard
Logboaok

SMART Setup
-~ o0
f-} { AT & +B8 U[‘T‘
Em W v | spn 6
Package Landmarks Indications | Landmarks [Regions Indications DQV Grouping Report Help
Shortcuts

The Landmark Detection window is used to configure the automatic detection of features such as tube
sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional
setup. They can however give a reference for the axial position in a tube. They can also be used by the
software to trigger automatic acquisition sequences.
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Bl Landmark Detection - [} X
Detection Channel: FICo4 - (Exitis used for
ence only)
. TsO e, TS|
Reporting From: ® StartRecord () Stop Record rm »
[ Negative Positioning: From |0.0 mm I
Stop ¥ Start
Detection Engine: Extended = Record I: I Record
Reporting from
Manual Sequence: [] (Check for Acquisition Detection) Length 0
Enable Detection
Landmark Table (in the order seen by the probe during data acquisition)
Name Tpe Pos. (mm) MinQty MaxQty Shape  Component Threshold (V) P2P (mm) Enable
Exit Exit 25 5 =5 1000000 Dicabled D
TSI TSI 0 -5 1000000 Enabled D
5 5 5 = 1000000 Enabled (%]
50 50 6000 P -+ 1000000 Enabled D
Floating Group Landmark Positioned Landmark
mport.. | [ Evport.. | [ suggest Ue = Add

Three landmarks are created if you press on the Suggest button. The channel selected to detect these
landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw.
This is the signal of the channel without software filter, rotation, or software gain applied.

You can base the position of your landmarks either on the location where you start to record (usually the
tube entrance, opposite from the operator position) or on the place you stop to record (usually the
operator side).

is used for
e only) T

Detection Channel: R_DIF-F1 ¥ (

Reporting From: (@) Start Record () Stop Record

[] Negative Positioning: From 0.0 mm

==

Stop Start
Detection Engine: Extended S Record |4 Record
L Reporting from
Manual Sequence: [] (Check for Acquisition Detection) Length
Detection Channel: R_DIF-F1 - (Exit is used for
] . TSO sequence only) TSI
Reporting From: ) StatRecord (@) Stop Record -
[ Negative Positioning: From 0.0 mm rm I
Stop 8  Start
Detection Engine: Extended S Record : ;: Record
Reporting from
Manual Sequence: [ (Check for Acquisition Detection) 0 Length

In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has
a negative position because this event happens before entering the tube. It is enabled only when doing
the acquisition.

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered
at the end of the acquisition.

Landmark detection can be set up manually by describing the shape, component, and voltage threshold
that will trigger the detection. The Shape describes the appearance of the signal when the landmark is
reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed.
The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to
trigger the landmark. And the Threshold is the voltage amplitude threshold.
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Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as
they will be automatically measured by the software. It's important to set the landmark positions as
accurately as possible. If the position is not accurately set, the software might prevent their automatic
detection since it won’t be at an expected position.

The Type field is a name that associates the calibration point with the landmark. If landmarks share the
same Type, they will be calibrated at the same time using the same point and process. To associate two
landmarks with the same Type, their signal must be the same. If support plates of the same geometry are
present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the
same Type because one is triggered when the probe goes inside the tube and the other is triggered when
the probe exits the tube.

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the
landmarks need to be entered with the right position. The system will look for the exact number of
landmarks entered at positions close to those entered in the table. With the Extended mode, the system
will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact
number of support plates don’t need to be constant or known.

REGIONS

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used
to categorize the data to process correctly. For example, they can be useful for restricting the detection
of channel saturation to an area within the tube or specify an automatic analysis type for a given region
(e.g., under the tubesheets).

SMART Setup
i (] an b | VB 5
o Wy L Y >
Enable | wizard Package Landmarks Indications | Landmarks|| Regions [ Indications  DQV Grouping Report Help
Logbook Shortcuts
Bl Region Detection X
Regions Details Preview
Name Name: Between —
_IZI Abbreviation: ; TSI (1SD)
Around lzl Location: Eetween v 5P (SP)
In Specimen BI el Al v 5P (SP)
Start Offsct: | 10.0mm : wEH
End Offset:  |-10.0mm : SP(SF)
SP (SP)
5P (SP)
' SP (5P)
srise
General Simulation Parameters SP(SP)
Landmark Thickness: |250mm  + SP(SP)
Floating Quantity Simulation E TS0 (TS0)
SP: 10 =
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If you are using the conventional detection tools, you can set up the regions according to the automatic

analysis tools you will use with the Indications and DVQ buttons (described later).

INDICATIONS

The Indications module allows the user to define various zones or even waveform types to trigger a certain

detection threshold.

Enable Wizard Package Landmarks
Logbook

SMART Setup ‘
AN | e “&
W L Y
Indications | Landmarks Regions JIndications| DQV

Grouping Report

Help
Shortcuts

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name

that will appear in the Code view.

Bl indication Detection
Detection Zones
Label Based on

PIT Channel F2DIF

Source

5
Details
Zone Type Zone
n E Inside Radius |01V B
Outside Radius | 2000V B
Orientation | 46° B
Aperture 850" B
Center (0,0)
Boundary
Increase by | 4ent B
Regions
Restrict to selected
Wi Duplicate | | =}= Add
[ ok ][ Cancel |[ Apply
LT P o
g = | x ]

There are five zone types:

2 Absolute pie

o Differential pie

[ | Centered rectangle

S Rectangle

= Over or under a horizontal or vertical threshold

And seven waveform types:

B Up
# - Down
$T Down-up
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¢+

Any direction

al

Up-down

31

Down-up-up

3

Up-down-up-down

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also
include the boundary setting to prevent signal oscillation from triggering unnecessary detections.

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating

the Edit Alarm option on the Current View tab.

The detected indication can be found in the Indication window, which can be activated in the Layout tab.

| Layout

L EBERER B D R == EREEE M

Select Manage Reload BackUp New Layout Replace Remove Split Infofield Cal. Infofield Data Report Dav Indications MNote Large

Acquisition

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip
chart view. If you click on an indication in the code view (described later), the associated indication is
highlighted in the Indications pane.

Indications oox

Label
IND

IND

IND

IND

| | - | | DIF- | F2‘ || 236V | 1 |

80.0 kHz £

IND

IND

IND

IND

IND

DATA QUALITY VALIDATION (DQV)

Data Quality Validation allows defining tests to validate the quality of the data.
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Enable
Logboaok

SMART Setup

% Q = D | ZE “:[f'DD

Wizard Package Landmarks Indications | Landmarks Regions Indications] DQV Grouping Report Help
Shorteuts

Five test types are available. To add a test, click on the Add button on the DQV page and select the test

type with the drop-down menu. Parameters associated with this test can be changed in the Details section
of the DQV window.

DOV Tests: Details
Enabled Test Type MName (Optional) Merge
Hardware Saturation |:| Range 10.0 mm =
Dead Channel |:| Regions
e N l:‘ Restrict to selected [Select
Add
| oK | | Cancel |

Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined
threshold. An amplitude that remains below the threshold throughout the scan indicates a dead
channel.

Landmark Detected: Verify the presence of all the selected landmark names in the Details section.
To validate full tube-length of straight bundles for ECT bobbin data using Al detection, select this
option and check the TSI and TSO landmarks. When Al setup for landmarks is completed and the
TWH calibrated, the DQV test will automatically use the Al results to perform the test.

Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows
grouping a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region,
for example, the areas inside the tube.

Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field
allows group a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region.

C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping
a zone together for which the test has failed. This function avoids having many notifications if the
test fails several times in one area. This test can be limited to a specific region.

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab.

378



Layout

B BB S ®E = S ERBE S M

Select Manage Reload BackUp Newlayout | Replace Remove  Split Infofield Cal. Infofield Data Report| DQV |[Indications Note A Lafgl‘:
cquisition
¥ oav 3 X
Test Result
Channel Saturation x Berors ©

Failures

Criteria

Hardware Saturation

o
Hardware Saturation @

¥ DQV Indications Note

GROUPING

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the
automatically detected indications.

SMART Setup ‘
— ao
| O | B
(+) “B
Enable | wizard Package Landmarks Indications Landmarl-cs Regions Indications Grouping] Report Help
Logbook Shortcuts

The Grouping menu offers a default configuration with three predefined categories:

e Support Plates
e  Critical

e Less Critical
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B Detected Indications Grouping — O X

Groups Details
Mame I:l Marme: |Critical
Support Plates I:l Amplitude Phase
_ I:l Channel: | DIF-F2 - Channel: | DIF-F2 -
Less Critical l:l Measure: | PP - Measure: | PP "
Min: 1.00v - Min: 0- -
Max: ] [10.00V Max: 120° -

Restrict to Regions

In Tube

Air to Air
[] Freespan
[] FreespanCal
[Tl

17150

[1sp

["] Hide unclassified indications

(1] | The default configuration will be applied. I |Resetto Default| | oK | | Cancel |

The Details section of each group shows the parameters defining the conditions that must be met for a
detected indication to be classified in this group. The user can modify all parameters.

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP)
measurement method, and Max/Min threshold values are set for amplitude and phase. For this group,
the criteria are limited to indications detected under the SP regions. As a result, the indications detected
under support plates for which all conditions are true will fall into this category.

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on
DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping
criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube
length data.

It should be noted that each automatically detected indication can only be categorized in a single group.
Also, the grouping operation is executed according to the order of the groups defined in the Groups list.
Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group.
If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be
categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does
not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single
indication will be categorized, and none can appear simultaneously in more than one group.

New groups can be created with custom parameters.
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Groups Details

Name

Mame: |Support Plates

[ [+

Amplitude Phase
Critical Channel: | ABS-F1 o Channel: | ABS-F1 "
Less Critical I‘E‘ Measure: | PP N Measure: | PP s
Min: 2,00V B Min: 2° =
Max: 1 [1000V = Max: 150° -

It is also possible to remove a group or use the up/down arrow keys to change the group priority within
the list.

Groups
Name +
Critical
Less Critical @

In the Front stage interface, the Grouping results will be displayed in the Indications pane.

Indications & X
10 of 10 results

Label Ampl. Phase

(~) Critical (4)

IND 1415V 82"

IND 340V GER

IND 278V 106 ®

IND 706 Y 16"

(~) Less Critical (4)

IND 102 v 11°
IND 1.00 v 40°
IND 127V 56 °
IND 113 W 73"

(~) Undlassified (2)
IND

IND

DOV Indications Mote
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the
Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom
of the Grouping menu and click on OK.

Bl Detected Indications Grouping - O #
Groups Details
Name MName: |Critical
Support Plates Izl Amplitude Phase
_ Channel: | DIF-F2 o Channel: | DIF-F2 v
Less Critical II| Measure: | PP = Measure: | PP v
Min: 1.00V = Min: 0° =
P [ |[10.00v M 120°° -

Restrict to Regions

In Tube

Air to Air
[] Freespan
[] FreespanCal
[Tl

[]Ts0

[]sp

Hide unclassified indications

0 l The default configuration will be applied. I |Resetto Default| |\/ oK | |x Cancel

Enabling this option influences the following elements of the software:

e Indications pane;
e Codeview;
e Logbook column.

The images below compare them when the Unclassified indications are shown (left) and when they are
hidden (right).

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the
header serves as a reminder to the user that not all indications are currently shown.
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Indications

26 of 26 results

Label Ampl. Phase
(&) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 084V 18°
IND 076V 17°
IND 1.20V 19°

(%) Undlassified (20)
IND

IND
IND
IND
IND

Indications

6 of 26 results

Label Armnpl. Phase
(~) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 0.84V 18°
IND 076V 17°
IND 120V 19°

OOV Indications Mote

OOV Indications Mote

In the Code view, the red markers from the Unclassified indications have been removed.
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In the data file list, the number shown in the Logbook column represents the number of visible indications,
matching the number shown in the header of the Indications pane.

Data 4 X Data 4 X
7 of 7 data hA 7 of 7 data
Row Cal 8 [el Row Cal 5 [el
201000001 v 201000001
201004005 201004005
| ~ 201006009 68 | ~ 201006009 ®
~ 201006016 ~ 201006016
v 201024022 v 201024022
v 201025017 v 201025017
v 201025019 v 201025019
El ED
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REPORT SHORTCUT

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is
possible to select a channel with a measurement method and to associate an indication with it.

SMART Setup ‘

Enable O
Logboaok

Wizard Package Landmarks Indications

oo
((‘ AT\ 1 . +O o1 '.D
Wy L | -
Landmarks Regions Indications DQV Grouping| Report Help
Shortcuts

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter

pits in the report.

| | Indication Based On
PIT Channel

- O o
!
Source Ampl. Measurer Phase Measurer Sizing Curve Shortcut
DIF-F2 Vpp PP DIF-F2 “| D b4
by

|V’ OK | |XCanceI |

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a
single key or a combination of keys such as ALT+D, for example.

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication
displays momentarily on the corresponding Lissajous.
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DATA SCREENING

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under
the Analysis tab.

|.6.nal1,-sis
? n |» oOBs R
% |% o 1|9
‘s ‘m [ (0 30 ¥ | g
Screening  Screening All Previous  Mext No " RST poiiew Msg  Capture | Subtraction
All Files Selected Files Defect

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files
when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed
in the Data window.

DATA LIST

Magnifi will save a file for each inspected tube. The file names are defined by creating a list of tubes.

This list can be created in the Data List section of the General tab of the Backstage.

Data List

MNaming Format: Row, Col s

Preview: 001001.magdata — =
| _ol |_@|

Create New List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending on the chosen
filename format.
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For the Row, Col option, enter the number of rows, the starting row number and row interval. You can
then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to

generate the list of tubes. You can also use the Create & New button to add another set of tubes to your
list.

[ . File List Creator @1

File List Cenfiguration

Mumber of Rows in Component: 1
Start Mumbering at Row: 1 -

Row Interval: 1 .

MNumber of Columns per Row:

Row Mb. of Columns
1 1
Column Interval: 1 -

-

Include first and last column of each row

Files to Create: 1
Filenarme Preview: 001001
[-l- Create & Mew | [ W Create l [ 4 Cancel |

b

The same principles apply to the other file formats, except for the Free format option for which the file
name(s) needs to be entered manually in the Data window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube list file can
be found in the Inspection folder. It is also possible to import a list created in the Tubepro software
(available from Eddyfi).
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button.
Click on the Connect button under the Instrument tab. This will open the Instrument
configuration page. Click on the line showing the instrument to which you want to connect and

then click Connect.
(M] OE i ¥ =

o Home Setup Advanced Instrument

SR e

Connect Setup  Disable Ch. Setup Info /o

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case,
ared and white Xicon will be shown in the Status field of the Instrument connection window. To download
a matching version to your Ectane, click on the Config. button and then click the Send firmware to the

instrument button of the Instrument configuration window.

. =0

Instrument Connection (Ectane)

Type Model MAC Address Host Details

e

Ectane2 | ET28RNMI  EC:92:33.00:01:49

Cancel

) —

Instrument Coenfiguration

Metwork Information Embedded Scftware Update

Made: ETETE - @ |Jse the embedded software that comes with Magnifi

Use custom embedded software

Two acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is used to
scan your calibration tube and make the necessary adjustments on your setup without saving the data

IP address: |152.168.15 .10

Subnet Mask: 255 255 255 0

Gateway: |0 0 .0 .0

4

L8

388



automatically. Acquisition mode is used for the inspection. In this mode, the software automatically saves

the acquired data using file names based on the tube list.

3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the

Home tab. This mode is active when the Setup Mode button is grayed.

Q Home
L o

Setup Mull
Fode

4. Plug the NFT probe on the Ectane 19-pin connector.

5. Bring the probe head in a clear area in your standard and balance the probe by clicking on the

Null button under the Home tab, or press F6 on your keyboard.
6. Push the probe head all the way through the tube so that it exits the tube.

7. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2

on your keyboard.
8. Pull the probe at approximately 12”’/s (300 mm/s).
9. When it’s done, press the Stop button or F2 again on your keyboard.

L 4w
OK 4 & = Magnifi®4.4RS5 - [Setup from original data file]..\Default\DemoDatad.2\NFT-BBAD. magdata

O Home Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

7| A EBRI ST ALDE

Mew  Locks Comp  Probe  Scan Datz  Process Landmark PCH‘ Calibrstion  Sizing  Indication Display

R R

‘ [-] ] ees.[rm)] [t ooy ] [] L] oF.] 7l [t rooov J4] [] [ ees ] F1l
E 300 Hz

5.00v 90° ? Y%
IEYEYEED [ cor ] cor )
[L] Jorr) | |
A 300 Hz ]
]
]
]
4.57v 90° i ? %bg
il | Vpp‘l “op | | 2% | M | \ COR | COR |
) Notification center Information Documentation Report
T T AT (ms) @ (smpl) @ (mm) & (mm) ¥ Lm (mm) [Speed (m/s) |AR (Hz)
I"f' M S1‘753 | 32‘153 | S{:gz ?zr;s | mgrg.n |TS’1"&§;2(T4 FE;B’; ) | agu © ~ NFT-BBAD o

Note that a red zone in the code pane means that at least one of the raw signals is saturated. This is usually

the case when your probe is out of the tube.
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VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes useful

functions to do so:

DISPLAYED CHANNEL

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These buttons

are

390

used for the channel selection.

1. 2. 3. 4
- DIF | F1

Fl F F F

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart
are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this
channel.

DREREEER E PR ED R T
158.4 kHz 158.4 kHz S

A
.

s

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the
desired channel to select it. Right-click or Left-click on this button to switch to the following or

previous channel in the list.
| | [ oF | Fi.
158.4 F1ABS

FIDIF
F2ABS
F2DIF
F3ABS
FIDIF
Land
MIX1

3. Same principle as 2., but for the type of channel only (absolute or differential.
4. Same principle as 2., but for the frequencies only.



STRIP CHARTS AXIS ORIENTATION

The Strip charts are projections of the Lissajous on the vertical or horizontal axis. To switch from one axis
to another, click on the box showing an arrow at the upper right corner of the Strip chart.

NI 1 400V |

158.4 kHz (

On the strip chart, hold the right button of your mouse and drag on the zone of interest to zoom in this
section.

ZOOMING

L] o] [mov o] [L]or ) E PR ED G
ki

158.4 khz 158.4 kiz Ts64 K

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.

PRERER [t 200v [=]
J “F

158.4 kHz

®_  Full Extent
% Adjust Cursor Size
3 BestFit

—++  Horizontal

View indications
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ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and
the full line is the center of what you have selected.

Only the portion of data between the dotted lines will be shown in the Lissajous.

To adjust your cursor length, hover your mouse over the dotted line, and click and drag the left mouse
button. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same
operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the
left button (decrease scale) or the right button (increase scale) of your mouse.

| oF | R, 1 756v Jepl | -] ] |1 =m0 i o7ssv
158.4 kHz F1DIF 158,84 khz
r

#

£
£
&

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the
scale button.

MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method.
A short description of the measurement methods can be found in the above calibration section of the
setup wizard.

1. 2 3. 4
Vep Ll pe L] 2P

[y}

=

1. Clicking on the corner with the black triangle gives the list of measurement method for the
amplitude of the signal. Click on the desired method to select it. Right- or left-click in this button
to select the next or the previous method in the list.

2. Same as 1., but for the phase measurement
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3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure
the phase with the right orientation.

4. Take the same two points in time to take the measurement in the other Lissajous

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw
a vector on your Lissajous.

LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of
your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on
the raw channels since these channels have no gain or rotated applied, by definition. Also, rotating the
signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous background
and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor at a point where you want the data to be
centered and use the spacebar on the keyboard.

CALIBRATION AND SIZING CURVES

CALIBRATION

The following section describes how to calibrate your probe.

1. Go to the Calibration tab and click on the System icon.
Select Channel in the Calibration window.

3. Inthe Strip chart, select the signal to calibrate and adjust the cursors to see only the desired
signal.

Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you select your calibration point. This will allow you to see what the system is using to make its
calibration. If for some reason the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.
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4 Calibration

S

@ Channel

Landmark

Channel and Sizing Curves

-

Exit
GR-60
HOLE
TSl
TS2

Calibrate

Reset

No vk

SI1ZING CURVES

The following section describes how to build your sizing curves.

1. Go the Calibration tab and click on the Sizing curve button.
2. Select Channel and Sizing Curves in the Calibration window.

Select the signal name in the list.

Click on the green arrow button to associate the measured signal to the calibration point.

If more than one calibration point is present in the list, repeat steps 3, 4 and 5 for each one.
When all your calibration points are checked marked, click on the Calibrate button.

3. Select the signal in your Strip chart and adjust the cursors to see only the desired signal.

Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you select your calibration point. This will allow you to see what the system is using to make its
calibration. If for some reason the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to
show the defect size. To have the correct interpolated point, the measurement method also needs to be
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the same as the one used for the sizing curve. To change the measurement method, click on the icons at
the bottom left of the Lissajous.

4. Select the signal name in the list.

5. Click on the green arrow.

6. Redo the previous steps for all the other indications in the list.
7. Click on the Calibrate button.

[-] ] o [F) 1wy | 4]

“| Calibration lﬂhj

Channel P

@ Channel and Sizing Curves

Landmark

Exit
GR-30
GR-60
HOLE
RBH-25
REH-50
RBH-75
Ts1
TS52

[ Calibrate |

[ Reset |

Sizing curves can also be adjusted manually. To do so, go to the Calibration tab, and click on View Curves.
The sizing curve window will appear. Each sizing curve you asked Magnify to create will be listed in the
drop-down menu. If an invalid notification is present on the curve, it means that you either haven’t
entered the sizing points yet, or that Magnifi failed to create the curve. To adjust the sizing curve manually,
enter the value in the table.

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws in the
Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw size does not
appear, it means that you are not in a channel where a sizing curve was set.

LANDMARKS

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks
window the same way you calibrated the sizing curve(s) points. You can use the Land channel to do so.
The positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the farside

395



tubesheet, that is, the first one encountered by the probe during data acquisition; TS1 is the nearside
tubesheet).

Once the landmarks are calibrated properly the system should be able to recognize them automatically.

Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far
end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button
under the Home tab. The displayed window will allow you to give an appropriate name to your setup and
to save it at the desired locations. The save location is, by default, your inspection file. Note that when a
data is saved, the setup is also saved with it.

r. Save Setup As lﬁw
. Setup
) Save setup in current inspection Browse.. |
File name: MNew setup
Mame
[v" QK ] [X{Zancel |

You can also save the data of your calibration standard by clicking on the Save As button under the Home
tab.
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STANDARD ACQUISITION

The following section describes how to perform an inspection.

1. Connect Magnifi to your instrument.

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab.
Acquisition Mode is activated when the Setup Mode button is not grayed.

3. Plugthe NFT probe into Ectane 19-pin connector.

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

5. Push the probe all the way through the tube until it exits the far end.

6. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2
on your keyboard.

7. Pull the probe towards you at a constant speed until it exits the tube.

8. When finished, press the Stop button or again F2 on your keyboard.

9. Repeat steps 4,5,6 and 7 for all the tubes to inspect in your bundle.

MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and
can trigger the acquisition start/stop and the data recording automatically. At least two landmarks are
needed to use this feature. These landmarks can be created by using the Landmarks button under the
SMART Setup tab.

To set the manual sequence:

1.

397

Click on the Manual Sequence button under the Calibration tab.

If a warning message is shown in this window, change the parameters until no warning is shown.
The system will progress through the different windows to guide you.

Click on Settings ...



8.

i '\ i '
= Sequence & Q Manual Sequence Configuration e

Sequence

/.\ Type: ) Mone @ Landmark
Start Recording Landmark: | Exit -
Launch . |

Start Recording Delay: 10s -

Stop Acquisition Landmarke  T51

Target Settings... Stop Acquisition Delay: 20s -
Restart
Type: () None ) UserInput @ Timer
MDD Review Delay: 100s -

. Pushing
. Pulling/Recording
. Waiting for Mext

0K l [ Cancel

You must be
connected to an
instrument to start
the sequence,

Connect... |

Select Landmark in the Type section

In the drop-down menu choose the Landmark that will initiate the data recording. If you keep
the default landmarks, you can select the Exit landmark that will be triggered when the probe
goes out of the tube when the probe is pushed.

You can enter a delay to start the acquisition after the first landmark is detected (Start
Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop
Acquisition Delay).

Two options are available to restart the acquisition: The user can either push a button or use a
timer. Select the desired option in the Restart section.

Click on OK.

To use the manual sequence:
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1.

Connect Magnifi to the instrument

Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab.
Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the NFT probe into the Ectane 19-pin connector.

Bring the probe head to a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

Open the Sequence window by clicking on the Manual Sequence button under the Calibration
tab.

Put your probe in the tube to inspect and click on the Launch button. This will start the data
acquisition.



7. Push the probe out of the tube. If set correctly, this will trigger the landmark that will start the
data recording.
8. Pull the probe until it exits the far end of the tube. If set correctly, Magnifi will recognize the
landmark and this will initiate the data recording.
9. Acquisition restart:
a. Ifyou selected User Input in the settings of the Manual Sequence Configuration, the system
will wait for the user to enter information on the tube to restart the acquisition. Click on
NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition.
Repeat steps 6, 7 and 8. for all the tubes to inspect.
b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown
will trigger after the last tube acquisition was taken. The acquisition will start after this time
has elapsed. Redo step 6 and 7 for all the other tubes to inspect in the bundle.

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is
the case, you won’t be able to catch the landmark that trigs the data recording at the end of the tube. In
this situation, you can click on the Target button in the Sequence window to start the data recording.

DATA LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the
Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be
found under the General tab of the Preference menu of the Backstage.

General (Setup Related)

Measurement Units

Report Units: | Millimeter

Preferences

Channels

Full Channel Scale: 2000V p-p 3

Hide Raw Channel

Precision
[] Enable

Amplitude: |2 decim...

General n
Phase 0 decim...

[ H Acquisition
Automatic File Recording

Display Auto Create new file on Next

Automatic Next on Stop acquisition

Analysis

The list of tubes is also shown in the Data window.

399



Data t X
22 of 22 data h A
Row Col ﬁ :

v 101000001 elia
v 101000002 (9%
v 101000003 iy
v 101001001 (16
v 101001002 (@)
v 10100200 (11
v 101002010 (14
101004005 (5"

[+ [=0] [@]

A common practice is to rescan your calibration tube and balance the probe periodically. You can save
this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can
go out of acquisition mode, scan your tube, and click on the Save Cal As... button under the Calibration
tab to save your data. You can then go back to acquisition mode to continue your inspection and to
automatically save the acquired tubes in your bundle.

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark
icon.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home
tab.

A tube name can be changed by right-clicking on its name and by selecting the Rename option.
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LOADING A FILE

1. First disconnect your computer to the Ectane by clicking on the Disconnect button under the
Home tab

2. You can load a file by double-clicking on the file name in the Data window. It can also be done
by selecting the file in the list and by clicking on the Load button under the Home tab. Note that
double-clicking on a tube when you are still connected to an instrument will initiate data
acquisition.

3. You can open the next or the previous file in the list by clicking on the Previous or Next button of
the Home tab.

The data files can be filtered by using the Filter button of the Data window.
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REPORT

INDICATIONS

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to
the report. These two buttons indicate the code that is associated with the defect being entered. Both
buttons are identical, but can be set to identify different flaws.

To add an indication to the data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous
includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect
to enter.

3. Click on the defect button to add an entry to the report.

1,] .| oF .| F, T o14sv 4] DIF | F1,[ |1 2783° |1 148V

158.4 kHz 158.4 kHz !

CRK
, DNT

4 DSl

./ ERO

/ NDD
; 0BS
; PIT
PLG
RST
WLL

&
0.4 119° 46.!
Vmp mp | CY 2P M COR

F] a4l
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Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is
explained in the SMART Setup section of this manual.

Indications can also be added to a tube to indicate, for instance, that it has no flaw or that it is plugged.
To add an indication to a tube:

1. Load thefile
2. Click on the appropriate indication button available under the Analysis tab

(M| OE 4 ¥ -

O Home Setup Advanced SMART Setup Instrument Calibration Analysis Layout Current View
(%] L ”m s s > oes =
fi l?" L7 10 0
| | < .3 < > PG &l
Screening Screening All Previous  Mext Neo Review Msg  Capture | Subtraction
All Files Selected Files Defect | RST
REPORT TABLE

To access the list of indications entered:

1. Make sure that the Report option is selected under the Layout tab.

Layout Current View

I. Infofield Data Report DOV Indications = Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible.

Report + X

Zone |Row  |Col” |Code Size Side Ampl. (V) Angle()  ChanneliCscan  Ypos (mm) LMK Y pos Offset Y pos. (mr Yleng. (mm)  Comment
1 0 0 0.00 0.00 0 0.0 0.0 00 x

2 0 0 0.00 0.00 0 0.0 0.0 0.0 x

A\ 2 new notifications Informatio

Entries in the report can be modified by changing the value in the table. You can also delete an entry by
clicking on the X next to it.

REPORT GENERATION
Magnifi can automatically generate a full report with the report table.
To generate this report:
1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.

403



2. Click on the Generate Report button under the Report section of the General tab.
3. Choose your preferences and enter the required parameters. The # of tubes in component is
used to show the percentage of tube in each category.

. Generate REF'IZII't o . Generate Report W

Section Selection
REPDH: Parameters Sections to Include in Report

Tube project parameters

Defect Table Format: | Tubing ECT *

Report Summary

[1 Show Empty Cells
Instrument Settings
Component Information

Picture: III

Inspection Summary
Date and Signature
Screen Captures

‘ # of tubes in component: | 50 - ‘

# of tubes in component: | &1 -

|xgancel | | ’ Mext | |XCanceI ||’ Next |

4. Click Finish to generate the report.

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed
using any regular web browser.

There is a “copy” button next to each element of the report such as tables and images. When clicking on
it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or
Word.

Eddyfi H i
Tecl'\{r"\.lologies AnalySIS Report @ s'ed:ry:nlag'les

Instrument Settings

Channels Instrument Settings

Channel Calibrations

Setup name: ECT-Bobbin
Mix Channels

Component
Information Channels
Inspection Summary
s Name Frequency (KHz) Drive (V) Gain (dB) Low Pass (KHz) High Pass (Cnt)
Inspection R_ABS-F1 160,0 2,50 460 400
Data

R_ABS-F2 80,0 2550 46,0 400

RABS-F3 40,0 2550 46,0 400

R_ABS-F4 20,0 250 46,0 400

R_DIF-F1 160,0 250 46,0 400

R_DIF-F2 80,0 2,50 46,0 400

R_DIF-F3 40,0 2,50 46,0 400
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The Print button, bottom right corner on image above, can be used to either print a paper copy of the
whole report or to save it as a .pdf document. The PDF generator available with the current web browser
will be used.

w023 153 Mo Roper:
" . Imprimer 4 pages
Analysis Report eoges P
Instrument Settings Destination B cnregistrer au formati ¥
Sonup nama: ECT-Babin
Channels Pages Tous
e o ey camiem e o
: o s Mise en page Portrait b
s “
s =
ransr 20 P - Plus de paramétres v

m Annuler
: - S “

The report logo can be modified by clicking on the Select Company Logo that can be found under the
System tab of the Backstage.

System (Computer Related)

Measurement Convention Measurement Units
Freere= @ asme @ Metric
) ASME Inverted e o Imperial
) EDF
Readback
D Do not display data during loading
Speed:

! Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
! Retain check state

General

@ Reset to checked after loading a data file
Display Setup Wizard Path: C\Users\daube  QTEC\Documents'MagnifitSetup

Automatic Features
D Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo
Preview:

o
‘a.. °
Select

Company Logo

The report table file in the Inspection folder can also be imported into other reporting software such as

Tubepro.
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NFA Probes
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INTRODUCTION

This procedure presents how to use an NFA probe with Magnifi and above on an Ectane test instrument.

EQUIPMENT

The NFA probes use a 160-pin connector that can be connected to an Ectane with the “E64’’ option.

The array section of the probe will provide a C-scan imaging and the conventional channel will display a

standard Strip chart / impedance plane signal for the absolute.

From the following table, the best probe for your application can be selected.

TUBE 00

mm in BWG
12
13

19.05 0750 1
15
10
1

2540 1.000 2
13
14
15
10

75 1250 1
12
13
10

3|10 1500 1

TUBEWT

mm
277
241
1
1.63
3.40
306
277
21
211
183
340
306
277
241
340
305
217
241

n
0,100
0.5
0,083
a2
0134
Q120
0109
[elli2 ]
0.083
.oz
0134
0120
0.10a
0.095
0134
0120
0.10e
0.095

COnE
124

DIAMETER

mm
12.4
130
133
14.2
17.0
180
184
188
194
20.0
230
et
24.4
250
.0
2.6
0.2
.8

in
0,463
o512
0.543
0,558
0,668
07
0724
0.740
0.78d
0.7a7
006
0.e29
0861
0,084
1.142
1.165
1.188
1.212

FRELL

CODE  RANGE

MF

1-A0kHz

PaLyY
CODE LENGTH
20 20mESH)
30 30mEeA)

The NFA calibration tube used in this document includes the following flaws:

e Internal taper groove, 30% of wall loss on 4in length

ID Round bottom hole 50% of wall loss, Diameter 0,138in

e |D Round bottom hole 50% of wall loss, Diameter 0,186in

e |D Round bottom hole 50% of wall loss, Diameter 0,375in

e |D Round bottom hole 50% of wall loss, Diameter 0,250in

e |D Round bottom hole 50% of wall loss, Diameter 0,312in

e Internal Groove 20 %

PROBE PART NUMBER
PRET-NFA-BBAN-1 24NF Dz
PAET-NFA -BBAR-1 30NF Mz
FRET-NFA-BRAL-1 38KF Mer
PRET-NFA-BBAS-1426F Mer
PRET-NFA-BBAA-1 TONF Dz
PAET-NFA-BBAL-1 BORF Mz
PRET-NFA-BBAL-1 BANF Mer
FRET-NFA-BBAL-1 BEKF Mer
PRET-NFA-BBAA-1 04MF Pz
PRET-FA-BBAL 200MF- ez
PRET-HFA-BRAL-2 3TMF-M
FRET-HF4-BRAY-2 3EMF-M=
PRET-NR4-BEAA-2 4AMF-M=
PRET-HFA-BEAA-250MF-Nz
PRET-HFA-BEAA-2DIMF-N=
PRET-MNFA-BEAA-205MF-N=
PRET-NR4-BEAA-302MF-Nz=
PRET-HR4-BEAA-20EAMF-N=

Other combinations of flaws can be used to calibrate the probe and to build sizing curves.
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PROJECT AND INSPECTION FILES

In this section, we will create a folder structure that will manage the saving location of your setup, data
and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different inspections
that are related in some way. For instance, it can include all the inspections done at a refinery shutdown
and be named Refinery_Shutdown_May_2018. The second level of the file is the Inspection folder.
Inspection folders are saved in the project file. An inspection folder can include the data specific to the
inspection of a tube bundle with a specific technology and could be named S5316_075x0.065_ECT for
instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.

PROJECT
(ex: Shell 04-17)

INSPECTION 1
(ex: Bundle No A1D3FX)

INSPECTION 2 INSPECTION X

| :

|
| |
| |
| |
| SETUP I

|
| |
| |
| l—‘ |
! i
| |
| |
| I
| TUBE |
i ust > DATA I
| |

|
| |
| |
| |
! i |
| l
| REPORT i
| |
| |
| |
! |
| |

e e ]
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When you open Magnifi, the first page displayed is called the Backstage.

Magnifi® 5.3B1T376 - [Setup from ariginal data file] - ECT-Babbin.magdata

General

Project / Inspection Information

Project Folder: Documents\Magnifi\Projects\Defa Probe: Unable to detect

]

Inspection Sub-
folder

Inspection Folder Doc jects\Defauit\DemeDatas | W)
Project Folder

Application: Generic

Tube Dimensions:

0D: 25.40 mm

Acg. Summary

Setup / Data

Setup Loaded: From eriginal data file WT: 1.65 mm

Setup Location: Jocuments\Magnifi\Projects\Defa é Length: 500 mm
Report Summary Create Setup | | Open Setup EplEE Material: ~ Stainless Steel 316

Data Loaded: ECT-Bobbin

Frequencies: 160.0, 80.0, 40.0, 20.0 kHz
Data List

Neming Format: | Row, Col v
Preview: £01001.magdata = =

Create New List| | Import List

Documentation

Report
Name Report.mdb v
T :
REEEs Table Profile: Tubing ECT - "
= Export Defect
i Table

[ Take screenshot with report entry

License

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an existing
project/folder, or you can create a new folder.

1. Create afolder by right-clicking on the location where you want to add your Project file. Select New,
Folder and enter the chosen name. You can then select the newly created folder and click on Select
Folder.

[ Select 3 project s
Q J* = PR )

Organize v New folder - v '
\
]
- = !
g
p
= Projects Folder
& Shortcut
8 Microsoft Access Database
& Bimapimage
[ Contact
81 Microsoft Word Document
= View » ] Microsoft Access Database
= Sort by » B Microsoft Project Document
Group by ? @' Microsoft PowerPoint Presentation
- Refresh @ Microsoft Publisher Document
[ SonicWALL Global VPN Client Document
=
e o Rich Text Format
z Undo Delete CtrteZ e i
= @7 Dessin Microsoft Visio
= hare with ’
= = Share it G Microsoft Excel Worksheet
New » B Briefcase
Properties I
Folder: Magnifi
| Select Folder Cancel
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Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your inspection.

Bl ranage >
l Inspections
o Manage Inspections Select Other...
MName State
Default

54179 _1inx0.120_MNFA |-E

|/ Select | |3 Close |

2. Click Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the New Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System
tab, you can change the measurement units from metric to imperial and vice versa. For the metric units,
you can choose to use meters, centimeters, or milimeters in the General tab. inchesThe default
measurement for imperial units is inches. When finished, click on Preferences again to go back to the
General window.

System (Computer Related)

Measurement Convention Measurement Units
Preferences @ ASME @ Metric

) ASME Inverted == Imperial
| EDF

Readback
D Do not display data during loading
Speed:
Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
Retain check state
@ Reset to checked after loading a data file

General

Setup Wizard Path:  C:\Users\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
[] Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Loga
Preview:

E, @ eddyfi

Shortcuts

Keyboard.. |
Remote... |

To create a new setup, it’s strongly suggested to use the Wizard option menu. Click on Create Setup to
start the Wizard.
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COMPONENT DEFINITION

The first page shown by the Wizard is the Component Definition.

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected.
If the material is not in the list, you can click on Manage... to open the List of Available Material window.

" Mew Setup Wizard x

n Component Definition -

0 Configure the geometry and material of the component to inspect

Geometry: ) Surface @ Tube from ID
Application: ® Generic () Air Conditioner
Material: Carbon steel V

Resistivity: 21 plcm

Permeability: 450 p

Velocity: 5890.000 m/'s
Wall thickness: 3.05 -

1
BWG

6 24
Dutside diameter: 25.40 mm -
Length: 6000 mm -

Mote about selected material:
ASTM: AT78, A179, A192, A210, A214

o] [B N

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant

name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is
used to set IRIS parameters only, and it doesn’t need to be set if an IRIS inspection is not performed on
this material.

It’s possible to add a note about the material to specify information such as its application or composition.
When you are done, click OK.

413



[y List of Available Materials

Custom Matenals

g

Browse...

Materials Co
MName 5:{;;;: ?r: /) [R;?i::;ty Permeability <+  Add
Stainless Steel 321 - ET ONLY 0.000 715 1 (| “ & Remaove Al
Stainless Steel 430 - ET ONLY 0.000 B3 100 (%

Stainless Steel Duplex - ET OMLY 0.000 74 75 |
Stainless Steel 9041 - ET ONLY 0.000 94 75 | ¥
Titanium 6070.000 486 1 (%€
Ti-6AI-4V - ET ONLY 0.000 123 1 (%
Zirconium 4650.000 a1 1| %

Motes About Selected Material

v ok J[X conce

You will be back to the Component Definition window. If you added a new material, it will now be available
in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider.
Enter the tube’s outer diameter and length.

These tube properties will help Magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION

In the Probe Selection window, you must select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique: drop-down menu.
More precise filtering can be done by using the Model drop-down menu. You can then select your probe
by its catalog number (PRBT-NFA-BBAA) and then click Next.

PRET-MFA-BBAA-170MF

PRET-MFA-BBAA-184MF

5+ Mew Setup Wizard *
’ Probe Selection -
Select the probe that you want to use for your inspection
™~
Technique: | MFT v | Model: MNFA v
Probes
Tech. Model Catalog Mumber Y | Description -
MNFT MFA PRET-NFA-BEAA-130MF MNFA probe, ABS with array receivers (2x3), diameter 13.0 mm, MF frequency range.
MNFT MFA PRET-MNFA-BEAA-138MF NFA probe, ABS with array receivers (2x9), diameter 13.8 mm, MF frequency range.
MNFT MFA PRET-MFA-BEAA-142MF NFA probe, ABS with array receivers (2x10), diameter 14.2 mm, MF frequency range.
MFT MEA PRET-MFA-BBAA-162MF MNF& probe, ABS with array receivers (2x12), diameter 16.2 mm, MF frequency range.

MF& probe, ABS with array receivers (2x13), diameter 17.0 mm, MF frequency range.

MFA probe, ABS with array receivers (2x14), diameter 18.4 mm, MF frequency range.

MFT MEA PRET-MF&-BBAA-188MF MNF& probe, ABS with array receivers (2414), diameter 18.8 mm, MF frequency range.

MFT MEA PRET-MFA-BBAA-T134MF MNF& probe, ABS with array receivers (2x15), diameter 19.4 mm, MF frequency range,

MNFT MFA PRET-MNFA-BEAA-200MF MNFA probe, ABS with array receivers (2x15), diameter 20.0 mm, MF frequency range. v
|g& New... | |§=‘E Manage... |

|x Cancel | |" Back | | ’ Mext |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the acquisition
rate and the typical probe speed.

7+ New Setup Wizard X % New Setup Wizard e

Sean Definition ] Scan Definition

Configure the type of scan you will be performing with your probe Encoder and axis settings

Scan: Single Pass Circular Axis Al Axis

Offset: Offset: 0,000 mm

Probe Resolution:

Clock ‘ Displayed Resolution: | 0.200 mm/smpl
Displayed Resolution: | 6.425 */smpl :
1500 He : Size 60000 mm

Size:

Aca

Typical probe speed: [ 1000.0 mmy/s

Oversampling; 2x Ml

[X Grea | [€ e | [B R Goncel | [ B | (B mer ]

The position along the tube can be defined by using either the internal clock of the system, or by using an
axial encoder. If you use the internal clock, the default position will be given assuming that the probe is
always pulled at the typical probe speed. If the typical probe speed is set to 300mm/s, and the time since
the acquisition began was 2 seconds, then the system will indicate a position of 600mm. Using an encoder
will give you the exact position of the probe. Note that the position can also be obtained by using the
landmark tool, but this feature will be shown later.

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate
is set to 1500 Hz for NFA.

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For instance,
with an acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least 2 points
per millimeter. If you do not use a pusher-puller device such as the Probot, the pulling speed won’t be
constant. Therefore, it is recommended to target a lower pulling speed to be able to reach your axial
resolution target. The typical probe speed should be set as close as possible to the real value. This will
help the algorithm that automatically detects landmarks (this will be explained in the Landmarks section).
The recommended pulling speed for NFA is approximately 300mm/s.

The Probe Resolution (Circular Axis) is defined by 360° divided by the number of pancake coils located on
the circumference of the NFA probe. For this instance, the 18mm NFA have 28 coils, so the resolution is
12.85°. The Displayed Resolution (Circular Axis) is the number of points displayed in the C-scan and it is
defined by the Probe Resolution divided by the Oversampling (interpolation).

The Displayed Resolution (Axial Axis) is defined by typical probe speed divided by the Acquisition rate.

The size is the length of the tube to be inspected. The length needs to be set accurately for the Landmarks
work in Magnifi.
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If you select to measure the position from Encoder, different fields will appear, and a second Scan
Definition page will become available.

% New Setup Wizard S| % New Setup Wizard ()
Scan Definition | ] Scan Definition
Configure the type of scan you will be performing with your probe Encoder and axis settings
oA g2k Gircular Axis Axial Axis
Main Scan Axis: Y Axis Offset; 0 Offset: 0,000 mm
Position from: Encoder ~] Ceisbzdliim: L 7eng] Displayed Resolution: | 0.500 mm/smp!
Displayed Resolution: |6.425 /smpl
Detect Overspesd Size: 6000.0 mm
Typical probe speed: 3000 mm/s. : et =2
Maximum probe speed: 4500 mm/s Oversampling: 2x -
Density: 2,000 smpl/mm
Axial Encoder
Type: [Quadrature =
Resolution: 25 460 % count/mm
] Invert direction
Preset: 0000 mm :
Apply preset on Start
(3 cancel | (4 Back | [P Net (3 cancel | (4 Back |[B nex |

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered.
The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the
number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition
rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a
speed exceeding the Maximum probe speed, there will be gaps in the data.

The second page includes the type of encoder and its resolution. A preset can also be specified if your
acquisition doesn’t start at 0 mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute
and Array channels. It is important to set these parameters correctly before acquiring the data since they
are driven by the instrument and cannot be modified during the analysis. But NFA the set frequency will
not change.

#* New Setup Wizard X

b Data Definition |
Select the C-scans you will be using and the necessary frequencies

Connector: ® 160 pins

#* New Setup Wizard X

b Data Definition

* Select you wil ing and y frequencies

Gain

23d8

C-scans
Mame
RAW

Required frequencies

Prefix Val (kHz)
Fl 80

Ampl (V)
10.00

Phase (7)
00

‘ Gain: |43 dB

Channels
Mame
ABS

Required frequencies
Prefix Val (kHz)
M8

Ampl (V)
1000

Phase (7)

00

CIRC
P

Suggest Add Suggest Add

[ cancel | [q Back | [P Neat [ cancel | [q Back | [P Nt

By default, Magnifi suggests one frequency set by default to 8kHz.

But frequency and drive voltage can be changed by replacing the value of your choice. Up to 4 frequencies
can be set at the same time. And the sum of their amplitude cannot exceed 10V. Also, the Absolute
channel(s) cannot use a different frequency than the Array channel(s). They are linked together.

Click on Next when the desired parameters are entered.
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DATA PROCESSING

The Data Processing window is used to configure the signal processing to apply to the channels.

You can choose to configure every frequency individually or you can apply the same filters to every
channel with the Individually configure all the channels check box.

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can
be changed without any problem during data analysis, while a wrong parameters choice for the data
acquisition can mislead the analysis. It is possible to change the filters parameters after the acquisition,
so it is always possible to fine tune the filters parameters during the analysis.

% Mew Setup Wizard *

5  DataProcessing ]

! Select the processings that you want to apply to the C-scans you have selected

[] Individually configure all the C-scans

Low Pass Median High Pass
MName ‘ Cutoff (Hz) Window Size (smpl)
CIRC 1 200 201
PIT 1 200 201
RAawW 1 200 1 11

|x Cancel | |‘ Back | |’ Mext
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"+ Mew Setup Wizard *

P\ Data Processing ]

! Select the processings that you want to apply to the channels you have selected

[[] Individually configure all the channels

Low Pass Median High Pass
MName : Cutoff (Hz) Window Size (smpl)
ABS O 167 [ 225

|x Cancel | |4 Back | |’ Mesxt |

The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful
when your defect signal has a lower frequency content than the background noise. In this case, using a
filter will remove part of the noise without removing the defect’s signals. This may help with data analysis.
However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too
low will filter out the defect’s signals.

The median high pass filter is used to filter out low frequency noise such as lift-off variations of the probe
within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of the high-
pass median filter should be set to at least three times the axial length of the longest flaw that may be
encountered. Data should be examined in both its filtered and unfiltered states. It is important to keep in
mind that the median high-pass filters can distort phase. More information about median filters for NDT
analysis can be found on Eddyfi’s blog.

Click Next when you are done.
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CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These indications will
later be used to calibrate your probe and to build sizing curves.

The units of measurement can be set in percentage or in depth (millimeters or inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and
size. The side and size of the flaw will be used to position the calibration point on the sizing curve(s).

Calibration points can also be imported with the Import button.

" New Setup Wizard *
Calibration Points _

@ Configure calibration points used for channels and sizing curves

Units of measurement: | Percentages (%) b

Calibration points

Mame Side Size

6R-20 D 200 %]
DO NOT USE Unknown 00 ]
T51 Unknown 0.0 |z|
Ts2 Unknown 0.0 |Z|
REH-25.9.5mm ID 250 %]
REH-75_9.5mm D 750 %]
REH-50_3.5mm ID 500 %]
REH-25_2.5mm D 250 ¥
REH-75_3.5mm ID 750 ]
GR-40 D 400 ¥
TAPER-20 D 200 ]
TAPER-60 D 600 %
REH-50_9.5mm D 500 @
REH-25_4.7mm D 250 ]
REH-25_6.3mm D 250 %]
REH-25_7.8mm ID 250 ]
REH-50_4.7mm D 500 %
REH-50_6.3mm ID 500 %]
REH-50_7.9mm D 500 ¥
RBH-75_4.7mm D 750 ]
REH-75_6.3mm D 750 %
REH-75_7.9mm D 750 |z|
Exit Unknown 0.0 |z|

é Import
|x Cancel | |4 Back | | P Mext |

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).

CALIBRATION

The Calibration pages are used to define reference signal(s) that will be used to set the amplitude(s) and
phase(s) of each channel using the selected measurement method.
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By default, the calibration is performed on the 9.5mm 50% round bottom hole for the array channels. The
angle will be 90° for CIRC channel and 42° for PIT and RAW. For all array channels the voltage will be set
to 2V. For the conventional channel the GR-20 is set to 2V, 90°. However, the calibration can be done
differently on each channel type. It can also be done individually for each frequency by selecting the
Individually configure all the channels option. Different reference signals can be set to calibrate the phase
and the amplitude independently.

= Mew Setup Wizard d

O calibration ]

= Configure parameters to calibrate C-scan amplitude and phase

[] Individually configure all the C-scans

Amplitude Phase
MName Voltage (V) Reference Measurement Angle (7] Reference Measurement 5G
CIRC 2.00 RBH-30_%.5mm Pp 90.0 RBH-50_9.5mm PPF
PIT 2.00 RBH-30_%.5mm Pp 42.0 RBH-50_5.5mm PPF
RAW 2.00 RBH-30_%.5mm Pp 42,0 RBH-50_9.5mm PPF

5G: Single Gain and Phase

|x Cancel | |‘ Back | |’ Mext
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5 New Setup Wizard d

O calibration ]

A Configure parameters to calibrate channel amplitude and phase

[ Individually configure all the channels

Amplitude Phase
Mame Voltage (V) Reference Measurement Angle (%) Reference Measurement
ABS 2.00 GR-20 PPF 80.0 GR-20 PPF

|x Cancel | |< Back | P Net |

When you select the reference signal, the system will use the selected measurement method to apply a
rotation and a gain. Here is a short description of the available options:

1. Absolute (A):
Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude.

2. Absolute Horizontal (AH):
Uses only the horizontal component, from the Lissajous origin to the main cursor position to
measure amplitude.

3. Absolute Vertical (AV):
Uses only the vertical component, from the Lissajous origin to the main cursor position to
measure amplitude.

4. Absolute Peak (AP):
Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure
amplitude.
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10.

11.

12.

13.

Absolute Peak Horizontal (APH):
Uses only the horizontal component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

Absolute Peak Vertical (APV):
Uses only the vertical component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

Average Peak (MP):
Takes the distances from points at the extremity of the cursor to the peak of the data selection
to build an average vector. Used only and recommended for absolute signals.

Average Peak Horizontal (MPH):
Uses the horizontal component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

Average Peak Vertical (MPV):
Uses the vertical component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

Peak to peak (PP):
Uses the combination of the vertical and horizontal component to measure the maximum
amplitude.

Horizontal (PPH):
Uses only the horizontal component to measure the amplitude.

Vertical (PPV):
Uses only the vertical component to measure the amplitude.

Peak to peak First Transition (PPF):

Uses the combination of the vertical and horizontal component of the first transition of the signal
to measure maximum amplitude. The first signal transition is from the base of an indication to its
peak.Click on Next went the parameters in the table are set according to your requirements.



SI1ZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this
table.

%% Mew Setup Wizard it

/\ Sizing Curves ]

Add and configure the sizing curves necessary for your inspection

D Mame Measure From Source Measurement

T TAPER Channel F1ABS Amplitude @
G GROOVE Channel F1ABS Amplitude |z|
20 PIT 3.50mm C-scan'y PIT Amplitude @
28 PIT 4.73mm C-scan'¥ PIT Amplitude |z|
33 PIT 8.35mm C-scan'y PIT Amplitude @
43 PIT 7.93mm C-scan'¥ PIT Amplitude |z|
55 PIT 9.52mm C-scan'y PIT Amplitude @

|x Cancel | |‘ Back | |.’ Next |

The sizing curve will allow you to estimate the size of a defect based on the calibration points signals
amplitude obtained with your calibration standard. Magnifi will give you the interpolated flaw size based
on the built sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be changed.
You can add sizing curves by clicking on the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window will appear to configure the curve properties.
The name of the curve will be shown in the upper left corner of the page (TAPER in the example below).
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5 New Setup Wizard d
Sizing Curves -]
A Configure the properties of the TAPER sizing curve
Measurement method: PP w e
ez BFL o Marme Side Size
[] Report as remaining wall TAPER-30 . 00 T
[] Force to zero TAPER-60 1D 0.0 A
[] GR-20 1D 20.0
[ ] RBH-254.7mm D 25.0
[] RBH-25_3.5mm ID 25.0
[ ] RBH-25_79mm ID 25.0
[] RBH-25.9.5mm ID 25.0
[ ] RBH-25_6.3mm ID 25.0
[] GR-40 1D 40.0
[ ] RBH-50_4.7mm D 50.0
[] REBH-50_9.5mm D 50.0
[ ] RBH-50_3.5mm ID 50.0
[] REBH-50_7.9mm ID 50.0
[l RRH-50 f.3mm D S0.0
| 20 Cancel | |‘ Back | | b Net |

The measurement method options are the same as what is described in the calibration section of this

document. By default, the peak-to-peak option is set for all channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of

the available options:

1.
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Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side calibration
points with respect to phase.

Best Fit (Dual Slope) (for phase measurement only):

A curve with two segments representing ID and OD (or Near and Far) side. The ID section is
linear and the OD section is polynomial. The OD side of the curve will need at least three points
(including the hole) in order to trace a polynomial curve.

Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured calibration points (requiring at
least three points).

Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.



5. Best Fit (Linear) (for phase and amplitude measurements):
Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD side of the curve.
Need at least three points.

The linear options are mostly used when few data points are available, while the Best fit (Dual Polynomial)
option is a more precise method when your calibration tube has multiple defects.

Once the measurement method and the interpolation curve shape are chosen, you can select the curve
points for each sizing curve previously created. The order in which the points appear in the list may
influence your sizing cure. Make sure that the measured values of the calibration points are in ascending
order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking
the box Report as remaining wall thickness.

Click Next when you are done.
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INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when analyzing
the data.

%% Mew Setup Wizard it

== _ Indication Codes ]

0 Configure the indications codes used for the report

Code Description Type Automatic Celor

COR Corrosion Defect @
CRK Crack Defect X]
DNT Dent Defect @
D3l Distorted support indicatic  Defect |Z|
ERO Erasion Defect @
MDD Mo defect detected Mo indication |Z|
0BS Obstructed Feature I" Red @
PIT Pitting Defect X]
PLG Plugged Feature I" Brown @
RST Restricted Feature I Yellow |Z|
WLL Wall loss long Defect @
WLS Wall loss short Defect X]
WLT Wall loss taper Defect @

2 Import | | =)= Add
(% Concel | |4 Back | [P Nea |

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.

You can modify the default indications codes list by changing the parameter in the table. New indications
can be defined by clicking on the Add button.

Click Next when you are done
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DiISPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.

5 New Setup Wizard d
F Display ]

Configure display and layout properties

General options Lissajou / Strip chart options

Zoom behavior on stop acquisition: [ ] Miniature strip chart

() Zoom to full scale
Proportion: 33.00 %
() Zoom to content _ o
Display Direction: Top to Bottom N

(® Keep current scale . : ) . .
Strip chart duration:  Currently linked with the C-5can size

C-scan options

Scan axis scale displayed during acquisition: QOrientation:

(@ Entire C-scan

i Sca Scan
() Specific scale: | 0.0 mm | T { | | I [ |

Index] JIndex

|x Cancel | |" Back | P Net |

The scroll direction is the direction in which data appears on the screen. If you choose downward, the
signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal
will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box.
The strip chart duration is the length of a Strip chart window when the data is acquired.
Click Next.

The second Display window is used to set the layouts. Checking the tick boxes in this window will make
the proposed layouts available in your setup. You will be able to switch from one the another via the
layout tab The " C " stands for code, " S " stands for Strip chart," L " for Lissajous, " CS " for C-scan and " CS-
3D " for 3D C-scan.

The layout with the blue background will be the one opened by default, which can be changed to your
desired option.
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Layouts can be readjusted at any time.

%% New Setup Wizard >
F Display |
. Select the layout that you want to use to display your inspection results
1 Strip chart, 1 C-scan, 2 Lissajous, 13D 1 Strip chart, 2 C-scans, 3 Lissajous
L L L
s [ 1lds|cs|cs
Cs-3D0 L|L
1 Strip chart, 2 C-scans, 4 Lissajous 1 Strip chart, 3 C-scans, 4 Lissajous
L|L L]L
[ 1lds|cs|cs [ s
L|L L]t
. : Default layout
) Help | 2 Cancel | | 4 Back | |\/ Finish

Click Next to complete the setup wizard process.

SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the
parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button
associated with the parameter you want to change.

Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View
N ™ E.i @ ¢ —
J’ —
o N T Y A N S B3
Comp Probe Scan Data Process Landmark P':_al Calibration  Sizing Indication Display
oints

This will open one of the windows previously described, where you can change the values you originally
entered. If applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.
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Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed
using advanced settings, the information shown using the Setup tab may not match your actual setup.

SMART SETUP TOOLS

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.

LOGBOOK
The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook.

SMART Setup

— ' | 0o
0@ D |8 %
o W L AN
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications DQV Grouping Report Help
Logbook Shortcuts

The logbook stores information about the analysis in addition to allowing the following functions: batch
screening, seeing results at a glance from the data list pane and saving manual modifications made to the
landmarks during the analysis.

The logbook stores the following information: landmarks (type, position, dimension, including manual
modifications), indications (Al and conventional, label, position, dimension, etc.), indication grouping, and
data quality validation results. When enabled, an additional column is added to the data file list to allow
seeing results and to filter, sort, or analyze according to these results.
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The following table shows the possible icons and their meaning:

Icon Description Meaning
No logbook entry associated with this file because
(empty) Empty .
it has not been screened yet.
Logbook entry associated with the file contains
. . information such as landmark detection or regions.
Dashed outline circle, . . . .
. . The absence of additional information on the icon
() without a number e . .
- reveals that no indication detection engine or DQV
tests were enabled when the logbook was written.
Logbook entries associated with the file contains
information such as landmark detection as well as
. . . detected indications. The number displayed inside
. Dashed outline circle, with a . . .
{1} the circle shows the quantity of potential

s

number

indications detected.
No DQV tests were enabled when the logbook was
written.

Dashed outline circle, with a

green check mark

The green check mark indicates that the DQV
test(s) passed on this file.
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e Dashed outline circle, with a The red cross indicates that at least one DQV
e red cross test(s) failed on this file.
) ) ) The logbook entries associated with this file
Dashed outline circle, with a o L
. indicates that potential indications have been
{37 number, with a green check . .
- mark detected by the detection engine and that the DQV
test(s) passed.
The logbook entries associated with this file
(7% Dashed outline circle, with a | suggest that potential indications have been
- number, with a red cross detected by the detection engine and that at least
one DQV test(s) failed.
The Al detection tools identified an unusual
situation. In this case, the level of confidence in the
A Orange warning triangle detection findings could be very low. Therefore,
users should pay special attention when reviewing
the detection results.

The logbook is saved within the inspection folder. Its data is written when a file is screened using the
dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the
logbook is enabled, and no logbook entry existed for this file yet.

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been
detected with detection tools that do not use Al (conventional landmark detection and indication boxes).
Also note that the automatic indication detection tools are not available if you use the acquisition license

(ACQ).

LANDMARKS

The Landmarks button is used to setup the parameters for landmark detection with conventional tools.

Enable Wizard
Logboaok

SMART Setup
-~ o0
f-} { AT & +B8 U[‘T‘
Em W v | spn 6
Package Landmarks Indications | Landmarks [Regions Indications DQV Grouping Report Help
Shortcuts

The Landmark Detection window is used to configure the automatic detection of features such as tube
sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional
setup. They can however give a reference for the axial position in a tube. They can also be used by the
software to trigger automatic acquisition sequences.
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Bl Landmark Detection - [} X
Detection Channel: FICo4 - (Exitis used for
ence only)
. TsO e, TS|
Reporting From: ® StartRecord () Stop Record rm »
[ Negative Positioning: From |0.0 mm I
Stop ¥ Start
Detection Engine: Extended = Record I: I Record
Reporting from
Manual Sequence: [] (Check for Acquisition Detection) Length 0
Enable Detection
Landmark Table (in the order seen by the probe during data acquisition)
Name Tpe Pos. (mm) MinQty MaxQty Shape  Component Threshold (V) P2P (mm) Enable
Exit Exit 25 5 =5 1000000 Dicabled D
TSI TSI 0 5 -5 1000000 Enabled D
5 5 5 = 1000000 Enabled (%]
50 50 6000 P -+ 1000000 Enabled D
Floating Group Landmark Positioned Landmark
mport.. | [ Evport.. | [ suggest Ue = Add

Three landmarks are created if you press on the Suggest button. The channel selected to detect these
landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw.
This is the signal of the channel without software filter, rotation, or software gain applied.

You can base the position of your landmarks either on the location where you start to record (usually the
tube entrance, opposite from the operator position) or on the place you stop to record (usually the
operator side).

Detection Channel: R_DIF-F1 i3 ( is used for

e only) T

Reporting From: (@) Start Record () Stop Record

[] Negative Positioning: From 0.0 mm

==

Stop Start
Detection Engine: Extended S Record |4 Record
L Reporting from
Manual Sequence: [] (Check for Acquisition Detection) Length
Detection Channel: R_DIF-F1 - (Exit is used for
] . TSO sequence only) TSI
Reporting From: ) StatRecord (@) Stop Record -
[ Negative Positioning: From 0.0 mm rm I
Stop 8  Start
Detection Engine: Extended S Record : ;: Record
Reporting from
Manual Sequence: [ (Check for Acquisition Detection) 0 Length

In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has
a negative position because this event happens before entering the tube. It is enabled only when doing
the acquisition.

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered
at the end of the acquisition.

Landmark detection can be set up manually by describing the shape, component, and voltage threshold
that will trigger the detection. The Shape describes the appearance of the signal when the landmark is
reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed.
The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to
trigger the landmark. And the Threshold is the voltage amplitude threshold.
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Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as
they will be automatically measured by the software. It's important to set the landmark positions as
accurately as possible. If the position is not accurately set, the software might prevent their automatic
detection since it won’t be at an expected position.

The Type field is a name that associates the calibration point with the landmark. If landmarks share the
same Type, they will be calibrated at the same time using the same point and process. To associate two
landmarks with the same Type, their signal must be the same. If support plates of the same geometry are
present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the
same Type because one is triggered when the probe goes inside the tube and the other is triggered when
the probe exits the tube.

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the
landmarks need to be entered with the right position. The system will look for the exact number of
landmarks entered at positions close to those entered in the table. With the Extended mode, the system
will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact
number of support plates don’t need to be constant or known.

REGIONS

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used
to categorize the data to process correctly. For example, they can be useful for restricting the detection
of channel saturation to an area within the tube or specify an automatic analysis type for a given region
(e.g., under the tubesheets).

SMART Setup
i (] an b | VB 5
o Wy L Y >
Enable | wizard Package Landmarks Indications | Landmarks|| Regions [ Indications  DQV Grouping Report Help
Logbook Shortcuts
Bl Region Detection X
Regions Details Preview
Name Name: Between —
_IZI Abbreviation: ; TSI (1SD)
Around lzl Location: Eetween v 5P (SP)
In Specimen BI el Al v 5P (SP)
Start Offsct: | 10.0mm : wEH
End Offset:  |-10.0mm : SP(SF)
SP (SP)
5P (SP)
' SP (5P)
srise
General Simulation Parameters SP(SP)
Landmark Thickness: |250mm  + SP(SP)
Floating Quantity Simulation E TS0 (TS0)
SP: 10 =
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If you are using the conventional detection tools, you can set up the regions according to the automatic
analysis tools you will use with the Indications and DVQ buttons (described later).

INDICATIONS

The Indications module allows the user to define various zones or even waveform types to trigger a certain
detection threshold.

Enable Wizard
Logbook

Package

Landmarks

SMART Setup ‘
AN | e “&
W L Y
Indications | Landmarks Regions JIndications| DQV

Grouping Report

Help
Shortcuts

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name

that will appear in the Code view.

B indication Detection % INER D T o
Detection Zones —— e
Label Based on Source Zone Type Zone
PIT Channel F2DIF ‘ Iz‘ Inside Radius LARAY -
Qutside Radius | 20.00 V -
Orientation 46° =
Aperture 85.0° B
Center (0,0)
Boundary
Increase by dent =
Regions
Restrict to selected
'
[ ok ][ Cancel |[ Apply
LT P o
g = - 4 x ]
There are five zone types:
2 Absolute pie
o Differential pie
[ | Centered rectangle
- Rectangle
Sirs Over or under a horizontal or vertical threshold

And seven waveform types:

B Up
# - Down
$T Down-up
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¢+

Any direction

al

Up-down

31

Down-up-up

3

Up-down-up-down

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also

include the boundary setting to prevent signal oscillation from triggering unnecessary detections.

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating
the Edit Alarm option on the Current View tab.

The detected indication can be found in the Indication window, which can be activated in the Layout tab.

| Layout

L EBERER B D R == EREEE M

Select Manage Reload BackUp New Layout Replace Remove Split Infofield Cal. Infofield Data Report Dav Indications MNote Large

Acquisition

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip

chart view. If you click on an indication in the code view (described later), the associated indication is
highlighted in the Indications pane.

Indications oox

Label
IND

IND

IND

IND

| | - | | DIF- | F2‘ || 236V | 1 |

80.0 kHz £

IND

IND

IND

IND

IND

DATA QUALITY VALIDATION (DQV)

Data Quality Validation allows defining tests to validate the quality of the data.
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Enable
Logboaok

SMART Setup

% Q = D | ZE “:[f'DD

Wizard Package Landmarks Indications | Landmarks Regions Indications] DQV Grouping Report Help
Shorteuts

Five test types are available. To add a test, click on the Add button on the DQV page and select the test

type with the drop-down menu. Parameters associated with this test can be changed in the Details section
of the DQV window.

DOV Tests: Details
Enabled Test Type MName (Optional) Merge
Hardware Saturation |:| Range 10.0 mm =
Dead Channel |:| Regions
e N l:‘ Restrict to selected [Select
Add
| oK | | Cancel |

Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined
threshold. An amplitude that remains below the threshold throughout the scan indicates a dead
channel.

Landmark Detected: Verify the presence of all the selected landmark names in the Details section.
To validate full tube-length of straight bundles for ECT bobbin data using Al detection, select this
option and check the TSI and TSO landmarks. When Al setup for landmarks is completed and the
TWH calibrated, the DQV test will automatically use the Al results to perform the test.

Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows
grouping a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region,
for example, the areas inside the tube.

Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field
allows group a zone together for which the test has failed. This function avoids having many
notifications if the test fails several times in one area. This test can be limited to a specific region.

C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping
a zone together for which the test has failed. This function avoids having many notifications if the
test fails several times in one area. This test can be limited to a specific region.

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab.
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Layout

B BB S ®E = S ERBE S M

Select Manage Reload BackUp Newlayout | Replace Remove  Split Infofield Cal. Infofield Data Report| DQV |[Indications Note A Lafgl‘:
cquisition
¥ oav 3 X
Test Result
Channel Saturation x Berors ©

Failures

Criteria

Hardware Saturation

o
Hardware Saturation @

¥ DQV Indications Note

GROUPING

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the
automatically detected indications.

SMART Setup ‘
— ao
| O | B
(+) “B
Enable | wizard Package Landmarks Indications Landmarl-cs Regions Indications Grouping] Report Help
Logbook Shortcuts

The Grouping menu offers a default configuration with three predefined categories:

e Support Plates
e  Critical

e Less Critical
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B Detected Indications Grouping - O X

Groups Details
Name I:l Mame: |Critical
Support Plates |:| Amplitude Phase
_ I:l Channel: | DIF-F2 = Channel: | DIF-F2 <
Less Critical I:' Measure: | PP = Measure: | PP "
Min: 1.00V = Min: 10° =
Max: 1 [10.00v Max: 120* =

Restrict to Regions

In Tube
Airto Air
[ Freespan
[] FreespanCal
] Tsl

] 750

[]sp

[[] Hide unclassified indications

(1] | The default configuration will be applied. I |Resetto Defau|t| | oK | | Cancel |

The Details section of each group shows the parameters defining the conditions that must be met for a
detected indication to be classified in this group. The user can modify all parameters.

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP)
measurement method, and Max/Min threshold values are set for amplitude and phase. For this group,
the criteria are limited to indications detected under the SP regions. As a result, the indications detected
under support plates for which all conditions are true will fall into this category.

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on
DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping
criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube
length data.

It should be noted that each automatically detected indication can only be categorized in a single group.
Also, the grouping operation is executed according to the order of the groups defined in the Groups list.
Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group.
If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be
categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does
not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single
indication will be categorized, and none can appear simultaneously in more than one group.

New groups can be created with custom parameters.
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Groups Details

Name

Mame: |Support Plates

[ [+

Amplitude Phase
Critical Channel: | ABS-F1 o Channel: | ABS-F1 "
Less Critical I‘E‘ Measure: | PP N Measure: | PP s
Min: 2,00V B Min: 2° =
Max: 1 [1000V = Max: 150° -

It is also possible to remove a group or use the up/down arrow keys to change the group priority within
the list.

Groups
Name +
Critical
Less Critical @

In the Front stage interface, the Grouping results will be displayed in the Indications pane.

Indications a X
10 of 10 results

Label Ampl. Phase

(~) Critical (4)

IND 1415V g2 -

IND 340V GER

IND 278V 106 ®

IND T06V 16°

(%) Less Critical (4)

IND 102V 111°
IND 1.00V 40°
IND 127V 56 °
IND 112V 73°

(~) Undlassified (2)
IND

IND

DOV Indications Mote
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the
Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom
of the Grouping menu and click on OK.

Bl Detected Indications Grouping - O #
Groups Details
Name MName: |Critical
Support Plates Izl Amplitude Phase
_ Channel: | DIF-F2 o Channel: | DIF-F2 v
Less Critical II| Measure: | PP = Measure: | PP v
Min: 1.00V = Min: 0° =
P [ |[10.00v M 120°° -

Restrict to Regions

In Tube

Air to Air
[] Freespan
[] FreespanCal
[Tl

[]Ts0

[]sp

Hide unclassified indications

0 l The default configuration will be applied. I |Resetto Default| |\/ oK | |x Cancel

Enabling this option influences the following elements of the software:

e Indications pane;
e Codeview;
e Logbook column.

The images below compare them when the Unclassified indications are shown (left) and when they are
hidden (right).

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the
header serves as a reminder to the user that not all indications are currently shown.
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Indications

26 of 26 results

Label Ampl. Phase
(&) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 084V 18°
IND 076V 17°
IND 1.20V 19°

(%) Undlassified (20)
IND

IND
IND
IND
IND

Indications

6 of 26 results

Label Armnpl. Phase
(~) Critical (1)

IND 153V 17°
(A) Less Critical (5)

IND 1.00V 14°
IND 093V 10°
IND 0.84V 18°
IND 076V 17°
IND 120V 19°

OOV Indications Mote

OOV Indications Mote

In the Code view, the red markers from the Unclassified indications have been removed.

443




=0 =0
o0 0
=0 0
=8 =
-
a B &
”3 BiE
] ﬂj s =
HE = MD
D
O
s
B o =P
BE =
T
BiE«
T=0 TS0

In the data file list, the number shown in the Logbook column represents the number of visible indications,
matching the number shown in the header of the Indications pane.

Data 4 X Data 4 X
7 of 7 data hA 7 of 7 data
Row Cal 8 [el Row Cal 5 [el
201000001 v 201000001
201004005 201004005
| ~ 201006009 68 | ~ 201006009 ®
~ 201006016 ~ 201006016
v 201024022 v 201024022
v 201025017 v 201025017
v 201025019 v 201025019
El ED
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REPORT SHORTCUT

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is
possible to select a channel with a measurement method and to associate an indication with it.

SMART Setup ‘

Enable O
Logboaok

Wizard Package Landmarks Indications

oo
((‘ AT\ 1 . +O o1 '.D
Wy L | -
Landmarks Regions Indications DQV Grouping| Report Help
Shortcuts

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter

pits in the report.

| | Indication Based On
PIT Channel

- O o
!
Source Ampl. Measurer Phase Measurer Sizing Curve Shortcut
DIF-F2 Vpp PP DIF-F2 “| D b4
by

|V’ OK | |XCanceI |

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a
single key or a combination of keys such as ALT+D, for example.

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication
displays momentarily on the corresponding Lissajous.
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DATA SCREENING

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under
the Analysis tab.

| Analysis
E. n |» oOBs R
% |% o 1|9
b - ‘m L7 3 ] _;.,[D *?0 P PG m ]
Screening  Screening Al Previous  Mext No | RST poiew Msg  Capture | Subtraction
All Files Selected Files Defect

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files
when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed
in the Data window.

DATA LIST

Magnifi will create a file for each inspected tube. The list of tubes can be created in the Data List section
of the General tab of the Backstage.

Data List

MNaming Format: Row, Col b

Preview: 001001.magdata |:! |:!
--0 --@

Create Mew List Import List

Four options are available to set the filename format:

1. Free format:
Each file has a custom name. Can also be defined from the Data tab of the Front Stage.

2. Prefix:
The file name includes a defined prefix followed by a sequential number.

3. Row, Col:
Row number, Column number. Mostly used for tubing inspections.

4. Zone, Row, Col:
Zone number, Row number, Column number. Mostly used for tubing inspections.

Click on the Create New List button. The displayed window will be different depending on the chosen
filename format.

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can
then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to
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generate the list of tubes. You can also use the Create & New button to add another set of tubes to your
list.

Il Fite List Creator e
| 3
File List Cenfiguration
Mumber of Rows in Component: 1 -
Start Mumbering at Row: 1 -
Row Interval: 1 -
Mumber of Columns per Row:
Row Mb. of Columns
1 1
Column Interval: 1 -
Include first and last column of each row
Files to Create: 1
Filename Preview: 001001
[+ Create & Mew l Ig" Create I [ b4 Cancel l

The same principles apply to the other file formats, except for the Free format option for which the file
name(s) needs to be entered manually in the file name window of the Frontstage.

The tube list can also be imported from another project using the Import List button. The tube list file can
be found in the Inspection folder. It is also possible to import a list created in Tubepro.
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PERFORMING AN ACQUISITION

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button.
Click on the Connect button under the Instrument tab. This will open the Instrument
configuration page. Click on the line showing the instrument to which you want to connect and
then click Connect.

Home Setup Advanced Instrument Calibration

XRREREe

Setup  Disable Ch. Setup Info /o Alarm  Fine Tune

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case,
ared and white Xicon will be shown in the Status field of the Instrument connection window. To download
a matching version into your Ectane, click on the Config. button and then click the Send firmware to the
instrument button of the Instrument configuration window.

¥ |
Instrument Connection (Ectane) ﬁ
—

Type Model MAC Address Host Status §Config Details
Ectane2 | E128RNMI . EC:92:33.00.0014 Q |o| @

Cancel
b
7 ¥ - - -
Instrument Configuration &J
Metworl Information Embedded Software Update
Made: Automatic - 2 Use the embedded software that comes with Magnifi
|P address:  |192.168.19 .10 Use custom embedded software
Subnet Mask:  |255.255.255.0
Gateway: (0.0 .0 .0
Cancel

Two acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is used to
scan your calibration tube and make the necessary adjustments on your setup without saving the data
automatically. The acquisition mode is used for the inspection. In this mode, the software automatically
saves the acquired data using file names based on the tube list.
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3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the
Home tab. This mode is active when the Setup Mode button is grayed.

Il
L3 ©

Setup Mull
Mode

4. Plug the NFA probe on the Ectane 160-pin connector.

5. Bring the probe head in a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

Push the probe head all the way through the tube so that it exits the tube.

Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2
on your keyboard.

8. Pull the probe at approximately 12”’/s (300 mm/s).

9. When it's done, press the Stop button or F2 again on your keyboard.

No
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VISUALIZING THE DATA

Multiple options are available to select your data and to measure it. The following describes useful

functions to do so:

DISPLAYED CHANNEL

There are four buttons at the upper right corner of the C-Scans, Strip charts and Lissajous windows. These

buttons are used for the channel selection.
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1. 2. 3. 4.
- DIF | F1

4 A

A

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart
are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this
channel.

PR ERE RN DR ED E N BT
158.4 kHz 158.4 kHz S

/
s
’

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the
desired channel to select it. Right-click or Left-click on this button to switch to the following or

previous channel in the list.
-] Joor ] F )
158.4 F1ABS

FIDIF
F2ABS
F2DIF
F3ABS
F3DIF
Land
MIX1

3. Same principle as 2., but for the type of channel only (absolute or differential)
4. Same principle as 2., but for the frequencies only



STRIP CHARTS AXIS ORIENTATION

The Strip charts are projections of the Lissajous on the vertical or horizontal axis. To switch from one axis
to another, click on the box showing an arrow at the upper right corner of the Strip chart.

NI 1 400V |

158.4 kHz (

On the strip chart/or on a C-scan, hold the right button of your mouse and drag on the zone of interest to
zoom in this section. This operation can be done in both axis for the C-scan.

ZOOMING

u L oF ]l [t 200w J=] I_,| | OIF | F‘.‘ ‘I 2000V |-0| oF L) Fr i

158.4 khz 158.4 kiz Ts64 K

-

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.

158.4 kHz

PRERER [t 200v [=]
J “F

®_  Full Extent
% Adjust Cursor Size
5 BestFit

—++  Horizontal

View indications
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ADJUSTING THE CURSOR LENGTH

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and
the full line is the center of what you have selected.

Only the portion of data between the dotted lines will be shown in the Lissajous.

To adjust your cursor length, hover your mouse over the dotted line, and click and drag the left mouse
button. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same
operation, but with the right button of your mouse.

ADJUSTING THE SCALE

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the
left button (decrease scale) or the right button (increase scale) of your mouse.

BREREY II 333V . BREREY R T

80.0 kHz

2.98v 12° 10.0% ID<9

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the
scale button.
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MEASUREMENT METHOD

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method.
A short description of the measurement methods can be found in the above calibration section of the

setup wizard.

[y

1. 2 3.4
Vep | e, 2P

=

1. Clicking on the corner with the black triangle gives the list of measurement method for the
amplitude of the signal. Click on the desired method to select it. Right- or left-click on this
button to select the next or the previous method in the list.

2. Same as 1., but for the phase measurement.

3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure
the phase with the right orientation.

4. Take the same two points in time to take the measurement in the other Lissajous

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw
a vector on your Lissajous.

LISSAJOUS ROTATION AND PANNING

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of
your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on
the raw channels since these channels have no gain or rotated applied, by definition. Also, rotating the
signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.

The origin point can also be moved by holding the left button of your mouse on the Lissajous background

and by dragging it in the desired direction.

DATA CENTERING

To center the data in the different windows, put your cursor at a point where you want the data to be
centered and use the spacebar on the keyboard. Calibration and sizing curves
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CALIBRATION AND SIZING CURVES

SLEW

The NFA probes include bobbins that generate absolute channel(s). It also includes a set of pancake coils
that generates C-scan(s). Since the bobbins and the pancake coils are not physically located at the same
position on the probe, there is a time delay between the channels (coils) and the C-scan (pancakes coils).
To bring all the signals at the same position, the bobbin channels can be shifted in time to match the C-

scan. This process is called Slew in Maghnifi.

To Slew:

1.

4.
5.
6.

Click on the Slew button that can be found under the Calibration tab.

( . Slew Calibration I&w

Select current slew:
[5|Ew / Slew Wizard Group A |

Capture Positions

Slew value: | -112 smpl

Close

L™ A

Place your cursor over a flaw in your C-scan.

Click on the button at the left in the Slew Calibration window. This will set the reference point at
which the channels will move.

Place your cursor over the same flaw but on the absolute channel.

Click on the button at the right in the Slew Calibration window.

Click on Apply.

Note that this process will move the channel(s) by a constant number of samples. Therefore, a probe
pulling speed that was not constant won’t have a data alignment that is valid throughout the hole scan.
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CALIBRATION

The following section describes how to calibrate your probe.

1. Goto the Calibration tab and click on the System icon.

2. Select Channel in the calibration window.

3. Inthe Strip chart, select the signal to calibrate and adjust the cursors to see only the desired
signal.

Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you select your calibration point. This will allow you to see what the system is using to make its
calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.

|74 Calibration

) Channel

() Channel and Sizing Curves

@i C-scan

() C-scan and Sizing Curves

) Landrmark

RBH-50_9.5mm

| Calibrate

| Reset

Select the signal name in the list.

Click on the green arrow button to associate the measured signal to the calibration point.

If more than one calibration point is present in the list, repeat steps 3, 4 and 5 for each one.
When all your calibration points are check-marked, click on the Calibrate button.

No vk
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SI1ZING CURVES

The following section describes how to build your sizing curves.

1. Go the calibration tab and click on the Sizing curve button.
2. Select Channel and Sizing Curves in the calibration window.
3. Select the signal in your Strip chart and adjust the cursors to see only the desired signal.

Note: The system calibrates the signal with a measurement method that is defined in the calibration part
of the setup (previous step). It is recommended to read the data with the same method as the system
when you select your calibration point. This will allow you to see what the system is using to make its
calibration. If for some reason the measurement is not taken properly, you may be able to readjust your
cursor to have the right measured values.

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to
show the defect size. To have the correct interpolated point, the measurement method also needs to be
the same as the one used for the sizing curve. To change the measurement method, click on the icons at
the bottom left of the Lissajous.

Select the signal name in the list.

Click on the green arrow.

Redo the previous steps for all the other indications in the list.
Click on the Calibrate button.

A

m Ok 4 ¥ ~ u N 18 - -ox
Q)| fome | setup  Adanced  imtrument  Colbwtion  Aabs  AstedAmabsis  Loyout  Cumment View [EI+]

000 LB < 0

yyyyy LosdFle Net Re Sevehs.. Clesr KO  prefecences
Setup

X[ Gl=] CET 53 2 N - | 9 2 N - ) Y O | 9 R N

= \

LA conos 8.0 kHz

. ' y | G : 3.4% ID
0.88V 264 0.26V 89 T:1.00% ID4

[ ] v:.I:TIIPI“H oeri J oef1 ] [ oo ] w JZ] 2w T oerr ] oerr ]

ip——— L
e

v
v
v
v
v
v
v
v
v R8
v
v
v
v
v
v

‘(,:7 Tow

DQV Screening Note

“information Documentation Report

456



LANDMARKS

The following section describes how to calibrate your landmarks.

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks
window the same way as you calibrated the sizing curve(s) points. You can use the Land channel to do so.
The positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the far side
tubesheet, that is, the first one encountered during data acquisition; TS1 is the nearside tubesheet).
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Once the landmarks are calibrated properly the system should be able to recognize them automatically.

Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far
end of the tube is needed.

SAVING YOUR SETUP

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button
under the Home tab. The displayed window will allow you to give an appropriate name to your setup and
to save it at the desired locations. The save location is, by default, your inspection file.
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i A
. Save Setup As u
F Setup
0 Save setup in current inspection Browse...
File name:  MNew setup
MName
| W OK | [ 3 Cancel ]

L A

You can also save the data of your calibration standard by clicking on the Save As button under the Home
tab.
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STANDARD ACQUISITION

The following section describes how to perform an inspection.

1. Connect Magnifi to the instrument.

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab.
Acquisition Mode is activated when the Setup Mode button is not grayed.

3. Plugthe NFA probe into the Ectane 160-pin connector. The orange dot on the connector must
be aligned with the orange dot on the Ectane.

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

5. Push the probe all the way through the tube until it exits the far end.

6. start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2
on your keyboard.

7. Pull the tube probe towards you at a constant speed until it exits the tube.

8. When finished, press the Stop button or again F2 on your keyboard.

9. Repeat steps 4,5 and 6 for all the tubes to inspect in your bundle.

MANUAL SEQUENCE

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and
can trigger the acquisition start/stop and the data recording automatically. At least two landmarks are
needed to use this feature. These landmarks can be created by using the Landmarks button under the
SMART Setup tab.

To set the manual sequence:

1.
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Click on the Manual Sequence button under the Calibration tab.

If a warning message is shown in this window, change the parameters until no warning is shown.
The system will progress through the different windows to guide you.

Click on Settings ...



8.

i '\ i '
= Sequence & Q Manual Sequence Configuration e

Sequence

/.\ Type: ) Mone @ Landmark
Start Recording Landmark: | Exit -
Launch . |

Start Recording Delay: 10s -

Stop Acquisition Landmarke  T51

Target Settings... Stop Acquisition Delay: 20s -
Restart
Type: () None ) UserInput @ Timer
MDD Review Delay: 100s -

. Pushing
. Pulling/Recording
. Waiting for Mext

0K l [ Cancel

You must be
connected to an
instrument to start
the sequence,

Connect... |

Select Landmark in the Type section.

In the drop-down menu, choose the Landmark that will initiate the data recording. If you keep
the default landmarks, you can select the Exit landmark that will be triggered when the probe
goes out of the tube when the probe is pushed.

You can enter a delay to start the acquisition after the first landmark is detected (Start
Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop
Acquisition Delay).

Two options are available to restart the acquisition: The user can either push a button or use a
timer. Select the desired option in the Restart section.

Click on OK.

To use the manual sequence:
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1.

Connect Magnifi to the instrument

Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. The
Acquisition Mode is activated when the Setup Mode button is not grayed.

Plug the NFA probe into the Ectane 160-pin connector.

Bring the probe head to a clear area in your standard and balance the probe by clicking on the
Null button under the Home tab, or press F6 on your keyboard.

Open the Sequence window by clicking on the Manual Sequence button under the Calibration
tab.

Put your probe in the tube to inspect and click on the Launch button. This will start the data
acquisition.



7. Push the probe until it exits the far end of the tube. If set correctly, , Magnifi will recognize the
landmark and this will initiate the data recording.
8. Pull the probe towards you until it exits the tube. This will trigger the last landmark detection
that will stop the data recording.
9. Acquisition restart:
a. Ifyou selected User Input in the settings of the Manual Sequence Configuration, the system
will wait for the user to enter information on the tube to restart the acquisition. Click on
NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition.
Redo step 6, 7 and 8a. for all the tubes to inspect
b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown
will be triggered after the last tube acquisition was taken. The acquisition will start after this
time has elapsed. Repeat steps 6 and 7 for all the other tubes to inspect in the bundle.

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is
the case, you won’t be able to catch the landmark that triggers the data acquisition at the end of the tube.
In this situation, you can click on the Target button in the Sequence window to start the data recording.

DATA LIST MANAGEMENT

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the
Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be
found under the General tab of the Preference menu of the Backstage.

General (Setup Related)

Measurement Units

Report Units: | Millimeter

Preferences

Channels

Full Channel Scale: 2000V p-p 3

Hide Raw Channel

Precision
[] Enable

Amplitude: |2 decim...

General n
Phase 0 decim...

[ H Acquisition
Automatic File Recording

Display Auto Create new file on Next

Automatic Next on Stop acquisition

Analysis

This list of tubes is shown in the Data window at the left of the Frontstage.
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Data T X
Row| Col

» 001 001 =)

b 002 001

b 003 001

b 004 001

4 total, 0 acquired

[ |[#=}'|[ |

MIEDRAY

A common practice is to rescan your calibration tube and balance the probe periodically. You can save
this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can
go out of acquisition mode, scan your tube, and click on the Save Cal As... button under the Calibration
tab to save your data. You can then go back to the acquisition mode to continue your inspection and to
automatically save the acquired tubes in your bundle.

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark
icon.

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home
tab.

A tube name can be changed by right-clicking on its name and by selecting the Rename option.
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LOADING A FILE

1. First disconnect your computer from the Ectane by clicking on the Disconnect button under the
Home tab.

2. You can load a file by double-clicking on the file name in the Data window. It can also be done
by selecting the file in the list and by clicking on the Load button under the Home tab. Note that
double-clicking on a tube when you are still connected to an instrument will initiate data
acquisition.

3. You can open the next or the previous file in the list by clicking on the Previous or Next button of
the Home tab.

The data files can be filtered by using the Filter button of the Data window.
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REPORT

INDICATIONS

The two (2) Indication buttons at the lower corner of the Lissajous windows can be used to add an entry
to the report. These 2 buttons indicate the code that is associated with the defect being entered. Both
buttons are identical, but can be set to different flaws.

To add an indication to the data:

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous
includes only the defect signal.

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect
to enter.

3. Click on the defect button to add an entry to the report.

1,] .| oF .| F, T o14sv 4] DIF | F1,[ |1 2783° |1 148V

158.4 kHz 158.4 kHz !

CRK
, DNT
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; 0BS
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&
0.4 119° 46.!
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Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is
explained in the SMART Setup section of this manual.

Indications can also be added to a tube to indicate, for instance, that it has no flaws or that it is plugged.
To add an indication to a tube:

1. Load thefile
2. Click on the appropriate indication button available under the Analysis tab

(M| OE 4 ¥ -

O Home Setup Advanced SMART Setup Instrument Calibration Analysis Layout Current View
(%] L ”m s s > oes =
fi l?" L7 10 0
| | < .3 < > PG &l
Screening Screening All Previous  Mext Neo Review Msg  Capture | Subtraction
All Files Selected Files Defect | RST
REPORT TABLE

To access the list of indications entered:

1. Make sure that the Report option is selected under the Layout tab.

Layout Current View

I. Infofield Data Report DOV Indications = Mote

2. Click on the report ribbon at the bottom of the screen to make the list visible

Report + X

Zone |Row  |Col” |Code Size Side Ampl. (V) Angle()  ChanneliCscan  Ypos (mm) LMK Y pos Offset Y pos. (mr Yleng. (mm)  Comment
1 0 0 0.00 0.00 0 0.0 0.0 00 x

2 0 0 0.00 0.00 0 0.0 0.0 0.0 x

A\ 2 new notifications Informatio

Entries in the report can be modified by changing the value in the table. You can also delete an entry by
clicking on the X next to it.

REPORT GENERATION
Magnifi can automatically generate a full report with the report table.
To generate this report:
1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.
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2. Click on the Generate Report button under the Report section of the General tab.
3. Choose your preferences and enter the required parameters. The # of tubes in component is
used to show the percentage of tube in each category.

. Generate Report e Bl Generate Report %
Section Selection
REPDrt Parameters Sections to Include in Report
Tube project parameters

Defect Table Format: | Tubing ECT *

‘ # of tubes in component: |50 - ‘ Report Summary
[1 Show Empty Cells

Instrument Settings
Component Information

Picture: III

Inspection Summary
Date and Signature
Screen Captures

# of tubes in component: | &1 -

| € cancel | | P Next | [ Cancal | [B_Next |
4. Click Finish to generate the report.

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed
using any regular web browser.

There is a “copy” button next to each element of the report such as tables and images. When clicking on
it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or
Word.

Eddvfi . .
oW Analysis Report (G

Instrument Settings

Channels Instrument Settings

Channel Calibrations

Setup name: ECT-Bobbin
Mix Channels

‘Component

Information Channels

Inspection Summary

Indication Table Name Frequency (KHz) Drive (V) Gain (dB) Low Pass (KHz) High Pass (Cnt)

Inspection R_ABS-Fi 1600 250 460 400

Data
R_ABS-F2 800 250 460 400
R_ABS-F3 400 2,50 460 400
R_ABS-F4 200 250 460 400
R_DIF-F1 1600 250 460 400
R_DIF-F2 800 250 460 400
R_DIF-F3 400 250 460 400

&
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The Print button, bottom right corner on image above, can be used to either print a paper copy of the
whole report or to save it as a .pdf document. The PDF generator available with the current web browser
will be used.

w023 153 Mo Roper:
" . Imprimer 4 pages
Analysis Report eoges P
Instrument Settings Destination B cnregistrer au formati ¥
Sonup nama: ECT-Babin
Channels Pages Tous
e o ey camiem e o
: o s Mise en page Portrait b
s “
s =
ransr 20 P - Plus de paramétres v

m Annuler
: - S “

The report logo can be modified by clicking on the Select Company Logo that can be found under the
System tab of the Backstage.

System (Computer Related)

Measurement Convention Measurement Units
Freere= @ asme @ Metric
) ASME Inverted e o Imperial
) EDF
Readback
D Do not display data during loading
Speed:

! Actual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
! Retain check state

General

@ Reset to checked after loading a data file
Display Setup Wizard Path: C\Users\daube  QTEC\Documents'MagnifitSetup

Automatic Features
D Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo
Preview:

o
‘a.. °
Select

Company Logo

The report table file in the Inspection folder can also be imported into other reporting software such as

Tubepro.
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MFL Probes
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INTRODUCTION

This document presents how to set up and calibrate the MFL probe with Magnifi on an Ectane test
instrument using the Setup Wizard.

EQUIPMENT

The MFL probes use a 19-pin connector that can be connected to an Ectane with the “ERMN’’ option.

The Absolute, Differential and Trail signal from the probe will provide Strip charts and Lissajous. Magnetic
flux leakage technology gives a variation of amplitude only. The phase variation on the Differential channel
is artificially built to help the user to identify the indications. The Trail signal is more sensitive to internal
flaws and can help determine the flaw side in a tube.

From the following table, the best standard probe for your application can be selected.

Note that Eddyfi also offers custom products at diameter that are not shown in this table.
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Table 12 — Probe diameter selection table

PRBT-MFL-ADT-XXX-Nzz
' |

TUBE OD TUBEWT DIAMETER POLY PROBE PART NUMBER NOTES
mm in BWG mm in CODE mm in CODE LENGTH
12 277 0.109
124 12.4 0.488 PRBT-MFL-ADT-124-Nzz
13 24 0.0%5 These probes offer less sensitivity
19050750 1 2t 0.083 138 13.8 0.543 PRET-MFL-ADT-138-N 1o extermal defects, ecause e
: ] -MFL-ADT-138-Nzz ;
15 183 0.072 core sections of the probes are
significantly smaller than the tube
16 165 0.0685 148 14.8 0.583 PRBT-MFL-ADT-148-Nzz section. Senaitivity to internal
9 376 0148 | 162 162 0638 PRBT-MFL-ADT-162-Nzz defects remains very high.
10 340 0.134 170 17.0 0.669 PRBT-MFL-ADT-170-Nzz
1 3.05 0.120
180 18.0 0.709 PRBT-MFL-ADT-180-Nzz
12 277 0.109
25.40 1.000 13 21 0.095 188 18.8 0.740 PRBT-MFL-ADT-188-Nzz
14 21 0.083
194 194 0.764 PRBT-MFL-ADT-194-Nzz
15 1.83 0.072
16 165 0.065 20 20m (B51t)
200 20.0 0.787 PRBT-MFL-ADT-200-Nzz
17 147 0058 30 30m (98
10 3.40 0.134
230 23.0 0.906 PRBT-MFL-ADT-230-Nzz
1 3.05 0120
12 277 0.109
31.75 1.250 244 244 0.961 PRBT-MFL-ADT-244-Nzz
13 24 0.095
14 21 0.083
256 25.6 1.008 PRBT-MFL-ADT-256-Nzz
15 1.83 0.072
10 3.40 0.134
290 29.0 1.142 PRBT-MFL-ADT-290-Nzz
11 3.05 0.120
12 277 0.109
3810 1.500 302 30.2 1.189 PRET-MFL-ADT-302-Nzz
13 2M 0.095
14 21 0.083
315 35 1.24 PRBT-MFL-ADT-315-Nzz
15 1.83 0.072

The MFL calibration tube used in this document includes the following flaws:
e Internal 360° groove, 10% of wall loss
e External 180° groove, 40%,60% and 80% of wall loss
e OD Flat bottom hole (FBH) 40%, 60% and 80% depth
e Hole, 100% of wall loss

Other combinations of flaws can be used to calibrate the probe and to build sizing curves.
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In this section, we will create a folder structure that will manage the saving location of your setup, data
and report. This management is operated through the creation of a Project.

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different inspections
that are related in some way. For instance, it can include all the inspections done at a refinery shutdown
and be named Refinery_Shutdown_May_2018. The second level of the file is the Inspection folder.
Inspection folders are saved in the project file. An inspection folder can include the data specific to the
inspection of a tube bundle with a specific technology and could be named S5316_075x0.065_ECT for
instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.

PROJECT
(ex: Refinery 04-17)

|
INSPECTION 1
(ex: Bundle No A1D3FX)

—F—— ] |

INSPECTION 2 INSPECTION X

| |
| |
| |
|
| SETUP |
| |
| |
| |
| |
| |
| |
| |
I TUBE I
| <> D
i LIST ATA
| |
| |
| |
| |
| |
| |
| |
| REPORT |
| |
| |
| |
- 1
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When you open Magnifi, the first page displayed is called the Backstage.

Magnifi® 5.3B1T376 - [Setup from original data file] - ECT-Bobbin.magdata

General
Project / Inspection Information
Project Folder Documents\Msgnifi Projects\Defa Probe: Unable to detect
General r
Inspection Folder Documents\MagnifProjects\Default\Demabatas | IE) 0 Application: Generic
oroject Fetder | |ImEpection Sub-| | Tansie
2l folder Inspection Tube Dimensions:
op: 2540mm
Acg. Summary Setup/ Data
Setup Loaded:  From original data file WL 165mm
N N
Setup Location: Jocuments\Magnifi\Projects\Defa (1) é Length: 500 mm
B Create Setu Open’s
P penSetup | | Open Data )
DataLoaded:  ECT-Bobbin Material:  Stainless Steel 316
Frequencies: 160.0, 80,0, 400, 20.0 kHz
Data List

Naming Format: | Row, Col

Preview: 001001 magdata — =
=0 =@

Create New List| | Import List
Documentation
Report
Name: Report.mdb -
reterences o,
Preferences Teble Profile: Tubing ECT - @ © .
Export Defect’
Report
[7] Take screenshot with report entry. Table

Start / Resume

To create or open a project, click on Open/Add Project in the backstage. You can select an existing
project/folder or you can create a new folder.

1. Create a folder by right-clicking on the location where you want to add your project file. Select
New, Folder and enter the chosen name. You can then select the newly created folder and click
on Select Folder.

[ Select 3 project (S5
@ J* = PR )

Organize v New folder s @
\
|
- = !
g
]
] Projects Folder
#] Shortcut
8 Microsoft Access Database
& Bimapimage
[ Contact
85 Microsoft Word Document
= View » ) Microsoft Access Database
m Sort by » B Microsoft Project Document
Group by » @' Microsoft PowerPoint Presentation
- Refresh B Microsoft Publisher Document
[ SonicWALL Global VPN Client Document
(9
a0 ¥ Rich Text Format
= Undo Delete CtrteZ o e
e @7) Dessin Microsoft Visio
" = Share with »
= = B Microsoft Excel Worksheet
New » B Briefcase
Properties
Folder: Magnifi
| Select Folder Cancel
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your
inspection.

i A’
. Manage ﬁ

l Inspections
o Manage Inspections Select Other...

Mame State

Default Ready for Inspection

Bundle_A_C5_254+2.77_M Fl| |_E

|v’ Select Hx Close ]

L9 A
3. Click Select. This will define the position where the setup(s) and data will be saved.
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SETUP WIZARD

In this section, we will show how to create a setup using the Setup Wizard in Magnifi.

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System
tab, you can change the measurement units from metric to imperial and vice versa. For the metric units,
you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement
for imperial units is inches. When finished, click on Preferences again to go back to the General window.

System (Computer Related)

Measurement Convention Measurement Units
Preferences @ ASME @ Metric
ASME Inverted m—— o ) Imperial
O EDF

Readback
[] Do not display data during loading
Speed:
Adtual Inspection Speed
@ Maximum
“Keep Current Setup” Button Behavior:
Retain check state

General

@) Reset to checked after loading a data file
Display Setup Wizard Path:  C\Users\daube.QTEC\Documents\Magnifi\Setup

Automatic Features
[] Allow to save setup in original location

Analysis Ask to save setup when the first data file is recorded

Logo
Preview:

£ (@ eddyfi

Sharteuts

Keyboard.. |
Remaote... |

To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to
start the Setup Wizard.
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COMPONENT DEFINITION

The first page shown by the Setup Wizard is the Component Definition.

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected.
If the material is not in the list, you can click on Manage... to open the List of Available Material window.

" New Setup Wizard @

Component Definition | [

0 Configure the geometry and material of the component to inspect

Geometry: ) Surface @ Tube from ID
Application: @ Generic 1 Air Conditioner
Material: Carbon steel vl [ Manage... ]

Resistivity: 21 pll-cm

Permeability: 450 p

Velocity: 5890.000 m/s
Wall thickness: 277 mm .

12
BWG

6 24
Qutside diameter: 2540 mm -
Length: 6000 mm -

Mote about selected material:
ASTM: A1T78, A179, A192, A210, A214

2 Cancel Back b Net

L r,

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant
name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is
used to set IRIS parameters only, and it doesn’t need to be set if an IRIS inspection is not performed on
this material.

It's possible to add a note about the material to specify information such as its application or composition.
When you are done, click OK.

476



[y List of Available Materials

Custom Matenals

g

Browse...

Materials Co
MName 5:{;;;: ?r: /) [R;?i::;ty Permeability <+  Add
Stainless Steel 321 - ET ONLY 0.000 715 1 (| “ & Remaove Al
Stainless Steel 430 - ET ONLY 0.000 B3 100 (%

Stainless Steel Duplex - ET OMLY 0.000 74 75 |
Stainless Steel 9041 - ET ONLY 0.000 94 75 | ¥
Titanium 6070.000 486 1 (%€
Ti-6AI-4V - ET ONLY 0.000 123 1 (%
Zirconium 4650.000 a1 1| %

Motes About Selected Material

v ok J[X conce

You will be back to the Component Definition window. If you added a new material, it will now be available
in the material list.

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider.
Enter the tube’s outer diameter and length.

These tube properties will help Magnify to suggest the optimal scan parameters.

Click Next when everything is set correctly.
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PROBE SELECTION

In the Probe Selection window, select the probe you will be using for your inspection.

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu.
More precise filtering can be done by using the Model drop-down menu. You can then select your probe
by its catalog number (PRBT-MFL-ADT) and then click Next.

r'/". MNew Setup Wizard " ' ' u-‘

/ l Probe Selection b - |
~ Select the probe that you want to use for your inspection
Technique: [MFL | Model:  [All -
Probes

Tech. | Madel ‘ Catalog Number Y | Description

17.9mm

MFL

(& New.. | |g4Manage. |

[ Cancel || Back |[Pp Nex |
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SCAN DEFINITION

The Scan Definition window is used to configure the axial position measurement method, the acquisition
rate and the typical probe speed.

% New Setup Wizard I e

Scan Definition

Configure the type of scan you will be performing with your probe

Scan: Single Pass

Main Scan Axis: Y Axis

Position from: @l

Acquisition rate: 2000 Hz -
Typical probe speed:  1000.0 mm,’s -
Acquisition Size: 600.000 s . Maxirum

[ Cancel |[‘ Back |[’ MNext l

e A

The position along the tube can be defined by using either the internal clock of the system, or by using an
axial encoder. If you use the internal clock, the default position will be given assuming that the probe is
always pulled at the typical probe speed. If the typical probe speed is set to 1000mm/s, and the time since
the acquisition began was 2 seconds, then the system will indicate a position of 2000mm. Using an
encoder will give you the exact position of the probe. Note that the position can also be obtained by using
the landmark tool, but this feature will be shown later.

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate
is set to 2000 Hz for MFL.

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For an
acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least 2 points per
millimeter. If you do not use a pusher-puller device such as the Probot, the pulling speed won’t be
constant. Therefore, it is recommended to target a lower pulling speed to be able to reach your axial
resolution target. The typical probe speed should be set as close as possible to the real value. This will
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help the algorithm that automatically detects landmarks (this will be explained in the Landmarks section).
The recommended pulling speed for MFL is approximately 1000mm/s.

If you select to measure the position from Encoder, different fields will appear, and a second Scan
Definition page will become available.

. New Setup Wizard - [ 2. New Setup Wizard > [
Scan Definition Scan Definition
Configure the type of scan you will be performing with your probe Encoder and axis settings
Scan: Single Pass. e
Main Scan Axis: Y Ais Type  [Quadrsture -
BL=TOREY Encoder | Resolution: 25460 % count/mm
Detect Overspeed ] Invert direction
Typical probe speed: 1000.0 mm/s - Preset: 0.000 mm =
Maximum probe speed:  1500.0 mm/s. : Apply preset on Start
Density: 2.000 smpl/mm
Acquisition Size: 100000 mm 3 | [#] Maximum
Cancel | [4 Back |[p Net Cancel | [4 Back |[B et |

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered.
The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the
number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition
rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a
speed exceeding the Maximum probe speed, there will be gaps in data.

The second page includes the type of encoder and its resolution. A preset can also be specified if your
acquisition doesn’t start at 0 mm.

Click Next when you're finished.
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DATA DEFINITION

The Data Definition window is used to set the hardware gain for the different channels. It is important to
set these parameters correctly before acquiring the data since they are driven by the instrument and
cannot be modified during the analysis.

r ™y
5" New Setup Wizard ¥ ’ @
» Data Definition e |

. Select the channels you will be using and the necessary frequencies
Connector: 19 pins
Channels
MName Prefix Gain (dB)
ABS ABS 30.0
DIFL DIFL 480
TRAIL TRL 36.0
DIF2 DIF2 48.0
|3 Cancd | |4 Back |[B Ned
e A

Click on Next when the desired parameters are entered.

The next window is used to build mixed channels. For MFL, a mix channel is built by default to create a
differential signal shape on the differential signal. This part of setup is used for internal signal processing
purposes only and it is not recommended to change it.
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i ™
=" New Setup Wizard ¥ ’ ﬁ

ﬂ Data Definition e > |

Configure the channel mixes for your inspection

Input Channel 1 Input Channel 2 Output Mixed Channel Mixed Reference Signal
DIFIDC DIF2DC DIFDC DO NOT USE (X

|3 Cancel || Back |[Pp Nex |

L. ”,

Click on Next.

DATA PROCESSING

The Data Processing window is used to configure the signal processing to apply to the channels.

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can
be changed without any problem during data analysis, while a wrong parameters choice for the data
acquisition can mislead the analysis. It is possible to change the filters parameters after the acquisition,
so it is always possible to fine tune the filters parameters during the analysis.
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( " New Setup Wizard , l&r
ﬁ Data Processing
Y Select the processings that you want to apply to the channels you have selected
[T Individually configure all the channels
Low Pass Median High Pass
MName - Cutoff (mm) Window Size (mm)
ABSDC [ 40 ] 1500
DIFIDC E 40 [C] 1500
DIF2DC E 40 ] 1500
DIFDC ] 40 [[] 1500
TRLDC E 40 [C] 1500
[ Cancel | [ 4 Back | [ b Mext |

L 4

The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful
when your defect signal has a lower frequency content than the background noise. In this case, using a
filter will remove part of the noise without removing the defect’s signals. This may help with data analysis.
However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too
low will filter out the defect’s signals.

The median high pass filter is used to filter out low frequency noise or drift such as lift-off variations of
the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of
the high-pass median filter should be set to at least three times the axial length of the longest flaw that
may be encountered. Data should be examined in both its filtered and unfiltered states. It is important to
keep in mind that the median high-pass filters can distort phase. More information about median filters
for NDT analysis can be found on Eddyfi’s blog.

Click Next when you are done.
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CALIBRATION POINTS

The Calibration Points page is used to define the points in your calibration tube. These indications will
later be used to calibrate your probe and to build sizing curves.

The units of measurement can be set in percentage or in depth (millimeters or inches).

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and
size. The side and size of the flaw will be used to position the calibration point in the sizing curve(s).

Calibration points can also be imported with the Import button.

" New Setup Wizard ) , @

Calibration Points ’
Configure calibration points used for channels and sizing curves

Units of measurement: | Percentages (%) -

Calibration points

MName Side Size

HOLE Through 100.0 %
FBH-80 oD 80.0 (X
FBH-60 oD 60.0 (%]
FEH-40 oD 400 X
FBH-20 oD 200 (%
IDGR-10 D 100 (%
IDGR-20 D 200 X
WS180-20 oD 200 (%]
WS180-40 oD 400 %
WS180-60 oD §0.0 (X
WS180-80 oD 80.0 (%]
DO NOT USE None 00

& Import | [ == Add |

[x Cancel H‘ Back “b Mext |

e A

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).
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CALIBRATION

The Calibration pages are used to define reference signal(s) that will be used to set the amplitude(s) and
phase(s) of each channel using the selected measurement method.

By default, the calibration is performed on the Hole signal by adjusting it to 1V and 90° on the differential

channel

. The wear scar 60% is used to calibrate the absolute channel at 6V and 90°. And the inside

diameter groove is used to set the trail signal at 10V with a phase of 0°. These calibrations are done to
have the amplitude on one axis only (0° or 90°) since signals from the MFL probe don’t have a phase.
Different reference signals can be set to calibrate the amplitude independently for each channel. Simply
modify the parameters in the table to customize the calibration.

-

% New Setup Wizard I —25—

o

MName
ABSDC
DIFIDC
DIF2DC
DIFDC
TRLDC

Calibration
A Configure parameters to calibrate channel amplitude and phase
[ Individually canfigure all the channels
Amplitude Phase
Voltage (V) Reference Measurement Angle (%) Reference Measurement
6.00 W5180-60 PP 0.0 DO MOT USE PP
1.00 HOLE pp 90.0 DO MNOT USE Pp
1.00 HOLE PP 90,0 DO MOT USE PP
1.00 HOLE PP 90.0 DO MNOT USE PP
10.00 IDGR-10 pp 0.0 DO MNOT USE Pp
[ Cancel | [ ‘ Back ] [ ’ Mext |

%,

A

When you select the reference signal, the system will use the selected measurement method to apply a

rotation and a gain. Here is a short description of the available options:

1.

2.
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Absolute (A):
Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude.

Absolute Horizontal (AH):
Uses only the horizontal component, from the Lissajous origin to the main cursor position to
measure amplitude.



3. Absolute Vertical (AV):
Uses only the vertical component, from the Lissajous origin to the main cursor position to
measure amplitude.

4. Absolute Peak (AP):
Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure
amplitude.

5. Absolute Peak Horizontal (APH):
Uses only the horizontal component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

6. Absolute Peak Vertical (APV):
Uses only the vertical component, from the Lissajous origin to the peak value of the data
selection, to measure amplitude.

7. Average Peak (MP):
Takes the distances from points at the extremity of the cursor to the peak of the data selection
to build an average vector. Only used and recommended for absolute signals.

8. Average Peak Horizontal (MPH):
Uses the horizontal component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

9. Average Peak Vertical (MPV):
Uses the vertical component of the distances form points at the extremity of the cursor to the
peak of the data selection to make an average vector. Used for absolute signals.

10. Peak to peak (PP):
Uses the combination of the vertical and horizontal component to measure the maximum
amplitude.

11. Horizontal (PPH):
Uses only the horizontal component to measure the amplitude.

12. Vertical (PPV):
Uses only the vertical component to measure the amplitude.

13. Peak to peak First Transition (PPF):
Uses the combination of the vertical and horizontal components of the first transition of the signal
to measure maximum amplitude. The first signal transition is from the base of an indication to its
peak.

S1zZING CURVES

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this
table.
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s % ] I .
%+ New Setup Wizard , &

A Sizing Curves | |
Add and configure the sizing curves necessary for your inspection

D MName Source
ABS ABSDC @
DIF DIFDC @

=)= Add

[x Cancel H‘ Back Hb Mext |

L 4

The sizing curve will allow you to estimate the size of a defect based on the calibration points signals
obtained with your calibration standard. Magnifi will give you the interpolated flaw size base on the built
sizing curves.

Sizing curve names are customizable. The channel source and measurement type can also be changed.
You can add sizing curves by clicking on the Add button.

Click Next when you are done.

For every sizing curve created in the last window, a window will appear to configure the curve properties.
The name of the curve will be shown in the upper left corner of the page (ABS in the example below).
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" New Setup Wizard , .3
Sizing Curves
Configure the properties of the ABS sizing curve
Meazurement method: [ PP - | LrsElli et
Shape: [ BEP v| MName Side Size
WS180-40 oD 40.0 T
Shape orientation: [ Auto, = |
W5180-60 oD 60.0
[T] Report as remaining wall WS180-80 oo %00
v - .
Force to zero =3
[] DO NOT USE None 0.0
[7] IDGR-10 D 100
[7] IDGR-20 D 200
[] HOLE Thraugh 100.0
[] FBH-20 oD 200
[E] ws180-20 oD 200
[] FBH-40 oD 40.0
[] FBH-GOD (o]u] 60.0
[E] FBH-80 oD 80.0
[ Cancel | [ 4 Back | [ b Mext ]

L 4

The measurement method options are the same as what is described in the calibration section of this
document. By default, the Peak-to-Peak option is set for absolute channels and the differential channels.

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of
the available options:

1. Best Fit (Dual linear) (for phase measurement only):
A curve with two linear segments representing ID and OD (or Near and Far) side calibration
points with respect to phase.

2. Best Fit (Dual Slope) (for phase measurement only):
A curve with two segments representing ID and OD (or Near and Far) sides. The ID section is
linear, and the OD section is polynomial. The OD side of the curve will need at least three points
(including the hole) in order to trace a polynomial curve.

3. Best Fit (Polynomial) (for phase and amplitude measurements):
Best polynomial (degree 2) interpolation within the measured calibration points (requiring at
least three points).

4. Connected Points (for phase and amplitude measurements):
Simple, point-to-point curve.

5. Best Fit (Linear) (for phase and amplitude measurements):
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Best linear interpolation within the measured calibration points

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements):
Polynomial (degree 2) interpolation with two segments for both ID and OD side of the curve.
Need at least three points.

Once the measurement method and the interpolation curve shape are chosen, you can select the curve
points for each sizing curve previously created. The order in which the points appear in the list may
influence your sizing cure. Make sure that the measured values of the calibration points are in ascending
order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking
the box Report as remaining wall thickness.

Click Next when you are done.
INDICATION CODES

The Indication Codes page is used to define the entries that can be added to the report when analyzing
the data.

" Mew Setup Wizard I =3
— Indication Codes
—
= Configure the indications codes used for the report
Code Description Type Automnatic Color
COR Corrosion Defect E|
CRK Crack Defect (%)
DNT Dent Defect (%)
DSl Distorted support indicatic  Defect E|
ERO Erosion Defect E|
MDD Mo defect detected Mo indication E|
0BS Obstructed Feature |™ Red E|
PIT Pitting Defect (%
PLG Plugged Feature |’ Brown E|
RST Restricted Feature I Yellow E|
wiL Wall loss long Defect %
wLs Wall loss short Defect %
WLT Wall loss taper Defect E|
A Import | | <= Add |
[ Cancel | [4 Back | [ ’ Next ]

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.

You can modify the default indications codes list by changing the parameter in the table. New indications
can be defined by clicking on the Add button.

Click Next when you are done
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DiISPLAY

The first Display window is used to set how the data is displayed during and after the acquisition.

" New Setup Wizard , @

| Display | ,
H=

Configure display and layout properties

General options Lissajou f Strip chart options

Zoom behavior on stop acquisition: [E] Miniature strip chart

Zoom to full scale

Proportion: 33.00 % -
) Zoom to content
Display Direction: Top to Bottormn -
@) Keep current scale
Strip chart duration: 6000 mm -

[x Cancel |[‘ Back |[’ Mext ]

L 4

The scroll direction is the direction in which data appears on the screen. If you choose downward, the
signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal
will go from the bottom to the top of the screen.

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box.
The strip chart duration is the length of a Strip chart window when the data is acquired.
Click Next.

The second Display window is used to set the layouts. Check marking the proposed layouts will make them
available in your setup. You will be able to switch from one to the another via the layout tab. The " S "
stands for Strip chart, " L " for Lissajous and “C” is for the defect Code indication zone.

The layout with the blue background will be the one opened by default, which can be changed to your
desired option.

Layouts can be readjusted at any time.
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' Y
5+ New Setup Wizard ¥ ’ M

Display = 1
Select the layout that you want to use to display your inspection results

3 Strip charts, 3 Lissajous stacked 2 Strip charts, 1 Lissajous

(]

. : Default layout

[x Cancel ][‘ Back ]I\/ Finish

" r

Click Next to complete the setup wizard process.

SETUP MODIFICATIONS

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the
parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button
associated with the parameter you want to change.

Setup Advanced Instrument Calibration Analysis Assisted Analysis Layout Current View

o N 2B § & A N Sp @

Comp Probe Scan Data Process Landmark PC'EI Calibration  Sizing  Indication Display
oints

This will open one of the windows previously described, where you can change the values you originally
entered. If applicable, go through the process by clicking on Next, and then click on the Finish button. This
will apply the modification to the setup.

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed
using the advanced settings, the information shown using the Setup tab may not match your actual setup.
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SMART SETUP TOOLS

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.

LOGBOOK
The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook.

SMART Setup

= ' | 0o
E q\ v D I - B o
o W L N
Enable Wizard Package Landmarks Indications | Landmarks Regions Indications DQV Grouping Report Help
Logbook Shortcuts

The logbook